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1.1 Rendezvous Team Duties 

PURPOSE 

To define the specific Mission Control Center (MCC) duties of the RNDZ GPO team console 
positions. 

PROCEDURE 

As a guide to defining interfaces, the following list highlights the specific principal duties and 
responsibilities of each member of the RNDZ/PROX OPS MCC team.  The RNDZ GPO and 
RNDZ FDO are co-leads of the RNDZ/PROX OPS MCC team. 

 

Table 1.1-1  RNDZ/Proximity Operations Team Members 

Operator Position Call Sign 

Rendezvous Guidance & Procedures Officer RENDEZVOUS "RON-DAY-VOO" 
Rendezvous Procedure Support RPS "R-P-S" 
Onboard Navigation ONAV "O-NAV" 
Rendezvous Targeting TARGET "TAR-GET" 
Proximity Operations PROX OPS "PROX-OPS" 
Flight Dynamics Officer FDO "FI-DO" 
Trajectory TRAJECTORY "TRAJ" 

 

 

Figure 1.1-1  RNDZ GPO Interfaces in the Mission Control Center 

ONAV RPS PROX OPSTARGETPROFILE
SUPPORT

GNAVDYNTRACK

FDO/TRAJ RNDZ
GPO

CAPCOM
FD CREW

Other FCs

 

                   



SHUTTLE OPS RESP: M. Fletcher  Rendezvous Team Duties 
RNDZ CHB/DM-CH-08 REV B: 1/15/02 SCP 1.1 

Verify this is correct version before use 1.1-2 

RNDZ GPO Duties 

RNDZ GPO Team coordination: 

• Establishes priorities for RNDZ GPO team actions 

• Advises Flight Director (FD, call sign "FLIGHT") on priorities of RNDZ-related actions  

• Communicates with FD and other FCR positions  

• Summarizes off-loop FCR discussions for MPSRs 

• Conducts briefings of crew, FD, etc., pre-simulation/mission 

• Reports action items, etc., post-simulation/mission 

• Ensures distribution of MCC products to MPSRs 

• Ensures libraries are configured 

• Organizes pre-mission RNDZ GPO team meetings 

• Writes RNDZ GPO post-flight report 

Guidance and Navigation functions: 

• Verifies proper target acquisition and sensor updates, and evaluates reasonability of 
external sensor updates 

• Monitors and assesses onboard vector management/configuration based on RNDZ 
sensor data   incorporation 

• Uplinks covariance (COVAR) matrix and recommends crew perform COVAR 
reinitialize (REINIT) as needed  

• Verifies proper state of the onboard guidance functions for maneuvers (Lambert vs. 
External Delta-V); recommends corrective action as needed. 

• Monitors and evaluates onboard targeting performance, and logs and evaluates 
onboard MNVR solutions 

• Verifies onboard target data pre-burn; recommends corrective crew action as needed. 

• Monitors burns for proper attitude, engine, and residuals 

• Develops and carries out contingency plans 

• Maintains the current status of the onboard guidance and navigation functions, as 
advised by ONAV. This includes such tasks as identifying the active sub-phase, 
coordinating with the GNC to confirm the effect of control and sensor systems 
problems, and evaluating the effects on guidance of NAV updates from external or 
ground updates. 

 RNDZ procedures: 

• Follows procedures execution, recommends contingency techniques and procedures   

• Follows mission with attention to impacts from other technical areas 

• Writes authorized changes into the RENDEZVOUS C/L 

                   



SHUTTLE OPS RESP: M. Fletcher  Rendezvous Team Duties 
RNDZ CHB/DM-CH-08 REV B: 1/15/02 SCP 1.1 

Verify this is correct version before use 1.1-3 

RPS Duties 

• Follows progress of crew procedures, block entries and completion, checklist (C/L) 
page numbers, etc. 

• Prepares flight notes for RNDZ GPO 

• Performs failure analysis to determine impacts on RNDZ operations 

• Makes recommendations on breakout strategies 

• Monitors burn PADs as read up to crew 

• Monitors prop numbers and impacts of OMS/RCS anomalies. 

• Monitors digital autopilot (DAP) configuration and parameters  

• Monitors Universal Pointing (UP) configuration and changes 

• Gives team a 'heads-up' on status/actions/page numbers 

• Support AOS/LOS monitoring 

• Prepare evaluation of expected COMM coverage of all critical RNDZ events, identify 
in advance those events to occur LOS 

• Maintains FCR/MPSR reference libraries for RNDZ GPO 

• Takes/collects/organizes hardcopies as planned 

• Analyzes DPS restringing options for impacts on RNDZ operations 

• Prepares training rosters and forwards to RNDZ GPO for filing 

• Starts ROSS telemetry acquisition processor for use by the RNDZ GPO team. 

TARGET Duties 

• Estimates trajectory effects of venting, missed burns, drag, etc. 

• RNDZ GPO team lead for recording/verifying crew read-back of burn PADs 

• Responsible for execution of variable downlist procedures  

• Keeps records pertinent to real-time and post-mission activities. 

• Compares TRAJ dispersions to pre-mission values 

• Provides expertise in guidance and targeting flight software 

• Performs BASE TIME management 

• Monitors and advises on MNVR solution selection 

• Provides midcourse 2 (MC2) targeting, monitoring, and validation 

• Provides relative state estimates 

• Simulates onboard targeting to allow look-ahead to anticipate reasonable onboard 
results 

• Operates appropriate console software for relative motion predictions (expected and 
contingency) 
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ONAV Duties 

• Carries out ONAV responsibilities as specified in the ONAV Console Handbook (JSC 
23006) and advises the RNDZ GPO on all procedural issues. 

• Monitors health of onboard NAV systems and validity of sensor data.  Monitors sensor 
status and performance, and advise RNDZ GPO on sensor selection 
recommendations. 

• Evaluates onboard states 

• Gives status on NAV convergence 

• Recommends AUTO/INHIBIT/FORCE controls executed on SPEC 33 

• Advises on COVAR REINIT requirement 

• Recommends Filter (FLTR) to PROP and vice versa requirements 

• Suggests need for SV uplinks and FLTR/PROP selection onboard 

• Advises on effects of redundancy management (RM) on NAV 

• Monitors inertial measurement unit (IMU) management 

• Examines the Star Tracker FOV charts generated by POINTING 

• Interfaces with INCO for Radar Self Tests and Radar problems 

• Provides expertise on ONAV filter operations and associated FSW working and 
sequencing 

• Provides expertise on NAV-related procedures 

PROX OPS Duties 

Provide expertise on the Tools for Rendezvous And Docking (TRAD) configuration: 

• Provide knowledge of the on-board hardware and software configuration and 
recommendations to configuration problems 

• Provide knowledge of RPOP setup, execution, and operation 

• Maintain expertise with nominal and off nominal TRAD related crew procedures.  

• Monitor RPOP function with identical on-board I-Loads using the downlisted telemetry 
and provide relative motion display to the FCR 

• Troubleshoot TRAD software anomalies and provide recommendations or solutions 

• Maintain log of TRAD anomalies and problem resolutions 

• Support RNDZ TOOLS CHECKOUT 

VPOP Operation: 

• Setup, execute and operate VPOP and provide display to FCR 

• Maintain VPOP display with appropriate views and pertinent sensor information 

Provide expertise in Proximity Operations profile: 

• Provide knowledge of profile constraints and peculiarities of pre-mission design for 
nominal and contingency procedures 
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• Follow and verify crew actions and inputs  

• Know Orbiter and payload official vehicle characteristics 

• Know Orbiter and payload vehicle capabilities 

• Know PIP requirements of main payloads and shared cargo 

• Estimate how Orbiter 6-DOF effects and perturbations will affect off-nominal 
procedures or re-planning 

• Estimate variances from pre-mission propellant budget 

Analyze, anticipate, and recommend resolution in contingency scenarios: 

• Provide nominal and known contingency relative motion 

• Prepare necessary pre-mission simulation setups that will facilitate quick resolution to 
unexpected contingency scenarios 

• Maintain a list of knowledgeable analysts to assist in quick turnaround analyses 

• Estimate effects on propellant budget 

• Recommend applicable procedural changes 

Provide support for real time evaluation and revision of docking timeline 

• Be knowledgeable of all flight rules related to the design of the docking timeline.  

• Maintain proficiency with SADS software 

• Maintain proficiency with Flight Notes system 

Keep records pertinent to mission and post-mission activities: 

• Maintain copies of all pertinent display information and RPOP data files 

• Provide post-flight report of Proximity Operations profile with references to pre-mission 
planning 

FDO/TRAJ Duties 

The distinction between RNDZ FDO and RNDZ GPO responsibilities during a rendezvous 
rests on the functional differences associated with ground navigation versus orbit 
navigation.  FDO is responsible for overall trajectory knowledge and control.  FDO 
performs determination of Orbiter and Target state vectors based on ground tracking, and 
is responsible for maintenance of both healthy state vectors on the Orbiter, via uplink; 
FDO performs ground targeting of RNDZ burns based on these ground-derived state 
vectors, and is responsible for uplinking, via commands and voiced Preliminary Advisory 
Digitals (PADs), the resulting burn solutions.  RNDZ GPO on the other hand is responsible 
for onboard NAV and the resulting computation of "improved" Orbiter state vectors (the 
"filtered" SV, or FLTR) based on sensor data (this involves maintenance of a proper 
COVARIANCE MATRIX on board, which also requires uplink of a CMD LOAD). 

As the Orbiter-Target range decreases, responsibility shifts from RNDZ FDO to RNDZ 
GPO.  By the time of Ti, FDO no longer can derive sufficiently accurate relative state 
information from ground tracking, so to continue to fulfill the ground targeting 
responsibilities, the FDO begins using the downlinked FLTR SV for ground computations. 

RNDZ-specific FDO duties include the following: 

• FDO uplinks Orbiter and target state vectors. 
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• FDO provides ground-targeted burns for BURN PADs and for COMMAND LOADS. 
These burns (NC, NH, NCC, Ti, Ti DELAY) are uplinked at least 30 minutes before 
TIG. 

• TRAJ confirms that the desired maneuver has actually been performed to the proper 
accuracy. Actual delta -V values are passed to PROP. 

• FDO fine-tunes separation and breakout burn sizes and advises if the "canned" burn 
can be improved. 

PROFILE SUPPORT Duties 

• FDO support for rendezvous trajectory control throughout the mission 

• Provide expertise in ground RNDZ targeting 

• Contingency profile analysis 

• Prepares solution forms for ground-targeting maneuvers 

• Compares real-time ûV, relative states to pre-mission predictions through Ti. 

MCC Interfaces 

The RNDZ GPO team interfaces with other flight controllers (data flow, procedural inputs, 
etc.), listed alphabetically.  These other specialists should have specific "RNDZ ISSUES" 
SCPs in their own console handbooks which contain this sort of detailed information.  
Other interfaces may be introduced on a flight-specific basis. 

DPS 

• Coordination with DPS is mainly in the area of GPC reconfiguration and restringing.  
The reconfiguration and/or restringing of GPC affect the availability of MDMs, sensors, 
effectors, jets, etc. 

• DPS also uplinks the VARIABLE PARAMETER list used by the RNDZ team to gain 
insight into SPEC 34 ORBIT TGT parameters. 

EECOM 

• Coordination with EECOM is generally isolated to Bus failures and impacts of water 
dumps on STRK passes. 

EGIL 

• Coordination with EGIL is generally isolated to payload bay floodlights. 

EVA 

• RNDZ GPO team must be aware of impacts of EVA requirements upon the 
rendezvous. 

FAO 

• Off-nominal timelines must be coordinated with FAO, especially DELAYS.  EVA PREP 
is also a scheduling impact. 
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GNC 

• Close communication is required in monitoring the performance of ONAV-related 
hardware such as STRKs, IMUs, and the COAS.  GNC designates the specific IMU to 
be deselected for a STRK pass, as entered on a previous burn PAD.  GNC is also 
responsible for COAS calibration.  Prior to navigation passes, the RNDZ team verifies 
the proper functioning of relevant hardware; during navigation passes, GNC is kept 
informed of any anomalies which may be due to hardware problems and thus be 
susceptible to workarounds; after each pass, joint evaluation of hardware performance 
is conducted. 

• GNC is responsible for knowing the current available DAP loads and the current active 
configuration.  GNC is the leading expert on DAP CONFIG specialist function display 
(SPEC 20). 

• GNC is responsible for the functioning of both the THC and RHC hand controllers, 
SENSE switches, ADIs, the DAP, and DAP pushbuttons.  GNC is also the resident 
expert on the S TRK/COAS CNTL specialist function display (SPEC 22). 

• GNC is lead for all IMU issues. 

• While PROP is responsible for the plumbing, GNC is responsible for the control 
authority derived from RCS jets. 

INCO 

• INCO is responsible for all Ku-band radar hardware operations and performance. 

• INCO provides uplink of new covariance matrixes as required. 

• INCO also monitors the RNDZ Radar (RR) self test.   

• During RR NAV, INCO informs RNDZ GPO of all anomalies that may be associated 
with hardware problems.   

• INCO may be asked about functions/data on the SM 201 (ANTENNA) display. 

• INCO is responsible for operation of the CCTVs. 

• INCO should inform RNDZ GPO of considerations of Ku-band jettison planning.  
Jettison is actually overseen by MMACS.  

MMACS 

• Coordination with MMACS is generally isolated to In-flight Maintenance 
procedures (IFMs) and docking system details. 

PAO 

• Coordination with PAO is generally isolated to preflight coordination of rendezvous 
events and to the real-time maintenance of the Visual Proximity Operations 
Processor (VPOP) by PROX OPS. 

PAYLOADS 

Real-time interfaces with PAYLOADS includes: 

• Target attitude determination at nominal and delayed RNDZ points. 

• Target sighting aids such as lights. 

• Target attitude control system impacts on Orbiter. 

• Target sensitivity to Orbiter effects such as RCS plumes and Ku-band power levels. 
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• Requirements for crewmember assessment of target status (attitude, motion, 
configuration). 

PDRS 

• PDRS monitors the operation and status of the Remote Manipulator System. 

• PDRS should consult RNDZ during considerations of RMS jettison planning. 

POINTING 

• POINTING supports FAO.  Through determination of attitudes for future events (target 
track, etc.), POINTING provides data that RNDZ GPO can use to verify proper vehicle 
attitudes during these operations. 

• POINTING can be asked questions about the functioning of UNIVERSAL POINTING 
(OPS 201 display). 

• POINTING provides a star tracker field-of-view plot against the celestial background. 

PROP 

• PROP monitors propulsive maneuvers in parallel with RNDZ, as specified on the 
RNDZ OMS BURN procedure, the OMS 2/ORB OMS BURNS cue card, and the RCS 
BURN cue card.  PROP is prime for determining ENGINE SELECT and monitoring 
proper crew selection on OPS 202.  Planning for any required PROP system 
downmoding is the prime responsibility of PROP and FDO, based on considerations of 
safety and mission   success criticality. 

• PROP keeps the MCC informed of loss of OMS engines, individual RCS jets, and of 
entire RCS manifolds.  Other failure modes include jet fail on and OMS overburn. 

• PROP is responsible for the OMS/RCS plumbing but the control authority derived from 
these jets is the responsibility of GNC. 

ISS MCC Interfaces 

The RNDZ GPO team also interfaces with ISS flight controllers for Space Station 
assembly and logistics flights.  The following text provides descriptions of key ISS FCR 
operators.  Again, other interfaces may be introduced on a flight-specific basis. 

ACO (Assembly and Checkout Officer) 

• Experts on integration and operations of Space Station Elements and equipment 
transfer to/from ISS. 

• Develops technical documentation and flight procedures including ISS/Shuttle 
Operations Checklist and Assembly Checklist. 

ADCO  (Attitude Determination and Control Officer) 

• Overall responsibility for the integration of all GNC and Propulsion activities (U.S. and 
Russian), including attitude determination and control, maneuver execution, 
momentum management, monitoring translational burns such as reboosts, maintaining 
a good navigation state, maintaining mass properties of the station and ensuring 
onboard GNC antenna and array pointing information is provided to other systems. 
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• Pre-mission phase (Increment 1, post 2R), ADCO will perform planning and analysis 
using the Flight Dynamics and Planning Analysis (FDPA) tool to generate attitude 
timelines, short-term propellant budgets, perform maneuver analysis and momentum 
management studies. 

• During Flight Operations, the ADCO position is responsible for creating and updating 
the attitude timeline for the two week short term plan and integrating GNC/P 
operations such as reboost and attitude changes.  

• ADCO will have additional system responsibilities for the ICM when it flies. 

CATO (Command And Tracking Officer) 

• Similar to the Shuttle INCO position, responsible for operating the S-Band, Ku-Band, 
Audio, Video, and UHF systems on the International Space Station. 

ODIN (Onboard Data and Information Network) 

• Supports ISS command and data handling. 

OPS PLAN (Operations Planner) 

• Similar to Shuttle FAO, supports changes to ISS timeline. 

OSO (Operations Support Officer) 

• Short-term planning, product development, maintenance prioritization.  

• Long-term planning including support to sparing, manifesting, & logistics.  

PHALCON (Power, Heating, Articulation, Lighting and CONtrol) 

• Manages the power generation, energy storage, and power distribution capabilities of 
the Station Electrical Power System (EPS) 

RIO (Russian Interface Officer) 

• Coordination with RIO is generally isolated to coordination of the sequence of 
rendezvous, docking, and undocking events. 

TOPO  (Trajectory Operations Officer) 

The Trajectory Operations Officer (TOPO) is the sole real-time trajectory flight controller 
for the U.S. ground segment of ISS operations.  There is no “back room” support 
assistance, except when the on-duty TOPO calls for assistance from DM office workers 
when necessary.  TOPO responsibilities in real-time operations include: 

• Maintenance and processing of best-available Station trajectory data 

• Serves as trajectory authority to ISS Flight Director 

• Distribution of trajectory data to ISS systems and International Partners 

• Supplying data for MCC world map 

• Interface with USSPACECOM for Station debris avoidance operations, including state 
vector transfers 

• Computation of orbital debris collision probability and determination of need for 
evasive translation maneuvers 

• Support payload operations as needed, particularly regarding state vector predictions 
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• Construction of uplink loads, including those for onboard rotation / nutation / 
precession (RNP) matrix updates, TDRS state vectors, and ISS onboard state updates 

• Support reboost maneuver activity and develop maneuver requirements to ensure ISS 
trajectory profile satisfies rendezvous and operational altitude limits.  Verifies that 
reboost maneuvers are successful. 

• Cognizance of visiting vehicle rendezvous and proximity operations techniques and 
status 

• Ensure a safe Station trajectory with respect to jettisoned (intentionally or accidentally) 
objects 

THOR (Thermal Operations and Resources) 

• Responsible ISS subsystems that collect, distribute, and reject waste heat from core 
systems and payloads. 
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1.2 Console Handbook Management 

PURPOSE 

To provide a description of the structure, maintenance and quality control process for the 
Rendezvous GPO Console Handbook (CHB). 

PROCEDURE 

1. Development of New Specific Console Procedures (SCPs) 

• Individual SCPs are written by specialists in the RGPO group.  

• Draft copies are peer reviewed, then, a CR is generated to incorporate the new SCP 
into the book. 

2. Maintenance 

• The CHB is maintained by the book manager as a controlled document DM-CH-08.    

• The official copies (one in MS Word and one in Adobe PDF) reside on the MOD web 
server in the DM34 folder.  The Word version is maintained for user download or 
printing and the PDF version is maintained for online use.   

• A copy of the signature page is linked from the electronic cover page.  The original 
signed signature page is stored in the DM ISO9000 Quality Records cabinet.  

• The DM ISO 9000 Master Document List includes the RGPO CHB and specifies the 
name of the book manager.   The DM Master Document List can be accessed from the 
DM Web Site.   When a user selects the RGPO CHB from the Master Document List, 
they are sent to the CHB on the DM34 web site.   

 

3. Change Process 

• Change requests may be initiated by any RGPO group member.   The initiator 
downloads a copy of the SCP from the web page and make the desired changes.  The 
initiator then obtains peer review, as required, from the RGPO group and incorporates 
any additional changes. 

• The initiator then completes an online CR form, which can be accessed from the CHB 
web pages.  Upon submission, the CR is automatically added to the CR database and 
assigned the next available CR number.  The CR database is maintained on the DM34 
web site and is accessible by all users.  The CR database also serves as a change 
record for each Page Change Notice (PCN)  or Revision to the CHB. 

• The CHB Book Manager reviews the revised SCP for accuracy and verifies that 
appropriate peer review has been secured.  The book manager will disposition the CR 
as required (approved, disapproved, etc) and update the status of the CR in the CR 
database.  The book manager will collect individual CRs and hold them until an 
appropriate time to publish a new PCN or revision to the CHB.  
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• The approved changes are grouped together into a PCN or Revision which is signed 
by the group lead.     

• The approved changes are then incorporated into both the web based Word and PDF 
versions of the CHB simultaneously to ensure consistency between downloaded and 
online versions.  The CR numbers and affected SCP numbers are included on the 
signed cover sheet, which is scanned into a viewable file and stored on the web site.  
Additionally the web site file structure and CHB main page are updated as necessary. 
A change log for each PCN  or Rev will be automatically be viewable through the web 
interface to the CR database.  The DM34 web curator may assist with maintenance of 
the CHB web site files and structure, as well as the CR database. 

• The book manager submits a hardcopy of the PCN or Rev to the DM quality records 
custodian. 

 

4. Document Format 

Header 

• The text “SHUTTLE OPS” to define applicable missions 

• The name of the responsible engineer: RESP: J. Q. Public  

• The title of the SCP 

• The book title and JSC number, in this case “RNDZ CHB/JSC DM-CH-08” 

• The date and edition of book 

• The number of the SCP 

Footer 

• The footer contains the words “Verify this is correct version before use.” to comply with 
ISO 9000 standards.   

Title 

• Full descriptive title for SCP. 

Purpose 

• This defines the intention of the SCP, why it was written, for whom, and under what 
circumstances it is invoked. 

Procedure 

• This is the meat of the SCP and defines the criteria, actions, and calls to be made 
under the circumstances addressed by the specific SCP.  It is for fast console 
reference; detailed rationale may follow (see below). 

Background 

• This is a brief summary of the situation that requires the existence of this SCP and 
how it fits into the overall RNDZ team operation.  As appropriate, the background 
information may be located below each SCP subsection.   
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Rationale 

• OPTIONAL.  If additional explanation of procedure steps is deemed desirable, it can 
be included here.  Otherwise, it may merely be a reference to other documentation, 
particularly the RNDZ & PROX OPS H/B, by specific section/page.  Often, one may 
combine the Background and Rationale into one subsection. 

Equations, Figures, and Tables 

• These are numbered with the SCP number, hyphen, and a sequential Arabic numeral 
(e.g., Equation/Figure/Table 1.1-5). 

• Equation captions are positioned to the right of the equation, Figure captions are 
positioned below the figure, and Table captions are positioned above the table. 

Pagination 

• Pages within each SCP are numbered with the SCP number, hyphen, and a sequential 
Arabic numeral (e.g., 1.2-16). 

• Table of Contents are numbered with the chapter number, hyphen, and a sequential 
Roman numeral (e.g., 3-ii). 

Text Format 

The BASIC REV B publication of the Rendezvous GPO Console Handbook uses the text 
styles included in the template document CHB MS Word Template that is stored on the 
DM34 web server with the MS Word version of the document.  

To attach this template to a new or existing SCP:  (MS Word 97) 

• On the Tools menu, click Templates and Add-Ins.  

• Select the Automatically update document styles check box in the Templates and Add-
Ins dialog box.   This will cause the styles from the template to be incorporated into the 
document.  Styles in the document that have the same name as those in the template 
will be updated to match the template styles. 

• Click Attach, and then select the template file. 

• Click Open. 

• The document styles should be automatically updated to reflect the template.  

BACKGROUND 

To standardize console documentation and operator procedures, DM34 published this CHB for 
use by RNDZ GPO and RPS.  The CHB consists of individual procedures, called SCPs. 
Although no MOD-wide standardized SCP format officially exists, the various discipline console 
handbooks (e.g., PROP, GNC, EECOM) have evolved a traditional format that has proven most 
useful in MCC operations.  The format described here is an adaptation of these traditional 
formats. This format is intended as a guideline only; some SCPs, due to the nature of the topic 
concerned, will deviate from this format if necessary. 

The Change Process outlined above is in compliance with ISO 9000 standards. 
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2.1 Console Management 

PURPOSE 

To provide guidelines for operating in a shared console mode in the Trajectory MPSR. 

PROCEDURES 

A smooth and mutually non-interference sharing of the MPSR consoles requires coordination 
and consideration in a number of areas, including environment, console-mounted 
documentation, inter-team communication, workstation utilization, and hardware malfunction 
tracking. 

Environment 

The Trajectory MPSR consoles are shared with Ascent/Entry flight controllers, so the 
normal MCC operating standards of neatness and consideration are doubly applicable 
here. 

Console Documentation 

Many items of Ascent/Entry reference are mounted on the console beneath the Plexiglas 
cover.  If these must be moved to mount RNDZ reference materials, they should be either 
replaced post-RNDZ or be stored in an envelope or folder in the console mailbox.  Note 
that the bookshelves next to the console are used by both Ascent/Entry and RNDZ.  
Please do not remove the binders from the room, and please replace binders on the 
bookshelves when finished with the materials. 

Inter-Team Communication 

Mailboxes are maintained at each console for the teams that share them.  These are to be 
used for Execute Packages, Console Documentation, etc., of a flight-control nature.  
These are not to be used for other purposes.  Please do not toss material for Ascent/Entry 
GPOs; bring the material back to the office or place a note on the pile drawing attention to 
the material.  Guideline here is to handle material from previous flight or long integrated 
simulation. 

Workstation Utilization 

The physical workstations are shared between Ascent/Entry and RNDZ, just as the 
consoles are.  Several simple guidelines regarding workstation utilization are in order. 

• Consult with the Group Administrator (GA) regarding the removal of any data log files 
after the shift is complete.  Pager numbers are located on the console underneath the 
Plexiglas. 

• Do not alter any of the "dot" files, such as .cshrc or .xsession, in the RGPO home 
directory.  All RGPO users share the same files, so changes affect all RGPO users. 

Reference: SCP 2.9 WORKSTATION PROBLEMS. 
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Hardware Malfunction Tracking 

Each team that experiences console or workstation malfunctions and/or servicing should 
notify other teams who may encounter the same problem.  Any console or workstation 
maintenance should be noted with all relevant information in the mission log. 

BACKGROUND 

The two consoles used by the RNDZ Team MPSR operators are also used by other teams during 
Ascent/Entry.  The primary users of the MPSR consoles are the GNAVs, ONAVs, A/E Guidance 
Support, ARD Support, and LSOs. 
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2.2 Console Documentation 

PURPOSE 

To define procedures for development and maintenance of the Console Log and Job Jar.  

PROCEDURES 

1. Console Log Overview 

• The console log contains a time-tagged brief narrative of events with entries made as 
events occur. 

• The console log is a single continuous document for each console position.  The log is 
continued by successive controllers so that chronological order and continuity are 
maintained over shift changes.   The newest materials are located to the back/bottom. 

• Pages are numbered consecutively from launch to landing. 

• Key facts or important parameters should be circled, boxed, or highlighted. 

• Once written console logs are not altered.  Incorrect entries or significant information 
not contained in the log are summarized at the end of the log.  A reference to such 
notes is included the margin of the log. 

• Auxiliary information is included at the back of the log.  Copies of flight notes, FDF 
changes, and display hardcopies should be collected and labeled. A reference to each 
item is included in the console. 

2. Console Log Contents 

Orbiter Configuration and Systems Anomalies 

Any nominal or off nominal orbiter system information including: 

• Description of all Orbiter system anomalies, even if they do not affect systems needed 
for rendezvous, along with the possible cause(s), and any action(s) taken. 

• DPS stringing and any related changes 

• GPC, bus, or MDM Failures 

• Sensor failures 

Target Anomalies 

Any abnormal or off-nominal configurations in the target, such as 

• System issues or anomalies 

• Attitude 

• Rates 

• Venting 
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• Appendages 

Key Events 

Time of key events such as 

• Rendezvous Checklist steps 

• Burns (note vector sources) 

• Target tally-ho 

• Vbar arrival 

• Grapple 

Communications 

Any questions, conversations, or flight notes, such as 

• Air-to-Ground questions. 

• Communications with payload controllers. 

• References to any flight notes written and any other information called up to the crew. 

• References to any FDF changes. 

• References to any Flight Rules invoked. 

• Parameters out of normal or expected operating range. 

The “Job Jar” 

The Lead RNDZ GPO can create a “job jar” before the mission.  The job jar contains a list 
of late-breaking actions to be performed by the team as well as a list of planned activities 
that should be performed on a given Flight Day.  Both of these items can serve as a 
reminder to the Lead RNDZ GPO in organizing the activities of the RNDZ team, and it is 
recommended to review the contents of the job jar with the RNDZ team once before 
launch. 

After launch, only the Lead RNDZ GPO needs to refer to the job jar.  The Lead RNDZ 
GPO should review the job jar and place actions into the handover log.  No other team 
member is to worry about maintaining the job jar. 
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2.3 DVIS Information 

PURPOSE 

To describe the DVIS system and the DVIS loops of interest to the Rendezvous team. 

PROCEDURES 

DVIS Pages 

The Rendezvous team is assigned 6 total DVIS IDs with 10 pages available per ID. 

• IDs 4213 1234 and 4214 1234 are reserved for FCR use at keysets 4213 and 4214.  
All pages are reserved as noted below. 

• IDs 4702 1234 and 4703 1234 are reserved for backroom use at keysets 4702 and 
4703.  All pages are reserved as noted below. 

• IDs 8213 1234 and 8214 1234 are available for use anywhere.  Page 1 is reserved as 
noted below.  Pages 2 through 10 can be modified by individuals as needed. 

NOTE: Logging onto the keysets at the RGPO and RPS positions using the keyset number 
only (without the 1234 extension) brings up pages assigned to Ascent/Entry.  Please do 
not modify these pages.  Log out immediately and logon again using the 1234 extension. 

As noted above, some of the pages are reserved for a particular team member.  Do not 
modify pages other than your own or the group pages.   

 

Table 2.3-1  DVIS Page Assignments 

Page Assigned To Page Assigned To 

1 Yencharis 6 Harshman 
2 O’Rourke 7 Fletcher 
3 Rickerl 8 Spehar 
4 Walker  9 Dunham 
5 O’Dosey 10 Bigonesse 

1* Machula 6* (open) 
2* (open) 7* (open) 
3* (open) 8* (open) 
4* (open) 9* (open) 
5* (open) 10* (open) 

* applies to DVIS IDs 8213 1234 and 8214 1234 only.  All others page assignments apply 
to DVIS IDs 4213 1234, 4214 1234, 4702 1234, and 4703 1234. 
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DVIS Loops of Interest 

Most loops are followed by a number, indicating which FCR they support (1 or 2).  The 
exceptions are the Air-to-Ground 1 and 2 loops; the FCR number precedes the loop.  Refer 
to the Table 2.3-2 for more details.   

Multi-Access allows the user to talk on multiple loops simultaneously.  Refer to the DVIS 
help information available at the console. 

Included at the end of this section is a blank DVIS keypad layout chart for personal use. 

Configuring DVIS 
 

Push the “CONFIGURE” button and then the select the appropriate cell to be configured.   
 

1) KNOWN LOOP ID Number (see Table 2.3-2) 
a) Enter the mode for the cell. 

• 1: M - Monitor 
• 2: HM - High Monitor 
• 3: TL - Talk Listen 
• 4: TLM - Talk Listen Monitor 

b) Enter the loop ID and press “ENTER”. 
  

2) UNKNOWN LOOP ID Number 
a) Press 8 on the keypad to go to the directory. 
b) Press the “SELECT PARTITION” button and choose the correct partition and hit 

“ENTER”. 
c) Press the “SELECT ALPHA LIST” button and push the correct keypad button that 

corresponds to the first letter of the loop name.  Then press “ENTER”.  If there are 
multiple letters on a keypad button, pushing it again will select the next letter. 

d) Highlight the correct loop ID.  Push the corresponding button for the desired mode of the 
loop. This will take you back to the original page being configured.  Press “ENTER” on 
the keypad to finalize the selection. 

 

BACKGROUND 

Reference: DVIS Ground Rules Loop Directory, JSC-28883 
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Table 2.3-2 DVIS Loops of Interest 

Loop Partition ID Description 
1A/G 1, 1A/G2 
2A/G 1, 2A/G 2 

MCC 2011, 2012 
3011, 3012 

(FCR 1 or 2) Air-to-ground loop (1, 2) 

A/G UHF 1 (2) MCC 2013, 3013 Air-to-ground UHF-only loop, prime and backup 
ADCO 1 (2) SSC 4304, 4404 ISS FCR ADCO Loop  
AFD CONF 1 MCC 2002, 3002 Auxiliary FD loop for debriefings/conferences 
A/P COORD MCC 2103, 3103 POINTING contact loop 
ASMBLY OPS 1 MCC 4346 ISS Activation and Checkout Officer (ACO)  
DFE MCC 7307, 7316 Data Flow Engineer loop for playbacks 
EBS SPEC EVENT MCC 7698 Secret broadcast loop 
FAO 1 (2) MCC 2101, 3101 FAO loop 
FD1 (2) MCC 2001, 3001 Prime and backup shuttle FD loop 
FM/AM MCC 7699 Tunes 
GC CALL MCC 2022, 3022 GC loop for ground support actions 
HOUSTON CONSULT MH 08 MCC 4228 Houston Consultant Group contact loop in Moscow  ("Loop 8") 
INCO MCC 2301, 3301 INCO loop 
ISS FD 1 (2) SSC 4333, 4433 ISS Flight Director prime and backup loops 
ISS TRAJ OPS1 (2) SSC 4348, 4448 TOPO FCR to MPSR loop. 
LANDING SUPPORT MCC 2751 Auxiliary Trajectory MPSR loop (when not used by LSO) 
MISSION AUDIO  MCC 2051 Audio patch for special feeds 
MMACS 1 (2) MCC 2801, 3801 MMACS loop 
MOCR DPS/CDMS 1 (2) MCC 2915, 3915 DPS loop 
MOCR DYN 1 (2) MCC 2707, 3707 FDO/GPO prime loop 
MOCR GNC/PROP 1 (2) MCC 2402, 3402 GNC/PROP loop 
MOCR SPEC 1 (2) MCC 2811, 3811 PDRS/EVA loop 
MOCR SYS 1 (2) MCC 2507, 3507 EECOM/EGIL/MMACS loop 
MPSR DYN A 1 (2) MCC 2761, 3761 FDO support loop 
MPSR DYN B 1 (2) MCC 2762, 3762 GPO support loop 
NASA SELECT MCC 2049 NASA Select audio feed 
NAV SUPPORT MCC 2781 GNAV loop 
NBC NTWK MON MCC 2047 NBC Commercial loop 
OPS ACTION 1 (2) MCC 2005, 3005 Payload troubleshooting loop 
OPS SUPPORT 1 (2) MCC 2204, 3204 Payload data/systems loop 
PAO CALL MCC 2039 Public Affairs Officer contact loop 
PAYLOAD 1 (2) MCC 2201, 3201 Payload Officer loop 
PHALCON 1 (2) SSC 4322, 4422 ISS Power, Heating Articulation, Lighting and Control loop 
PRIME OPS 1 (2) MCC 2203, 3203 Remote POCC loop to Payload Officer 
RIO CONSULT MCC 2342 Alternate RIO loop 
RIO MOCR MCC 2340 Main Russian Interface Officer loop 
SDP DYN MCC 7208, 7210 DYNAMICS loop 
SPAN MCC 2081 Mission Operations Integration Room (MOIR) Manager loop 
TOPO1, TOPO2 SSC 4347, 4447 TOPO prime and sim loops 
WSS CALL MCC 4065 Workstation Systems Support loop for workstation problems 
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Figure 2.3-1  Personal DVIS Keypad Layout 
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2.4 Workstation Operations  
PURPOSE 
To define the steps for the initialization, display selection, and shutdown of the consoles. 

PROCEDURE 

1. General Workstation Initialization 
Note:  For workstation troubleshooting see SCP 2.9. 
• Check with GC regarding the workstation Activity to choose. 
• Login using your personal ID.  Contact Access Control and Audit (ACA) at number 

posted on console for password problems. 
• Select the appropriate Activity and proceed with login. 
 

2. Standard Config Initialization: 
• This should happen automatically at activity selection. If it doesn’t, or if you quit ROSS for 

some reason, it can be restarted as follows: select ROSS>Console Config>Telemetry - 
Standard.  This will start the ROSS EXEC, ROSS GUI, and 10 ROSS streams: 

 
00. PTM  G - Orbiter telemetry stream 
01. TCS2  S - Trajectory Control Sensor payload telemetry stream 
02. GDR  G - Generic Data Retrieval from the Traj Server 
03. PIM  G - ISS telemetry stream (will be D for sims with no SSFT) 
04. RCMP G - Rendezvous Computations 
05. DGEN S - Some constants needed for calculations  
06. ISUB  G - ISP Subscribe stream from the RGPO ISP server 
07. LOCI  G - More rendezvous computations 
08. SPEC S - ISP Subcribe stream from the DPS SPECs server (for crew keystrokes) 
09. TS   G - Some timing services that RGPOs don’t need unless you start Acqmon 

 

3. Master Config Initialization: 
• This will also happen automatically at activity selection, but only if the RGPO ISP server 

is NOT yet running, effectively only for the first RGPO to log into the activity. If it does not, 
or if you stop (or de-configure) the Master Config for some reason, it can be re-started as 
follows: select ROSS > Console Config > Start Master.  This will start the RGPO ISP 
server, VPOP Comps, and one ROSS stream: 

 
10.    IPUB G - An ISP Publish stream providing computed paramters to the RGPO ISP 

server for use by VPOP Comps. 
 

• The Master Config can be moved from workstation to workstation. This can be useful in 
response to workstation problems. 
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• If the workstation running the Master Config has not failed outright, attempt to stop the 
Master Config gracefully by selecting ROSS>Console Config>Stop Master. If this is 
unsuccessful, (ISP server fails to quit), Call WSS and ask for a reboot. If the move is 
being done for convenience only, expect to see the ROSS ISP PUB stream go D . Also 
expect the RGPO ISP server quit, and everyone’s ROSS ISUB streams go D until the 
server comes up on the new W/S. If the VPOP SGI is running the VPOP Graphics, they 
will crash. The VPOP user interface may also need to be re-started. 

• Start the Master config on the new workstation as noted above. As long as the RGPO 
ISP server hasn’t been down for more than a few minutes, everyone’s ISUB streams 
should automatically re-connect. 

• If VPOP Computations need to be restarted manually, select VPOP > Start VPOP 
Computations.  Start VCR if desired (See SECTION 2.6 Data Recording and Playbacks). 

3. Display Selection 
• From the Rendezvous menu, choose the ROSS layout desired. 
• Individual ROSS applications are available under the ROSS submenu. 
• Other discipline’s displays are available under the Master menu. 

4. Shutdown 
• Choose Logout from the window manager. 

BACKGROUND 
Workstations running ROSS form the basis of the monitoring software used by the Rendezvous 
GPOs.  See the ROSS User’s Guide for an in-depth explanation of the ROSS applications.  
Documentation of the ROSS layouts can be found in SCP 7.3.  
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2.5 Telemetry 

PURPOSE 

To describe the workstation telemetry streams and the Master and Standard telemetry 
configurations.  Also, this section serves as a quick lookup of various Telemetry Format Load 
(TFL) values that support rendezvous operations. 

PROCEDURES 

1. RGPO Master Telemetry Configuration 

The RGPO master telemetry configuration is established on the RPS workstation while the 
rest of the RPGO team uses the RGPO standard configuration.   In the master 
configuration two servers are established (RGPO and VPOP) which are then subscribed to 
by the other team workstations.  The RPS also establishes a backup workstation to protect 
for master workstation failures.   See figures 2.5-1 and 2.5-2 for RGPO master and 
standard telemetry configurations.  

2. Stream Descriptions: 

• RPUB: RGPO publication stream – writes to RGPO server (on RPS W/S) 

• VPUB: VPOP publication stream – writes to VPOP server (on RPS or Prox Ops W/S) 

• RSUB: subscription stream – reads from RGPO server  

• VSUB: subscription stream – reads from VPOP server  

• VCR: user created stream to record or playback telemetry data.  See SCP 2.6 Data 
Recording and Playbacks for details. 

• Data Acquisition (DACQ) Streams:  All DACQ data (except GDR) is broadcast on 
the MCC LAN and a DACQ listener, running on each workstation, extracts the MSIDs 
desired by that workstation.   This extracted data is then passed onto the individual 
DACQ streams as listed below.  

 

• PTM: The bulk of the RGPO data comes from this stream.   This is the main 
Orbiter downlist that comes from the Front End Processor (FEP) – no MOC is 
required for this data.   

• PPM: Payload and TCS stream(s). 

• GDR: Data from the MOC/Trajectory Server including state vectors.   

• DGEN: Data Generation Stream.   Used to set constants required by other 
ROSS applications.   This includes T1 TIG slots, TCS unit IDs, Orbiter/Target 
weight, CD and area. 

• RCMP: Rendezvous Computation Stream written in C language.   Computes 
Orbiter LVLH attitude, LVLH position, time, etc.  
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• LOCI: Used for other rendezvous computations that have not yet been ported 
to the C language for RCMP including Time to 150 and 135kft, high data rate jet 
firing alarms, Radar data (gimbal angles, etc.).  (The LOCI applications are written 
in an interpreted script language called oc (pronounced “oak”). 

3. Troubleshooting: 

Failure of RPS Master workstation: 

Assuming the RPS backup workstation is still operating normally: 

• RPS calls WSS on WSS CALL loop to notify of problem and obtain concurrence to 
reboot workstation.  

• RPS attempts to restart the workstation  

• RGPO team members either wait for restart of the RPS workstation   

-- OR -- 

• Change their subscription to the backup RPS workstation: 

• Double click on RSUB stream 

• Change SOURCE to RGPO2 

• Reconnect stream 

Note: The backup workstation configuration does not currently include VPOP 
computations (i.e. sunrise, sunset clocks, TCS IF to IF data).  To regain this data 
the users must be subscribed to the RPS prime workstation.  

General Telemetry Problems: 

• The spinning ICON on the ROSS GUI tells you that both the ROSS executive and 
ROSS GUI are running.  

• Status indicators for each streams are interpreted as follows: 

Table 2.5-1 ROSS Stream Status 

Indicator Meaning 

G Good 
S Static 

D Disconnected 

I Initializing 

O Time Overrun (stream taking too long) 

T Stream is terminating 

A Attention required by user 

 

• Holding the mouse over the status indicator for a given stream brings up a popup that 
indicates how many parameters were processed by the stream over the last cycle.  

• The ISPMON application tells you if the ISPNULL servers are running  

• If an SUB or PUB stream comes up disconnected, then most likely the associated 
server is not running.   Once the server is started, the stream should automatically 
reconnect.  

                   



SHUTTLE OPS RESP: N. O’Dosey Telemetry 
RNDZ CHB/DM-CH-08 REV B: 1/15/02 SCP 2.5 

 

Verify this is correct version before use 2.5-3 

 

 

D
at

a 
A

cq
ui

si
tio

n

PTM

(Orbiter D/L)

PPM

(TCS Data)

ROSS Telemetry Executive

VSUB
(VPOP Comps)

RSUB
(LOCI & GDR)

ROSS Applications and GUI

RCMP
(comps)

DGEN
(constants)

VPOP
Server

RGPO
Server

ROSS

RPS Workstation Servers

Figure 2.5-2 RGPO Standard Telemetry Configuration
RGPO and Other User W/S

Workstation

D
at

a 
A

cq
ui

si
tio

n

PTM
(Orbiter D/L)

PPM
(TCS Data)

ROSS Telemetry Executive

VSUB
(from VPOP)

VPUB
(to VPOP)

ROSS Applications and GUI

RCMP (C
comps)

DGEN
(constants)

RGPO Server

ROSS

Figure 2.5-2 RGPO Master Configuration - RPS Workstation

GDR
(Orbiter D/L)

LOCI (oc
comps)

RPUB
(LOCI & GDR)

VPOP Server

RPS Workstation

Figure 2.5-1 RGPO Master Configuration – RPS Workstation 

                   



SHUTTLE OPS RESP: N. O’Dosey Telemetry 
RNDZ CHB/DM-CH-08 REV B: 1/15/02 SCP 2.5 

 

Verify this is correct version before use 2.5-4 

 

BACKGROUND 

Telemetry Formats 
The TFL is basically a set of instructions for storing each telemetry parameter in a specific 
location in the formatter RAM.  There are standard characteristics of the format that do not 
change between flights, as well as flight-specific format characteristics.  Telemetry formats are 
built in the PCMMU telemetry formatter and are determined by the Telemetry Format Load (TFL) 
that is supplied to the PCMMU by the SM application, which, in turn, retrieves the TFL from the 
Mass Memory Unit (MMU) during the TFL load process.    

Flight-specific TFLs can be found on the Portable Onboard Computer Control Board page at 
http://ranger.jsc.nasa.gov/DL2/poccb/index.html.  The generic and flight-related requirements 
and planned usage for all TFLs can be also found in Space Shuttle Telemetered and Recorded 
Data Format Requirements.  TFL requirements are summarized in Section 5 of the Payload 
Management (PM) Flight Software Requirements (FSR) for each flight.  The presence of an 
MSID within a TFL can be determined by an MIS query as described in Section 49.2.1.2.   See 
Table 2.5-2 for an example of flight-specific TFLs for STS-108. 

Table 2.5-2 STS-108 TFLs for Various Operations 

Application Packet ID TFL 
Stream 

TFL Support 1 Output for 
Prime 

config (on 
WinDeco

m PGSC) 2 

Output for 
RMS config 

(on 
WinDecom 

PGSC) 2 

3D Orbiter 15 

17 

GNC 

GNC 

129,161,164,179,184,185,192,199,203,205,206,211,212 

129,161,164,179,184,185,192,199,203,205,206,211,212 

Net, 1, 2 

Net, 1, 2 

Net, 1, 2 

Net, 1, 2 

Cabin Leak 23 

24 

OI 

SM 

161,184,188,205 (164,192,199,211,212) 4 

161,184,188,205 (179,185,203,206) 4 

Net, 1, 2 

Net, 1, 2 

Net, 1, 2 

Net, 1, 2 

FCMS 32,33,34 FCMS Any Net, 1, 2 Net, 1, 2 
Packet 
Display 
    Program 

POC Plot 

All avail any All available Net, 1, 2 Net, 1, 2 

RSAD 27 SM 161,179,184,185,188,203,205,206 Net, 1, 2 Net, 1, 2, 4 

RPOP 40 GNC 129,161,164,179,184,185,192,199,203,205,206,211,212 Net, 1, 2, 4 Net, 1, 2 

Water Dump 28 OI 129,161,164,184,188,192,199,205,211,212 Net, 1, 2 Net, 1, 2 

WorldMap 

Time Vector 

  Server 

15 

30 

GNC 

OI 

129,161,164,184,192,199,205,211,212 
(179,185,203,206) 4 

129,161,164,184,192,199,205,211,212 (188) 4 

Net, 1, 2 

Net, 1, 2 

Net, 1, 2 

Net, 1, 2 

1 Only HDR ascent, on-orbit, and entry TFLs listed.  TFL 129 is an ascent and fixed TFL and TFL 164 is an entry TFL.  
Reference Document JSC-19478-108 (PL Mngt Level C Flight S/W Requirements) 

2 Prime Config:  Network; COM1 and COM2 @ 38400 Baud; COM4 @ 9600 Baud 

   RMS Config:  Network; COM1 and COM2 @ 38400 Baud, and COM4 @ 19200 Baud 

3 10.2 Depress uses only packet 35 as default.  If needed, can be manually switched to use packet 25 and 30. 

4 Application may not receive all required packets when configured in any of these TFLs shown in parentheses 
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Table 2.5-3  Packet IDs 

Packet ID Description 

15 Orbiter and target state vectors 

Radar range and range rate data 

Quaternion 

Angular rate 

17 Attitude error 

M50 to LVLH quaternion 

22 RCS quantities 

OMS He pressures 

23 GMT and MET 

Non-prop consumables 

Cabin dP/dT 

Cabin pressure 

24 Non-prop consumables 

25 Cabin dP/dT 

Cabin pressure 

PPO2 

27 RMS parameters 

28 Supply/waste H2O parameters 

30 GMT and MET 

32 Fuel cell #1 subcell voltages 

33 Fuel cell #2 subcell voltages 

34 Fuel cell #3 subcell voltages 

35 Cabin dP/dT 

Cabin pressure 

PPO2 A, B, C 

External airlock pressure 

Overboard airlock pressure 

GMT and MET 

40 Orbiter and target state vectors 

Radar range and range rate data 

Quaternion 

Angular rate 

DAP info 
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2.6 Data Recording and Playbacks 

PURPOSE 

To specify techniques and rationale for telemetry and video playback. 

PROCEDURES 

1. Telemetry Playback During a Flight 

Reference: FCOH SOP 4.5. 

• Coordinate GMT/MET interval of playback with RNDZ GPO Team. 

• Coordinate with INCO to determine at what time the data for the requested interval will 
be dumped, and verify that the dump has taken place. 

• Complete Mission Data Request Form (MDRF) and send to GC. 

• Verify with GC that the data has arrived at the MCC and is available for playback. 

• Coordinate with GC as necessary to define how data will be viewed – i.e. what the new 
activity name will be, which workstations the data will be sent to, etc. 

• Coordinate with other disciplines that might be interested in the playback data. 

Background:  

Playback of Orbiter data may be of interest to the RNDZ team as follows: 

• Playback of LOS Events 

Depending on TDRS and ground site coverage, some events might occur during LOS 
periods.  These include navigation passes, onboard targeting, and propulsive 
maneuvers.  If anomalies arise during the event in question, a playback can be 
requested.  This may allow for identification of the anomaly and subsequent 
modification of procedures, if required.  Both the ODRC and realtime telemetry 
playback are options for obtaining this data. 

• Playback of AOS Events 

Events that occurred AOS may be revisited via playback to process and display 
telemetry in different formats, on different displays, or with attention placed in other 
areas.  ROSS log file delog, ODRC, or realtime telemetry playback are all viable 
options for obtaining this data. 

2. Post Flight/Sim Full Telemetry Data Playback: 

Reference FCOH Sections 10.1 and 10.2. 

• Call the sim recorder group at x35981. 

• Ask them the tape numbers for the sim or flight timeframe (provide applicable GMT 
begin and end times). 

• Request a 30-day hold on those tapes. 
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• Call TOCCS lab representative. 

• Request/schedule a comp run on the OPS side (not CDE). 

• Give him/her the tape numbers. 

• Tell him/her if you need a MOC (if a FDO wants to be involved). 

• During the playback, configure the workstation as for flight / sim and record ROSS 
data if desired.  

Background: 

This procedure is for playing back all downlinked telemetry from a sim or flight.   Generic 
simulation tapes are maintained for 7 days, flight specific sim tapes are maintained until 
the flight launches, mission tapes are maintained until the next flight of that vehicle.   

3. ROSS Telemetry Recording (VCR) 

• Right Mouse Click on the spinning globe. 

• Select New Stream. 

• Select VCR for Stream Type. 

• Select RECORDER for VCR Type. 

• Log file name will default to ACTIVITY_GMT (ex: SSP096_185:XX:XX:XX.log). If you 
input your own file name, be sure to include the preceding path info as well 
(/users/rgpo/ross/log) or your VCR stream will not connect. 

• Press CONNECT. 

• If not automatically recording, press the RECORD button on the VCR CONTROLS, 
make sure that the record counter starts increasing. 

• DISMISS the screen (be sure to open and stop recording when data recording is no 
longer needed). 

• If your log file needs to be preserved, such as actual flight data or interesting sim 
cases, open an XTERM window and navigate using cd to ~rgpo/ross/log.   Rename 
your log file per the following naming convention: 

STSXXX-FDYY-payload-event.log 

STSXXX – STS flight number (STS097, STS112) 
FDYY = Flight Day number (i.e. FD03, FD11) 
payload = name of payload (i.e. ISS, SPARTAN, HST) 
event = a simple high-level description of what was happening (i.e. rndz, 
undock, deploy)  

• Compress the log files using the command: gzip STSXXX-FDYY-payload-event.log 

 Provide a list of the flight log files to any TOCCS lab Group administrator and 
request that they be archived to the IPS archive server.  

 

Background: 

The ROSS telemetry will be recorded, however, non-ROSS telemetry (i.e. crew 
keystrokes, Onboard Fault Summary (OFS)) will not be recorded.   
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4. ROSS Telemetry Playback (VCR) 

• On DNAV, Select TELEM TOOLS > ROSS Playback.  

Telemetry will be initiated, VPOP computations will be initiated and a VCR stream will 
be created.  

• Select the VCR stream. 

• Select the appropriate log file.  It should default to the correct folder.  Select the right 
name for the log file.  Note: the normal path to log files is ~rgpo/ross/log. 

• Press CONNECT the data will start flowing to all ROSS alarms.  All data should be 
flowing to all ROSS alarms and paramplots currently displayed. 

5. ODRC Data Retrieval 

See SCP 9.7 MEWS HELP NOTES. 

 

6. DVIS Voice Loop Data Retrieval 

• Only the left-hand DVIS (4213) is recorded for flights, so make sure any loops you 
want recorded are active on that DVIS. It is unclear what, if anything is recorded for 
sims. 

• Obtain a Mission Data Request Form (MDRF) from the GC console. 

• Complete MDRF and deliver to the Voice Control group on the first floor of the old 
MCC.   

• Specify the GMT of the start and end of the desired information as well as the DVIS 
console number(s) of interest. 

• Once the Voice Control group place a MDRF number on the MDRF, take your copy of 
the MDRF and wait for delivery of tape. 

7.  Video Tape Recorder (VTR) Playback 

• Coordinate the times at which the docking video will be downlinked from the Orbiter.  
This should be coordinated with the Flight Affairs Officer (FAO).  Note that the time will 
vary based on crew workload.  This is normally done several hours after docking.  
Make sure you note the exact GMT of when the playback occurs, for use in the 
following steps. 

• Fill out a Mission Data Request Form (MDRF), which can be found in hard-copy format 
only at the Ground Control (GC) console. 

• When filling out the form, be sure to request Shuttle Downlink (or other video source 
as necessary) during the appropriate GMT timeframe.  Leave your office number as a 
contact. 

• Submit the form back to GC, who will fax the request to Houston TV personnel in 
Building 8. 

• When Houston TV calls to let you know the video is ready, go to Building 8 to pick it 
up.  It is convenient to use the door facing the duck pond.  The tape should be in VHS 
format.  If after hours, use the buzzer to the right of the door to ring the attendant (and 
note that it only buzzes for as long as you’re holding it down). 
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2.7 MSKs/TV Channels of Interest 

PURPOSE 

• To list the RF and Picture-in-Picture channels for VPOP and RPOP.   

• For historical purposes:  to list the old MSKs of interest to the Rendezvous team. 

PROCEDURE 

VPOP/RPOP Video Channels 

The Visual Proximity Operations Processor (VPOP) and the Rendezvous Proximity 
Operations Program (RPOP) outputs are directed via hardware to video switcher units that 
provide the data to the rest of the flight control team over RF TV or via the workstation 
application “Picture in Picture.” 

 

Table 2.7-1  RPOP and VPOP Video Channels 

Application Picture-in-Picture B30S RF TV 

RPOP 47 51 

VPOP 34 44 

 

MSKs of Interest 

For the historical record, a list of MSKs of interest is provided below.  Many of the MSKs 
listed below have been superceded by workstation applications.  Examples are SPECS 
from DPS (replaces 1346/7 SCRATCHPAD), and FAULT from DPS (replaces 1345 FAULT 
1).  One notable exception to this rule at present is FDO who is still MSK-based. 

 

                   



SHUTTLE OPS RESP: T. Rickerl  MSKs /TV Channels of Interest 
RNDZ CHB/DM-CH-08 REV B: 1/15/02 SCP 2.7 

Verify this is correct version before use. 2.7-2 

Table 2.7-2  MSKs of Interest 

MSK Description MSK Description 

0901 ANT MGMT A 1107 PROP RNDZ 
2330 ATTITUDE TIMELINE 1882 RMA STATUS 
0421 COVARIANCE 0482 RMD [Relative Motion Digitals] 
2756 DAP ERROR ATT 1888 RNDZ PROX OPS 
2744 DAP ERROR RATE 1102 RCS DETAILS 
2626 DATA FLOW ENGINNERING 1024 RMS STATUS 
0476 DMT [Detailed Maneuver Table] 0480 RNDZ EVAL TABL 
1305 FAULT 1 1346 SCRATCHPAD HISTORY 1 
1404 GNC CONTROL 1347 SCRATCHPAD HISTORY 2 
1405 GNC SENSORS - ORB 2747 ST FOV [Star Tracker Field-of-View] 
1414 IMU SUMMARY 0461 SUNRISE/SET (GMT) 
0964 KU RADAR SM [Self-Test]  0462 SUNRISE/SET (PET) 
0962 RDR/COMM STATUS  1875 SUPERSIGHTER 
0549 ONAV ORB STAT 0459 TDRS AOS/LOS (GMT) 
0790 ORBITER E/S POINTING 0458 TDRS AOS/LOS (PET) 
1879 POINTING SUMMARY 0372 VECTOR COMPARE 
0455 PSAT (GMT) TGT    
0456 PSAT (PET) TGT   
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2.8 Facility Problems 

PURPOSE 

To describe procedures and points of contact for facility problems.  Refer to SCP 2.9 
WORKSTATION PROBLEMS for details on workstations. 

PROCEDURE 

Report problem immediately to contact listed in table 2.8-1. Contact GC on GC CALL for any 
equipment, procedural, or processing problem.  Identify console number, keyset number, etc., as 
appropriate. 

If applicable, document problem as soon as possible using a Anomaly Report (AR) 
(http://usa10.unitedspacealliance.com/tx/drts/ ).  Refer to  

DM-SW-01  DM GAF FDD User Involvement in the Formal MCC Software Life Cycle 
(http://mod.jsc.nasa.gov/dm/division/documents/DM-SW-01.doc)  section 4.1.2.2 AR Process 
for AR submission details. 

 

Table 2.8-1  Points of Contact for Facilities Problems 

Console Equipment/Support 

Data Flow Problems 

Contact Position DVIS loop or Extension 

Workstations GC (FCR)  GC CALL 
 WSS (MPSR) WSS CALL 

TSTAC VIDEO x36931 or x31818 

 DSS/FSM x35615 or x35665 

RPOP/VPOP Video GC GC CALL 

Air conditioning GC GC CALL 

Lighting/power GC GC CALL 

DVIS Keyset HOUSTON VOICE VOICE CONTROL 

 

Note for RPS: When communicating with any facilities personnel, refer to yourself as 
“RENDEZVOUS SUPPORT” instead of RPS.  They will then understand who you 
are and will be much more helpful. 

 

BACKGROUND 

GC “owns” the facility and thus is the primary point-of-contact for any problems with the facility.  
Certain problems can be referred directly to the subsystem specialist. 
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2.9 Workstation Problems 

PURPOSE 

To describe recovery procedures for workstation problems. 

PROCEDURES 

Problem During Mission Support Time-Critical Phases 

• Do not reboot the workstation.   

The reason that a problematic workstation is not immediately rebooted is that WSS can 
often gather information on workstation problems through remote means.  Key 
diagnostic data is destroyed when a workstation is rebooted. 

• Immediately contact Ground Controller (GC) on GC CALL and report problem. 

• Log problem in console log.  Note the time, workstation ID, and a brief description of the 
problem. 

• Move to backup workstation. 

• When time permits, proceed with non time-critical actions, below. 

Problem During Non Time-Critical Phases and Simulations 

• Do not reboot the workstation.. 

• Contact Workstation Software Support (WSS) on WSS CALL and report problem. 

• If you believe the problem is with a DM application, contact the RGPO Group 
Administrator (GA). 

• If possible, expand Advisory Services to full screen and do a screen print.  Repeat with 
DXConsole. 

• Check with other workstation users for similar behavior. 

Submitting an Anomaly Report 

Refer to  DM-SW-01  DM GAF FDD User Involvement in the Formal MCC Software Life Cycle   
(http://mod.jsc.nasa.gov/dm/division/documents/DM-SW-01.doc) section 4.1.2.2 AR Process for 
AR submission details. For a TSTAC AR: 

• Function Group: MCC: H/W Maint 

• System: STANDALONE 

• Application/Subsystem: CTHPC 

• Sub-Subsystem: PC 
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BACKGROUND 

GC is responsible for the overall health of the workstation hardware and operating system, 
assisted by WSS.  The GA is responsible for the system administration of the Trajectory MPSR 
workstations, involving the general software configuration.  The ROSS Application Sponsor is the 
resident expert on ROSS problems. 
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2.10 RGPO Preflight Checklist 

PURPOSE 
Provide direction for the lead of the Rendezvous Team prior to real-time flight operations. 

PROCEDURE 

Prior to start of sims 

Tag-up with team.  Go over pertinent flight rules, changes in procedures, crew preferences, 
expectations for team, etc. 

 

Inside L-15 days 

1. Complete the Configuration Checklist for the MCC. 

2. Tag-up with PROP on “actual” vs. “budgeted” prop usage. 

3. On the Orbit Trainer or SES, both RGPO and RPS go fly a rendezvous. 

4. Hold RGPO team meeting within 2 weeks of launch, cover any issues with the flight. 

5. Develop Job Jar for the shifts to work. 

6. Set up directory/file structure on the flight directory. 

7. Make copy of timelines, spreadsheets and other files that are required on the V: drive and 
on the MPSR C: drive, in case servers become inaccessible. 

8. Develop Flight Rule summary for flight specific, Volume C & Volume A rules. 

9. Have a complete Rendezvous book with all PCNs/errata completed. 

10. Create a notebook for the console log, data book, Rendezvous Checklist and other FDF 
articles.  Sections of the console log should contain, but not limited to: 

1. Console Log 

2. SADS Data 

3. Flight notes/Messages 

4. Burn Pads 

5. Execute Packages 

• Miscellaneous Data Copy of the RGPO tag-up notes 

• Beeper list (everyone, not just Cindy’s beeper list) 

• Shift schedule 

 

(continued)
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6. Other FDF Articles 

• Flight specific Rules 

• Volume C rules 

• JOIP 

• On-Orbit ICD 

• Vehicle Config Data Book 

• Flight specific Orbit console handbook 

11. Coordinate with Prox Ops on rendezvous tools checkout support. 

 

 

 

BACKGROUND 
 
All applicable software items on the RGPO DNAV pulldown menu should be verified 
using the Flight Load Checklist (FLC) between L-30 days and L-15 days.  The FLC must 
be performed using a "CERT" ("MIS" or "SIM") activity for the flight of interest.  If 
possible, applications should be used during a simulation run to verify functionality.  It is 
the responsibility of the discipline to identify or arrange for an appropriate activity in 
which to perform the FLC. The objective of the FLC is to ensure that all required 
applications are available and properly configured in their flight support environment. This 
objective is met by actually running the applications on some representative input data and 
observing the results to be consistent within the context of available data and functions 
exercised. No qualitative or specific criteria are required to either prove or document 
success. There is no expectation to either execute or verify all of the functionality 
associated with each application. This check relies on the engineering judgment and 
training of the operator executing the FLC to select which functions to exercise and 
subsequently determine that the application appears to perform properly. As such, the 
operator executing the FLC must be a prime user from the responsible discipline. 
This checklist must minimally document each application on the RGPO DNAV pulldown 
menu and exhibit a pass/fail indication. It is responsibility of discipline to reconcile 
incompletes or failures via waivers, workarounds or resolutions. Any such actions should 
be documented with the FLC. It is responsibility of the discipline to accept the results of 
the FLC and archive all the associated documentation for future reference (for at least 3 
months after launch). 
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2.11 Execute Packages 

OVERVIEW 

The Execute Package is created by the Planning Shift FAO based upon inputs supplied by the 
rest of the flight control team.  It contains information to be uplinked to the crew as well as to be 
distributed to the controllers on the ground.  Information such as a news summary, lighting and 
event summary for rendezvous, checklist changes, mass properties updates, and Earth 
observations deltas are contained in the package. 

PROCEDURE 

The type of information to change is covered by SCP 2.12 PLANNING SHIFT OPERATIONS.   

• During or before the Orbit 2 to Orbit 3 shift handover, determine the input cutoff time. 

• Coordinate scope and format of the changes with FAO.   Determine whether to provide 
inputs as “WAS...IS...” or as new timeline/procedure pages 

• Provide a line-by-line correction in the following format, if feasible: 

 In the RENDEZVOUS C/L, page x-x, Block/Step xx: 

 WAS: xxx 

 IS:  xxx 

• If the number of changes is too extensive for this format, produce new 
timeline/procedure pages and send to FAO, placing change bars next to the 
changes 

• The updates can be submitted by copying a Word or other electronic file into the FAO 
inbox directory or by other arrangements made with FAO. 

• FAO and his/her backroom will take the inputs and generate the execute package.  

• The execute package can be reviewed via the PC application Joint Execute Package 
Development and Integration (JEDI).  This application can be accessed from the JSC-
MAS home page under the following tabs. 

  For missions use the Mission: STS Users > Tools > JEDI  tabs. 

 

For sims select the Sim 1, Sim 2, or Sim 3 button, and then the STS Users > Tools 

> JEDI  tabs 
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2.12 Planning Shift Operations 

PURPOSE 

The following defines the duties of the Rendezvous GPO and his team on the planning shift prior 
to the nominal day of rendezvous.  Many of these tasks may be performed at any time after 
launch; however, the planning shift prior to the day of rendezvous is responsible for ensuring the 
completion of these tasks. 

PROCEDURE 

The Rendezvous GPO team will review and/or perform the following during planning shifts: 

1. Impact Assessment and Workarounds of Anomalies 

Review all systems and other anomalies to determine impacts assessments on 

• planned procedures 

• timelines 

• Flight Rules 

Consult with other FCR operators as needed for specific inputs to changes needed to day-
of-RNDZ procedures, other FDF items, or Flight Rules in the following areas: 

• DPS hardware/software faults - DPS 

• Communication coverage anomalies - INCO 

• MCC hardware/software faults - GC 

• Crew health and human factors - SURGEON 

• Onboard FDF status (checklists, overlays, etc.) - FAO 

• Preliminary PROP "bingo" PAD and prop margins - PROP 

• Flight performance of IMUs, STRKs, Ku-Band - GNC, INCO 

• SR/SS, TDRS handover, Pointing concerns (sun, stars, etc.) - POINTING 

2. Actual Trajectory Lighting and Communications Coverage 

• After final trajectory is determined, use Sunrise/Sunset tables to verify event times fall 
in the proper places in the existing timelines.  Example: Ti burn should be at sunset 
minus 28 minutes, approximately. 

• Use TDRS coverage tables to be aware of where events fall relative to LOS periods.  
Also, verify that handovers may be shifted to optimize communications around certain 
events. 

• Work with RPS to generate new AOS/LOS and Sunrise/Sunset timeline pages for 
Rendezvous Checklist.  Note:  If these changes are minor, use as a console reference 
only. 
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• Review lighting and communication coverage at least 1 orbit past planned end of 
RNDZ activities. 

3. MCC Software 

• Reboot the workstations. 

• Verify that the correct version of ROSS is available under DNAV. 

• Start ROSS Telemetry services. 

• Verify that CRANS, SPECS, FAULT, and ELOG can be executed from DNAV. 

4. Celestial Background Check 

• Coordinate with FAO and/or POINTING on the generation of celestial sphere 
background plots for star tracker passes (planned and post-Ti contingency).  This is to 
anticipate possible bright celestial object passage in the star tracker field-of-view. 

• Review beta angle, type of approach to the target, and sunrise/sunset times for the 
manual phase.  This is to advise crew of possible bright object near the target. 

5. Procedure Changes 

• Review all procedure blocks that are relocated or added to the Rendezvous C/L for 
compatibility in DAP and Universal Pointing selections, arising from RMS, EVA, or 
system anomaly recovery steps. 

• Try to minimize attitude maneuvers during the rendezvous phase to reduce 
dispersions in the trajectory.  Coordinate TVR for all burns with FDO. 

• Avoid planned FREE DRIFT and maneuvers from TGT TRACK attitude during 
navigation passes. 

6. Target Features 

Consult with Payload Officer to determine the following, if applicable: 

• Target appendage status (PROX OPS and RMS clearance concern). 

• Target attitude control system status (PROX OPS and RMS piloting concern). 

• Target communications system status (Command timeline concern). 

• Target power status (Payload ACS health concern). 

7. Console Checkout 

As time allows, verify the following: 

• Console lights 

• Workstation monitors 

• VPOP and RPOP video connections 

• Voice loops 

• DVIS pages 
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8. Execute Package Preparation 

See SCP 2.11 EXECUTE PACKAGES for details on how to prepare inputs for the execute 
package. 

• Provide FAO with early estimates of the scope and size of Rendezvous GPO inputs to 
the package. 

• Review the Rendezvous team's pre-flight submissions for the package, including 
checklist corrections and updates, flight rule modifications, etc. 

• Submit items to FAO as soon as the materials are available so that processing can 
begin. 

• Retain copies of all submitted materials for reference. 

9. Electronic Timeline Page Uplink Preparation 

This procedure describes how to generate rendezvous timeline pages for uplink. 

• Prepare timeline pages as desired in MS Word.  

• Verify that your PC has both the Cyrillic and Arial Box fonts loaded. One way to do this 
is to review the timeline pages and verify that each of the fonts looks correct on 
screen. Another way is to open the Fonts folder under the Control Panel and verify that 
Cyrillic and Arial Box are present. 

• Print the desired pages on either the MPSR Pentium or the RGPO console Pentium 
using the "Print to File" print driver. This driver should be selectable from the pull-down 
list in the Print... box. If this driver is not available, see the instructions below for 
loading it. 

• Copy the resulting PostScript (.prn) file to FAO's inbox directory. FAO's backroom will 
convert the file to a format that can be uplinked to the TIPS printer onboard. If there is 
any confusion with the FAO backroom, inform them that the file should be converted 
to a PCX file. This essentially amounts to an electronically scanned page, much as if 
you faxed a document directly from your PC. 

• Ask FAO for a final TIPS printout of the file from their backroom. Verify that the file 
transferred and printed properly.  

• The FAO backroom will take care of getting the timeline into EDP for review. 

Installing the "Print to File" driver (if required per instructions, above).  

Use the standard Windows 95 "add printer" wizard. Pick any printer to install -- the Traj1 
printer is fine. Install the HP LaserJet 4P/4MP PostScript driver for the printer. Name the 
driver "Print to File". Upon exit from the printer wizard, right click on the printer "Print to 
File" to bring up Properties and make the following modifications:  

• Under the Details tab, type "FILE:" (no quotes) into the "print to the port" field.  

• Under the PostScript tab, select the PostScript output format "Archive format". 

10. Execute Package Review 

• Check all rendezvous procedural updates. 

• Verify proper entry and exit between Flight Plan and Rendezvous Checklist. 
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• Verify all burn times (and especially base time). 

• Verify accuracy of times, sequences, and relative order of all other events mentioned 
in both the Rendezvous Checklist and the Flight Plan. 

• Verify the accuracy of rendezvous events and the attitude timeline along the bottom of 
the Summary Timeline. 

• Verify other team's inputs for effects on the rendezvous procedures and timelines. 

11. Rendezvous Team Handover Report 

Review log and prepare a summary of the following for the on-coming Rendezvous GPO 
per SCP 2.2 CONSOLE DOCUMENTATION: 

• Mission status. 

• Orbiter systems summary. 

• Payload status summary. 

• Actions taken as noted above. 

• Jobs complete. 

• Jobs in work and their status. 

• Jobs remaining. 

• Any open actions remaining. 

BACKGROUND 

The main product of the planning shift is the FAO's Execute Package, the uplink message that 
amends the preflight FDF, in accordance with the subjects discussed above.  Everything that can 
be sent up early should be.  Coordinate these activities pre-flight with the Execute Shift 
Rendezvous GPO to ensure that the proper material is covered.  The secondary product is a 
package of preparatory material for the on-coming RNDZ GPO team supporting the execute 
shift. 
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2.13 Shift Handovers 

PURPOSE 

To define procedures to be used by the team to allow an effective and orderly shift handover.  

PROCEDURE 

1. Shift Handover 

Actions for the Outgoing RNDZ GPO are as follows: 

• Contact incoming replacements in the event of shift schedule changes. 

• Organize late-arriving plots, hardcopies, flight notes, FDF changes, and the console 
log. 

• Complete a handover log summarizing events from the shift (per instructions in the 
next section). 

• Remain on console until dismissed by the outgoing FD. 

• Clear the MCC when handover is complete. 

Actions for the Incoming RNDZ GPO are as follows: 

• Review plots, console hardcopies, flight notes, and console logs. 

• Review the handover log for specific actions to be performed on the upcoming shift. 

• Prepare a brief written handover briefing to give to the oncoming FD. 

2. Handover Log 

Creating a new handover log: 

• Create the directory U:\WORK\GPO\STS-XXX\HANDOVER, where STS-XXX is the 
mission being supported.   This is done once during a mission.  

• Double-click on the file U:\WORK\GPO\HANDOVER.DOC and complete the information 
in the dialog box that should pop up immediately 

-- OR --  

• Open a previous handover file from your flight, double click on the bar at the top of the 
document labeled “Double Click on this bar to perform a shift change”, 
and complete the information in the dialog box 

• Either step automatically creates a new filename based upon the information you enter 
into the dialog box. 

• The outgoing RGPO should type the shift handover information in the boxes provided, 
one each for the following topics: 
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Orbiter Anomalies 

Summarize key Orbiter anomalies at a level appropriate for a handover briefing to the 
incoming FD.  Place a reference to entries in the console log for more details, if required. 

Payload Anomalies 

Summarize key target anomalies that may impact rendezvous operations, again at a level 
appropriate for a handover briefing to the incoming FD.  Place a reference to entries in the 
console log for more details, if required. 

MCC/Console Anomalies 

Summarize important anomalies related to building facilities. 

Actions/Things to Do  

List specific actions to be performed by the oncoming team during the upcoming shift.  The 
Lead RGPO can list actions to be performed during the upcoming Flight Day.  If a 
previously-listed task is not completed, leave the task here with a status update for the 
oncoming  team.  Only the Lead RGPO can delete actions without providing a resolution. 

Completed 

Move completed actions from the above section to this section, along with any notes 
concerning the resolution of the action.  List any unassigned tasks completed in this 
section also.  The Lead RGPO can delete entries from here as needed. 

Notes 

List any items here that do not fit into any of the above categories. 

BACKGROUND 

The RNDZ Phase execute shift is usually preceded by a planning shift and may be followed by 
an additional shift to support RMS berthing, EVA activities, or deploy.  Typical rendezvous 
events occur with Orbit 3 as planning, Orbit 1 as execute, and Orbit 2 as the additional shift, but 
these may vary on a flight-specific basis.  Proper documentation and handover activities are 
critical to smooth console operations. They are also critical to reconstructing flight events to 
support post-flight analysis and investigations. 

The handover log is to serve as an aid to guide the oncoming RNDZ GPO in preparing a 
handover briefing to the oncoming FD and to serve as a guide for activities to perform on the 
upcoming shift.  As such, it must be clear and concise. 

The Microsoft Word template for the electronic handover log is located at  

\\S:\Divisions\DM\Private\DM34\Documents\forms\handover.dot 
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2.14 Variable Parameter Requests 

PURPOSE 

This procedure explains how and when to submit the Variable Parameter Display Request form.   
This also includes information on where to obtain the HAL addresses. 

Reference:  Target Console Handbook section 3.2.3: 
http://usa1.unitedspacealliance.com/usahou/orgs/48-30/chb/OFDCHB.htm 

PROCEDURES 

Overview: 

The variable parameters list allows data not on the downlist to be downlisted from the 
orbiter.  For rendezvous operations, Target generally requests through DPS support that 
the T1 TIG for onboard-targeted maneuvers be downlinked.  This allows Target to confirm 
that the I-loads are correct and to determine the MC2 TIG slip without having the crew read 
down the TIG from SPEC 34.  The T1 TIG is downlinked as the hexadecimal equivalent of 
the MET seconds. 

Figure 2.14-1 shows an example of a completed VP Request Form. When the form is 
completed, three copies must be submitted to the DPS Support position.  This can be done 
prior to the first sim or at the beginning of the first sim.  Once the final load is built, the 
following forms are submitted prior to flight to DF2. 

• the completed form  

• a copy of the HALSTAT data showing the address.  The HAL address for the T1 TIG 
can be found on the FSW Product CD for the specific flight. 

• a table of the coverage times, as shown, if there is more than 1 span to be monitored  
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Figure 2.14-1 Example Variable Parameter Display Request form 

   

H AL Nam e A ddress K B IAS TYPE (2) SLOT (3)

C GZV_T_M AN E 4 D 4 FXS

E 4 D 5

NO T E S : (1) O ptio nal F ield s - Req u ired fo r v iew in g  o n M S K 1352  (2) Typ e is  F X S  (F ixe d-po in t) o r F LS  (F lo ating -p o in t)  (3) DP S  Usag e O n ly

Req u esting  D iscip lin e

T O: S p ecify Co verag e:  (R eferen ce E ven ts o r G M T ’s)

R endezvous/Target

V ariab le  Param eter D isplay R equest
S u bm it 3  cop ies to  DP S  S P T

Nam e G M T :
D awn M . Gabriel

G N C  2 G N C  3 G N C  8 G N C  9 S M  2 S M  4

M ajor Fu nc tio n/O peratio ns:

Co verag e
S naps hot(s)  o f D ata M o nitor fo r a  S pa n of T im e

Reten tio n

G N C  1

C urrent F light/S IM  only A ll F ligh t/S IM S

F RO M : S p ecify  Co verag e:  (R eferen ce E ven ts o r G M T ’s)
Post M C4N CC  - 1  hour

Ratio nale:

E lim inate crew  read  down o f orb it tgt (spec 34) data

T itle  (3) DS M :  (3) DP S  S ig n atu re  (3)
G N C  V P  S P E C  3 4  D A T A 230
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STS-77 VP Request 

 

Requesting Discipline: Rendezvous 

Point of Contact: Tom Snyder (282-2832) 

Event Required VP Start Times (MET) Required VP Stop Times (MET) 

SPARTAN/IAE (NCC-1 hr)   02/00:00:00.0 (MC4+1.5 hr)   02/04:45:00.0 

PAMS-STU Proxyvous (P0) (NCC-1 hr)   03/00:00:00.0 (VBN-P0+1.5 hr)   03/04:54:00.0 

PAMS-STU Rendezvous 1 (P1) (NCC-1 hr)   05/18:10:00.0 (VBN-P1+1.5 hr)   05/22:58:00.0 

PAMS-STU Rendezvous 2 (P2) (NCC-1 hr)   06/18:10:00.0 (VBN-P2+1.5 hr)   06/23:00:00.0 

   

Note: all event start and stop times are based on the planned liftoff day and time. Actual MET start and stop times may vary if the 
launch slips, however, the times listed above should account for any slip. 
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3.1 DPS / EPDC 

PURPOSE 

To identify impacts from Data Processing System or Electrical Power Distribution and Control 
system failures.    

PROCEDURES 

DPS 

For DPS Dictionary see: \\Jsc-mod-fs9\fdf\Books\Current Published Documents\Generic,\DPS 
Dictionary\Start Use On STS-101\Dps_gj5.pdf 

1. DPS Definitions 

• Common Set:  all PASS GPCs that are processing PASS software and communicating 
with one another.   May be running different application software.   

• Redundant Set:  Subset of common set made up of GPCs that are simultaneously 
receiving identical inputs, performing identical calculations and generating identical 
outputs.   

• Simplex GPC:   Operates independently.   May or may not be part of CS.   (BFS is not 
part of CS) 

• SM:   A simplex machine which communicates with other GPCs but is not part of the 
RS.  For Rendezvous the SM is used only for radar acquisition of target (not for 
tracking).  

2. RS Expansion or Contraction (or OPS Mode Recall) 

• Rel Nav is disabled due to transition through Ops 0 (see SCP 4.2 RENDEZVOUS NAV 
SAFING & IMPACTS). 

• Can only happen in X01. 

• The target set of the NBAT is changed. 

• The NBAT is envoked upon the OPS mode recall. 

3. GPC Stringing / Restring Planning 

• Obtain the string configuration from DPS or from the DPS Overview Display on the 
workstation. 

• Select appropriate DPS Stringing Chart 1212, 1221, 1122, or 1233 and update CRANS 
as applicable.  Note:  If the stringing is something else, such as 1232, use the chart 
with the closest pattern.  
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Note: The DPS Stringing charts reveal the relationships between GPC string 
assignments and the LRUs driven.  The 14 RCS jet groups are listed according to 
string with PRCS and VRCS in separate tables.  Any GPC string assignments resulting 
in "vulnerable" jet groups (i.e., driven from a single GPC) are annotated.  An MDM table 
is provided at the bottom for quick assessment of system losses in the event of MDM 
failures.   

• Mark current RCS Jets and other systems failures on chart and in CRANS. 

• Determine translational or rotational losses or other vulnerabilities with stringing and jet 
losses.   

Note:  +Z translations MUST be one-fault tolerant to approach within 250 feet of the 
target.  LOW Z counts as an added level of redundancy as long as it is not lost with the 
same failure that will take NORM Z.   

Reference: Flight Rule A2.1.3-18.  

• Be aware of impacts to IMUs, NAV sensors, DAP buttons, Hand Controllers and Flight 
Rules with the stringing. 

4. DPS System Failures: 

GPC Loss 

• If flying triple G2 (stringing 1233) and GNC GPC fails: 

For loss of verns:  DAP PRI/AUTO            
Likely Restring xyxy – no impact to RNDZ NAV or Pointing 

• Ti and PROX OPS:  Two GNC GPCs are required at Ti and within 200 feet of the 
target.  If a GPC fails, must evaluate which state vector should be saved if the failure 
occurred during sensor pass.  If the PROP vector is better, a PROP to FLTR will be 
needed before the redundant set expansion.   This is because the FLTR vector will be 
copied upon enabling RNDZ NAV to create the PROP.  The target state vector 
becomes static until RNDZ NAV is enabled so a target track before RNDZ NAV is 
enabled might cause a large maneuver on UNIV PTG and will result in GPC 
computational errors.   

• SM Loss: The SM is required for Ku Antenna Pointing using the GPCs.   If the 
Antenna is already locked on the target, loss of the SM will probably not result in loss of 
lock.  Reference:  SCP 3.7 Figure 3.7-1. 

• Note:   With lowered cabin pressure (i.e. preparation for EVA), may have to operate 
with two GNC GPCs instead of three due to decreased heat dissipation capabilities.   

MDM Loss: Reference MAL DPS 5.3 

• Some apparent MDM failures may be caused by GPC or stringing problems.  

• Expect multiple I/O ERROR messages and I/O RESETS while the crew attempts 
recovery.   I/O resets take a minimum of 8 seconds to complete.  

CAUTION:  I/O RESETS will cause IMU swaps when one IMU is deselected.  

• MDM power cycle may cause the associated IMU to “cage.”   A caged IMU can be 
recovered with an IMU-IMU align.  

• PORT MODING may recover the MDM, lead to the loss of the related FF/FA MDM or 
(rarely) result in a GPC failure. 

• MDM Card Failures will cause partial loss of MDM data.   Serial and input card errors 
will result in a “BCE STRG X” error message; output card errors give no message.  
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• If failure recovery is not possible, determine the RNDZ capability lost or degraded 
(NAV, PROX OPS, MNVRs, etc.).  

• MDM PL1 Sends KU pointing commands from the SM GPC to the Radar 

• MDM FF3 Loss of FF3 puts you in a Radar Fail case.   FF3 sends radar data from 
the KU to the GNC GPCs.  The digital displays on A2 are hard wired to the RR.  Loss 
of FF3 also results in loss of Verns.  

 

EPDC 

EPDC Bus Failures 

MN Bus Failure: 

• Wait for bus tie attempt – may not be done if short is found depending on where the 
short is.   Otherwise may isolate the short and reestablish the remainder of the bus.  

• Main DC buses may be cross-tied to recover redundancy after a Flight Critical bus loss.  

• Confirmed shorts will result in shut down of all or part of the affected bus.  

• Reference BUS FAILURES chart to determine impacts to rendezvous systems. 

 

 

 

 

 

 

 

 

 

 

                   



SHUTTLE OPS RESP:  J. Spehar DPS / EPDC 
RNDZ CHB/DM-CH-08 REV B PCN-2: 06/27/2005 SCP 3.1 

 

Verify this is correct version before use.  3.1-4 

 

 
PRIMARIES Jet Group 

String GPC 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

1 1 F1F F1L  F1U  F1D R1A L1A L1L R1R L1U R1U   

2 2 F2F  F2R F2U F2D  R3A L3A L3L R3R   L3D R3D 

3 1   F4R  F4D    L2L R2R L2U R2U L2D R2D 

4 2 F3F F3L  F3U  F3D   L4L R4R L4U R4U L4D R4D 

VERNIERS  

1 1         L5L    L5D  

2 2          R5R    R5D 

3 1     F5R F5L         

4 2               

 

Jet Group Attitude 
Mnvr 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

+Pitch     1 1     1 1   

-Pitch    1         1 1 

+Roll            1 1  

-Roll           1   1 

+Yaw  1        1     

-Yaw   1      1      

 

Translation Jet Group 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

+X       1 1       

-X 2              

+Y  1   1 1   1      

-Y   1  1 1    1     

+Z    1       1 1   

-Z     1 1       2 2 

LO Z 2      1 1       

PCT     1 1       1 1 

 

Degraded Translations  Jet Group 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

+X       1 1       

-X 1              

-Z     1 1       1 1 

 

DAP pb THC 

Fwd                   Aft 
MDM / 
String 

GPC IMU STRK RR 
DAP  
Lts 

Cntl Axes Cntl Axes  

ADI Att  
Ref pb Fwd Aft 

RHC 
Aft 

1 1 1 -Z  Fwd A A C  Left A A A 

2 2 2    B B   Right B B B (p/y) 

3 1 3 -Y RR>Nav Aft C  A A Aft C C C 

4 2       B B    B (roll) 

Figure 3.1-  DPS Stringing Scheme 1212 

 

 

OR 

         Vulnerable to GPC failure 
 

                   



SHUTTLE OPS RESP:  J. Spehar DPS / EPDC 
RNDZ CHB/DM-CH-08 REV B PCN-2: 06/27/2005 SCP 3.1 

 

Verify this is correct version before use.  3.1-5 

 

 

 

PRIMARIES Jet Group 

String GPC 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

1 1 F1F F1L  F1U  F1D R1A L1A L1L R1R L1U R1U   

2 1 F2F  F2R F2U F2D  R3A L3A L3L R3R   L3D R3D 

3 2   F4R  F4D    L2L R2R L2U R2U L2D R2D 

4 2 F3F F3L  F3U  F3D   L4L R4R L4U R4U L4D R4D 

VERNIERS  

1 1         L5L    L5D  

2 1          R5R    R5D 

3 2     F5R F5L         

4 2               

 

Attitude Mnvr Jet Group 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

+Pitch     1 1     1 1   

-Pitch    1         1 1 

+Roll            1 1  

-Roll           1   1 

+Yaw  1        1     

-Yaw   1      1      

 

Translation Jet Group 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

+X       1 1       

-X 2              

+Y  1   1 1   1      

-Y   1  1 1    1     

+Z    1       1 1   

-Z     1 1       2 2 

LO Z 2      1 1       

PCT     1 1       1 1 

 

Degraded Translations  Jet Group 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

+X       1 1       

-X 1              

-Z     1 1       1 1 

 

DAP pb THC 

Fwd             Aft 
MDM / 
String 

GPC IMU STRK RR 
DAP  
Lts 

Cntl Axes Cntl Axes  

ADI Att  
Ref pb Fwd Aft 

RHC 
Aft 

1 1 1 -Z  Fwd A A C  Left A A A 

2 1 2    B B   Right B B B (p/y) 

3 2 3 -Y RR>Nav Aft C  A A Aft C C C 

4 2       B B    B (roll) 

Figure 3.1-2  DPS Stringing Scheme 1122 

 

         Vulnerable to GPC failure 
 

OR 
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PRIMARIES Jet Group 

String GPC 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

1 1 F1F F1L  F1U  F1D R1A L1A L1L R1R L1U R1U   

2 2 F2F  F2R F2U F2D  R3A L3A L3L R3R   L3D R3D 

3 2   F4R  F4D    L2L R2R L2U R2U L2D R2D 

4 1 F3F F3L  F3U  F3D   L4L R4R L4U R4U L4D R4D 

VERNIERS  

1 1         L5L    L5D  

2 2          R5R    R5D 

3 2     F5R F5L         

4 1               

 

Attitude Mnvr Jet Group 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

+Pitch     1 1     1 1   

-Pitch    1         1 1 

+Roll            1 1  

-Roll           1   1 

+Yaw  1        1     

-Yaw   1      1      

 

Translation Jet Group 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

+X       1 1       

-X 2              

+Y  1   1 1   1      

-Y   1  1 1    1     

+Z    1       1 1   

-Z     1 1       2 2 

LO Z 2      1 1       

PCT     1 1       1 1 

 

Degraded Translations             

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

+X       1 1       

-X 1              

-Z     1 1       1 1 

 

DAP pb THC 

Fwd                   Aft 
MDM / 
String 

GPC IMU STRK RR 
DAP  
Lts 

Cntl Axes Cntl Axes  

ADI Att  
Ref pb Fwd Aft 

RHC 
Aft 

1 1 1 -Z  Fwd A A C  Left A A A 

2 2 2    B B   Right B B B (p/y) 

3 2 3 -Y RR>Nav Aft C  A A Aft C C C 

4 1       B B    B (roll) 

Figure 3.1-3  DPS Stringing Scheme 1221 

 

OR 

         Vulnerable to GPC failure 
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PRIMARIES Jet Group 

String GPC 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

1 1 F1F F1L  F1U  F1D R1A L1A L1L R1R L1U R1U   

2 2 F2F  F2R F2U F2D  R3A L3A L3L R3R   L3D R3D 

3 3   F4R  F4D    L2L R2R L2U R2U L2D R2D 

4 3 F3F F3L  F3U  F3D   L4L R4R L4U R4U L4D R4D 

VERNIERS Jet Group 

1 1         L5L    L5D  

2 2          R5R    R5D 

3 3     F5R F5L         

4 3               

 

Attitude Mnvr Jet Group 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

+Pitch     1 1     1 1   

-Pitch    1         1 1 

+Roll            1 1  

-Roll           1   1 

+Yaw  1        1     

-Yaw   1      1      

 

Translation Jet Group 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

+X       1 1       

-X 2              

+Y  1   1 1   1      

-Y   1  1 1    1     

+Z    1       1 1   

-Z     1 1       2 2 

LO Z 2      1 1       

PCT     1 1       1 1 

 

Degraded Translations             

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

+X       1 1       

-X 1              

-Z     1 1       1 1 

 

DAP pb THC 

Fwd                   Aft 
MDM / 
String 

GPC IMU STRK RR 
DAP  
Lts 

Cntl Axes Cntl Axes  

ADI Att  
Ref pb Fwd Aft 

RHC 
Aft 

1 1 1 -Z  Fwd A A C  Left A A A 

2 2 2    B B   Right B B B (p/y) 

3 3 3 -Y RR>Nav Aft C  A A Aft C C C 

4 3       B B    B (roll) 

Figure 3.1-4  DPS Stringing Scheme 1233 

 

 
Reference: Reference Data Book, Generic Rev E, July 8, 1999 

OR 
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 FF1 A PNL F6 (FWD L ADI) Sws (eight)  FA1 D L RCS MANF 5 JET RM 
  IMU 1 Status     L, R RCS MANF 1 JET RM 

 B F RCS MANF 1 JET RM   O L RCS MANF 5 JETs 
  CNTLRs/PBIs/SWs:    L, R RCS MANF 1 JET vlvs 

  - AFT DAP CNTL: chnl 3*  FA2 D L, R RCS MANF 3 JET RM 

  - AFT RHC: chnl 1   O R RCS MANF 5 JETS 
  - AFT SENSE sw: chnl 1    L, R RCS MANF 3 JET vlvs 

  - AFT THC: chnl 1  FA3 D L, R RCS MANF 2 JET RM 

  - FWD DAP AXES: chnl A   O L, R RCS MANF 2 JETS 

  - FWD DAP CNTL: chnl 1  FA4 D L, R RCS MANF 4 JET RM 

 S IMU 1   O L, R RCS MANF 4 JETS 

  NSP 1     
  -Z STRK     

 O -Z STRK  PL1  GPC KU ANTENNA POINTING 

  FWD DAP LIGHTS  PL2  CCTV U/L COMMANDS 

FF2 A IMU 2 Status      
  PNL F8 (FWD R ADI) Sws     

 B F RCS MANF 2 JET RM     
  CNTLRs/PBIs/SWs:     

  - AFT SENSE: chnl 2    NOTES: 
  - AFT RHC (pitch, yaw only): chnl 2    DAP AXES 
  - AFT THC: chnl 2    • Bottom 3 rows of pbi (18 pbi) 
  - FWD DAP AXES: chnl B    • Three redundant I/O channels per pbi 

(1, 2, 3) 
  - FWD DAP CNTL: chnl 2     
  - FWD THC: chnl 2    DAP CNTL 

 S IMU 2    • Top row of pbi (6 pbi) 

 O F RCS MANF 2 JETS    • Two redundant I/O channels per pbi 
(A, B) 

  IMU 2     

FF3 A IMU 3 Status    AFT SENSE Sw 
  PNL A6 DISP (AFT ADI) Sws (three)    • Three redundant I/O channels (1, 2, 

3) 

 B F RCS MANF 4 JET RM     
   MANF 5 JET RM     
  CNTLRs/PBIs/SWs:     
  - AFT ATT REF     
  - AFT DAP AXES: chnl A     

  - AFT DAP CNTL: chnl 1    KEY: 
  - AFT RHC: chnl 3    A, B, C, D:  BCE Input Cards 
  - AFT SENSE sw: chnl 3    S: Serial I/O Cards 
  - AFT THC: chnl 3    O: GPC Output 

  - FWD DAP CNTL: chnl 3     
  - FWD THC: chnl 3     

 S IMU 3     
  - Y STRK     
  RNDZ RADAR     

 O F RCS Manf 5 Jets     
  F RCS Manf 4 Jets     
  IMU 3     
  -Y STRK     
  DISPLAYS     
  - AFT DAP LIGHTS     

FF4 B F RCS MANF 3 JET RM     
  CNTLRs/PBIs/SWs:     
  - AFT DAP AXES: chnl B     
  - AFT DAP CNTL: chnl 2     
  - AFT RHC (roll only): chnl 2     

 O F RCS MANF 3 JETS      

Note: The technically correct nomenclature for MDM PL1 is MDM PF1.  Since the crew procedures and 
Caution & Warning refer to PF1 as PL1, we chose to use PL1 to remain consistent with the crew. 

 

Figure 3.1-5  MDM-LRU Relationship by I/O Card 
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 DDU
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 DDU

 DDU
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  Sec

  Sec
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  Pri
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  Sec
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  Pri

  Pri
  FF3
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  Sec
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  Pri
  FF4

  Sec

  Sec
  FA4

  Pri

IMU
1

-Z
STRK

RJDF
1B

F1
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NSP
1

RJDA
1B

L1

Jets

L OMS
PRI GMBL

R1

Jets

L5

Jets

IMU
2

RJDF
1A

F2

Jets

RJDA

2B

L3

Jets

L OMS

SEC GMBL

R3

Jets

R5

Jets

IMU

3

Ku

RDR

RJDF

2B

F4

Jets

NSP

2

-Y

STRK

F5

Jets

RJDA
1A

L2

Jets

R OMS
SEC GMBL

R2

Jets

RJDF

2A

F3

Jets

RJDA
2A

L4

Jets

R OMS
PRI GMBL

R4

Jets

 
 

Figure 3.1-6  MDM-LRU Relationship by Port Assignment 
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Reference:  Reference Data Book, Generic Rev E, July 8, 1999 

Note: This table has the same format as the associated table in the Reference Data Book.   Those items directly 
pertaining to RGPO responsibilities are included.    See Ref Data Book for additional system losses.   
 

BUS LOST CRITICAL 
EQUIPMENT LOST 

CRITICAL 
REDUNDANCY 

LOST 

INSTRUMENTATION / OTHER 
LOSSES 

OMS/RCS AFFECTED 

DA1     

FPC 1 DEU/CRT 1  MCIU  

FLC 1 F RCS Manf 1 Jets    

 

 

AC 1   IMU Fan A -Y STRK SYS 1 Door Mtr 
 
OMS/RCS Prplt Qty (Gauging) 

 

 APC 4     

  APC 1 L OMS Pri TVC 
R OMS Sec TVC 

  L Manf 5 Jets 

  ALC 1   L, R RCS Manf 2 Jet Htrs 
OMS Qty Gauging 

L Manf 5 Jets 
L OMS Eng P vlv Pos 

 O14 L Instr Pwr  Fwd Mission Timer 
IMU Fan Sensor 
-Z STRK 
Aft Event Timer 

 

 O14 & A8   RMS Pri Pwr F1 Manf RJDs (if sw off) 

 R14 UHF Pwr Amp 
(xmit) 

 CCTV Mon 1 
Aft PLB Cameras 

 

 MPC 1   RMS Pri Pwr 
RMS Pri Pwr 
PLB Floodlights 
O/H Docking Lights 

 

  MMC1 
MMC3 

  RMS Redun MRL  

DA2     

FPC 2 DEU/CRT 2    

FLC2 F2 Manf Jets     

AC2  IMU Fan B A2 Digitals (˯C)  

APC 5     

 APC2 L OMS Sec TVC  Aft MNB Bus PWR R RCS Manf 5 Jets 

 ALC 2   L OMS Qty Gauging  R RCS Manf 5 Jets 

O15 R INST Pwr  Fwd Event Timer 
-Y STRK 

 

O15&A8    F2 Manf RJDs (if Sw OFF) 

R14 Ku System (Comm 
& Rdr) 

 Fwd Cameras 
CCTV Mon 2 
RMS Cameras 

 

 

MPC 2 Ku System (Comm 
& Rdr) 

 Mid Port Floodlight 
Fwd Stbd Floodlight 
RMS Backup Power 

 

DA3   PL Primary MN C Pwr  

FPC 3 DEU/CRT 3 / 4  Ku Radar  

 FLC3 F RCS Manf 4 Jets   F5 Manf Jets 

 AC3  IMU Fan C IMU Fan Signal Conditioner 

COAS Light (˯A) 

 

APC6     

 

APC3 R OMS Pri TVC    

 

 

ALC3   R OMS Qty Gaging  

 O16 RJD    F4 Manf RJDs (if F3 and 
F4/5 sw OFF) 

 R14   Ku Signal Processor 
EVA/Keel Cameras 

 

 MPC 3   Mid Stbd Floodlight 
Aft Port Floodlight 

 

Figure 3.1-7  Main Bus Loss 
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AB1 CRT 1 
Manf F1 RJDs (if SW OFF) 
L ADI Att Ref pb 

BC1 F, L, R RCS Manf 5 Jets 
Manf F2 RJDs (if SW OFF) 
R ADI Att Ref pb 

CA1 CRT 3 
Manf F3 RJDs (if SW OFF) 
A ADI Att Ref pb 
RMS Spotlight 
Docking Light 

AB2 F RCS Manf 1 Jets 
Manf L5 RJDs (if SW OFF) 
L ADI Att Ref pb 
L ADI sws 
Aft DAP – cntl pbs chnl 3 

BC2 CRT 2 
F, L, R Manf 5 Jets 
Manf F2 RJDs (if SW OFF) 
R ADI Att Ref pb 
R ADI sws 
Aft DAP – cntl pbs chnl 2 
Aft DAP – axes pbs (18) 

CA2 CRT 4 
F RCS Manf 3 Jets 
A ADI Att Ref pb 
A ADI sws 
Aft DAP – cntl pbs chnl 1 
Aft DAP – axes all pbs (18) 

AB3 Fwd DAP – cntl pbs chnl 1 
Fwd DAP – axes pbs (18) 
 

BC3 Manf F4 RJDs (if SW OFF) 
Manf F5 RJDs (if SW OFF) 
Fwd DAP – cntl pbs chnl 2 
Fwd DAP – axes pbs (18) 
 

CA3 F RCS Manf 4 Jets 
Fwd DAP – cntl pbs chnl 3 

 

Figure 3.1-8  Control Bus Loss 
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MNA APC1
FF1

FA1

MNA ALC1

CNTLAB1*
FA3**

MNA ALC1

CNTLAB1*
FA4

MNB ALC2

CNTLAB2*

FA1

MNB ALC2

CNTLAB2*

FA2

MNB APC2

FF2
FA2

Left OMS

Pri TVC

Left OMS

Ignition

Left OMS

Sec TVC

LEFT OMS

MNC APC3
FF4

FA4**

MNC ALC3

CNTLCA1*
FA4**

MNC ALC3

CNTLCA1*
FA3

MNA ALC1

CNTLCA2*
FA1

MNA ALC1

CNTLCA2*
FA2

MNA APC1
FF3

FA3

Right OMS
Pri TVC

Right OMS
Ignition

Right OMS

Sec TVC

RIGHT OMS

* If CNTLAB1 or AB2 (CA1 or CA2) failed and ignition path still
    exists at OMS fail, assume L(R) OMS     is PRPLT FAIL

** If FA3(4) or Pc failed high and L(R) OMS fail, no guidance
    downmode after OMS ENG switch OFF (TGO slow, ADI

    needles in error, 6 ft/s underburn)

If two FA MDMs lost:

MDMs

1,2

1,3
1,4

2,3

2,4

3,4

Preburn:
ENG-OFF

LEFT (TVC)
RIGHT (IGN)

LEFT (IGN)

LEFT (IGN)

RIGHT (IGN)

RIGHT (TVC)

During Burn:
MAN SHUTDN

BOTH
LEFT

RIGHT

RIGHT

LEFT

BOTH  

Figure 3.1-9  OMS FAILURES Cue Card 
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3.2 DAP  

PURPOSE 

To serve as a quick reference for Digital Auto Pilot information. 

PROCEDURE 

DAP Panel redundancy management (RM): 

• The 6 PBIs on the top row are all 3 contact pushbuttons and use standard three level RM. 

• Remaining PBIs are 2 contact and use standard two level RM. 

DAP Configuration  Notes: 
Table 3.2-1 DAP Notes 

Setting Description 
AUTO (automatic) • Attitude defined by Universal Pointing or Orbit Burn Guidance 

• ROT DISC RATE and PULSE: disabled although their lights may be illuminated. 
• Manual selection of DISC or PULSE has no effect 
• Moving the RHC:  downmode from AUTO to INRTL 
• If no auto maneuver, pointing or tracking option is being processed, AUTO will initiate 

an inertial attitude hold.  
 

INRTL (manual 
inertial) 

• Initiates attitude hold in any axis that has DISC RATE selected. 
• ROT DISC RATE and PULSE:  AUTOMATICALLY MODED TO DISC RATE 
• Any axis moded to PULSE will go to free drift.   

  
LVLH (manual) • LVLH Hold for each axis – IF – DISC RATE ON 

• ROT DISC RATE and PULSE:  AUTOMATICALLY MODED TO DISC RATE 
• Any axis moded to PULSE will go to free drift. 
 

FREE • ROT DISC RATE / PULSE:  AUTOMATICALLY MODED TO PULSE 
• Crew can not select DISC RATE in any axis 

Automatic Moding to 
FREE 

IMU Failure 
• If there is no IMU data being received by the DAP, it will downmode to FREE with Rot 

Pls, Pls, Pls 
• When 1+ IMU is recovered DAP will remain in FREE / Rot Pls,Pls, Pls until crew 

takes action 
Loss of VERNS 
• Anything that causes VERN Failure (i.e. some MDM failures) downmodes the DAP to 

FREE. 
VERN Failure 
 

• Loss of any of the four down firing jets (F5R, F5L, R5D, L5D) 
• DAP reconfig fault message generated 

PRI • Deflecting THC causes DAP to upmode to PRI.  
ALT • Attitude control: Uses primary jets with fewer jet firings of a smaller duration and 

selectable delay between firings to allow attitude control when verniers are lost.  
• For attitude mnvrs, ALT is preferred over VERN because of its lower translational 

coupling and is preferred over PRI because of its more efficient jet selection logic. 
• # Jets:  maximum number of PRI jets that fire simultaneously while in ALT.   This 

applies to rotations only.   Deflecting THC causes DAP to up mode to PRI.  
VERN • Uses only vernier jets for attitude control 

LOW Z 
• Fires 2 aft and 2 fwd firing jets to produce +Z motion.  
• Inhibits up firing jets for attitude control.  
• Increases fuel consumption by a factor of 10 
• Used with small range rate and only when required for pluming concerns           (more) 
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• Due to RCS cross coupling:  
• An out-of-plane correction will increase closure 
• “Walks” the orbiter in toward the target – induces a pitch moment 
• Final braking is done in Norm Z for better control. 

High Z 
• Fires all 9 up firing jets and is used for emergency back away.   

PCT  
 

• Requires one fwd down firing jet per side and one down firing jet in each aft pod.    
• This requirement is met as long as ±Y and –Z translational capability exists. 

During OMS Engine 
Firing 

There is no RCS response to THC inputs while the DAP is in TVC mode (engines are on). 

  

DAP A vs B 

A7/B7 RNDZ:    B has higher ROT RATE in both PRI and VERNS 

    A has higher TRANS and ROT PLS 

A8/B8 TERMINAL PHASE: A has higher TRANS and ROT PLS 

A9/B9 PROX OPS:  A has higher TRANS and ROT PLS 

A10/B10 DOCKING:  A has higher TRANS and ROT PLS 

 

Prox Ops 

DAP A/B is a crew choice item. DAP B is not required but since small inputs are expected 
due to the benign environment of stationkeeping, DAP B is usually preferred. AUTO is 
required to maintain the +Vbar attitude during the approach.  Maintaining the +Vbar 
attitude provides a correct reference for maintaining the approach corridor (inside 250 ft 
CG-to-CG).  

VERNs are preferred for the approach because the smaller deadband, finer control and 
absence of up firing jets produce less plume impingement and propellant usage than 
PRI/NORM Z or PRI/LOW Z. In addition, vernier jets produce significantly less cross 
coupling into -Z (closing rate) acceleration than PRI LOW Z, which greatly reduces the 
probability that braking burns will be required on Rbar approaches and reduces the number 
of braking burns on Vbar approaches. If VRCS fails, the downmode is to PRI since ALT 
has not been certified for use in the manual phase. 

 
Due to loads concerns, only DAP B should be used inside 150 ft.  Or course, DAP A may 
be used at the pilot’s discretion, to avoid collision, correct unsafe relative motion, or simply 
to return to the pilot’s “comfort zone.”   

 

Corridor Sep with Vern Fail 

ALT DAP should be used for VERN failed corridor seps to 450 ft.  Earlier analysis had 
shown that the PRI DAP mode might result in the Orbiter “stalling” while backing out to 
450 ft. 
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3.3 POINTING 

PURPOSE 

To give a quick lookup table for various combinations of Orbiter body pointing vectors and 
omicron. 

PROCEDURE 

Values and Limits 

The following table lists the possible values for TGT ID (UNIV PTG, ITEM 8).  The most 
common TGT ID values for rendezvous operations are 1 and 2, although 4 is sometimes 
used during deploy operations. 

 

Table 3.3-1  UNIV PTG Target IDs 

TGT ID Description 

1 Target Track (RNDZ NAV must be enabled) 
2 Center of Earth 
3 Point on Earth Surface 
4 Center of Sun 
5 Celestial target 
6-10 Unassigned (will give ILLEGAL ENTRY if entered) 
11-110 Navigation stars 

 

The following table lists the possible values for the Orbiter body pointing vector (UNIV 
PTG, ITEM 14).  Values 1 thru 4 contain preset values for pitch and yaw to point the BPV 
in the described direction. 

 

Table 3.3-2  UNIV PTG Body Vectors 

BPV Description 

1 +X Orbiter Body Axis 
2 -X Orbiter Body Axis 
3 -Z Orbiter Body Axis (~ -Z STRK Boresight) 
4 -Y STRK Boresight 
5 Selectable 

 

The following table describes the limits on the pitch, yaw, and omicron values (UNIV PTG, 
ITEM 15 thru ITEM 17). 
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Table 3.3-3  UNIV PTG Body Vector and Omicron Limits 

Component Range 

Pitch 0 to 360 deg 
Yaw 0 to 90 and 270 to 360 deg 
Omicron 0 to 360 deg 

 
Target Track 

The following figures illustrate the orientation of the Orbiter on the VBAR when executing a 
target track with a star tracker.  Examples are shown for both star trackers (–Z/–Y) with 4 
values of omicron (0, 90, 180, 270) in two possible Orbiter-TGT geometries (Orbiter trailing 
the TGT and Orbiter leading the TGT). 

 
 VBAR to left 

RBAR down 
TGT to left 

OM 0 OM 90 OM 180 OM 270 

  
 
TGT ID 1 
BV 3 
P 90 
Y 0 
 
 

    
  

 
TGT ID 1 
BV 4 
P 0 
Y 280.6 
 
 

    

 

Figure 3.3-1  Universal Pointing Examples for Target Track from Behind 
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 VBAR to left 
RBAR down 
TGT to right 

OM 0 OM 90 OM 180 OM 270 

  
 
TGT ID 1 
BV 3 
P 90 
Y 0 
 
 

    
  

 
TGT ID 1 
BV 4 
P 0 
Y 280.6 
 
 

    

 

 

 

Figure 3.3-2  Universal Pointing Examples for Target Track from in Front 
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Earth Track 

The following illustrates the orientation of the Orbiter when tracking the center of the Earth 
for 6 body pointing vectors (+/-X, +/-Z, +/-Y) and 4 values of omicron (0, 90, 180, 270). 

 
 VBAR to left 

RBAR down 
Earth down 

OM 0 OM 90 OM 180 OM 270 

  
 
TGT ID 2 
BV 1 
P 0 
Y 0 
 
 

    
  

 
TGT ID 2 
BV 2 
P 180 
Y 0 
 
 

    

Figure 3.3-3  Universal Pointing Examples for Earth Track with ±X Axis 

 

 

 
 VBAR to left 

RBAR down 
Earth down 

OM 0 OM 90 OM 180 OM 270 

  
 
TGT ID 2 
BV 5 
P 270 
Y 0 
 
 

    
  

 
TGT ID 2 
BV 3 
P 90 
Y 0 
 
 

    

Figure 3.3-4  Universal Pointing Examples for Earth Track with ±Z Axis 
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 VBAR to left 
RBAR down 
Earth down 

OM 0 OM 90 OM 180 OM 270 

  
 
TGT ID 2 
BV 5 
P 0 
Y 90 
 
 

    
  

 
TGT ID 2 
BV 5 
P 0 
Y 270 
 
 

    

Figure 3.3-5  Universal Pointing Examples for Earth Track with ±Y Axis 

BACKGROUND 

The Orbiter body pointing vector (BPV) is specified in terms of a vector starting coincident with 
the Orbiter +X body axis.  The vector is rotated in a pitch/yaw Euler sequence from this point.  (A 
convenient mechanism for determining the BPV is to use a "ghost Orbiter" starting coincident 
with the Orbiter and applying the pitch/yaw Euler sequence.)   Omicron is defined as the angle 
between the plane containing the negative angular momentum (+YLV) vector and the BPV and 
the plane containing the BPV and the Orbiter body +Y axis.  In cases where the BPV is along the 
Orbiter body +Y-axis, the Orbiter body +Y-axis is replaced with the −Z-axis.  If the BPV is along 
the +YLV vector, the negative angular momentum vector is replaced with the −ZLV vector.  A 
less precise but perhaps more easily implemented procedure to determine the desired omicron 
is: 

• Point the BPV at the target (center of earth, orb vehicle, sun etc.). 

• Find omicron = 0 by rotating the Orbiter about the BPV until the starboard (right) wing 
(+Y body) is pointed down the +Y LVLH axis.  (Depending on the BPV and the target, 
this is not always possible. In these cases rotate the Orbiter about the BPV until the 
starboard wing is as close to the +Y LVLH as you can get) 

• Using the right hand rule rotate about the BPV to define the attitude associated with 
any other omicron. 

Several references exist for discussing BPV and omicron in detail, including the I/O/D G&C 2102 
manual. 
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3.4 OMS 

PURPOSE 

To give an overview of the OMS systems monitored by PROP. 

PROCEDURE 

OMS System 

Pre-burn 

• Review the MDM, Control Bus, OMS FAILURES Cue Card, and OMS Plumbing charts 
along with the current stringing to determine if any single GPC, MDM, or bus failure 
will result in ignition problems, early shut down, or TVC problems. 

• Work with FDO and PROP to predetermine the appropriate response to the above. 

No Ignition 

• Switch to other OMS engine (ITEM 2 or 3 as required). 

• Retarget (if LAMBERT-guided burn - SPEC 34) 

• LOAD (ITEM 22) and start TIMER (ITEM 23) 

• Maneuver to new attitude (ITEM 27) 

Note: should take about 2 minutes once call is made to the crew. 

Early Shutdown 

• If GPC problem, restring and complete/start the burn. 

• Otherwise, downmode to +X RCS. 

Overburn 

• ARM/PRESS switch to OFF. 

• Trim residuals (may be large) with RCS. 

Gimbal Failure 

• Trim residuals with RCS ASAP. 

• Work gimbal failure procedures after VGOs trimmed. 
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OMS System Description 

Each OMS engine has two main control valves aligned in series, each with two coils.  
Either coil can operate the valve but both valves must be open for the engine to burn.  
Each valve will spring close unless at least one of the coils is holding it open.  A coil will 
hold the valve open only if it receives the following 

• An OPEN signal from a GPC via one of the Aft MDMs; and 

• Power via the main bus. 
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LEFT

OMS ENG

ARM

OFF
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Figure 3.4-1  Left OMS Plumbing with DPS Interfaces 
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Figure 3.4-2  Right OMS Plumbing with DPS Interfaces 

 

To receive power, the main power bus element (ALC1, ALC2, or ALC3) must be working 
along with the corresponding control bus element for each coil (CNTLCA1, CA2, AB1, or 
AB2).  Also, if a GPC or MDM fails during a burn, it is possible for the MDM to "hang-up" in 
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the ON mode.  In this case the coil will continue to hold that valve open until the power is 
removed from the coil.  If this happens to both valves, the burn must be shut down 
manually via the ARM/PRESS switch (to OFF).  Refer to the OMS Plumbing figures. 

For OMS ignition, both valves must open.  Since either coil can open each valve, it takes 
two failed coils on the same valve to prevent the OMS from burning.  The PROP Officer 
will normally try to set the stringing such that the same GPC does not command both coils 
on either valve.  This is not always possible.  The OMS FAILURES Cue Card presents a 
quick summary of this failure.  Details are available in the OMS Plumbing figures later. 

For OMS shut down, the burn is terminated if either valve closes.  GPC or MDM failures 
can cause stuck "ON" commands from the MDM.  If this happens to both valves, the burn 
must be manually terminate via the ARM/PRESS switch.  The PROP Officer will ty to 
establish a stringing such that the same GPC does not command coils on both valves.  For 
dual G2 operations this stringing is in direct conflict with the desirable stringing for OMS 
ignition.  Something has to give.  The OMS FAILURES Cue Card covers this case in the 
table "If two FA MDMs lost". 

Propellant Costs 

Refer to the OMS/RCS Estimated Performance tables below for detailed propellant usages 
for various maneuvers. 

 

Table 3.4-1  OMS Propellant Approximate Quantities Quick Reference 

Quantity Amount of Propellant 

L OMS Fuel 4711.5 lbs 
L OMS Oxidizer 7743.5 lbs 
R OMS Fuel 4711.5 lbs 
R OMS Oxidizer 7743.5 lbs 
Total OMS Load 25064 lbs* 
* includes prop trapped in lines, budgeted for dispersions, and gauging errors. 
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3.5 RCS 

PURPOSE 

To give an overview of the RCS systems monitored by PROP. 

PROCEDURE 

Overview 

The Reaction Control System (RCS) consists of 38 primary jets and 6 vernier jets.  The 
primary jets are rated at 870 lbs of thrust each, the vernier jets at 24 lbs each.  The 
primary RCS system is multiply redundant in each of the 6 thrust directions with each jet 
being assigned a priority via SPEC 23.  The vernier RCS system is zero-fault tolerant to 
the loss of any single vernier jet. 

 

RCS System 

Refer to the DPS Stringing, MDM, Control Bus, RCS Plumbing, RCS Jet Configuration, 
and the Primary RCS Jet Selections and Priorities charts to uncover losses or 
vulnerabilities in translational and/or rotational capabilities.  Note that +Z translations 
MUST be single-fault tolerant to enter within 200 feet of a target (see FR 2-61); LOW Z 
counts as a level of redundancy to NORM Z +Z translations. 
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Table 3.5-1  Primary RCS Commanded Jet and Jet Group Selection 

Rotation Fwd Left Aft Right Aft 

+Pitch F3D, F4D (5,6) L1U (11) R1U (12) 
-Pitch F3U (4) L3D (13) R3D (14) 
+Roll --- L3D (13) R1U (12) 
-Roll --- L1U (11) R3D (14) 
+Yaw F3L (2) --- R3R (10) 
-Yaw F4R (3) L1L (9) --- 

Low Z Fwd Left Aft Right Aft 

+Pitch F3D, F4D (5,6) --- --- 
-Pitch --- L3D (13) R3D (14) 
+Roll --- L3D (13) --- 
-Roll --- --- R3D (14) 
+Z F1F, F2F (1) L3A (8) R3A (7) 

Translation Fwd Left Aft Right Aft 

+X --- L3A (8) R3A (7) 
-X F1F, F2F (1) --- --- 
+Y F3L (2) L1L (9) --- 
-Y F4R (3) --- R3R (10) 
+Z F3U (4) L1U (11) R1U (12) 
-Z F3D, F4D (5, 6) L2D, L3D (13) R2D, R3D (14) 

Hi Z Fwd Left Aft Right Aft 

+Z F1U, F2U, F3U (4) L1U, L2U, L4U (11) R1U, R2U, R4U (12) 

The highest priority jet(s) shown from the jet group indicated in parentheses. 

 

Table 3.5-2  Primary RCS Nominal Jet Priority by Jet Group 

 1 

-X 

2 

+Y 

3 

-Y 

4 

+Z 

5 

-Z 

6 

-Z 

7 

+X 

8 

+X 

9 

+Y 

10 

-Y 

11 

+Z 

12 

+Z 

13 

-Z 

14 

-Z 

1 F1F F3L F4R F3U F4D F3D R3A L3A L1L R3R L1U R1U L3D R3D 
2 F2F F1L F2R F1U F2D F1D R1A L1A L3L R1R L4U R4U L2D R2D 
3 F3F  F2U      L4L R2R L2U R2U L4D R4D 
4         L2L R4R     
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Figure 3.5-1  Forward RCS Plumbing with DPS Interfaces 
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Figure 3.5-2  Left (Right) Aft RCS Plumbing with DPS Interfaces 
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Figure 3.5-3  RCS Jet Configuration 

Propellant Costs 

Refer to the OMS/RCS Estimated Performance tables below for detailed propellant usages 
for various maneuvers. 

Table 3.5-3  RCS Propellant Approximate Quantities Quick Reference 

Quantity Amount of Propellant 

Fwd RCS Fuel 805 lbs 
Fwd RCS Oxidizer 1275 lbs 
Total F RCS 2446 lbs* 
L or R RCS Fuel 856 lbs 
L or R RCS Oxidizer 1356 lbs 
Total Aft RCS 4970 lbs* 
* includes prop trapped in lines, budgeted for dispersions, and gauging errors. 
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Table 3.5-4  Primary RCS Thrusters Propellant Usage (lbs/hr, 3.5 deg deadbands) 

 100 nmi 120 nmi 150 nmi 200 nmi 300 nmi 

Orientation Fwd Aft Fwd Aft Fwd Aft Fwd Aft Fwd Aft 

X-pop inertial 10.5 20.2 10.2 19.8 9.8 19.3 9.3 18.6 8.8 18.0 
Y-pop inertial 11.0 24.0 10.2 19.9 9.4 17.7 8.4 15.7 7.6 14.6 
Z-pop inertial 8.6 21.0 8.6 20.2 8.6 19.3 8.6 18.5 8.6 18.0 
X-pop -ZLV 9.8 21.2 9.3 20.8 8.4 20.4 7.3 19.8 6.0 19.0 
Y-pop -ZLV 10.3 18.0 10.1 17.8 9.8 17.5 9.5 17.1 9.1 16.5 
-X sol inertial 10.4 20.8 10.4 20.4 10.4 19.9 10.4 19.4 10.4 19.0 
-Z sol inertial 10.0 19.9 10.0 19.9 10.0 19.9 10.0 19.9 10.0 19.9 
X-psl PTC 9.3 19.0 9.3 19.0 9.3 19.0 9.3 19.0 9.3 19.0 

 

Table 3.5-5  Vernier RCS Thrusters Propellant Usage (lbs/hr, 1.0 deg deadbands) 

 100 nmi 120 nmi 150 nmi 200 nmi 300 nmi 

Orientation Fwd Aft Fwd Aft Fwd Aft Fwd Aft Fwd Aft 

X-pop inertial 3.0 11.6 1.5 5.7 0.9 3.8 0.7 3.0 0.6 2.8 
Y-pop inertial 1.9  6.3 1.6 4.7 1.5 4.5 1.4 4.3 1.3 3.9 
Z-pop inertial 2.9 11.5 2.0 8.1 1.6 6.8 1.5 6.5 1.4 5.9 
X-pop -ZLV 4.1 13.3 1.6 5.1 0.7 1.3 0.4 0.6 0.4 0.4 
Y-pop -ZLV 0.5  1.0 0.5 0.8 0.5 0.7 0.5 0.6 0.5 0.5 
-X sol inertial 2.9 10.6 2.2 7.7 1.8 6.7 1.8 6.5 1.8 6.1 
-Z sol inertial 3.6  8.8 2.6 5.5 2.3 4.8 2.2 4.7 2.2 4.5 
X-psl PTC 5.6 10.9 4.8 7.2 4.2 4.9 3.8 3.4 4.3 3.6 

 

Table 3.5-6  Propellant Usage to Start, Maintain, and Stop a 115-deg Rotation (lbs) 

  Roll Pitch Yaw 3-axis 

Jets Rot Rt (deg/s) Fwd Aft Fwd Aft Fwd Aft Fwd Aft 

VRCS 0.2 1.4  5.7 2.0  6.5 1.6  8.3 2.0  9.6 
PRCS 0.2 10.3 23.9 13.1 28.3 9.0 20.3 8.8 20.2 
PRCS 0.5 8.2 20.7 10.0 19.4 10.2 21.0 10.6 18.2 
PRCS 1.0 6.8 23.7 12.9 22.4 13.2 24.1 16.5 26.9 
PRCS 2.0 6.4 34.2 22.0 32.7 21.0 36.6 30.2 45.5 

 

Table 3.5-7  RCS Propellant Usage for Translation Maneuvers (lbs/fps) 

Orb Wt +X -X +/-Y +Z LO +Z -Z OM
S 

(klbs) Fwd Aft Fwd Aft Fwd Aft Fwd Aft Fwd Aft Fwd Aft  

180 0.5 20.8 19.6 4.1 8.5 25.2 7.5 12.5 140 117 10.5 18.9 17.9 
200 0.5 23.1 21.8 5.1 9.3 27.4 8.1 14.1 159 132 11.3 21.2 19.8 
220 0.5 25.4 24.0 6.1 10.0 29.6 8.7 15.7 178 147 12.1 23.5 21.8 
240 0.5 27.7 26.2 7.1 10.7 31.8 9.3 17.3 197 162 12.9 25.8 23.8 
260 0.5 30.0 28.4 8.1 11.4 34.0 9.9 18.9 216 177 13.7 28.1 25.8 
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Multiple Jet Failures 

On STS-110, the failure of two jets increased the risk of a loss of full control capability.  
Specifically, L1A and F1D were down.  The additional loss of L3A would have left the Orbiter 
with a degraded +X capability (see SCP 7.5).  The additional loss of F3D would have prohibited 
±Y translation.  The following notes were generated during STS-110 real-time operations. 

 

If L1A and L3A are down: 

• Impacts to flight control: 

o Degraded +X translation. 

�� +Ydot will result from roll and yaw axis cross-coupling induced during +X 
translations. 

�� All +X inputs need to be doubled to achieve the desired +X translation. 

�� While LOW Z is selected, the DAP will fire down-firing jets to counter 
yaw moment, resulting in a closing rate and prop consumption. 

o Degraded LOW Z braking capability. 

�� -X translation will occur during LOW Z braking pulses, which may 
require additional +X translation commands (see +X translations 
concerns above).  

o No additional impact for loss of verns. 

• If L3A fails, full LOW Z capability is lost.  Go to Vbar or Shuttle Nose In-Plane Breakouts 
as appropriate with the following notes: 

o Vbar Breakout is OK at any time outside of 150 ft.  Preferred initial +X burn 
range is 150 ft due to recontact concerns brought on by expected increase in 
closure rate.  Since this breakout is performed in LOW Z attitude control, 
unbalanced +X inputs that induce a yaw moment will force the DAP to fire down-
firing LOW Z jets to control attitude.  This induces moderate closure that should 
be acceptable for all applicable ranges of the Vbar Breakout.  Ignore the 
temporary closure rate and avoid pluming ISS with braking pulses.   

o Do not attempt to null Ydot in either breakout because the out-of-plane 
translation gives us even safer relative motion. 

 

If F1D and F3D are down: 

• Impacts to flight control: 

o No ±Y translations will be honored due to DAP software logic inhibit. 

o Degraded –Z translation available. 

�� A –roll and –yaw rate will be induced during –Z translation commands.  
The DAP will fire +roll and +yaw VRCS jets as necessary to correct any 
attitude excursions exceeding control deadbands. 

• Stay in Vernier attitude control and go LOW Z at 75 ft per nominal procedures. 

o If cockpit resources are available, monitor deadbands and avoid making 
translational firings near pitch, yaw or roll firings. 
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o We recommend DAP B only for +Z translation, because the pulse duration used 
for DAP B pulses limits the hot sticking phenomena, which is of concern here.  
The use of DAP A in this case could potentially stall the opening rate because of 
a degraded +Pitch condition.  DAP A firings are OK in all other axes. 

• If F3D fails, ±Y translation capability is lost, perform the breakout listed below:   

o If Range < 150 ft, continue corridor sep to 150 ft and then perform the VBAR 
CORRIDOR BREAKOUT, page 5-14. 

�� If a ±Y input is required to prevent a corridor violation, reselect F1D 

�� After the breakout has been initiated, do not attempt to null Ydot.  
Deselect F1D. 

o If on the Vbar and Range > 150 ft, perform VBAR CORRIDOR BREAKOUT, 
page 5-14. 

�� Do not attempt to null Ydot in either breakout because the out-of-plane 
translation gives us even safer relative motion. 

�� The Vbar Breakout is OK at any time outside of 75 ft, but we would prefer 
to do it at 150 ft due to reduce loads and give you safer relative motion.  
Ignore any temporary closure rate and do not plume ISS with braking 
pulses.   Same applies if NORM Z due to loss of VRCS (see VRCS failed 
concerns below).  Rdot will open up as the Orbiter passes over ISS. 

o If flyaround is in progress, perform SHUTTLE NOSE IN-PLANE BREAKOUT, 
page 5-16. 

 

• If F3D and Vernier attitude control fails: 

o If in LOW Z mode, go to NORM Z/ PRI immediately. reselect F3D, select LOW 
Z, if on Vbar, establish an opening rate, and execute the breakout listed below.  

�� If Range < 150 ft, continue corridor sep to 150 ft and then perform the 
VBAR CORRIDOR BREAKOUT, page 5-14. 

• If a ±Y input is required to prevent a corridor violation, reselect 
F1D 

• After the breakout has been initiated, do not attempt to null 
Ydot.  Deselect F1D. 

�� If on the Vbar and Range > 150 ft, perform VBAR CORRIDOR 
BREAKOUT, page 5-14. 

• Do not attempt to null Ydot in either breakout because the out-
of-plane translation gives us even safer relative motion. 

• The Vbar Breakout is OK at any time outside of 75 ft, but we 
would prefer to do it at 150 ft due to reduce loads and give you 
safer relative motion.  Ignore any temporary closure rate and do 
not plume ISS with braking pulses.   The same applies if NORM 
Z due to loss of VRCS (see VRCS failed concerns below).  Rdot 
will open up as the Orbiter passes over ISS. 

�� If flyaround is in progress, perform SHUTTLE NOSE IN-PLANE 
BREAKOUT, page 5-16. 

o Note: If F1D, F3D and VERNS have failed and the LOW Z is selected, a large 
closing rate can quickly develop.  If the Orbiter reaches a –Pitch deadband, the 
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DAP will try to fire unbalanced down-firing nose jets and will get roll, pitch and 
yaw.  In LOW Z, while the yaw error is controllable with aft yaw jets, the DAP 
attempts to control the roll error with an uncoupled (due to failure of forward jets) 
down-firing tail jet, which leads to more –Pitch.  This cycle continues, leading to 
dramatically increased closure rates (approximately 0.3 fps) and prop usage.  +Z 
translation commands to counter this closure will not compensate for the closure 
rate seen.  Securing from LOW Z ensures adequate control in this scenario. 

o In the Vbar Breakout procedures under step 3, load DAP A9/B9 instead of 
A7/B7.  This ensures the Orbiter configures for tail-only control. 
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3.6 Star Tracker 

PURPOSE 

To describe the Star Tracker system. 

PROCEDURE 

Refer to SCP 4.5 STAR TRACKER NAVIGATION for details on the use of the star trackers 
for onboard navigation. 

Refer to the Stringing tables in SCP 3.1 DPS for impacts to star trackers due to MDM and/or 
bus losses. 

 
Star Tracker System Characteristics 

The -Z Star Tracker boresight is tilted by 3 degrees in a plane rotated by 41 degrees from the 
Orbiter +X Body axis.  The Horizontal direction is approximately in the Orbiter X and the 
Vertical in the Orbiter Y.  The Universal Pointing Body Vector used with the -Z Star Tracker is 
body vector 3, which points along the Orbiter -Z axis and not the star tracker boresight.  The 
-Y Star Tracker boresight is rotated by about 10.5 degrees from the Orbiter -Y Body axis.  The 
horizontal direction is approximately in the Orbiter Z axis and the Vertical in the Orbiter X 
axis.  The Universal Pointing Body Vector used with the -Y Star Tracker is body vector 4, 
which points along the -Y star tracker boresight.  See Figure 3.6-1 for an illustration of the star 
tracker coordinate system. 
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Figure 3.6-1 Star Tracker Coordinate System 
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The following table lists the values at which the star tracker shutters will open and close due 
to the detection of a bright object. 

 

Table 3.6-1 Star Tracker Bright Object Sensor Limits 

Object Shutter Close Shutter Open 

Sun Limb 23 deg 29 deg 
Earth Limb 16 deg 19 deg 
Target (Magnitude < -12) 9 deg 9 deg 

 

The next table lists the possible star tracker status words.   

 

Table 3.6-2 Star Tracker Status Words 

Value Meaning 

0 Blank 
1 ST Fail Self Test 
2 ST Pass Self Test 
3 False Track 
4 Out of FOV 
5 High Rate 
6 No Target 

 
Solid State Star Tracker (SSST) Ground Testing performed by Engineering personnel in the 
Electro-Optics Laboratory showed a tendency for 'ghost' images to appear in the tracker's 
field-of-view if the target was too large and bright (like the ISS).  These 'ghost' images are 
produced by reflections in the tracker's casing, between the tracker lens and the Protective 
Window Assembly (PWA).  These reflective images can be bright enough for the tracker to 
lock on to, which could occur if the tracker were to initiate a full-field scan.  The ground testing 
also showed that the tracker was less likely to track the same ghost image if the threshold 
level was set to a lower sensitivity (because the ghost image would then not be bright enough 
to track).  So in an attempt to avoid finding ghost images in a full-field scan, the tracker's 
threshold setting is set to it's lowest sensitivity (3) at the beginning of rendezvous star tracker 
operations. 
 
For both the SSST and Image-Dissecting Tube (IDT) star trackers, the threshold settings are 
as follows (on SPEC 22): 

Item 14+0 = Sensitivity threshold equivalent to 3.0 magnitude (highest sensitivity) 
Item 14+1 = Sensitivity threshold equivalent to 2.4 magnitude 
Item 14+2 = Sensitivity threshold equivalent to 2.0 magnitude 
Item 14+3 = Sensitivity threshold equivalent to 1.0 magnitude (lowest sensitivity) 
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3.7 Ku Radar 

PURPOSE 

To describe the Ku Radar system hardware.  Also see SCP 4.4 RENDEZVOUS RADAR 
NAVIGATION. 

SYSTEM  CHARACTERISTICS 

1. Coordinate System 

The native coordinate system for the KU radar is ˺ and ˻ gimbal angles (also called shaft 
and trunnion).  The KU electronics convert these gimbals to an azimuth and elevation (also 
called roll and pitch) that are in the Orbiter body sense.  To compute the LOS of the radar 
given azimuth and elevation, first rotate in azimuth (positive about the Orbiter -X body axis), 
then in elevation (positive about the Orbiter -Y body axis) as in an azimuth/elevation Euler 
sequence.  Note that the Rendezvous Navigation software converts the KU angle 
measurements back to shaft and trunnion to do its angle processing, for it is in this frame 
that angle biases must be solved for and applied. 

To compute ˺ and ˻ (shaft and trunnion) from azimuth (̏) and elevation (́), the following 
equations can be used: 

 

˻ = arcsin −cosK siń + sin K sin̞ coś[ ] Equation 3.7-1 

˺ = arctan
− sinK siń − cosK sin̞ coś

cos̞ coś
⌈ 

⌊ � 
⌉ 

⌋ �   
 

Equation 3.7-2 

 

where K = 67 deg = 1.17 rad  (the “deployed” angle of the KU system relative to Orbiter +X). 

CAUTION:  

There is an operational constraint to not allow RR angle searches when the magnitude of 

the ˻ gimbal exceeds 38 deg.  Above this value, the high-speed angle search can result in 

hitting gimbal hard stops that could cause damage to the mechanism.  When the ˻ gimbal 
exceeds 38 deg, the GPC should be moded to AUTO TRK and GPC mode should be 
avoided to prevent automatic searches after a break lock. 
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2. Radar Data Parameter Measurement Limits 

Table 3.7-1 Radar Operational Limits 

Parameter Passive Mode Characteristic 

LOS range 100 ft to 10 n.mi. 
Effective range 135 kft (22 n.mi.) 
Maximum unambiguous range 147 kft (24 n.mi) 
LOS range rate 148 fps closing 

75 fps opening 
LOS pitch angle Plus or minus 30 degrees 
LOS roll angle Plus or minus 30 degrees 
Pitch inertial angle rate Plus or minus 20 mrad/sec 
Roll inertial angle rate Plus or minus 20 mrad/sec 

3. Radar Error Characteristics 

Table 3.7-2 Radar Error Characteristics 

Parameter Random Error (1̌̌̌̌) Bias Error (1̌̌̌̌) 

Range 27 ft out to 8 kft 
0.0033*Range from 8 to 30 kft 
100 ft when > 30 kft 

27 ft out to 8nm 
0.00053*Range when > 8 nm 

Range rate 0.33 ft/sec or 0.33% of range rate, 
whichever is greater 

0.33 ft/sec 

Angle 0.153 deg 1.0 deg 
Angle rate 0.0027 deg/sec 0.0027 deg/sec 

4. Radar Data Path 
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Target
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Figure 3.7-1  Radar Data Path 
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5. Radar Steering Modes 

GPC 

This is a fully automatic mode.  If no signal is detected when GPC mode is selected, the 
antenna will automatically be commanded to search around the GPC commanded point in a 
spiral pattern up to 30 deg, the size depending on range.  The antenna is inertially stabilized 
during the search operation.  Once the antenna is tracking in GPC mode and it loses lock, 
an SM alert (G33 RNDZ RADAR) will be issued, the system will wait 20 sec, then a search 
will be started.  Manual control is inhibited in this mode. 

AUTO TRACK 

In this mode, the antenna must be manually pointed for initial acquisition.  Searches must 
be manually initiated using the KU SEARCH switch.  The SLEW RATE must be in SLOW in 
order for the antenna to lock onto the target while it is being slewed.  When tracking in this 
mode, manual control is inhibited.  To force the system to break lock, the mode must be 
switched to MAN SLEW and the antenna slewed away from the target.  This mode also 
uses a 30 deg spiral search pattern that is inertially stabilized. 

GPC DESIGNATE 

In this mode, the antenna is commanded to point to the location indicated by SPEC 33 
ITEM 2 - uses the TGT SV if (*), uses TDRS SV if no (*).  No closed-loop angle tracking is 
performed in this mode. Range and range rate data goods will be set when tracking. 

MAN SLEW 

Angle search and angle tracking are not available in this mode.  The antenna is body 
stabilized when not being manually slewed.  Since no angle tracking is available in this 
mode, angle data goods will never be set.  Range and range-rate data goods will be set 
when tracking, however,  and this data could conceivably be taken into nav if the switch 
were stuck in this mode for some reason. 

 

Table 3.7-3  Summary of Ku-band Steering Modes 

Steering 

Mode 

Computer 

Steering 

Manual 

Steering 

Angle 

Tracking 

Signal 

Tracking 

Search Stabilize 

GPC X  X X Computer Inertial 
Designate X   X NA Both 
Auto  X X X Manual Inertial 
Manual  X  X NA Body 
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6. Radar Tracking Criteria 

When the radar system gets a "DETECT" on a target, it starts a timer and will not declare 
data good for the various radar measurements until a certain amount of time has elapsed, 
based on the following table (times in seconds): 

 

Table 3.7-4  Radar Tracking Criteria 

Parameter Range < 

23040 ft 

23040 ft  

< Range < 

49920 ft 

  Range > 

49920 ft 

Range 8 sec 8 sec 28 sec 
Range Rate 5 sec 5 sec 30 sec 
Angle 7 sec 7 sec 7 sec 
Angle Rate 10 sec 30 sec 30 sec 

 

In GPC DESIG and MAN SLEW, a “TRACK” indication results when the range data good is 
set.  In GPC and AUTO TRACK, angle and angle-rate data goods are required in addition to 
range data good to get a “TRACK” indication. Note that range rate data goods are not 
required to get a “TRACK” indication in any mode.  Once true, the angle data good flags will 
only go false after a break track or if the steering mode is switched to a non-angle tracking 
mode (GPC DESIG or MAN SLEW).  

One idiosyncrasy has been observed concerning the Antenna Steering Mode Select switch.  
When this switch is turned from AUTO TRACK to GPC or vice-versa, it passes through 
GPC DESIG.  If the radar SOP, running at 6 HZ, happens to sample the switch at the time 
the switch is in GPC DESIG, it will set the angle data good flags to false.  The radar will then 
break track when the SOP finally sees the switch in GPC mode (say the next cycle). 
Depending on the range from the target, it will take from 10 to 30 sec (see the table above) 
to get a "TRACK" indication again.  To circumvent this problem, the KU CONTROL switch 
can be temporarily turned to CMD while the steering mode is switched, then returned to 
PNL to read the switch. 

7. Radar Mainscan 

The mainscan is the initial pattern used to search for a target.  It is commanded 
automatically by GPC and via the SEARCH switch in AUTO.  The pattern is a spiral with a 
maximum radius (pmax) up to 30 degrees, depending on the steering mode and/or the 
range designate. When the scan radius (p) is less than 9 degrees (“zone 1”), the scan 
radius has a constant rate change (pdot = constant); for a scan radius greater than 9 
degrees (“zone 2”), the scan has a constant dwell.  The scan is terminated by target 
detection or 60 seconds, whichever comes first.  Unfortunately, one cannot follow the 
progress of the scan via telemetry since during the search the angle data is not updated 
during the scan. 
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Table 3.7-5 Radar Mainscan Characteristics 

Mode Designate 

(nmi) 

T1 

(sec) 

p1 

(deg) 

Q1 

(deg/s) 

Q2 

(deg/s) 

Tmax 

(sec) 

pmax 

(deg) 

AUTO -- 10.1 9 290 45 60 30 
GPC 0 to 8 10.1 9 290 45 60 30 
 8 to 9.2 10.1 9 290 45 60 27.7 
 9.2 to 10.3 10.1 9 290 45 60 24.4 
 10.3 to 11.8 10.1 9 290 45 60 21.7 
 11.8 to 15 10.5 9 275 43 60 19.6 
 15 to 25 13.8 9 230 33 60 16.5 

 
Notes: T1 is the time to the switchover point between zones 1 and 2; 

 p1 is the scan radius at the switchover point between zones 1 and 2; 

 Q1 is the angular rate of change of the spiral scan in zone 1;   (continued) 

 Q2 is the angular rate of change of the spiral scan in zone 2; 

 Tmax is the timeout point; and 

 pmax is the scan radius at the timeout point. 

ZONE 1 ZONE 2

SWITCHPOINT
(̊

1
, T

1
)

̊
m

̊

 

Figure 3.7-2  Radar Mainscan Pattern 

8. Radar Velocity Ambiguity 

When the radar is tracking a target at a range greater than 7.2 nmi, the Ku-band radar 
operates in a PRF mode  of 3 kHz (per table, above).  This region is a velocity ambiguous 
region. 

The spec values for the radar are 75 fps max closing and 150 fps max opening.  These 
values relate to the frequencies of -2100 Hz and 4144 Hz, respectively.  When in the 7 kHz 
PRF mode, there are enough filters (or bins) to cover the entire opening and closing 
velocities expected.  When in the 3 kHz mode, the PRF of 2987 Hz is insufficient to cover 
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the 4144 Hz associated with the 150 fps of a maximum closing target.  These velocities are 
aliased into lower frequencies.  Unfortunately, there is a corresponding overlap from 
opening target returns.  In the 3 kHz PRF mode, there is a region of frequency “bins” 
occurring from 887 Hz to 1157 Hz where this aliasing overlap occurs.  If a target returns a 
Doppler frequency in this region, it could be either opening or closing.  To resolve what a 
target is actually doing, the velocity processor uses the coarse estimate of the range rate 
computed by the range processor by differencing the last two range measurements. 

For a target providing a weak signal return, two or more successive range measurements 
could be confused.  In the overlap region and at the same aliased frequencies, two 
successive returns could be confused as a target varying in velocity by approximately 106 
fps.  If two successive returns measure a target with a 106 fps error, then the displayed 
velocity will be in error by 106 fps.  If one measured return is in error by 106 fps and the 
next is correct, then the displayed velocity will be in error by 53 fps. 

RADAR SEARCH GATES 

 

Table 3.7-6  Radar Search Gates 

Designation Search 

Range, nmi. Range, ft. Range Gate Setting PRF mode*, kHz 

0.0 - 0.42 100 - 2550 ** 7 
0.42† - 0.63 2560 - 3830 3840 ft 7 
0.63 - 0.95 3840 - 5750 at designate 7 
0.95 - 1.1 5760 - 6390 6400 ft 7 
1.1 - 1.9 6400 - 11510 at designate 7 
1.9 - 2.2 11520 - 13430 13440 ft 7 
2.2 - 3.8 13440 - 23030 at designate 7 
3.8 - 4.2 23040 - 25590 25600 ft 7 
4.2 - 7.2 25600 - 43510 at designate 7 
7.2‡ - 8.2 43520 - 49910 49920 ft 3 
8.2 - 49920 - at designate 3 

 
Notes: *Cycled between TWT bypass, TWT-24 dB, and TWT-12 dB 

 **60-foot intervals from 120 ft to 4260 ft 

 †2560 ft for closing targets, 3200 ft for opening targets 

 ‡43520 ft for closing targets, 49920 ft for opening targets 

 

 

9. SM ANTENNA Display Functions 

RDR RNG AUTO 

An ITEM 16 on the SM ANTENNA Display enables the GPC pointing angles and range 
designate to be based on the onboard NAV relative state.  The KU SEL switch must be in 
GPC for this setting to have any effect. 

RDR RNG MIN 

An ITEM 17 on the SM ANTENNA Display forces the GPC pointing angles to an AZ/EL of 
0/0 (the Orbiter -Z axis) and a range search between 100 and 2500 ft.  This mode is used 
during deploys when the onboard NAV state may not be accurate enough to provide proper 
pointing. The KU SEL switch must be in GPC for this setting to have any effect.  Care must 
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be taken to deselect this RNG MIN mode if the target is known to be considerably off the 
Orbiter -Z axis and the steering mode is GPC. 

SELF TEST 

A self-test performs a series of tests to demonstrate that the EA1, EA2, and DA units are 
operational.  The self-test can only be performed in the radar mode.  Also the KU RADAR 
OUTPUT must be in HI to prevent the system from failing the self-test.  The self-test is 
started with an ITEM 7 on the SM ANTENNA display and runs 3 min, 20 sec. It must be 
terminated with a second ITEM 7.  If the self-test is not terminated it will continue to repeat.  
If the KU is switched to COMM mode while the self-test is in progress, the self-test will stop 
but will resume again when returned to radar mode.  As a note of interest, INCO can 
command the initiation and termination of the self-test from the ground if the KU is in radar 
mode. 

10. Radar Self Test Data 

 

Table 3.7-7  Radar Self Test Steps 

Task Description 

1 (not implemented) 
2 PROM check of EA-1 
3 EA-2 Operate Status 
4 Initialize Antenna 
5 Servo test:  P = 30, R = 0; P = 30, R = -30; P = 0, R = 0 
6 XMIT Power Level 
7 Range, Range Rate 
8 Angle Track 
9 Receiver Sensitivity 
10 Compile Test Results 

 

This is a brief summary of what indications to look for during the Radar Self Test: 

Task 2   (at elapsed time = 0 seconds): 

• Range at 2621439 

• Range Rate at +1638.3 

Task 4   (at elapsed time = 25 seconds): 

• Antenna Pointing Mode in GPC DESIG 

Task 5.1   (at elapsed time = 40 seconds): 

• Elevation Angle counting up to 30.0 

Task 5.2   (at elapsed time = 55 seconds): 

• Azimuth Angle counting down to -30.0 

Task 5.3   (at elapsed time = 70 seconds): 

• Elevation Angle counting down from 30.0 to 0.0 

• Azimuth Angle counting up from -30.0 to 0.0 

Task 7.1   (at elapsed time = 100 seconds): 

• Antenna Pointing Mode in MAN SLEW 
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• TRACK indication 

• Range at 5320 (expected value -- noise will deviate this value) 

• Range Rate at 0.0 

• RANGE DATA GOOD indication 

• RANGE RATE DATA GOOD indication 

Task 7.2   (at elapsed time = 110 seconds): 

• No TRACK indication 

• Range at 0.0 

• No DATA GOOD indications 

Task 7.3   (at elapsed time = 120 seconds): 

• TRACK indication 

• Range at 10240 (expected value -- noise will deviate this value) 

• RANGE DATA GOOD indication 

• RANGE RATE DATA GOOD indication 

Task 8.1   (at elapsed time = 130 seconds): 

• Antenna Pointing Mode in AUTO TRACK 

• No TRACK indication 

• All DATA GOOD indications 

Task 8.2   (at elapsed time = 140 seconds): 

• TRACK indication 

Task 9   (at elapsed time = 160 seconds): 

• Antenna Pointing Mode in GPC ACQ 

Task 10   (at elapsed time = 200 seconds): 

• Antenna Pointing Mode in MAN SLEW 

• Range at 8888.8 or 3333.3, indicating SELF TEST PASSED or FAILED, respectively 

• No ANGLE DATA GOOD indication 

• No ANGLE RATE DATA GOOD indication 
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3.8 Hand Controllers  

PURPOSE 

To discuss Translational Hand Controller (THC) and Rotational Hand Controller (RHC) systems. 

PROCEDURE 

Refer to the Stringing tables in SCP 3.1 DPS AND EPS for details concerning impacts to THC and 
RHC operations due to MDM and/or bus losses. 

RHC / THC Power 

Three internal power supplies each power one channel of the Commander (CDR), Pilot (PLT), and 
aft station controllers. 

The three power channels in each controller are redundant and each controller can operate with only 
one channel powered. 

Signals 

Triple redundant roll pitch and yaw signals are processed from both the CDR and PLT RHC.  The 
three redundant signals are then sent through RM and failure/dilemma conditions are presented to 
the crew.  The crew can deselect/reselect RHC signals through the keyboards in OPS 2 & 8.  
Automatic deselection can also occur.  

THC Operations in PULSE Mode 

The SOP samples THC contacts at a rate of 6.25 Hz (160 ms).  In PULSE mode, the DAP requires 
an ON sample and an OFF sample.  Thus, the maximum effective THC input rate in PULSE mode is 
3.125 Hz, or one input every 320 ms, or at most 3 deflections per second.  A positive deflection 
followed quickly by a negative deflection can effectively cancel out each other, resulting not in one 
positive and one negative firing by the DAP, but instead resulting in no firing.  Therefore, careful THC 
deflections by the operator are imperative. 

 

Transient Signals 
The THC no longer generates spurious inputs to the flight control system when the Flight Controller 
power is turned on, however this had been a problem in the past.  Prior to the Multifunction Electronic 
Display System (MEDS) cockpit configuration, all hand controller channels were powered on at once.  
If transient signals were received on at least 2 channels by 2 or 3 level switch RM, this would 
command a jet firing.  The workarounds were to minimize the number of times the Flight Controller 
power is switched on and to disable RM by a SPEC 25 ITEM 16 EXEC immediately before powering 
on the flight controllers.  The crew would then re-enable switch RM with another SPEC 25 ITEM 16 
EXEC (toggle) immediately after flight controller power was turned on.  During the switch RM disable 
period, all cockpit switch changes were ignored by the flight software, therefore it was important that 
the re-enable occur before any other switch changes were made.  These steps were employed in the 
undocking procedure, when powering on the THC, however they have since been removed.   
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The spurious inputs did not downmode the DAP, but they did fire jets unnecessarily. Before OI-8D, 
the workaround for the Orbit DAP was to set the DAP to VERNIER mode before switching the Flight 
Controller power on.  In VERNIER mode, the DAP ignored translation commands.  With the hotstick 
downmoding (OI-8D CR # XXXX), when in VERNIER mode, the orbit DAP will upmode to primary for 
the duration of THC out of detent.  This would result in unnecessary primary jet firings.  With the 
MEDS reconfiguration, hand controller channels are powered on sequentially, so that a transient 
input can occur in only one channel at a time.  This will not result in unwanted jet firings, because 2 
or 3 level switch RM must receive two channels high to command a jet firing.  A spurious firing is still 
possible if switch RM is at the 1 level. 
 

 

 

BACKGROUND 

RHC 
The RHC mechanical hard stop occurs at +24.3� in the pitch and roll axes and at +14.3� in the yaw 
axis. The mechanical hard stop is the maximum deflection that can be obtained in an axis. The 
mechanical soft stop for the RHC occurs between +19� and +20� for the roll and pitch axes and 
between +9.5� and +10.5� for the yaw axis. The mechanical soft stop is a built-in resistance that 
occurs prior to the hard stop in an axis.  
 
See section 13.2 of SHUTTLE OPS GNC/JSC-18863, “CONTROLLERS” for redundancy 
management information.  That document and other systems briefs are available on the GNC web 
site at http://mod.jsc.nasa.gov/df/df62/sb.html. 
 

 

 

Figure 3.8-1 Rotational Hand Controller 
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THC 
The THC is utilized to perform translation movements of the vehicle by utilizing propulsion systems 
associated with the movement of the controller. The THC has three-axis movement respective to 
itself: up-down (vertical), left-right (lateral), and in-out (longitudinal). See Figure 3.8-2 for a pictorial 
view of the THC. The movement of the THC in any axis is a maximum of half an inch from the center 
position. As previously stated, there is a THC on the commander’s side forward and a THC in the aft 
station. The THC is the only controller that uses DC power exclusively. 
 
See section 13.3 of SHUTTLE OPS GNC/JSC-18863, “CONTROLLERS” for redundancy 
management information.  That document and other systems briefs are available on the GNC web 
site at http://mod.jsc.nasa.gov/df/df62/sb.html. 
 

 

Figure 3.8-2 Translational Hand Controller 

 

 

 

Table 3.8-1 Body transformations of Aft THC Inputs in Both Senses 

Aft THC 

Physical 

Movement  

(wrt panel) 

Display 

Outputs 

Transformed Aft THC Outputs (body axis) 

  

           -X Sense                        -Z Sense 

+X +X -X -Z 

-X -X +X +Z 

+Y -Z -Y -Y 

-Y +Z +Y +Y 

+Z +Y +Z -X 

-Z -Y -Z +X 
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Figure 3.8-3 Forward Locations of CDR and PLT Hand Controllers 

 

 

 

 

Figure 3.8-4 Aft Locations of CDR and PLT Hand Controllers 
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Figure 3.8-5 Power Diagram for CDR and PLT Controllers 

 

Figure 3.8-6 Power Diagram for Aft Flight Deck Controllers 
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3.9 Cameras  

PURPOSE 

To discuss various cameras used on the Orbiter during rendezvous.  

 

PROCEDURE 

The procedures in the Rendezvous Checklist and Photo/TV 19 should be used for camera 
operations during rendezvous and proximity operations.  

 

BACKGROUND 

Portions of the following information are taken from the Rendezvous & Prox Ops Design Reference 
(RPODR) for the International Space Station.  See sections 70 through 74 of the Systems Brief on 
the Instrumentation and Communications Officer (INCO) web site at 
http://mod.jsc.nasa.gov/df/df24/index.htm for more detailed information. 
 
Closed Circuit Television Cameras 
 
The Orbiter is equipped with several television cameras and camera mounts in the payload bay 
(PLB). These cameras are used heavily during proximity operations.  Table 3-9.1 identifies the 
cameras used during various phases of rendezvous and undocking operations, while the exact 
locations of Orbiter cameras are shown in Figure 3.9-1. 
 
The Orbiter Closed Circuit Television (CCTV) system is comprised of several types of cameras. 
The Intensified Television Cameras (ITVC) are black and white cameras with the capability to 
remotely control the lens iris, zoom and focus. The ITVC uses an illuminator ring, which makes the 
camera more effective during nighttime payload bay operations than the color television camera.  
The solid-state color television camera (CTVC) system consists of a color-separating prism that 
provides a balanced composite color video output signal that is compatible with the CCTV system. 
The CTVC does not have an image intensifier and is not used in very low light conditions, such as 
the viewing of stars.   
 
The flight requirements document can be checked to determine flight-specific camera assignments. 
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Figure 3.9-1  CCTV Camera Locations 

 

 

Table 3.9-1 CCTVs Used During Rendezvous 

Operation Cameras Required Usage Functions Required 
Flyaround ODS Centerline 

A/D, B/C 
Line-of-Sight 
Backup Range/Range-Rate 

Zoom 
Pan, Tilt, Zoom 

Rbar Approach ODS Centerline 
A/D, B/C 

Corridor 
Backup Range/Range-Rate 

Zoom 
Pan, Tilt, Zoom 

Vbar Approach ODS Centerline 
A/D, B/C 

Corridor 
Backup Range/Range-Rate 

Zoom 
Pan, Tilt, Zoom 

Stationkeeping ODS Centerline 
A/D, B/C 

Corridor 
Backup Range/Range-Rate 

Zoom 
Pan, Tilt, Zoom 

Angular Misalignment Flyout ODS Centerline Corridor, Angular Misalignment Zoom 
Docking (30 to 0 ft) ODS Centerline 

A/D 
Corridor 
Range/Range-Rate 

Zoom 
Pan, Tilt, Zoom 

Separation ODS Centerline 
A/D, B/C 

Corridor 
Backup Range/Range-Rate 

Zoom 
Pan, Tilt, Zoom 

Backout ODS Centerline 
A/D, B/C 

Corridor 
Backup Range/Range-Rate 

Zoom 
Pan, Tilt, Zoom 

 

The Orbiter will use both types of cameras in the PLB during approaches to the ISS.  Cameras A, B, 
C, D, and the RMS elbow will be mounted in a Pan/Tilt unit which provides 170° in pan and tilt 
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moving at 12°/s or 1.2°/s.  All cameras have zoom capability listed in Table 3.9-2. For approach and 
separation, the ISS flights will primarily use the centerline camera, which should always be a CTVC, 
as shown in Figure 3.9-1.  For non-ISS payloads such as HST, the keel camera will be used for 
approach and separation (ODS/centerline camera is not installed). 
 

Table 3.9-2 CCTV FOVs 

Camera Full Zoom 
(HFOV x VFOV) 

(deg) 

Corridor Zoom 
(HFOV x VFOV) 

(deg) 

No Zoom 
(HFOV x VFOV) 

(deg) 
CTVC 10.1 x 7.6 40.0 x 30.816 74.4 x 59.9 
ITVC 6.95 x 4.4 N/A 56.13 x 42.1 

 

Onboard Camera Selection 

The CCTV system is operated onboard from the switches on panel A7, and switches on the 
cameras themselves.   
 

Automatic Light Control (ALC) 

The CTVCs and ITVCs are normally operated in an ALC mode.  ALC circuits provide automatic 
feedback to limit the amount of light penetrating the lens and exciting the Charge-Coupled Devices 
(CCDs) that convert the light energy into an electric signal.  Each camera type has the common 
settings of peak, normal, and average.  What differentiates each setting is the area of the video 
picture in which the amplitude of the video signal from adjacent picture elements (pixels) must 
exceed a defined limit before the ALC circuit senses a video signal amplitude violation.  The 
purpose of an ALC circuit is to maintain consistent illumination for maintaining picture quality. 

 

Gain and Iris Settings 

Both the CTVC and ITVC provide manual gain and iris settings in case the automatic settings do 
not provide the desired output.  Both types of cameras can provide manually selected gain settings 
of 0db, +12db, and +24dB gain settings.  Whenever a manual gain setting is selected, the ALC 
circuit is bypassed, enabling the users to fully control the amount of light entering the camera by 
commanding the iris themselves.  The ITVCs also provide an additional gain option that can be 
used with either manual or ALC mode.  The NITE setting provides approximately 16dB more gain at 
low light levels than the DAY setting, but does this at the expense of Signal/Noise Ratio (SNR).  The 
SNR for DAY at higher light levels is around 56dB, whereas the SNR for NITE mode is, at best, 
40dB.  NITE setting also amplifies the fixed-pattern noise (inherent to the image intensifier) in 
addition to the random white noise in the video signal.  Generally speaking, reducing the gain in the 
ITVC provides a less noisy picture. 

Pan/Tilt Unit (PTU) 
The PTU is a remotely controlled azimuth/elevation mount for CCTV cameras located on the 
forward and aft bulkheads and on the Remote Manipulator System (RMS) elbow of the orbiter.  The 
power supply cable routing is from bulkhead to PTU and from PTU to TVC.  Pan and tilt motions are 
provided upon TVC command at 1.2° per second (slow command) or 12° per second (fast 
command) over a total range of 340° (+170° from nominal zero position).   
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Note that the pan/tilt readouts on each camera display are not true pan/tilt unit telemetry.  They are 
maintained by the camera and indicate where the camera “thinks” that it is pointed.  If the PTU 
hangs up, fails, or is nonexistent, the camera does not know and indicates pan/tilt angles as if it 
were really panning or tilting.  The pan/tilt counter is 11 bits; so the angles could go as high as 
409.4°, then reset to zero and continue. 

Camera Selection from the Ground 

Ground commanding is accomplished via a 14-bit parallel word set on MDM PF2 (sometimes 
known as MDM PL2).   

 

 

Figure 3.9-2  CCTV Hardware Diagram 
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Centerline Camera 
 
The ODS centerline camera is mounted in a way that provides a 12.8° unobstructed field of view. 
The camera has a capability for on-orbit alignment prior to rendezvous. Since the centerline view is 
required for docking, a spare camera is carried in case the prime camera fails. There is no non-axial 
camera like there was for Shuttle/Mir dockings, so a failed centerline camera will require a halt in 
the approach until the centerline camera is replaced and aligned. 

 

The centerline camera is installed and aligned in PHOTO/TV 19 – SETUP C/L CAM INSTALL.  This 
usually takes place on the day before rendezvous.  Crew members are required to install the 
camera itself into the camera bridge, which is flown in place.  Using the green crosshairs on a flight 
deck monitor, the crew ensures that the center of the crosshairs (representing the center of the 
camera field of view) are within the inner diameter of the ODS washer, which can also be seen on 
the monitor.   The procedures also call for the crew to check the alignment of the camera using the 
crosshairs and the vertical and horizontal tick marks on the sides of the screen.  These operations 
are represented in Figure 3.9-3. 

 

 

 

Figure 3.9-3  A Well-Aligned C/L Camera View 

 

 

Side and top views of the ODS with the centerline camera installed are shown in Figures 3.9-4 and 
3.9-5. 
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Figure 3.9-4  Side View of ODS with C/L Camera Installed 

 

 

 

Figure 3.9-5  Top View of ODS with C/L Camera Installed 
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Centerline Video Troubleshooting 

 

Because the centerline video is critical to a successful docking, it is important to have a rudimentary 
understanding of the potential system failures (and their possible workarounds), so that the 
Rendezvous team may be able to effectively coordinate troubleshooting efforts with INCO/IFM.  
Nominally, the centerline camera video output is connected to ODS TV port 1, and then travels 
through the VPU (video processing unit), PL2, VSU (video switching unit) and then to the monitors.  
Each of these paths has the potential to fail, and if they do, some workarounds exist in the photo TV 
flight supplement checklist.  For example, if the video switching unit fails, it can be replaced with a 
rudimentary switching unit called the TVCU in about 25 minutes (5 minutes to unstow and 20 
minutes to configure).  Figure 3.9-6, which is from the photo TV flight supplement checklist, shows 
the cabling configuration for a VSU failure (where the TVCU replaces the VSU).  Besides the VSU 
failure, two other 0 fault tolerant video components exist in the centerline video path and they are 
PL2 and the VPU.  Although the workarounds for these failures are not currently documented in the 
flight procedures, failure of PL2 can be worked around by using the stowed TVCU cable 
(SED33105876-301) connected between the VPU and the PIGMY cable (see lower right hand 
corner of figure 3.9-6) that leads to the flight deck TV port (O19).  The flight deck TV port connects 
directly to the VSU, thereby eliminating the failed PL2 video bus from the video path.  To work 
around a VPU failure (and a PL2 failure if desired) an option is to connect a video cable directly 
from the centerline camera to the middeck TV port.  Unfortunately, the drawback of this option is 
that the inner hatch must be left open during docking to allow the cable run. 

 

 

Figure 3.9-6  VSU Failure Workaround Cabling Diagram 
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4.1 State Vector Management  

PURPOSE 

To provide a description of the onboard navigation system and management of the PROP and 
FILT state vectors.   

PROCEDURES 

1. Onboard State Vector Overview: 

Prior to the initialization of relative navigation, FDO generates and uplinks a fresh Orbiter 
and Target state vector using the latest ground tracking available.  A drag K-factor for each 
vehicle is also uplinked.  When rel nav is enabled the PROP vector is created and is equal 
to the FILT vector.  

The onboard state vectors are propagated using sensed velocity changes from the three 
functionally independent Inertial Measurement Units (IMUs) and math models that account 
for Earth gravity and atmospheric drag.  

Once the orbiter is within sensor range of the target, sensor data is fed to the onboard 
Kalman filter and the FILT vector is updated accordingly.   

The external sensors used during the orbit RNDZ phase are: Ku-band RNDZ Radar (RR), 
Star Tracker (STRK), and Crew Optical Alignment Sight (COAS).  

2. Onboard State Vector Maintenance  

Tables 4.1-1 and 4.1-2 define the environmental models, IMU thresholds and algorithms 
used in onboard vector propagation.    

Note: 

SPEC 33 ITEM 5 AVG G - OFF disables incorporation of IMU-sensed accelerations 
(despite the label, it does not turn on or off AVG G). 

SPEC 21 ITEM 18 is in units of ̅g-sec, meaning that it is the number of microgees 

accumulated in one nav cycle of 3.84 sec (therefore, 1000 ̅g will use a value of 3840 in 
SPEC 21 ITEM 18). 

 

Table 4.1-1  On-Orbit Vector Propagation 

Thrust Status Threshold Models Used 

OFF Acceleration > 1000 ̅g (SPEC 21 ITEM 18) 
accumulated velocity > 0.12 fps/NAV cycle 

J4 Gravity, 
Atmospheric 
Drag 

ON Accumulated velocity > 0.06 fps/NAV cycle 
(ILOADed value) 

J2 Gravity 
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Table 4.1-2  Vectors Updated by Rendezvous Navigation Vector Propagation 

Vector Update Rate Propagated By Updated With 

Orbiter FLTR 3.84 sec Super G Vents, drag, IMU ˝Vs, 
NAV sensor data 

Orbiter PROP 3.84 sec Super G Vents, drag, IMU ˝Vs 
UPP 0.96 sec Average G IMU ˝Vs 
 3.84 sec SV SEL overwrite --- 

TGT 3.84 sec Super G Drag 

 

3. Ground Vectors 

• The TLM-10 vector contains either the FLTR or UPP downlisted Orbiter vector elected 
by FDO. 

• The TLM-11 vector contains the downlisted Target vector. 

• Usually, Ephemeris-1 contains FDO's best Orbiter vector and Ephemeris-3 the best 
Target vector.  Check with FDO to confirm this.  

• The EPH-1, EPH-3, TLM-10, and TLM-11 vectors are used in the STATE VECTOR 
section at the top left part of the Rendezvous ONAV Status, window title, 
“RNDZ_STAT:(RNDZ_STAT): ONAV ORBITAL STATUS.  This display is accessed 
from the DNAV menu under Console Apps> ONAV Orbital Status. 

• GND-PFS  = EPH-1 minus TLM-10. 

• GND-TGT  = EPH-3 minus TLM-11. 

• ONBD_REL = TLM-11 minus TLM-10. 

4. FILT vs PROP Management 

Overview 

Either FLTR or PROP can be selected as the NAV source for other guidance and navigation 
functions. Also, either vector can be transferred to replace the other. As NAV sensor 
measurement data is incorporated into the FLTR, the difference between the vectors is 
monitored in terms of delta position and energy. At various points during the rendezvous, 
the FLTR vector will be transferred to the PROP after the FLTR has been determined to be 
the best vector.  

Rendezvous NAV Initialization 

When RNDZ NAV is enabled, the PROP vector is created and set equal to the FLTR. The 
SV SELECT option is initialized to PROP.  The SV Select is changed to FILT after the 
required number of sensor marks have been incorporated into the FILT state and the SV 
update is less than as specified tolerance.  See SCP 4.4 Rendezvous Radar Navigation and 
SCP 4.5 Star Tracker Navigation. 

FLTR-TO-PROP 

FLTR-TO-PROP vector transfers will usually be done for the following: 

• Second star tracker pass: After STRK acquisition but prior to incorporating data into the 
Filter. This is to save the current best SV before incorporating STRK data into it, on the 
chance that the STRK data may subsequently degrade rather than improve the FLTR 
vector. 
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• Radar. After RR acquisition but prior to incorporating data into the Filter. Criteria are 
radar data good and ratios less than 1.0 for four NAV cycles (about 31 sec). 

• Post-Ti. After sensor acquisition but prior to incorporating data into the Filter. 

• Final MC2 Targeting.  The vector used to target and execute MC2 and MC3 is saved for 
possible use in the failed radar procedures 

• Late Radar Nav. Another FLTR � PROP is included to ensure the Orbiter continues to 
point based on the vector used to target and execute MC2. 

• Note: A FLTR-TO-PROP vector transfer is generally not performed in the middle of a 
sensor pass because there is no positive test to determine if the FLTR is really better 
than the PROP. 

PROP-TO-FLTR 

The PROP vector is maintained to provide recovery capability should the Filter solution be 
polluted as the result of processing erroneous sensor measurement data. 
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4.2 Rendezvous Nav Safing & Impacts 

PURPOSE 

To describe Rendezvous Nav safing steps and the possible impacts on Rendezvous Nav from 
DPS operations.  

PROCEDURES 

1. Preparation for Rendezvous Nav Disable:  

CANCEL target track on UNIV PTG 201 (ITEM 21) and reconfigure DAP as desired.  

• Targeting: protected simply by not executing Lambert targeting when Rendezvous Nav 
is not active.   

• Pointing: protected by canceling target track on the DAP or moding to INRTL, LVLH or 
FREE.   If UP tries to track the target after Rendezvous Nav disable, internal GPC 
errors and excessive jet firing may be seen due to the static TGT vector.   

• TGT Vector: Becomes static (not propagated) and may require new uplink from 
ground if Rendezvous Nav is disabled for a long time period.  

• Orbiter Vector:  May be lost with OPS 0 transition (see table below).     

 

2. REL NAV Display Status Impacts 

 

Table 4.2-1 Rendezvous Nav Status Impacts 

 RNDZ NAV 

Enable 

Restring Add/Delete GPC 

to/from RS 

OPS 

Transition 

RNDZ NAV Enable --- OK Lost Lost 
Angle Source Last Value OK OK STRK 
AUTO/INHIBIT/FORCE Last Value OK Last Value INHIBIT 
COAS Calibration --- OK OK OK 
DV_DISP Counters OK OK 0 0 
FLTR minus PROP 0 OK PROP=FLTR PROP=FLTR 
IMU Deselect --- OK OK OK 
KU Antenna Enable Last Value OK OK Lost 
Mark Counters 0 OK 0 0 
Orbiter State Vector and 
drag K-factor 

OK OK OK* OK* 

Star Tracker Mode --- OK TERM IDLE TERM IDLE 
State Vector Select PROP OK PROP PROP 
Target State Vector and 
drag K-factor 

OK OK OK Lost 

2-Level IMU Reference --- OK Lowest IMU Lowest IMU 
U/L Covariance Matrix Initialized OK Reinitialized Lost 
UNIV PTG Options --- OK OK Same 

* Orbiter state vector is lost if more than 10 minutes is spent in OPS 0. 
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Notes: 

• Adding or deleting a GPC in the GNC GPC redundant set causes the GPC(s) to enter 
OPS 0 momentarily. 

• After 10 minutes in OPS 0, the Orbiter state vector will be replaced by an I-Loaded 
default orbital state vector in an equatorial orbit and a new, valid Orbiter state vector 
must be uplinked. 

• The Target state vector must be within �15 hours of current time to enable Rendezvous 
Nav. 
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4.3 Navigation Anomalies 

PURPOSE 

To provide procedural guidance for cases where REL NAV ratios > 1.0 on SPEC 33 (REL NAV) 
and thus to respond to the specified "Call MCC" note in the Rendezvous Checklist. 

PROCEDURE 

Take actions in an order that will cause the smallest perturbation to the onboard relative state 
vector. More aggressive actions can always follow in an attempt to correct a bad NAV situation. 

Manage the onboard state vectors (SV) as described in SCP 4.1 STATE VECTOR 
MANAGEMENT. In the event one of the two state vectors (Orbiter or Target) must be uplinked, 
procedures are in place to build the other vector from the existing good relative state so as to 
minimize the effect on the onboard relative state. 

Uplink of New Orbiter SV 

• Verify current Onboard relative state and Inhibit data to the FLTR 

• Coordinate with FDO to select a new Orbiter state vector (choose an ephemeris vector or a 
previously saved onboard vector) 

• Coordinate with FDO to build a new Target vector based on the new Orbiter vector and current 
onboard relative state 

 

When both vectors are ready: 

• Request FREE Drift on the DAP 

• Uplink both state vectors and verify them 

• Return to AUTO DAP 

• Perform a FLTR TO PROP vector transfer  (Orbiter vector uplinks always go into the FLTR 
vector) 

Note: AUTO DAP cannot be used while uplinking the new vectors. There will be some short 
amount of time when only one new vector is onboard and the onboard relative state will be bad. 
Furthermore, should a bad state vector be uplinked for either the Orbiter or Target, an attitude 
maneuver would be initiated in AUTO.  Previously, LVLH was to be selected but this would also be 
vulnerable to an erroneous Orbiter state vector uplink. 

Uplink of New Target SV 

• Coordinate with FDO to uplink the new Target vector 

• Verify the new vector 

• Resume incorporation of sensor data 

Note:  With this method, NAV will behave as if this were the first sensor acquisition using a bad 
vector. 

                   



SHUTTLE OPS RESP: T. Rickerl Navigation Anomalies 
RNDZ CHB/DM-CH-08 REV B PCN-2: 06/27/2005 SCP 4.3 

Verify this is correct version before use.  4.3-2 

BACKGROUND 

There are several points in the RENDEZVOUS C/L where a sequence of anomalous conditions 
requires the crew to "call MCC". The key symptom is that ratios computed by onboard NAV and 
displayed on SPEC 33 (REL NAV) are greater than 1. 

Most NAV problems can be characterized as follows: 

Bad State Vector 

A bad Orbiter or Target state vector uplink will be seen either at uplink (Orbiter/Target) or upon 
enabling RNDZ NAV (Target).  A "bad" state vector uplink can be characterized in one of two 
ways: 

• Invalid time-tag. The vector's time-tag is beyond the 15 hour limit for onboard NAV 
propagation.  Symptom is a fail indication on MSK 549 in the TIME TAGS section - "O F" or "T 
F" indicated for Orbiter or Target state prediction failures, respectively. In this event, the 
uplinked vector will be rejected and the current state vector will be retained 

• Bad state vector. Symptoms are large GND-PFS or GND-TGT vector comparisons and 
apparent attitude control or DAP problems.  During day of  Rendezvous navigation, a bad state 
vector could also detected as a larger than expected FLTR - PROP or change in the relative 
nav range that does not match predictions. 

IMU Problems 

A bad IMU may be due to bad attitude (gyro) data, bad accelerometer data, or both. 

• Bad attitude data. A drifting or biased IMU gyro platform will affect NAV only while incorporating 
NAV sensor data and thus will affect the FLTR vector only. The bad attitude data will be fed 
into the Filter via the sensor Angle updates and it may at first appear to be NAV sensor 
problem.  STRK data will be affected much more than RR data. 

• Bad accelerometer data. IMU accelerometer data is always incorporated into both the FLTR 
and PROP state vectors. At the 3-IMU level RM will protect NAV, but at the 2-IMU level (during 
a STRK pass) accelerometer data is averaged. This means that both FLTR and PROP vectors 
will be affected. The FLTR may be better than the PROP depending on the quality of sensor 
data but it is best in this case to uplink a whole new Orbiter state - preferably the last onboard 
state that was saved. See the state vector uplink procedures below. 

Note:  The possibility for an IMU accelerometer spike short enough to avoid RM action is small 
but real. 

NAV Errors 

NAV Sensor errors are almost guaranteed in some form or another. That is why Navigation uses 
the Kalman Filter. The Filter is designed to account for limited amounts of sensor bias, noise, and 
drift against predetermined estimates of NAV state error. The NAV Filter I-Loads define the 
expected sigma error for each sensor. The Filter has the capability of solving for constant bias 
errors if provided enough information and time. 

• Star Tracker. STRK data is the most accurate sensor and has very small sigma error values.  
The health of the STRKs will be known (based on current flight data and IMU align history), 
and a bad STRK will not be used. In general any NAV error introduced during a STRK pass will 
be due to IMU misalignment or drift. The possibility of acquiring a star is quite real, either at the 
beginning of a STRK pass or during the pass if the star is close to the LOS to the Target. 
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• Rendezvous Radar. Radar is currently the only sensor to provide both range and bearing data 
to NAV. RR angle data is expected to be quite noisy and range and range rate error will vary as 
a function of range.  Faulty radar may or may not be detected by INCO during the self-test. The 
probability of failing self-test and still having good RR data is high and the possibility of losing 
RR lock is quite real. 

Note:  It can be assumed that no other orbiting body is close enough to the target to confuse the 
radar. 
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4.4 Rendezvous Radar Navigation 

PURPOSE 
To give information concerning the rendezvous radar data and its use by onboard nav.  For 
characteristics of the Ku-band radar system, see SCP 3.7 KU RADAR. 

PROCEDURE 
Refer to the BACKGROUND section on information regarding the rendezvous radar data: 

• Radar Data Parameter Measurement Limits 

• Radar Data Error Characteristics 

• Radar Data Angle Definitions, Calculations, and Constraints 

• Radar Data Path 

BACKGROUND 

Radar Data Parameter Measurement Limits 

 

Table 4.4-1 Radar Parameter Measurement Limits 

Parameter Passive Mode Characteristic 

LOS range 100 ft to 10 n.mi. 
Effective range 135 kft (22 n.mi.) 
Maximum unambiguous range 147 kft (24 n.mi) 
LOS range rate 148 fps closing 

75 fps opening 
LOS pitch angle Plus or minus 30 degrees 
LOS roll angle Plus or minus 30 degrees 
Pitch inertial angle rate Plus or minus 20 mrad/sec 
Roll inertial angle rate Plus or minus 20 mrad/sec 
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Radar Data Error Characteristics 

 

Table 4.4-2 Radar Error Characteristics 

Parameter Random Error (1σ) Bias Error (1σ) 

Range 27 ft out to 8 kft 
0.0033*Range from 8 to 30 kft 
100 ft when > 30 kft 

27 ft out to 8nm 
0.00053*Range when > 8 nm 

Range rate 0.33 ft/sec or 0.33% of range rate, 
whichever is greater 

0.33 ft/sec 

Angle 0.153 deg 1.0 deg 
Angle rate 0.0027 deg/sec 0.0027 deg/sec 

 

Radar Angle Definitions, Calculations and Constraints 

The native coordinate system for the KU radar is . DQG � JLPEDO DQJOHV �DOVR FDOOHG VKDIW DQG

trunnion).  The KU electronics convert these gimbals to azimuth and elevation (also called roll 
and pitch) that are in the Orbiter body sense.  To compute the LOS of the radar given azimuth 
and elevation, first rotate in azimuth (positive about the Orbiter -X body axis), then in elevation 
(positive about the Orbiter -Y body axis) as in an azimuth/elevation Euler sequence.  Note that 
the Rendezvous Navigation software converts the Ku angle measurements back to shaft and 
trunnion to do its angle processing, for it is in this frame that angle biases must be solved for and 
applied. 

 

To compute . DQG � �VKDIW DQG WUXQQLRQ� IURP D]LPXWK�-� DQG HOHYDWLRQ���� WKH IROORZLQJ

equations can be used: 

 

β = arcsin −cos K sinθ + sin K sin ϕ cosθ[ ]  Equation 4.4-1 

α = arctan
− sin K sin θ − cos K sinϕ cosθ

cosϕ cosθ
 

  
 

  
  

 

Equation 4.4-2 

 

where K = 67 deg = 1.17 rad  (the “deployed” angle of the KU system relative to Orbiter +X). 

 

Note that there is an operational constraint to not allow RR angle searches when the magnitude 
RI WKH � JLPEDO H[FHHGV �� GHJ� $ERYH WKLV YDOXH� WKH KLJK-speed angle search can result in 
KLWWLQJ JLPEDO KDUG VWRSV WKDW FRXOG FDXVH GDPDJH WR WKH PHFKDQLVP� :KHQ WKH � JLPEDO

exceeds 38 deg, GPC mode should be avoided (AUTO TRACK preferred) to prevent automatic 
searches after a break lock. 
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Radar Data Path 
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Figure 4.4-1  Radar Data Path 
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4.5 Star Tracker Navigation 

PURPOSE 

To give information concerning the incorporation of star tracker measurements into onboard 
navigation.  See SCP 3.6 Star Tracker for details on the star tracker hardware systems. 

PROCEDURES 

1. Star Tracker Pass Overview 

After sensor data is accepted into the NAV Filter, the Filter position update behavior is monitored 
for indication of Filter convergence. For each measurement processed, the SV correction is 
weighted as a function of the estimated knowledge of the state error (i.e., covariance matrix) 
before the correction is applied to the state vector. Thus, the decrease in size of successive SV 
updates should be fast initially, then more gradual as the number of data marks incorporated 
increases. After the SV update values stabilize below a specified value, the Filter is considered 
converged on the relative state. For STRK NAV, SV updates are expected to increase in the 
middle of the STRK pass (80 to 100 marks) as the Filter gains enough knowledge to distinguish 
downtrack position error from radial position error and begins to apply the appropriate position 
updates. 

In addition to SV position updates, the individual measurement residuals (Estimated minus 
Measured) are observed. As the Filter converges, these values should also stabilize below a 
predefined value but will do so very quickly and then remain there. Other parameters monitored 
for general Filter status and data quality assessment include covariance matrix position RSS, 
number of sensor marks accepted/rejected, and sensor biases as determined by the Filter. 
Ground minus Onboard vector differences for both Orbiter and Target are monitored as an 
overall evaluation of the onboard state. 

2. Assessing a Star Tracker Pass 
Procedures call for a SV SELECT switch to FLTR when 9 or more marks have been accepted by 
the filter and when SV UPDATE POSITION is less 1000 ft for STRK and 300 ft for radar: 

• Verify that ST is selected as the angle source (SPEC 33 ITEM 12) 

• Compare initial residual versus range per tables in the BACKGROUND section 

If FLTR minus PROP exceeds 8∗  kft (profile dependent) in a single STRK data pass 
the data should be discarded by performing the following:  

◊ Inhibit sensor data to NAV 

◊ Perform a PROP-to-FLTR 

◊ Break track with the star tracker  

NOTE: The 8 kft value applies assuming a post-NC star tracker pass in a rendezvous from 
behind with NC at approximately -40 nmi, single-rev transfer to Ti. Another value is 12 kft for a 
rendezvous from in front with NC at approximately +30 nmi, two-rev transfer to Ti. 
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BACKGROUND 
The relationship between a residual and an offset distance at a particular range is 

 

δ =
180

π
  
  

  
  ∗

d

R
  
  

  
   

 

Equation 4.5-1 

hence, 

 

d =
π

180
  
  

  
  δR 

 

Equation 4.5-2 

 

where d = offset distance, 

 δ = residual from SPEC 33 

 R = range to target 

 

The correspondence between residual value and offset distance for typical star tracker passes: 

 

Table 4.5-1 Star Tracker Offsets Versus Residuals 

Star Tracker Pass #1 Star Tracker Pass #2 Post-Ti Star Tracker Pass 

Range = 245,000 ft Range = 148,000 ft Range = 50,000 ft 

Resid Offset (ft) Resid Offset (ft) Resid Offset (ft) 

0.01   43 0.01   26 0.01   9 
0.05  214 0.05  129 0.05  44 
0.10  428 0.10  258 0.10  87 
0.50 2138 0.50 1291 0.50 436 
1.00 4276 1.00 2583 1.00 873 

 

The offset direction is dependent upon the star tracker component (H, V) and the value of 
omicron. 

For the -Z Star Tracker in the nominal -Z Target Track attitude (BV=3, OM=0): 

• H residual corresponds to a radial offset; 

• V residual corresponds to an out-of-plane offset; 

For the -Y Star Tracker in the nominal -Y Target Track attitude (BV=4, OM=90): 

• H residual corresponds to an out-of-plane offset; 

• V residual corresponds to a radial offset; 
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As it turns out (due to the definition of H and V for each star tracker) the offset direction for a 
given value of omicron is completely independent of which star tracker took the measurement.   
For example, for OM=0, H always corresponds to a radial offset, regardless of whether it is 
measured by the -Z or -Y star tracker. Refer to the table, below, for offset directions versus 
orthogonal values of omicron. 

 

Table 4.5-2  Star Tracker Residuals Versus Offset Direction 

Component OM 0 OM 90 OM 180 OM 270 

H radial out-of-plane radial out-of-plane 
V out-of-plane radial out-of-plane radial 

 

See SCP 3.3 POINTING for illustrations of the above UNIV PTG attitudes.  Obviously, if omicron 
is non-orthogonal, then H and V do not map directly into radial and out-of-plane. 
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4.6 COAS Navigation 

PURPOSE 

To provide information about the Crew Optical Alignment Sight (COAS). 

 

PROCEDURE 

For nominal operations, the COAS is used from post-MC4 until docking in the following manner: 

• Line-of-sight manual trajectory control to set up for Rbar arrival, in conjunction with the 
centerline camera.  See SCP 3.9 CAMERAS. 

• Secondary cue to backup the centerline camera for TORVA start and control, Vbar 
acquisition, and corridor maintenance. 

 

In a radar failed case, in addition to the functions listed above, the COAS is used for the 
following: 

• Determination of the magnitude of the radar failed correction burn.  For every degree the 
target is high in the COAS, the crew performs two +X (“up”) pulses.  For every degree 
the target is low, the crew performs one –X (“down”) pulse.  These procedures are in 
>��'@ in the Rendezvous Checklist. 

 

BACKGROUND 

 
The COAS has two principal functions.  First, it provides optical alignment capability for 
rendezvous and docking (see below).   
 
Second, the COAS provides redundancy to the two star trackers for aligning the inertial 
measurement units (IMUs).  The star tracker software will not accept stars for IMU alignments if 
the stars are more than 1.4° from where the general purpose computer (GPC) thinks it should be. 
Should the IMUs become misaligned by more than this limit, the COAS serves as the alternate 
method of star tracking.  Like the trackers, the COAS is used to establish a line-of-sight (LOS) 
vector to a star, thus enabling determination of the IMU orientation with respect to the stars.  It 
can be used as the method of approximate alignment, with the star trackers completing the job 
with a fine alignment, or it can be used stand alone in the case of a failure of both star trackers.  
An orbit calibration is required before the devise can be relied upon as a backup to the trackers. 

 
The COAS is a cylindrically shaped device about 8 inches long, with a combining glass at one 
end, a box-like attachment at the other end containing a rheostat for light intensity control, and a 
mounting plate attached to the central portion of the cylinder. 
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Figure 4.6-1  COAS Hardware 

 

 

 

Figure 4.6-2  COAS Hardware Side View 
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Figure 4.6-3  COAS Hardware Bottom View 

 

 

 
For rendezvous and proximity operations, the COAS is mounted in the aft overhead window 
looking along the Orbiter -Z axis.  Measurements within the 5° reticule are the most accurate; 
however, less accurate measurements can be estimated up to about 15°.   
 
The COAS has two mounting positions: one above the commander (CDR) +X FW window (W3) 
and one in front of the starboard OW (W7) above the aft flight station.  The +X mount is 
boresighted parallel to the +X axis and the –Z mount parallel to the -Z axis of the Shuttle.  
Attention must be given to the forward/overhead (FW/OW) switch. This switch allows the 
crew to rotate the COAS when installed for forward or aft/overhead view.  If used in wrong 
position, the Station could see approximately 10° of error displacement in the -y direction, like on 
STS-101. 
 
With the COAS mounted on panel 01, power to illuminate the reticule is provided from the 
COAS POWER switch on panel 01.  COAS power at the aft mount is controlled by the COAS 
POWER switch on panel 019.   
 
The COAS, because it is aligned with a high degree of accuracy along the Orbiter –Z axis, is 
used by the pilot as a tool for flying the “manual phase” of rendezvous, in which course 
deviations normal to the LOS must be corrected by manual inputs to the THC.  This phase runs 
from shortly after MC4, at about 2000 ft, to the final docking or RMS berthing.  The COAS may 
be used as early as ~5000 ft for the radar fail case manual correction burn. 
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Figure 4.6-4  Mir Through the COAS 

 
Currently, the COAS is not used for close range angular alignment, although working groups 
have studied it.  Due to the large offset in distance between the COAS and the ODS, a COAS 
target would not be accurate enough for lateral alignment.  Current docking mechanism 
requirements specify a maximum 4.2 inches of lateral misalignment.  Accounting for all 
quantifiable error sources, this would require the COAS target to be within 4.4 inches of the 
docking mechanism centerline.  The COAS can be used as a backup navigation sensor during 
rendezvous, as long as the pilot can see the target vehicle. 
 
Line-of-sight angles can be measured by having the pilot manually rotate the Orbiter with the 
rotational hand controllers (RHC) until the target vehicle passes across the center of the reticule 
pattern.  At that point, the pilot takes a mark by depressing the ATT REF push button. If the pilot 
feels the mark was a good one, he then enters it into onboard navigation with a keyboard item 
entry on SPEC 33. 
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4.7 Covariance Matrix Management 

PURPOSE 

To provide a description of the covariance matrices used by the onboard navigation system 
during rendezvous and proximity operations, and how they are manipulated. 

PROCEDURE 

Covariance Matrix Uplink 

Covariance Matrix Uplink Requirements 

• Deploy - If Rendezvous Nav will be used following Deploy the Prox Ops covariance 
matrix should be uplinked. 

• Deploy/Rendezvous - If the Prox Ops covariance was uplinked to support Deploy and 
Sep, the Rendezvous covariance must then be uplinked before the start of rendezvous 
operations. 

• Ground-Up Rendezvous - No uplink is required, the I-Loaded Rendezvous covariance 
matrix will be used. 

• Rendezvous Post-Ti - The Prox Ops covariance matrix will be uplinked post-Ti if radar 
data has been incorporated.  The COAS Nav covariance matrix will be uplinked if 
COAS navigation will be performed post-Ti. 

Covariance Matrix Uplink Procedures 

See SCP 9.1 RENDEZVOUS GPO COMMAND LOADS. 

Covariance Matrix Reinitialization 

Reinitializing the Covariance Matrix will reset Mark Accept/Reject counters to zero and NAV 
Sensor Bias Estimates to zero. 

Automatic Reinitialization 

The following events will reinitialize the covariance matrix to the I-Loaded (or Uplinked) 
value: 

• Enable Rendezvous Nav 

• Orbiter or Target state vector uplink 

• Any of the following state vector transfers: 

• PROP TO FLTR 

• TGT TO ORB 

• ORB TO TGT 
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Manual Reinitialization 

The crew can reinitialize the covariance matrix to the I-Loaded (or Uplinked) value via 
SPEC 33 ITEM 16 (COVAR REINIT). 

Covariance Matrix Reset 

The covariance matrix will automatically be reset to the I-Loaded (i.e., RNDZ) covariance 
by either an OPS 2-8-2 Transition or an OPS 2-3-2 Transition. 

If the PROX OPS covariance had been uplinked it must be re-uplinked before resuming 
rendezvous operations. It is preferable to uplink it before re-enabling RNDZ NAV, 
otherwise the crew must perform a manual COVAR REINIT to read in the uplinked values. 

BACKGROUND 

(Parts of the following are from FDD-NAV-630-90-53 by T. Miller.) 

The onboard RNDZ navigation covariance matrix was originally developed for the Solar Max 
rendezvous mission and has been used for rendezvous ever since. It represents the expected 
relative state covariance matrix at the time of RNDZ NAV initialization, which takes into account 
Orbiter and Target state vector uncertainties, Orbiter energy growth, and both Orbiter and Target 
propagation errors. 

The current I-loaded RNDZ state covariance matrix sigma values are 

2000,20000,2000,21,2,6 (U,V,W ft, and VU,VV,VW ft/sec). 

The important item to remember is that this covariance matrix assumes small sensor errors and 
large state vector errors at NAV sensor acquisition in order to protect for large state errors. This 
tends to drive the sensor RATIO artificially low even for very large sensor errors.  This is 
especially true for star tracker data. 

The current PROX OPS state covariance matrix sigma values are 

1000,1000,1000,1,1,1 (U,V,W ft, and VU,VV,VW ft/sec). 

The sigma values for the PROX OPS matrix were arbitrarily chosen to be small (to represent 
state errors after radar data incorporation) but large enough to prevent excessive editing of NAV 
sensor data. 

The COAS NAV state covariance matrix sigma values are 

500,5000,100,5,1,1 (U,V,W ft, and VU,VV,VW ft/sec). 

This covariance matrix was tailored specifically to COAS navigating with large objects and was 
first designed for the STS-63 mission for the first rendezvous with Mir. 

The covariance matrix used by NAV exists in the NAV software. These values are loaded from a 
"Covariance Matrix Buffer" by a Covariance Reinitialization event (automatic or manual). The 
contents of the Buffer is loaded from the I-Load values by an OPS Transition or the uplinked 
values by an Uplink event. 
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Figure 4.7-1  Covariance Matrix Paths 

 

Note: Care should be taken when reinitializing the covariance matrix.  Reinitialization may 
have the effect of actually making NAV worse for a short time because whatever certainty had 
been acquired in the state vector will be lost.  Depending on what sensors are available it may 
take some time for NAV to reconverge to the degree seen before. 
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5.1 Orbit Targeting SPEC 34 Overview 

PURPOSE 

Provide an overview of the Orbit Targeting software to be used by the RNDZ GPO as a quick 
reference.   

PROCEDURE 

SPEC 34 Inputs 

 
Table 5.1-1 Description of SPEC 34 Inputs 

ITEM # Variable  Description 

1 TGT NO Target set #.  Recalling the TGT Set initiates several 
actions that are discussed later. 

2-5 T1 TIG = BASE TIME + "T1 rel to BASE TIME" 
6 EL Elevation angle. 
7-12 ∆x,y,z; ∆x,y,z dot Position and velocity at T1. 
13-16 T2 TIG = T1 TIG  + ∆T 
17 ∆T Transfer time.  Used to calculate T2. 
18 ∆X X offset at T2. 
19 ∆Y Y offset at T2. 
20 ∆Z Z offset at T2. 
21-24 BASE TIME Used to calculate T1 each time TGT Set is recalled. 
26 LOAD Loads Display buffer variables into the Compute and 

Load buffers. 
28 COMPUTE T1 Computes the velocity required at T1TIG to reach the 

offset position in the specified transfer time. 

 

Targeting based on time or elevation?  

• Targeting is based on TIME if EL = 0 or T1 TIG is in the past. 

• Targeting is based on ELEVATION if EL � �� DQG 7� 7,* LV LQ WKH IXWXUH� 

Targeting based on time (T1 TIG in the future)  

• If EL = 0 and T1 TIG is in the future, targeting is based on time.  

• No Compute Buffer variables are changed when compute (ITEM 28) is executed.  
(Exception:  If T1 position and velocity (ITEMs 7-12) are zero, the software will 
compute T1 state vector based on the onboard state.) 

• Neither BASE TIME nor "T1 rel to BASE TIME" are altered after a solution is found. 
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Targeting based on elevation 

• If EL ≠ 0  and  T1 TIG is in the future, targeting is based on elevation angle.   

• Targeting s/w makes the following adjustments to the Compute Buffer variables when 
compute is executed: 

T1 TIG is determined from EL angle search.  T1 TIG = Function(EL) .  "Seed" T1 TIG 
is used as the first guess for the elevation search. 

T2 TIG = new T1 TIG  +  ∆T. 

• After the solution is found: 

BASE TIME is set to T1 TIG   (I-Load & Display Buffer) 

"T1 rel to BASE TIME" is set to 0/00:00:00    (I-Load Buffer) 

Targeting based on time (T1 TIG in the past) 

• If T1 is in the past, targeting is based on time. (Value of Elevation Variable (EL) is 
not significant)  

• Targeting s/w makes the following adjustments to the Compute Buffer variables 
when compute is executed: 

• T1 TIG is set to current time + 1 minute. 

• �7 �&RPSXWH DQG Display Buffer) is adjusted so that T2 TIG does not change. 

• After the solution is found: 

• No I-Load Buffer variables are changed unless LOAD (ITEM 26) is executed.  

• Display Buffer variables "T1 TIG", "T2 TIG" and "∆T" are updated automatically.  

Buffers 

• Display Buffer - memory location for values displayed on MCDS.  Values displayed 
on the MCDS always equal buffer values. 

• Compute Buffer - memory locations for values actually used as targeting constraints. 

• I-Load  Buffer - memory location for target set information and BASE TIME.  

Actions initiated by EXECution of ITEM entries 

TGT NO (ITEM 1 +## EXEC)  transfers data from the I-Load Buffer (IB) to the Display 
Buffer (DB) and Compute Buffer (CB) and sets items 7-16 equal to zero.  ∆T, ∆X, ∆Y, ∆Z 
and BASE TIME are transferred directly.  T1 TIG is calculated as follows:   

• Set T1 TIG (DB & CB) =  BASE TIME (IB)  + "T1 rel to BASE TIME" (IB). 

• Set Position @ T1 TIG (ITEMs 7-9 in DB & CB)  =  0.0 

• Set Velocity @ T1 TIG (ITEMs 10-12 in DB & CB)  =  0.0         

• Set T2 TIG (DB & CB)  =  0.0 

• Set ∆T, ∆x, ∆y, ∆z (DB & CB)  =  ∆T, ∆x, ∆y, ∆z (IB) 

LOAD (ITEM 26 EXEC)  transfers data from the Display Buffer (DB) to the Compute 
Buffer (CB) and the I-load Buffer (IB).  If the crew changes ITEMs 2-24 via manual input, 
LOAD will flash.  The values are transferred to the IB and CB when an ITEM 26 (LOAD) is 
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executed.  All variables are transferred directly from the DB to the CB and/or the IB expect 
for "T1 rel to BASE TIME" which is set equal to T1 TIG (DB) - BASE TIME (DB).    

COMPUTE (ITEM 28 EXEC) performs checks on the Compute Buffer (CB) variables: 

• Is T1 in the future?  (See earlier discussion.) 

• Is Elevation = 0?  (See earlier discussion.) 

• Is T1 position and velocity = 0?  (If YES, calculate a new T1 state vector based on 
onboard nav; if NO, use current state that was manually input by the crew.) 

After the checks are performed, the targeting s/w is executed in an attempt to solve for the 
∆V that must be burned at T1 to arrive at T2. 

Changing the I-Load buffer  

The I-Load buffer can be altered in only 3 ways: 

• Ops Transition:  I-Loaded values are read from the MMU. 

• LOAD - ITEM 26 EXEC:  Display values over-write old values. 

• COMPUTE - ITEM 28 EXEC:  If and only if EL ≠ 0 and T1 TIG is in the future, the s/w 
automatically changes BASE TIME and "T1 rel to BASE TIME"  

To change any variable except "T1 rel to BASE TIME": 

• Change the value in the Display Buffer (crew MCDS entries) 

• LOAD - ITEM 26 EXEC 

To change "T1 rel to BASE TIME": 

• Recall the TGT SET (ITEM 1 + ## EXEC).   {Not required if TGT Set already 
displayed} 

• Set the BASE TIME as desired (ITEM 21 +# +## +## +## EXEC). 

• Set T1 TIG so that T1 TIG = BASE TIME + desired "T1 rel to BASE TIME" (ITEM 2 
+#...  EXEC). 

• LOAD - (ITEM 26 EXEC). 

• Recall target set and confirm T1 TIG and BASE TIME. (ITEM 1 +## EXEC). 
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5.2 Targeting Anomalies 

PURPOSE 

To identify possible anomalies associated with Orbit Targeting and to define the proper 
MCC/crew responses to them.  The following are addressed: 

• Quick lookup tables for targeting alarms. 

• MC2 TIG slip. 

• Half-rev transfers for late NCC and MC1 burns. 

• Targeting alarms during re-maneuver orbit targeting in Major Mode 201. 

• Alarms During ORBIT MNVR EXEC Target LOAD (Major Mode 202). 

• Alarms During ORBIT MNVR EXEC burn execution with Lambert Cyclical Guidance. 

• Second rendezvous attempt. 

• Unreasonable ∆Vs with no targeting alarms. 

• Checking PRED MATCH, solution ∆Vs, and target set I-loads. 

PROCEDURE 

Quick Lookup Reference for Lambert Targeting Alarms 

 

Table 5.2-1  Lambert Targeting Alarms  

Alarm PRED MATCH Quick Cause 

TGT DT --- ITEM 28 requested with DT and T2 TIG=0 

TGT DT 999999 Transfer angle = 0 or 360 deg or 
transfer requires parabolic trajectory 

TGT DT 999999 Orthogonal braking fails to solve for transfer time 

   
TGT ITER 999999 Max Newton-Raphson iterations 

TGT ITER --- Max iterations to reduce miss distance 

   

TGT EL ANG --- Elevation angle search error 
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MC2 TIG Slip 

For TIG slips at the limit direct crew to "BURN MC2 USING TGT SET 19" in the 
RENDEZVOUS C/L.  The following steps describe this direction. 

If MC2 TIG slip < − 3 minutes 

• Set BASE TIME to Nominal MC2 TIG - 3 minutes. 

• LOAD changes with ITEM 26. 

• Use Target Set 19 and retarget. 

If MC2 TIG slip > +7 minutes 

• Set BASE TIME to Nominal MC2 TIG + 7 minutes. 

• LOAD changes with ITEM 26. 

• Use Target Set 19 and retarget. 

Half Rev Transfers for late NCC and MC1 Burns  

If NCC burn TIG is delayed to PET -00:48 (i.e., a 7 to 10 minute delay) 

• LOAD final targeting solution. 

• Downmode to EXDV and burn VGOs. 

If MC1 burn TIG is delayed to PET +00:30 (i.e., a 7 to 10 minute delay) 

• LOAD final targeting solution. 

• Downmode to EXDV and burn VGOs. 

Targeting Alarms During Pre-Maneuver Orbit Targeting in Major Mode 201 

If TGT ∆T Alarm 

• Check TRANSFER TIME - ITEM 17 - to see if it is near zero or a FULL REV-- if so, 

• Check inputs for errors and correct. 

• LOAD - ITEM 26. 

• If using orthogonal braking 

• Recall Target Set. 

• Abort orthogonal braking by removing minus sign from ITEM 17. 

• LOAD - ITEM 26. 

• If TRANSFER TIME is acceptable and not using orthogonal braking, proceed with TGT 
ITER Alarm Procedure, below 

If TGT ITER Alarm 

• Check Target Set Data. 

• Get crew report on PRED MATCH and solution ∆Vs. 
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• Recall Target Set and repeat targeting. 

• If alarm repeats, 

• If good agreement between onboard and ground and PRED MATCH small, retype 
and reload onboard PEG 7s and burn as External ∆Vs (EXDV). 

• If NOT good agreement between onboard and ground or PRED MATCH large, 
load ground solution into PEG 7s and burn as External ∆Vs (EXDV). 

If MC2 EL ANG Alarm 

• Check TGT Set Data 

• If trajectory is short (trajectory never hits the angle) AND TIG slip is within limits (7 
minutes late and 3 minutes early), burn the solution. 

• If trajectory is short AND TIG slip is NOT within limits, use target set 19 and use the 
early or late limit. 

• If T1 TIG and EL are approximately nominal values, recall target Set and recompute T1. 

• If T1 TIG and EL are NOT approximately Nominal Values: 

• Check NAV state and trajectory with FDO. 

• If NAV State questionable and using FILT, repeat targeting with PROP. 

• If NAV State OK and FDO confirms trajectory is short or if using PROP, use 
Target Set 19 and target using nominal + 7 min MC2 TIG. 

Alarms During ORBIT MNVR EXEC Target LOAD (Major Mode 202) 

If TGT ∆T Alarm 

• Check TRANSFER TIME - ITEM 17 - to see if it is near zero or a FULL REV.  If so: 

• Check inputs for errors and correct. 

• LOAD - ITEM 26. 

• If TRANSFER TIME is acceptable, use TGT ITER Alarm procedure, below. 

If TGT ITER Alarm 

• Check TGT Set Data. 

• Get crew report on PRED MATCH and solution ∆Vs. 

• Have FDO grab onboards and run ground solution. 

• If good agreement between onboard and ground and PRED MATCH small, downmode 
from LAMBERT to EXDV and burn onboard PEG 7 solution. 

• If NOT good agreement between onboard and ground or PRED MATCH large, load 
ground solution into PEG 7s and burn EXDV. 

Alarms During ORBIT MNVR EXEC Burn Execution with LAMBERT Cyclical 
Guidance 

For any alarm (TGT DELTA T or TGT ITER), complete the burn. 

                   



SHUTTLE OPS RESP: T. Rickerl Targeting Anomalies 
RNDZ CHB/DM-CH-08 REV B: 1/15/02 SCP 5.2 

Verify this is correct version before use.  5.2-4 

Second Rendezvous Attempt 

Prior to having the crew load BASE TIME at the start of the rendezvous day, 

• Check TGT Set Data in each target set, ESPECIALLY TGT Set 12 (MC2 on EL ANG) 

• Correct as necessary. 

• LOAD - ITEM 26. 

• Proceed with LOAD BASE TIME. 

Unreasonable ∆Vs with No TARGETING ALARM 

If "unreasonable" ∆Vs appear during preliminary targeting, 

• Check target set data for errors. 

• Correct as necessary. 

• LOAD - ITEM 26. 

• COMPUTE T1 - ITEM 28. 

• If unreasonable ∆Vs reappear or no errors noted, perform one of the following: 

• Ti - Ti Delay. 

• MC2 - Use Target Set 19 and target using nominal MC2 TIG. 

• Other - Load ground solution into PEG 7s and burn EXDV. 

If "unreasonable" ∆Vs appear preburn during LCG (TIG−15 sec) 

• Do nothing -- no action required. 

If "unreasonable" ∆Vs appear during LCG while burning 

• Downmode to EXDV and burn VGOs. 

Checking PRED MATCH, Solution ∆Vs, and TGT Set ILOADs 

Have crew read down PRED MATCH and solution ∆Vs 

• PRED MATCH 

• ∆VX 

• ∆VY 

• ∆VZ 

Have crew recall TGT Set and read the following: 

• T1 TIG  (ITEM 2-5) 

• El Angle  (ITEM 6) 

• T2 TIG  (ITEM 13-16) 

• Transfer Time (ûT)  (ITEM 17) 

• X Offset at T2 (ûX)  (ITEM 18) 

• Y Offset at T2 (ûY)  (ITEM 19) 
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• Z Offset at T2 (∆Z)  (ITEM 20) 

• BASE TIME  (ITEM 21-24) 

Compute T1 Rel To BASE TIME: 

• T1 TIG BASE TIME = __________ 

Compare vs. expected values on page 6-3 of RENDEZVOUS C/L 

 

BACKGROUND 

MC2 TIG 

The MC2 TIG can vary in time since this burn is tied uniquely to elevation angle.  The 
amount of the slip is computed onboard and is double-checked by the ground.  The 3 min 
early limit is to ensure that manual takeover at MC4 +2 min will occur in sunlight.  The 7 
min late limit is to ensure that the Orbiter will reach 200 ft prior to sunset.  MC2 TIG slips 
can occur with non-nominal trajectories, if Ti is burned such that the resulting trajectory is 
"short" or "long."  Target Set 19 removes the elevation angle constraint and targets MC2 
on time. 

Half Rev Transfers 

Late execution of NCC or MC1 can result in a burn targeted with a near half rev transfer.  
Special caution is required when this scenario occurs.  The problem stems from the fact 
that as the transfer angle approaches 180 deg, the transfer orbit becomes undefined.  
Orbit Targeting handles this case by forcing the transfer orbit to be in the chaser’s orbit 
plane.  Orbit Targeting recognizes this condition whenever the transfer angle is within 9.7 
deg of a half rev (the “180 deg transfer cone”), and sets a flag to alert LCG of this 
condition.  If this burn is targeted just outside the cone, however, LCG will be unaware of 
this condition.  As the burn progresses, the transfer angle will slip into “the cone” and 
divergent VGOs can result, initially in the Y component.  Since only LCG is susceptible to 
this problem, it can be avoided by downmoding to EXDV prior to loading a Lambert burn 
whenever the burn is likely to be executed within ~3 min of a half rev transfer. 

Typical Targeting Alarm Responses 

The response to a targeting alarm can be categorized roughly by the type of alarm, the 
value of PRED MATCH, and the event leading to the alarm (targeting in SPEC 34, during 
LOAD, or during Lambert Guidance).  In general, if the value of PRED MATCH is small 
and Orbit Targeting yields a solution, loading the solution and downmoding to EXDV is 
usually fine.  If PRED MATCH is large, burning the ground solution is the obvious choice.  
If the alarm occurs during LCG, the algorithm automatically zeroes out the VGO_CORR 
term calculated by Lambert, essentially leaving the situation in an EXDV scenario.  That is 
why simply completing the burn is satisfactory in this case. 

TGT ITER 

A TGT ITER alarm indicates that the Orbit Targeting software executed 10 iterations 
without converging on a solution.  In general, this is an indication of a FSW problem or a 
problem with some of the supporting I-loads used by Orbit Targeting. 
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Lambert’s algorithm results in a velocity required to get from one inertial position to 
another over a given transfer time.  It is an iterative routine that, in the Shuttle Flight 
Software, uses a Newton-Raphson iteration scheme.  Normally, the algorithm should 
converge quickly, but if a maximum number of iterations is reached (currently 10), the 
iteration will be terminated and a TGT ITER will result.  A PRED MATCH of 999999 on 
SPEC 34 during targeting is the key indicator that max iterations were reached in the 
LAMBERT routine.  Since a valid ∆V could not be determined, ∆Vs will not be calculated 
and transferred to PEG 7 guidance.  Additionally, since the LAMBERT module is called 
during both Lambert targeting and Lambert guidance, TGT ITER can be scene during both 
burn targeting and execution.  If a TGT ITER is experienced during burn execution, the 
Flight Software will not update the VGOs based on Lambert updates and the burn will 
behave as an EXDV type burn. 

 

Table 5.2-2  TGT ITER Alarm Details 

Alarm 

(PRED 
MATCH) 

Targeting Cause FSSR Task Related FSSR 
Parameters 

     
TGT ITER 

(---) 
Lambert Difference between predicted 

position at T2 (RS_TERMINAL) and 
desired position (RS_T2TIG) could 
not be reduced to or below R_TOL 
in under 10 iterations 

Precision 
Velocity Task 
(PREVR) 

ALARM_A 
N_MAX_ITER 
(V96U7790C) 
R_TOL 
(V96U7789C) 

     
TGT ITER 
(999999) 

Lambert Either of the following did not occur 
in under N_MAX_ITER iterations: 
 
1. | T_TILDA_ERROR | < 

T_TILDA_DESIRED (EPS_U) 
 
2. | U_STEP | ≤ EPS_U 

LAMBERT ALARM_A 
ALARM_KILL 
EPS_U 
(V96U7515C) 
N_MAX_ITER 
(V96U7790C) 

     
TGT ITER 

(---) 
CW Difference between desired and 

predicted relative positions at T2 
has increased 2 iterations in a row 

PROX_TGT_ 
SUP 

ALARM_C 
ERR 
D_MISS1 
D_MISS2 

     
TGT ITER 

(---) 
CW A solution could not be found in 

under N_MAX_ITER iterations for 
which the miss distance is less than 
a computed tolerance -or- the 
solution for any three successive 
iterations out of N_MAX_ITER was 
not less than 0.05 ft/sec 

PROX_TGT_ 
SUP 

ALARM_C 
I_LOW 
N_MAX_ITER 
(V96U7790C) 
R_MAX 

     

 

Assuming the LAMBERT module computes a velocity required successfully (without 
reaching max iterations), this solution is passed up to the Precision Velocity Required task 
(PREVR).  Since the Lambert solution is a conic solution (spherical earth, no drag, etc.), it 
is the job of PREVR to “fly out” the Lambert solution using a high accuracy integrator with 
an oblate earth and atmosphere model.  One this solution is flown out, a miss distance 
from the desired aim point is determined and the aim point is adjusted to compensate for 
this miss distance.  The LAMBERT module is called with the “tweaked” aim point to get a 
new solution.  As before, this new solution is flown out and a new miss distance is 
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computed.  This process continues until the miss distance is less than an I-loaded 
tolerance (RTOL), which is currently set to 250 ft.  If the miss distance does not converge 
to less than the tolerance within 10 iterations, a TGT ITER will be annunciated.  In this 
case, the last computed ∆V will be displayed and passed on to PEG 7 guidance for 
execution and the PRED MATCH will reflect the magnitude of the last computed miss 
distance.  If the PRED MATCH is a reasonably small value, the computed solution can be 
burned.  Note that this type of TGT ITER can only be seen during burn targeting since the 
PREVR routine is not called during Lambert guidance.  

Additional notes:  There is a bug in the LAMBERT module in the Flight Software that has 
previously resulted in slightly erroneous ∆Vs being computed.  These ∆Vs were in error 
enough to cause the PREVR iteration to not converge, and a TGT ITER resulted with a 
PRED MATCH of approximately 350 ft.  This problem was “patched” with an I-load change 
that significantly reduces the probability of the TGT ITER, but can result in a slightly less 
accurate solution: 

 

Old Iloads:  EPS_U = 1e-6   RTOL = 10 

New Iloads:  EPS_U = 1e-7   RTOL = 250 

The Flight Software bug will be fixed in OI-26A, slated for STS-85.  There are currently no 
plans to go back to the old I-loads with the tighter convergence requirements. 

TGT ∆T 

A TGT ∆T alarm occurs when the onboard software tries to compute a solution with a ∆T 
resulting in either a transfer angle near 0 deg or 360 deg (the term "near" is defined by an I 
-loaded value with a present value of ~2 min or ~8 deg), a parabolic transfer, a value near 
a multi-REV transfer time singularity, or an iteration failure in the orthogonal braking logic.  
This alarm is usually an indirect indication of a target set I-load problem. 
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Table 5.2-3  TGT DT Alarm Details 

Alarm 

(PRED 
MATCH) 

Targeting Cause FSSR Task Related FSSR 
Parameters 

     
TGT DT 

(---) 
Lambert Lambert targeting was requested 

(ITEM 28) but the transfer time 
(ITEM 17) and T2 TIG (ITEMs 13-
16) are zero. 

PROX_EXEC ALARM_D 
COMP_PROX_DT 
T2_TIG 

     
TGT DT 
(999999) 

Lambert Pre-iteration normalized transfer 
time (T_TILDA_DESIRED) is 
negative or less than or equal to the 
parabolic transfer time (T_MIN) 

LAMBERT ALARM_D 
ALARM_KILL 

     
TGT DT 
(999999) 

Lambert Transfer Angle is close to 0 or 360 
degrees 

LAMBERT ALARM_D 
ALARM_KILL 
EP_TRANSFER 
(V96U7517C) 

     
TGT DT 
(999999) 

Lambert 
or CW 

Transfer time for orthogonal braking 
could not be found in under 10 
iterations 

OMEGA_DT_ 
COMP 

ALARM_D 
ALARM_KILL 
IC_MAX 
(V96U7517C) 

     
TGT DT 
(999999) 

CW Transfer angle = integral rev, also 
denoted as 1/K < EP_TRANSFER 

OFFSET_TGT ALARM_D 
ALARM_KILL 
EP_TRANSFER 
(V96U7514C) 

     

 

MC2 EL ANG 

An MC2 EL ANG alarm appears during Lambert targeting when the software exceeds the 
maximum number of iterations in planning a burn based upon elevation angle, or when the 
desired elevation angle is not achievable.  Targeting will indicate in ITEM 6 at what angle 
the iteration stopped.  The ∆Vs displayed by ORBIT TGT pertain to the displayed angle.  A 
possible scenario for giving rise to this alarm would be that the current trajectory will be 
short at intercept and will not cross the desired elevation angle.  In the case where the 
trajectory never achieves the subtended angle, the last time iteration is transferred to 
PREVR and a valid solution is returned. The solution is transferred correctly to guidance. 
Standard TIG slip logic should be applied. 
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Table 5.2-4  TGT EL ANG Alarm Details 

Alarm 

(PRED 
MATCH) 

Targeting Cause FSSR Task Related FSSR 
Parameters 

     
TGT EL ANG 

--- 
Lambert Time could not be found in less 

than 10 iterations when target 
position is on the same side 
(above/below) of Orbiter local 
horizontal as desired target 
position specified by I-loaded 
elevation angle 

Elevation Angle 
Search Task 
(TELEV) 

ALARM_B 
DELTA_H 
EL_ANG 
IC_MAX 
(V96U7517C) 

     
TGT EL ANG 

--- 
Lambert Time could not be found in less 

than 10 iterations when the 
elevation angle was within 
EL_TOL of the I-loaded elevation 
angle. 

Elevation Angle 
Iteration Task 
(ELITER) 

ALARM_B 
EL_ERR 
EL_TOL 
(V96U7787C) 
IC_MAX 
(V96U7517C) 

     

 

ILOADs 

On second and subsequent rendezvous attempts, the ILOADs used by Orbit Targeting will 
be different than those stored on the MMUs unless an OPS TRANSITION (mode from 
OPS 2 to OPS 3 or 8, and back) is performed after the first rendezvous attempt.  This is so 
because of the structure of the buffers used by Orbit Targeting.  The contents of the 
ILOAD buffer can be changed by an OPS TRANSITION (loads original ILOADs from 
MMU), a LOAD via ITEM 26 on SPEC 34 (loads contents of DISPLAY buffer into ILOAD 
buffer), or through a successful EL angle search for BURN on EL ANGLE sets (because 
the results of the computation overwrite EL and BASE TIME).  The safest and surest bet is 
to perform an OPS TRANSITION if time permits. 

Unreasonable ∆Vs 

Unreasonable ∆Vs during preliminary targeting may arise (in order of likelihood) through 
inadvertent crew keystrokes missed by the ground, through improper ILOADs due to 
previous rendezvous attempts, or through MMU and/or GPC problems.  The first response 
is to check the TGT Set data for indications of incorrect entries in SPEC 34.  If these can 
be corrected, press.  If not, MMU and/or GPC problems may be the cause. 

Note that large ∆Vs may be observed during the first few seconds of LCG, starting at 
TIG−15 seconds.  This is a known anomaly that was not fixed by crew request; it serves as 
an indication to them that LCG is active. 
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5.3 [Reserved] 
 

 

 

This section formerly dealt with Target Set I-loads for Late Rendezvous.   OI-29 fixes this problem, since 
base times up to 365 days can be entered on SPEC34.  This section is left in the CHB to preserve page 
numbering. 
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This section formerly dealt with Target Set I-loads for Late Rendezvous.   OI-29 fixes this problem, since 
base times up to 365 days can be entered on SPEC34.  This section is left in the CHB to preserve page 
numbering. 
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5.4 Maneuver Monitor 

PURPOSE 

To specify steps to be taken during every the execution of every rendezvous maneuver. 

PROCEDURE 

During Preliminary/Intermediate Targeting 

• Coordinate appropriate TV Roll with FDO to minimize attitude maneuvers both before and after burn. 

• Review FLIGHT PLAN and Predicted Site Acquisition Table (PSAT) for comm coverage during 
burn.  If no comm is expected, prepare Playback request. 

• Monitor the MNVR pad as it is read up/down. 

• Monitor the crew inputs in MM 202 (Engine Select, TV Roll, Trim Load, WT, TIG, ˝Vs) 

• Monitor targeting solutions and record in console log and RENDEZVOUS C/L. 

After Final Solution 

• If RSS of PEG7 components < 0.2 fps, execution of RCS Burn Cue Card is not required. If 
crew has already transitioned to MM202, no action is required.  

• Verify Engine Select (FR 2-56). 

• Select appropriate procedure to monitor (RNDZ OMS BURN plus OMS 2/ORB OMS Cue Card 
or RCS BURN Cue Card) 

If Maneuver to Burn Attitude is Required 

• Verify TV Roll. 

• Determine latest PET at which to begin maneuver and achieve attitude prior to TIG using 0.2 
deg/s and 0.5 deg/s maneuver rates. 

• Monitor attitude maneuver and compute time remaining to achieve burn attitude. 

• At TIG - 00:30:  Confirm proper DAP selection  (If RCS is selected, ensure DAP is NOT in 
AUTO). 

• Watch crew trim out residuals (< 0.2 fps). 
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To Return to Lambert Guidance after Downmode to EXDV 

• Recall SPEC 34 ORBIT TGT SPEC 34 PRO 

• Recall the target set  ITEM 1 + XX 

• Recompute the ˝Vs  ITEM 28 EXEC 

• Resume to MNVR EXEC RESUME 

• LOAD the ˝Vs     ITEM 22 EXEC, ITEM 23 EXEC 

Note:  Burn TIG is automatically set to 1 minute in the future. 

BACKGROUND 

RNDZ GPO is responsible for determining the burn/no-burn status of onboard-targeted burns with 
total delta Vs near the no-burn threshold. 

RPS is responsible for assuring that the proper procedures are followed during a maneuver.  

TARGET and ONAV are responsible for verifying the ˝V attained from the maneuvers. 

Burn/No-burn status for small NCC and midcourse burns 

For small onboard-targeted corrective burns (typically NCC, MC1-3) whose total PEG-7 ˝V falls 
below the 0.2 fps level, it is preferable to avoid the RCS burn procedure completely and remain in 
MM201 through the burn TIG, so that sensor data into nav is not interrupted.  Going to MM202 

and working the burn cue card is not bad, however.  If a PEG-7 ˝V is borderline, it is 
recommended that the crew go to MM202 to check each body VGO. 

In the past, the standard procedure for no-burns had been to stay in MM201 if at all possible, to 
avoid having the crew mode the DAP to LVLH.  In working the old pre-OI29 cue card, very small 
trajectory perturbations are introduced by the act of selecting LVLH/PRI at TIG-30 seconds and 
subsequently returning to AUTO/VERN after the burn.  These small perturbations could have 
incurred a relatively large cost for subsequent burns.  Now, with OI-29, multi-axis burns are 
performed in target track, so it is OK to have the crew go to MM202 and check individual body 
VGOs while eliminating trajectory perturbations.  Time spent in MM202, however, detracts from 
time incorporating data into nav, therefore it is probably best to stay in MM201. 

When RNDZ sees a final targeting solution with an RSS of the PEG7 ˝Vs that is less than 0.2 fps, 
a call will be made to Flight stating that the maneuver is a no-burn and that the RCS Burn Card 
actions are not required. In response, the crew should remain in MM201 with the current REL 
NAV AUTO/INH options in place.  In the event that the crew has already transitioned to MM202 
(either final NCC targeting or just a quick transition after final MC targeting), the call to Flight will 
indicate that the crew may return to MM201.  RNDZ should strive to make the no-burn call prior to 
TIG - 2 minutes, although the transition back to MM201 can be made without impact at any time 
while on the cue card. 
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Engine Select Criteria 

If forward prop is critical, a maneuver to attitude should be performed if more than 2 fps will be 
used out of the forward prop.  The FDO will assess the body VGOs to make this determination 
and coordinate engine selection with PROP.  The general rule for the crew in the event of no 
comm is: 

• ˝V < 4 fps - RCS multiaxis 

• 4 < ˝V < 6 - RCS +X 

• ˝V > 6 fps - 1 OMS 

TV Roll selection 

Commonly used values are 0 and 180 (heads up and heads down).  For off nominal burns at Ti, a 
TV Roll should be selected to maintain radar lock if possible.  The value of TV Roll is determined 
by the right-hand rule about the thrust vector with 0 being heads up (-RBAR).  For burns nearly 
parallel to the RBAR (within 3 degrees), the value of TV Roll is defined by the right-hand rule 
about the �RBAR (which ever is nearly aligned with the Orbiter +X axis), with 0 being along the 
+VBAR.  FDO makes the TV Roll determination usually upon the choice that minimizes 
maneuvers to and from burn attitude. 

Guidance 

Any entries to the left side of MNVR EXEC will cause an automatic downmode from Lambert to 

External ˝V guidance mode.  Recovery is to retarget and reload solution.  Burn TIG is 
automatically advanced to 1 minute in the future. 

Lambert guidance will begin cycling at ~15 seconds prior to TIG causing VGOs to update and will 
continue to compute VGOs every 3.84 seconds during the burn. 

When in OPS 202, ORBIT MNVR EXEC, if the DAP is in AUTO a maneuver to burn attitude will 
be commanded at TIG regardless of whether or not an ITEM 27 MNVR was performed. 

For any burn performed in OPS 202, attitude guidance will compute a burn attitude.  Attitude 
guidance will activate at TIG and will continually update the burn attitude based upon VGO 
remaining and the desired thrust vector.  When TGO=6 seconds, guidance will freeze the burn 
attitude to avoid the possibility of large attitude deviations at the end of the burn due to off-axis 
residuals. 

If RCS is selected (ITEM 4 on ORBIT MNVR EXEC), there is a 'gotcha' in the software that 

checks for TGO<6 AND THC out of detente.  This means that the guidance will perform as 
expected during the burn when the CDR is pushing on the THC; however, as soon as the CDR 
releases the THC (say, at the end of a burn or when DAP TRANS is set to PULSE), attitude 
guidance will update the burn attitude regardless of the TGO.  This means that if the DAP is 
configured to AUTO, attitude maneuvers will be initiated as the burn attitude is updated with each 
pulse. 

If OMS is selected, the only check is for TGO<6, so even though the CDR may trim residuals at 
the end of a burn, the burn attitude will not update and therefore no attitude maneuver will take 
place. 
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Attitude Verification 

The ROSS application Timers displays the time to reach attitude. 

If any ATTITUDE ERROR > 5o at TIG, the burn is NO-GO per GNC's call. 

For EXDV burns, delay until in burn attitude, then proceed with the burn if still within TIG slip 
limits. 

For LAMBERT burns, delay until in burn attitude, retarget, reload, re-maneuver, then proceed with 
the burn if still within TIG slip limits. 

With OI-28 and subs, the 202 Burn Attitude will display yaw = 90 or 270 and blank the roll and 
pitch values if yaw value = �90.  Prior, all three values were blanked. 

Other OMS Burn Considerations 

For an OMS burn, the PRCS attitude deadband is 5�. 
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5.5 TIG Slips 

PURPOSE 

To clarify the effects of TIG slips. 

PROCEDURE 

Slips in EXDV Burns 

• Check with FDO for specific TIG slip capability for upcoming burn 

• Configure DAP as required to avoid unnecessary attitude maneuvers 

• Use DAP: LVLH for NC burns 

• Use DAP: INRTL for NH burns 

• Coordinate slip capability with MCC and crew prior to critical burns 

• Update TIG, if required (check with FDO) 

Slips in Lambert Guided Burns 

• Check with FDO for specific ground-targeted TIG slip capability for upcoming burn 

• Coordinate slip capability with MCC and crew prior to critical burns 

• Retarget with Lambert to update TIG and ûV if burn start has been delayed such that 
the burn will not be completed by 90 seconds after original TIG 

BACKGROUND 

EXDV Burns 

Slips in EXDV burns are driven primarily by the increase in prop and ∆V with increasing 
time.  In some circumstances, there is a point in time where it is cheaper to waive-off a 
burn in favor of modifying a subsequent burn later or a rendezvous the next day.  FDO is 
responsible for computing this trade-off point. 

For EXDV maneuvers, it is typically required to update the burn TIG to a future time.  
When this occurs, the DAP should be placed in LVLH to maintain the LVLH burn attitude 
and avoid maneuvering to the new inertial attitude of the future burn TIG.  When the TIG 
is updated to a future time, the new burn attitude will be close to the old burn attitude in an 
LVLH sense and therefore LVLH hold is the desired DAP configuration.  (NC is typically in 
this category.)  In some instances, however, if there is no need to update the TIG, inertial 
hold is desired to maintain the inertial attitude of the old TIG.   (NH is typically in this 
category.) 
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Lambert Guided Burns 

Slips in Lambert Guided burns are driven primarily by algorithmic shortcomings and 
secondarily by the same considerations as EXDV burns (prop and ∆V).  Due to algorithmic 
shortcuts, the onboard Lambert Cyclical Guidance (LCG) function ∆V solution starts to 
degrade around 2 minutes after TIG.  The errors are a function of the non-conic 
acceleration experienced by the Orbiter with the J2 acceleration being the primary 
perturbing factor.  The change is strongly driven by the orientation of the J2 vector.  To 
protect from unwanted divergence in solution ∆Vs, the time limit for LCG solutions is 90 
seconds, after which the burn should be retargeted with Lambert Targeting.  Lambert 
Targeting resets the TIG to one minute in the future and also does not suffer from the 
algorithmic shortcuts taken in LCG. 
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5.6 Degraded +X RCS Translations 

PURPOSE 

To document the procedures for performing +X burns with combinations of jet failures 
resulting in the loss of one of the aft pods. 

PROCEDURE 

In the context of degraded +X burns, the following teminology is used: 

• Loss of LEFT POD results from loss of RCS jets L1A and L3A; 

• Loss of RIGHT POD results from loss of RCS jets R1A and R3A. 

Degraded +X RCS Rendezvous Burns 

Use OMS if possible (burn large enough, jet losses known in advance, etc.).  However, if 
this is not an option (if loss occurs during a +X RCS burn, for instance), then 

• Stop burn 

• Loss of LEFT POD:  Manually yaw right 19 degrees 

• Loss of RIGHT POD:  Manually yaw left 19 degrees 

• Resume burn 

• Burn VGO X in NORM until VGO X < 0.5 fps (vice 1.0). 

• When burn complete, remain in DAP: PRI until DAP errors and rates are within 
deadbands. 
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BACKGROUND  

The following information was compiled during the STS-66 mission after L3A was lost 
during ET SEP and the potential impacts of an L1A failure were investigated 

Rendezvous Impacts 

For a degraded +X burn, only one jet will fire instead of two (a normal +X translation uses 
one jet from each pod).  Acceleration is cut in half, so all +X burns will require twice as 
much time to complete.  The DAP does not provide any compensation for degraded +X 
translations, so each +X pulse will result in only one-half the loaded TRANS PLS size.  
Degraded  +X burns will induce minus yaw and plus roll (loss of LEFT POD) or plus yaw 
and minus roll (loss of RIGHT POD).  Attitude jets will fire to maintain the attitude, 
resulting in Y translations due to cross-coupling.  The amount and direction of cross-
coupling is highly dependent on the attitude hold DAP mode.  Degraded +X burns also 
increase prop usage. 

Proximity Operations Impacts 

In vernier attitude control, a +X burn will cross-couple into a small amount of minus Y (loss 
of LEFT POD) or plus Y (loss of RIGHT POD) translation.  In PRCS NOSE/TAIL attitude 
control, there is very little cross-coupling of X into Y.  Once stable on the approach axis, 
VRCS is an acceptable mode since the quantity and frequency of +X inputs are reduced 
(in other words, it is easier to accomodate the degraded mode).  Since LOW Z requires 
one jet in each pod, LOW Z is not available with the loss of either pod. 
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6.1 Trajectory Rules of Thumb 

PURPOSE 

To provide the Rendezvous Team with general trajectory information for quick "back of the 
envelope" calculations. 

PROCEDURE 

Orbital Parameters, 160 nmi Orbit 

 

Table 6.1-1  Orbital Parameters for a 160 nmi Orbit 

Parameter Value 

Period: 90.44 min, 5426.71 sec 
Orb rate: 0.06634 deg/sec, 3.98 deg/min, 1.158 mrad/sec 
Velocity: 25353 fps, 4.173 nmi/sec 
Phase: 62.9 nmi/deg 
Sunlight/Darkness: 55/35 min (for Beta = 0o) 
Depression Angle: 17.1o 

 

Delta Velocity Effects, 160 nmi Orbit 

 

Table 6.1-2  ûV Requirements for a 160 nmi Orbit 

Parameter Value 

Plane change: 442 fps/deg 
Node change: 220 fps/deg (28.5o incl.) 
Altitude change: 1.76 fps/nmi (one side of orbit) 
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Table 6.1-3  Trajectory for a 1 fps Burn in a 160 nmi Orbit 

 Downrange in 1 rev Radial in 1/2 rev 

(Altitude change) 

1 fps Posigrade 16280 ft 3455 ft 
 2.7 nmi 0.57 nmi 
 5.0 km 1.0 km 

 Downrange in 1/2 rev Radial in 1/4 rev 

(Altitude change) 

1 fps Radial 3455 ft 864  ft 
 0.57 nmi 0.14 nmi 
 1.0 km 0.26 km 

 OOP in 1/4 rev  

1 fps Out of Plane 864  ft  
 0.14 nmi  
 0.26 km  

 

Delta Height Effects, 160 nmi Orbit 

 

Table 6.1-4  Constant Height Offset Relationships Based on a 160 nmi Coelliptic Orbit 

Quantity Relationship vs ∆H Rule of Thumb 

Downrange Displacement (xx/rev): 3π * ∆H (xx) 10 * ∆H (xx) 
Coelliptic Velocity (xx/sec): 3/2 * ω (rad/sec) * ∆H (xx) ∆H (xx) / 600 

 

Table 6.1-5  Cusp Trajectory Relationships Based on a 160 nmi Coelliptic Orbit 

Quantity Relationship vs ∆H 

Downrange Displacement (xx/rev): 12π * ∆H (xx) 
∆Period: 2.26 (sec/rev) * ∆H (nmi) 
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Phasing Rates, 160 nmi Orbit 

 

Table 6.1-6  Phasing Rate Relationships Based on a 160 nmi Orbit 

Parameter Value 

∆Θ (nmi/rev): 2.68 * ∆V (fps) (same initial orbit) 

∆Θ (xx/rev): 4.7 * ∆H (xx) (coapsidal orbits) 

∆Θ (o/hr): ∆H (nmi) / 10 (coelliptic orbits) 

∆Θ (o/rev): 0.15 * ∆H (nmi) (coelliptic orbits) 

∆Θ (nmi/rev): 9.45 * ∆H (nmi) (coelliptic orbits; 1o = 63 nmi @ 160 alt) 
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Altitude Effects 

Down Range Position per Rev due to 
1 fps Burn vs Altitude
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Figure 6.1-1  Downrange Displacement vs Altitude 

Depression Angle vs Altitude
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Figure 6.1-2  Depression Angle vs Altitude 
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Period vs Altitude
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Figure 6.1-3  Orbital Period vs Altitude 

Orb Rate vs Altitude

1.06

1.08

1.1

1.12

1.14

1.16

1.18

100 140 180 220 260 300 340 380

Altitude (nmi)

 
Figure 6.1-4  Orbital Rate vs Altitude 
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6.2 Relative Motion 

PURPOSE 

To provide the Rendezvous Team with relative motion time histories for quick "back of the 
envelope" calculations. 

PROCEDURE 

Optimal Manual Phase Approach 

The Optimal Manual Phase Approaches contained below were developed using a 
Clohessy-Wiltshire (CW) formulation with no atmospheric drag at an orbital altitude of 210 
nmi.  Three approaches are addressed: 

• Standard RBAR trajectory from MC4 to 250 feet CG-to-CG separation 

• ORBT RBAR trajectory from MC4 to 250 feet CG-to-CG separation 

• ORBT RBAR with TORVA trajectory from MC4 to VBAR arrival 

The Standard RBAR trajectory is that based upon the existing Stable Orbit Rendezvous 
(SOR) profile with Ti located at 1200 feet above the VBAR, 48600 feet trailing, and with a 
designed RBAR state at 600 feet below the target traveling at 0.8 fps closing.  Manual 
phase is constrained by not allowing the target to drop below 15 degrees, performing an 
ideal +X burn to stop motion at subsequent RBAR crossing, and pumping Zdot per the 
standard RBAR braking gates. 

The ORBT RBAR trajectory is that based upon an Optimized RBAR Targeting (ORBT) 
profile with Ti below the VBAR and with Ti and midcourse corrections designed to achieve 
an RBAR state of 600 feet below the target traveling at 0.8 fps closing.  The ORBT design 
itself highly optimizes manual phase with little or no burns required between the last 
midcourse correction burn and RBAR arrival. 

The ORBT RBAR with TORVA trajectory is that based upon the above with an initiation of 
a Twice Orbit rate RBAR to VBAR transition (TORVA) at 500 feet on the RBAR and ending 
upon VBAR arrival around 300 feet leading the target.  No Rdot logic is invoked during the 
TORVA itself by design. 
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Table 6.2-1  Standard RBAR Approach to 250 ft CG-CG (170 IF-IF), 210 nmi Orbit 

MC2 
time 
(min) 

Delta 
Xdot 
(fps) 

Delta 
Zdot 
(fps) 

X(t) (ft) Z(t) (ft) Xdot 
(fps) 

Zdot 
(fps) 

Range 
(ft) 

Rdot 
(fps) 

Θ (rad) Θ dot 
(rad/s) 

20.0 0.00 0.00 -1378 4438 7.14 -6.84 4647 -8.64 1.87 -1.030 
21.0 0.00 0.00 -978 4030 6.21 -6.76 4147 -8.04 1.81 -1.071 
22.0 0.00 0.00 -633 3627 5.30 -6.66 3682 -7.47 1.74 -1.106 
23.0 0.00 0.00 -342 3231 4.40 -6.53 3250 -6.95 1.68 -1.135 
24.0 0.00 0.00 -105 2845 3.52 -6.36 2847 -6.49 1.61 -1.154 
25.0 0.00 0.00 81 2469 2.67 -6.17 2470 -6.08 1.54 -1.161 
26.0 0.00 0.00 216 2105 1.84 -5.94 2116 -5.73 1.47 -1.154 
27.0 0.21 1.61 313 1816 1.39 -4.11 1843 -3.81 1.40 -1.125 
28.0 -0.70 0.00 342 1579 0.16 -3.78 1616 -3.66 1.36 -0.590 
29.0 0.24 1.00 344 1390 -0.04 -2.44 1432 -2.37 1.33 -0.385 
30.0 0.00 0.00 332 1254 -0.34 -2.11 1297 -2.12 1.31 -0.159 
31.0 0.00 0.00 303 1138 -0.61 -1.76 1178 -1.86 1.31 0.113 
32.0 0.00 0.00 260 1042 -0.82 -1.41 1074 -1.57 1.33 0.425 
33.0 0.00 0.00 205 968 -0.99 -1.06 990 -1.24 1.36 0.759 
34.0 0.00 0.00 142 916 -1.11 -0.70 927 -0.86 1.42 1.070 
35.0 0.00 -0.35 73 877 -1.20 -0.68 880 -0.78 1.49 1.295 
36.0 1.29 -0.47 1 833 -0.01 -0.79 833 -0.79 1.57 0.007 
37.0 0.11 -0.19 1 786 -0.01 -0.79 786 -0.79 1.57 0.007 
38.0 0.11 -0.18 0 739 0.00 -0.79 739 -0.79 1.57 0.006 
39.0 0.11 -0.17 0 691 0.00 -0.79 691 -0.79 1.57 0.006 
40.0 0.11 -0.16 -1 644 0.00 -0.79 644 -0.79 1.57 0.006 
41.0 0.11 -0.13 -1 597 0.00 -0.78 597 -0.78 1.57 0.005 
42.0 0.10 0.00 -1 554 0.00 -0.65 554 -0.65 1.57 0.003 
43.0 0.08 0.00 -1 519 0.00 -0.52 519 -0.52 1.57 0.001 
44.0 0.07 -0.08 -1 489 0.00 -0.49 489 -0.49 1.57 0.001 
45.0 0.06 -0.08 -1 460 0.00 -0.46 460 -0.46 1.57 0.000 
46.0 0.06 -0.08 -1 434 0.00 -0.43 434 -0.43 1.57 -0.001 
47.0 0.06 -0.07 -1 409 0.00 -0.41 409 -0.41 1.57 -0.001 
48.0 0.05 -0.07 -1 385 0.00 -0.38 385 -0.38 1.57 -0.002 
49.0 0.05 -0.06 -1 363 0.00 -0.36 363 -0.36 1.57 -0.003 
50.0 0.05 -0.06 -1 342 0.00 -0.34 342 -0.34 1.57 -0.003 
51.0 0.04 -0.06 -1 322 0.00 -0.32 322 -0.32 1.57 -0.004 
52.0 0.04 -0.05 -1 304 0.00 -0.30 304 -0.30 1.57 -0.004 
53.0 0.04 -0.04 -1 286 0.00 -0.27 286 -0.27 1.57 -0.004 
54.0 0.03 0.00 -1 272 0.00 -0.21 272 -0.21 1.57 -0.005 
55.0 0.02 0.00 -1 261 0.00 -0.15 261 -0.15 1.57 -0.006 
56.0 0.02 0.00 -1 254 0.00 -0.09 254 -0.09 1.57 -0.006 
57.0 0.01 0.00 0 251 0.00 -0.03 251 -0.03 1.57 -0.006 
Total 3.87 5.37         

 
   = RBAR +/-X logic     = braking gates  

           
    = RBAR -Z logic       

 

Note:  Table starts with post-MC4 burnout vector at MC2 + 20 min and ends at the 
beginning of the 250-ft CG-CG (170-ft IF-IF) stationkeeping point. 
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Table 6.2-2  ORBT RBAR Approach to 250 ft CG-CG (170 IF-IF), 210 nmi Orbit 

MC2 
time 
(min) 

Delta 
Xdot 
(fps) 

Delta 
Zdot 
(fps) 

X(t) (ft) Z(t) (ft) Xdot 
(fps) 

Zdot 
(fps) 

Range 
(ft) 

Rdot 
(fps) 

Θ (rad) Θ dot 
(rad/s) 

27.0 0.00 0.00 -900 1800 2.69 -2.07 2012 -3.05 2.03 -0.736 
28.0 0.00 0.00 -747 1677 2.41 -2.01 1836 -2.82 1.99 -0.754 
29.0 0.00 0.00 -610 1558 2.14 -1.95 1674 -2.60 1.94 -0.767 
30.0 0.00 0.00 -490 1444 1.88 -1.88 1524 -2.38 1.90 -0.773 
31.0 0.00 0.00 -384 1333 1.63 -1.79 1388 -2.18 1.85 -0.772 
32.0 0.00 0.00 -294 1229 1.39 -1.70 1263 -1.98 1.81 -0.760 
33.0 0.00 0.00 -217 1129 1.17 -1.60 1150 -1.80 1.76 -0.735 
34.0 0.00 0.00 -153 1036 0.96 -1.50 1047 -1.62 1.72 -0.695 
35.0 0.00 0.00 -102 950 0.76 -1.39 955 -1.46 1.68 -0.638 
36.0 0.00 0.00 -62 870 0.58 -1.27 872 -1.30 1.64 -0.562 
37.0 0.00 0.00 -32 798 0.42 -1.14 798 -1.16 1.61 -0.465 
38.0 0.00 0.00 -11 733 0.27 -1.01 733 -1.01 1.59 -0.348 
39.0 0.00 0.00 1 677 0.14 -0.87 677 -0.87 1.57 -0.212 
40.0 0.00 -0.06 6 628 0.03 -0.79 628 -0.79 1.56 -0.062 
41.0 0.05 -0.08 6 581 -0.02 -0.73 581 -0.73 1.56 0.024 
42.0 0.09 0.00 4 541 -0.02 -0.60 541 -0.60 1.56 0.021 
43.0 0.08 -0.03 3 509 -0.01 -0.51 509 -0.51 1.56 0.019 
44.0 0.07 -0.09 3 480 -0.01 -0.48 480 -0.48 1.57 0.017 
45.0 0.06 -0.08 2 452 -0.01 -0.45 452 -0.45 1.57 0.015 
46.0 0.06 -0.08 1 426 -0.01 -0.42 426 -0.42 1.57 0.013 
47.0 0.06 -0.07 1 401 -0.01 -0.40 401 -0.40 1.57 0.012 
48.0 0.05 -0.07 1 378 0.00 -0.38 378 -0.38 1.57 0.010 
49.0 0.05 -0.06 0 357 0.00 -0.35 357 -0.35 1.57 0.008 
50.0 0.05 -0.06 0 336 0.00 -0.33 336 -0.33 1.57 0.006 
51.0 0.04 -0.06 0 317 0.00 -0.31 317 -0.31 1.57 0.005 
52.0 0.04 -0.05 0 298 0.00 -0.30 298 -0.30 1.57 0.003 
53.0 0.04 -0.03 0 282 0.00 -0.25 282 -0.25 1.57 0.002 
54.0 0.03 0.00 0 268 0.00 -0.19 268 -0.19 1.57 0.000 
55.0 0.02 0.00 0 259 0.00 -0.13 259 -0.13 1.57 -0.002 
56.0 0.01 0.00 0 253 0.00 -0.07 253 -0.07 1.57 -0.003 
57.0 0.01 0.00 0 250 0.00 -0.01 250 -0.01 1.57 -0.004 
Total 0.98 1.13         

 
   = RBAR +/-X logic     = braking gates  

           
    = RBAR -Z logic       

 

Note:  Table starts with post-MC4 burnout vector at MC2 + 27 min and ends at the 
beginning of the 250-ft CG-CG (170-ft IF-IF) stationkeeping point. 
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Table 6.2-3  ORBT TORVA Approach to VBAR Arrival, 210 nmi Orbit 

MC2 
time 
(min) 

Delta 
Xdot 
(fps) 

Delta 
Zdot 
(fps) 

X(t) (ft) Z(t) (ft) Xdot 
(fps) 

Zdot 
(fps) 

Range 
(ft) 

Rdot 
(fps) 

Θ (rad) Θ dot 
(rad/s) 

27.0 0.00 0.00 -900 1800 2.69 -2.07 2012 -3.05 2.03 -0.736 
28.0 0.00 0.00 -747 1677 2.41 -2.01 1836 -2.82 1.99 -0.754 
29.0 0.00 0.00 -610 1558 2.14 -1.95 1674 -2.60 1.94 -0.767 
30.0 0.00 0.00 -490 1444 1.88 -1.88 1524 -2.38 1.90 -0.773 
31.0 0.00 0.00 -384 1333 1.63 -1.79 1388 -2.18 1.85 -0.772 
32.0 0.00 0.00 -294 1229 1.39 -1.70 1263 -1.98 1.81 -0.760 
33.0 0.00 0.00 -217 1129 1.17 -1.60 1150 -1.80 1.76 -0.735 
34.0 0.00 0.00 -153 1036 0.96 -1.50 1047 -1.62 1.72 -0.695 
35.0 0.00 0.00 -102 950 0.76 -1.39 955 -1.46 1.68 -0.638 
36.0 0.00 0.00 -62 870 0.58 -1.27 872 -1.30 1.64 -0.562 
37.0 0.00 0.00 -32 798 0.42 -1.14 798 -1.16 1.61 -0.465 
38.0 0.00 0.00 -11 733 0.27 -1.01 733 -1.01 1.59 -0.348 
39.0 0.00 0.00 1 677 0.14 -0.87 677 -0.87 1.57 -0.212 
40.0 0.00 -0.06 6 628 0.03 -0.79 628 -0.79 1.56 -0.062 
41.0 0.05 -0.08 6 581 -0.02 -0.73 581 -0.73 1.56 0.024 
42.0 0.10 -0.10 4 539 -0.02 -0.69 539 -0.69 1.56 0.022 
43.0 1.24 -0.12 3 498 1.12 -0.69 498 -0.69 1.56 -2.268 
44.0 -0.07 0.01 66 455 0.95 -0.72 460 -0.58 1.43 -2.274 
45.0 -0.05 0.01 118 412 0.80 -0.73 428 -0.48 1.29 -2.272 
46.0 -0.03 0.01 163 368 0.68 -0.73 402 -0.39 1.15 -2.270 
47.0 -0.01 0.01 200 324 0.57 -0.73 381 -0.32 1.02 -2.269 
48.0 0.00 0.00 231 281 0.47 -0.73 364 -0.26 0.88 -2.268 
49.0 0.01 -0.01 256 237 0.38 -0.73 349 -0.22 0.75 -2.267 
50.0 0.01 -0.01 276 193 0.28 -0.73 337 -0.19 0.61 -2.267 
51.0 0.01 -0.01 290 149 0.19 -0.74 326 -0.17 0.47 -2.267 
52.0 0.00 0.00 299 105 0.09 -0.73 317 -0.16 0.34 -2.268 
53.0 0.00 0.00 301 62 -0.01 -0.71 307 -0.15 0.20 -2.269 
54.0 0.00 0.01 298 20 -0.11 -0.69 298 -0.15 0.07 -2.270 
55.0 0.00 0.67 289 -1 -0.15 0.00 289 -0.15 0.00 0.003 
Total 1.58 1.11         

 
   = start/stop TORVA     = braking gates  

           
   = TORVA maintenance logic  

 

Note:  Table starts with post-MC4 burnout vector at MC2 + 27 min and ends after 
stabilizing on the VBAR. 
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Figure 6.2-1  Relative Motion Plot of Optimal Manual Phase Approaches to 600 feet 
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Figure 6.2-2  Relative Motion Plot of TORVA and RBAR Approaches from 600 feet 
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Effects of a 1 fps Burn 

The following chart details the relative motion achieved by a 1 fps posigrade burn. 

Time X(t) Z(t) Range Xdot Zdot Rdot Reverse sign of X and Z
(min) (f t) (f t) (f t) (f ps) (f ps) (f ps) for Retrograde burn

0 0 0 0 1.00 0.00 1.00
1 60 -4 60 0.99 -0.14 1.00
2 119 -16 120 0.96 -0.27 0.99
3 175 -37 179 0.92 -0.41 0.98
4 228 -65 237 0.85 -0.54 0.97
5 277 -101 295 0.77 -0.67 0.95
6 320 -145 352 0.67 -0.79 0.94
7 357 -196 408 0.55 -0.92 0.93
8 387 -255 463 0.42 -1.04 0.92
9 407 -321 518 0.27 -1.15 0.93
10 419 -393 574 0.11 -1.26 0.94
11 420 -471 632 -0.07 -1.36 0.97
12 410 -556 691 -0.26 -1.46 1.02
13 389 -646 754 -0.47 -1.55 1.09
14 354 -742 822 -0.68 -1.63 1.18
15 307 -842 896 -0.91 -1.70 1.29
16 245 -946 977 -1.15 -1.77 1.43
17 169 -1054 1068 -1.39 -1.83 1.59
18 78 -1166 1168 -1.64 -1.88 1.77
19 -28 -1280 1280 -1.90 -1.92 1.97
20 -150 -1396 1404 -2.17 -1.96 2.18
25 -1003 -1993 2231 -3.52 -1.98 3.35
30 -2257 -2563 3415 -4.81 -1.78 4.52
35 -3871 -3042 4923 -5.90 -1.38 5.49
40 -5763 -3374 6678 -6.65 -0.81 6.15
45 -7820 -3521 8576 -6.99 -0.16 6.44
50 -9910 -3467 10499 -6.86 0.52 6.31
55 -11895 -3218 12322 -6.30 1.13 5.78
60 -13651 -2802 13935 -5.35 1.62 4.92
65 -15080 -2266 15250 -4.14 1.92 3.81
70 -16122 -1674 16209 -2.80 2.00 2.57
75 -16760 -1091 16796 -1.47 1.85 1.35
80 -17025 -585 17035 -0.33 1.49 0.28
85 -16988 -215 16989 0.51 0.96 -0.52
90 -16758 -22 16758 0.95 0.32 -0.95
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Figure 6.2-3  Relative Motion Effects of a 1 fps Posigrade Burn, 210 nmi Orbit 

                   



SHUTTLE OPS RESP: T. Rickerl Relative Motion 
RNDZ CHB/DM-CH-08 REV B: 1/15/02 SCP 6.2 

Verify this is correct version before use.  6.2-7 

The following chart details the relative motion achieved by a 1 fps radial burn. 

Time X(t) Z(t) Range Xdot Zdot Rdot Reverse sign of X and Z
(min) (ft) (ft) (ft) (fps) (fps) (fps) for Radial up burn

0 0 0 0 0 1.00 1.00
1 4 60 60 0.14 1.00 1.00
2 16 120 121 0.27 0.99 1.02
3 37 179 182 0.41 0.98 1.04
4 65 237 246 0.54 0.96 1.07
5 101 294 311 0.67 0.94 1.11
6 145 350 379 0.79 0.92 1.15
7 196 404 449 0.92 0.89 1.20
8 255 457 523 1.04 0.86 1.25
9 321 507 600 1.15 0.82 1.31

10 393 555 680 1.26 0.78 1.36
11 471 600 763 1.36 0.73 1.42
12 556 643 850 1.46 0.68 1.47
13 646 682 940 1.55 0.63 1.52
14 742 719 1033 1.63 0.58 1.57
15 842 752 1128 1.70 0.52 1.62
16 946 781 1227 1.77 0.46 1.66
17 1054 807 1328 1.83 0.40 1.70
18 1166 829 1431 1.88 0.34 1.73
19 1280 848 1535 1.92 0.27 1.75
20 1396 862 1641 1.96 0.21 1.77
25 1993 874 2176 1.98 -0.13 1.76
30 2563 786 2681 1.78 -0.45 1.57
35 3042 607 3102 1.38 -0.72 1.21
40 3374 359 3393 0.81 -0.91 0.71
45 3521 70 3522 0.16 -1.00 0.14
50 3467 -227 3475 -0.52 -0.97 -0.45
55 3218 -499 3256 -1.13 -0.82 -0.99
60 2802 -713 2891 -1.62 -0.59 -1.42
65 2266 -845 2419 -1.92 -0.29 -1.70
70 1674 -881 1891 -2.00 0.05 -1.79
75 1091 -815 1362 -1.85 0.38 -1.71
80 585 -656 879 -1.49 0.67 -1.49
85 215 -422 474 -0.96 0.88 -1.22
90 22 -139 141 -0.32 0.99 -1.02
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Figure 6.2-4  Relative Motion Effects for a 1 fps Radial Burn, 210 nmi Orbit 
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The following chart details the near-field relative motion achieved by a 1 fps burn at various 
angles relative to the VBAR.  All of these have some degree of posigrade component, so reverse 
the signs for retrograde motion. 

Effects of a 1 fps burn at various angles
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Figure 6.2-5  Relative Motion Effects for 1 fps Burns at Various Angles, 210 nmi Orbit 
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6.3 Rendezvous Delay 

PURPOSE 

To specify the procedures to follow in the event that a rendezvous delay is required. 

PROCEDURE 

Prop Assessment 

Assess prop available and time required for delay and recommend where to delay, at Ti versus 
prox ops. 

• Ti delay cost ≈ 6 fps, 150 - 200 lbs. 

• Prox ops stationkeeping costs ≈ 175 lbs/rev. 

 

General rules of thumb: 

• If delay time required is greater than 1 hour, perform Ti delay. 

• If delay time required is less than 1 hour, delay can be accommodated with prox ops 
stationkeeping. 

• If delay time required is uncertain, a Ti delay is preferred to preserve options and save prop in 
the event a breakout and second rendezvous attempt may be needed. 

• Make decision to delay as early as possible and stick to that decision; make it no later than Ti 
TIG -10 minutes. 

Note: For a loss of communication case, the LOSS OF COMM procedure in the Rendezvous 
Checklist instructs the crew to perform a Ti Delay if a ”go for Ti” is not received from the MCC by 
Ti TIG - 5 minutes. 

Note:  Check flight-specific FLIGHT RULES ANNEX for specific rules governing Ti Delay versus 
prox ops stationkeeping. 

Pre-Burn Actions 

• Ensure entire FCR is aware of choice of Ti burn. 

• Verify burn pad with FDO. 

• RNDZ from behind:  Ti Delay ˝V ≈ Ti ˝V + 3 fps ˝Vx. 

• RNDZ from in front:  Ti Delay ˝V ≈ Ti ˝V – 3 fps ˝Vx. 

• Send crew to Ti Delay procedure on page 5-25 of the RENDEZVOUS C/L. 

• Perform SCP 5.4 MANEUVER MONITOR. 
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Post-Burn Actions 

• Maneuver to target track attitude. 

• Establish/maintain navigation. 

• Get new BASE TIME to crew. 

• Assess Post-Ti NAV - star tracker or radar? 

• Assess need for a second NCC. 

• Reset MCC PET timer counting to Ti TIG. 

Prox Ops Stationkeeping 

Ensure entire team is aware of choice of stationkeeping and provide FD and PROP with estimates 
of prop usage.   See SCP 7.2 STATIONKEEPING for more information. 

• VBAR in LOW Z ≈F 175 lbs/rev 

• VBAR in NORM Z ≈F 101 lbs/rev 

• RBAR ≈ 110 lbs/rev + ∆height (ft) * 0.5 (lbs/rev) 

• Inertial ≈ 110 lbs/rev + Range (ft) * 0.5 (lbs/rev) * 0.7 

BACKGROUND 

Orbiter and/or payload system anomalies may induce a significant delay into the planned 
rendezvous.  Such delays can be accommodated prior to entering onto the rendezvous, at Ti via a 
Ti delay, or post-Ti via prox ops stationkeeping. 

Delay prior to day of rendezvous 

The most convenient way to delay a rendezvous is to slow the catch-up rate such that the Orbiter 
makes a rendezvous with the target at the desired time.  This can be done at any planned phasing 
MNVR (NC), typically with no propellant penalty, or an additional maneuver can be inserted into 
the rendezvous profile.  Mission activities and propellant budgets will determine which option to 
use. 

Delay at Ti 

If it becomes inconvenient to slow the phasing prior to Ti, continue the nominal rendezvous profile 
and delay at Ti.  Ti is the last point at which the RNDZ can be delayed prior to entering into prox 
ops.   

Should a situation arise prior to execution of the Ti burn that requires a delay in the completion of 
the rendezvous, performing the Ti Delay burn places the Orbiter in a safe trajectory relative to the 
target.  This allows the crew and ground to assess the status of the problem and decide whether 
or not to continue with the rendezvous. 
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Short term delay at Ti point 

For short delays (one or two revs), the ground will compute a phasing maneuver to return to the Ti 
position (football) based on the most current onboard relative state and will voice the MNVR target 
sets to the crew during the RNDZ sequence.  Desirable lighting conditions will be maintained as 
long as there is an integral number of revs between the original and new Ti MNVR.  The crew has 
expressed an interest in remaining at least 6 nmi. from the target when Ti is positioned at 8 nmi.; 
the ground can easily accommodate this desire. 

Unfortunately, there is a propellant penalty for executing a Ti delay when rendezvousing from 

behind.  The magnitude of this penalty, due only to the extra ˝V required, is ~6 ft/sec (an extra ~3 
fps to initiate the delay plus ~3 fps to start again).  There is no penalty when rendezvousing from 
in front. 

Long Delay at Ti Point 

A long delay (greater than two revs) requires an opening rate to eliminate the need for the crew to 
continuously monitor the target.  Long delays usually involve at least one crew sleep cycle.  
Typically, if propellant is available, the delay MNVR would be targeted to the point where the last 
phasing MNVR was executed (~40 nmi. trailing).  

Post Ti-Delay-Burn Activities 

If Ti delay has been performed, a number of activities will occupy the extra 90 minutes. 

First, the cause of the Ti delay may impact the timing and order of the RNDZ activities to perform 
post-Ti.  For instance, if the delay requires an OPS 2-8-2 transition, performing the BASE TIME 
load prior to the transition is a wasted effort; it will have to be repeated after the transition.  
Therefore, the RNDZ team must be aware of the immediate activities and respond flexibly and 
accordingly. 

Second, retargeting Ti with the new base time received from the MCC will restart the GNC 
counter.  As a first approximation, add 90 minutes to the old base time.  Set the systems 
management (SM) timer to the next burn. 

If there has not been good radar tracking pre Ti, the MCC will advise the crew to perform a STRK 
pass post Ti.  Note that the Ti DELAY procedure states where the RENDEZVOUS C/L should be 
reentered after the Ti Delay burn.  

Two Revs to Ti Transfers 

Given sufficient notice of an impending delay, FDO and RGPO may decide to recommend 
modification of the rendezvous profile such that two revs rather than one occur between NC4 and 
Ti.  This technique has various pros, such as the addition of an extra star tracker pass and 
reduced prop cost for the day.  However, two negative aspects are that a two rev to Ti transfer 
changes the rendezvous profile in ways the crew may not have seen in their training, and the 
RGPO team will have to uplink numerous changes to the rendezvous timeline.  In addition, the 
flight control team would have to ensure the NCC burn was not attempted on the first rev, since 
the transfer time expected by Lambert targeting would be wrong.   

These pros and cons should be considered carefully when making the decision real-time. In 
general, the most benign and accepted means by which to delay a rendezvous is via a Ti Delay, 
since the crew can go hands off during that time to work systems malfuntions, etc.  

Prox Ops Delay (via Stationkeeping) 

See SCP 7.2 STATIONKEEPING. 
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6.4 Breakout 

PURPOSE 

To specify the procedures to follow in the event that a breakout is required. 

PROCEDURE 

• Coordinate with FDO on type of breakout to be performed 

• Ensure everyone is aware of decision to perform a breakout 

• If in prox ops, ensure that crew keeps target along -Z axis and nulls any closing rate 

• Log PET of breakout decision and type of breakout required 

• Direct crew to proper breakout procedure (Rendezvous Breakout, Shuttle Nose In-
Plane Breakout, a flight-specific breakout, or, if time permits, a modified Prox Ops 
breakout that minimizes plume effects on the payload) 

• Monitor crews execution of breakout procedure 

• Disable Rendezvous Nav and evaluate potential for another rendezvous attempt on 
subsequent flight days 

BACKGROUND 

Maintain awareness as to the type of breakout that may be required at all times during the 
rendezvous.  It is a good idea for the Rendezvous team to cross-check each other at various 
stages of the rendezvous to determine the kind of breakout to perform if a breakout is required at 
that stage. 
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6.5 Planar Control 

PURPOSE 

To specify the procedures to control planar motion. 

PROCEDURE 

• Determine time to next planar crossing.  Use one of the six available options listed in the 
BACKGROUND section. 

• Ross application: Time To ATT/OPP  

• SPEC 33 Display  

• Exact Equations 

• Rough Equations when Closing on a Node 

• Full-Range “Spider” Chart 

• Final 10 Minutes Chart 

• Null Ydot when Y = 0 (Y firings cost ~35 lbs/fps). 

Next Planar Crossing 

Reference one of the following six means to obtain the time to the next planar crossing. 

Option 1:  ROSS application Time To ATT/OPP 

The ROSS application “Time to ATT/OPP” displays the time to node, out of plane (OPP) velocity  
at node, current OPP velocity, current OPP position and maximum OPP position:  

 

  

Figure 6.5-1  ROSS Time To ATT/OOP display   
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Option 2:  SPEC 33 Display 

Starting with OI-30 the time to nodal crossing is displayed on SPEC 33 (downlinked parameter). 

  

  

Figure 6.5-2  SPEC 33 Time to Nodal Crossing  

Option 3:  Exact Equations  

For Y and Ydot having opposite signs (i.e., approaching a nodal crossing), the time in minutes to 
the next nodal crossing is given by the following equations: 
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Equation 6.5-1 

 

where Y is in ft, Ydot is in ft/s (any consistent unit can be used in place of ft in both),  ̒(orb rate) is 
in rad/s, and T (orb period) is in minutes. 

For Y and Ydot having the same sign (i.e., departing from a nodal crossing): 
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Equation 6.5-2
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Option 4:  Rough Equation, Closing on Node 

For Y and Ydot having opposite signs (i.e., approaching a nodal crossing), the approximate time 

in minutes to the upcoming nodal crossing is given by the following equation: 
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Equation 6.5-3 

 

where Y is in ft and Ydot is in ft/s (any consistent distance unit can be used in place of ft in both) 

Option 5:  Full Range "Spider" Chart 

Time Until Next Planar Crossing (min)
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Figure 6.5-3 Time Until Next Planar Crossing, Full Range 

How to use: 

•  Locate current value of Y in kft (km) along the horizontal axis; 

•  Locate current value if Ydot in ft/s (m/s) along the vertical axis; 

•  Determine intersection of Y and Ydot and read (or interpolate) the value of t in minutes. 
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Option 6:  Final 10 Minutes Chart 

Time Until Next Planar Crossing (min)
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Figure 6.5-4  Time Until Next Planar Crossing, Final 10 Minutes 

Use this chart when Y and Ydot have opposite signs.  For the purposes of this chart, negate both 
Y and Ydot if Y is negative and Ydot is positive.  Use a consistent distance unit in both Y and 
Ydot. 

•  Locate appropriate value of Y in ft (m) along the horizontal axis; 

•  Locate appropriate value of Ydot in ft/s (m/s) along the vertical axis; 

•  Determine intersection of Y and Ydot and read (or interpolate) the value of t in minutes. 

                   



SHUTTLE OPS RESP: J. Spehar Vents and Dumps 
RNDZ CHB/DM-CH-08 REV B: 1/15/02 SCP 6.6 

Verify this is correct version before use.  6.6-1 

6.6 Vents and Dumps 

PURPOSE 

To specify the effects of Orbiter vents and dumps on the relative trajectory and actions to be 
taken by the Rendezvous team. 

PROCEDURE 

Venting an Auxiliary Power Unit (APU) 

• Pre-Ti:  vent out-of-plane 

• Post-Ti:  vent in-plane 

Water Dumps 

• Flash Evaporator System (FES):  anytime from a trajectory standpoint (may be 
payload constraints, however) 

• Waste/Supply Water Dump:  never during a rendezvous 

Unknown Vent 

If the relative trajectories of the Orbiter and target have unexplained motions, check the 
following: 

• FDO:  Is the target drag correct? 

• PAYLOADS:  Is the target venting anything? 

• PROP:  Are there any prop leaks? 

BACKGROUND 

APU 

To avoid trajectory impacts, APU burns should be performed out of plane to negate 
possible down-range errors.  However, post-Ti, this cannot be done without impacting 
sensors, so the ∆V hit must be taken in plane and then corrected with the MC burns. 

The thrust of an APU burn oscillates between ~4 and ~12 lbs in the +Z direction can 
introduce a significant ∆V of several ft/s over an hour period.  Specifically, the APUs vent 
4 lbf in OPS 2 and 21 lbf in OPS 8.   Also note that the Water Spray Boilers kick on after 
the first ten minutes when the APUs are driving aerosurfaces.  That adds 2 lbf and 3 lbf, 
respectively.  These numbers translate into roughly 2 fps per hour in OPS 2 and 12 fps per 
hour in OPS 8. 

The APU houses two chemical reactions that produce hydrogen and nitrogen.  
Contamination of the target vehicle with this exhaust should be looked at real-time.  Also 
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note that ammonia may also be vented if the second chemical reaction is not working 
properly. 

Note that it is unlikely that an APU will be burned during a RNDZ because, if the leak is 
tiny, burning the APU can be delayed, and if the leak is large, it can be expected that the 
RNDZ will be terminated with the appropriate breakout, followed by APU burn and deorbit 
prep. 

See MALFUNCTION, APU/HYD SSR-5 and ORB OPS, DPS G2-G8 and G8-G2 for 
applicable procedures. 

Water Dumps 

The FES releases water at very slow rates with little or no perturbing effects on the Orbiter.  
Also, the water released does not interfere with rendezvous sensors. 

Waste and/or supply water dumps, on the other hand, require a large amount of time, 
greatly perturb the Orbiter in the +Y body axis direction, and can interfere with optical 
tracking, especially with the -Y star tracker.  Therefore, waste/supply water dumps are 
ruled out of the rendezvous timeframe. 
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7.1 Prox Ops Overview 

PURPOSE 

To specify procedures to follow during proximity operations. 

PROCEDURE 

• Maintain awareness of Orbiter DAP configuration at all times, especially LO Z. 

• Keep track of Orbiter and payload attitudes and relative position.  If you are unsure of 
the Orbiter/payload relative position, do not hesitate to ask the crew. 

• If a backout is needed, send crew to VBAR CORRIDOR BACKOUT in the Contingency 
section of the RENDEZVOUS C/L. 

• Maintain awareness of propellant consumption and prop bingos. 
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7.2 Stationkeeping 

PURPOSE 

To specify considerations needed while stationkeeping. 

PROCEDURE 

• Ensure entire team is aware of choice of stationkeeping. 

• Provide FD and PROP with estimates of prop usage.  

• Vbar (in LOW Z)  ~ ���� �OEV�UHY� 

• Vbar (in NORM Z) ~ ���� (lbs/rev) 

• Rbar    ~ ���� �OEV�UHY� � ¨height (ft) * 0.5 (lbs/rev) 

• Inertial Stationkeep  ~ ���� �OEV�UHY� � 5DQJH �IW� 
 ���� �OEV�UHY� 

BACKGROUND 

Due to a requirement to suspend the rendezvous post-Ti, or to backout from the target 
post-rendezvous prior to a second approach, it may be necessary to stationkeep on the 
Vbar for up to several hours. 

Vbar Stationkeeping 

Vbar stationkeeping, which is typically performed inside 400 ft and outside 170 feet, costs 
roughly 1.9 lbs per minute (175 lbs/rev) in LOW Z with Vernier control.  Vbar 
stationkeeping should be performed outside 400 ft CG-to-CG for ISS attitude control or US 
array feathering problems, outside 250 ft for Orbiter problems, and outside 170 ft for 
Russian array problems.  Therefore, all Vbar stationkeeping should be done in LOW Z.  In 
the event of a loss of LOW Z capability, stationkeeping in NORM Z is acceptable as long 
as no +Z (out) pulses are input between 1000 and 75 ft.  In this case, prop usage is 
approximately 1.1 lbs per minute (101 lbs/rev). 

There are time constraints for stationkeeping based on Orbiter range.  For instance, 
stationkeeping at 30 ft is only allowed for 15 minutes before the Orbiter must back out to a 
greater range.  These time constraints decrease linearly until 170 ft, where no time 
constraints exist.   

Rbar Stationkeeping 

Rbar stationkeeping above or below the target requires the same propellant allotment as 
for Vbar with NORM Z plus additional prop to counteract the ∆height effects (~0.022 fps 
per rev per foot of separation, or ~0.5 lb per rev per foot of separation).  There is no 
additional penalty for Rbar stationkeeping with LOW Z. 

For example, a 200 foot Rbar stationkeep would require approximately 110 lbs + 100 lbs, 
or 210 lbs/rev (~9.5% RCS). 
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Inertial Stationkeeping 

Inertial Stationkeeping cost is essentially the cost of Vbar stationkeeping plus and additional 
cost due to the range offset rotating above and below the Vbar.  This cost can be 
approximated by 0.707 * the max ∆height * 0.5 lbs per rev which equates to 0.35 * range. 

For example, a 200 foot Inertial Stationkeep would require approximately 110 lbs + 70 lbs, 
or 180 lbs/rev (~8% RCS). 
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7.3 Plumes 

PURPOSE 

To provide dynamic pressure contours from RCS jet firings for prox ops considerations.  Focus is 
on translations and rotations with upward-firing jets. 

PROCEDURE 

Refer to appropriate charts as listed below (value in parentheses denotes maximum 

dynamic pressure in lb/in2 shown on that chart). 

Translation 

Plume contours are show for the following translation maneuvers at the values denoted: 

• NORM Z +Z Translation (10-1) 

• NORM Z +Z Translation (10-3) 

• LOW Z +Z Translation (10-1) 

• LOW Z +Z Translation (10-3) 

• +X Translation (10-3) 

• +X Translation (10-3) 

Rotation 

Plume contours are shown for the following rotation maneuvers: 

• NORM Z +Pitch Rotation (10-1) 

• NORM Z -Pitch Rotation (10-1) 

• NORM Z ±Roll Rotation (10-1) 

 

BACKGROUND 

The following charts illustrate plume contours for various key maneuvers obtained from 
simulation modeling. 
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NORM Z  +Z Translation (10-1) 

-200

0

200

400

600

800

1000

1200

1400

1600

1800

2000

2200

2400

2600

2800

-8 00 -600 -40 0 -200 0 200 40 0 600 800 1000

Dynamic Pressure,  lb / in**2

X  S truc tu ra l Axis , ft

-100 0

 

Figure 7.3-1  NORM Z +Z Translation (10-1) 
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NORM Z  +Z Translation (10-3) 
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Figure 7.3-2  NORM Z +Z Translation (10-3) 
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LOW Z  +Z Translation (10-1) 
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Figure 7.3-3  LOW Z +Z Translation (10-1) 
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LOW Z  +Z Translation (10-3) 
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Figure 7.3-4  LOW Z +Z Translation (10-3) 
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+X Translation (10-3) 
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Figure 7.3-5  +X Translation (10-3) 
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-X Translation (10-3) 
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Figure 7.3-6  -X Translation (10-3) 
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NORM Z  +Pitch Rotation (10-1) 
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Figure 7.3-7  NORM Z  +Pitch Rotation (10-1) 
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NORM Z  -Pitch Rotation (10-1) 
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Figure 7.3-8  NORM Z  -Pitch Rotation (10-1) 

                   



SHUTTLE OPS RESP: J. Yencharis Plumes 
RNDZ CHB/CH-DM-08 REV B: 1/15/02 SCP 7.3 

Verify this is correct version before use.  7.3-10 

NORM Z  ±Roll Rotation (10-1) 
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Figure 7.3-9  NORM Z  ±Roll Rotation (10-1) 
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7.4 Jettison 

PURPOSE 

To specify the actions of the Rendezvous GPO team during a contingency jettison. 

PROCEDURE 

Assessment 

Assess planned jettison time to ensure: 

• Sufficient time to reach attitude 

• Jettison will occur during sunlight 

• In AOS, if possible 

Attitude 

Ensure Orbiter is in proper jettison attitude (+Z VV, -X LV): 

 

  TGT ID  +2 

  BODY VECT +2 

  OM  +0 

 

BACKGROUND 

Jettison procedures exist for the RMS (PDRS/ALL p6-50), the Ku-band antenna (ORBIT 
OPS/ALL p2-18), and the IPS (Instrument Pointing System, a GNC book), and, although systems 
functions are the responsibility of respective systems FCs, the dynamics of vehicle flying are the 
responsibility of the Rendezvous GPO (if on console) or the FDO (if not RNDZ phase). 
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7.5 Degraded +X RCS Prox Ops 

PURPOSE 

To document the procedures for performing Prox Ops with combinations of jet failures 
resulting in the loss of both +X jets in one of the aft pods. 

PROCEDURE 

In the context of degraded +X burns, the following terminology is used: 

• Loss of LEFT POD results from loss of RCS jets L1A and L3A;  

• Loss of RIGHT POD results from loss of RCS jets R1A and R3A.  

 

 

Loss of Right Pod (Group 7) or Left Pod (Group 8) +X Jets 

 

If LEFT or RIGHT POD +X jets are down: 

• Impacts to flight control: 

o Degraded +X translation. 

�� All +X inputs need to be doubled to achieve the desired +X translation. 

�� Ydot will result from roll and yaw axis cross-coupling induced during +X 
translations.  -Ydot (body sense) will occur from loss of the left pod and 
+Ydot will occur for loss of the right pod.  The magnitude of Ydot is 
similar for NORMZ vs. LOWZ and for PRI vs. VERN, but is much more 
pronounced in TAIL-ONLY than in NOSE+TAIL control.   For example, 
there is a 5-10% coupling of X into Y for NOSE+TAIL, but a 30-35% 
coupling of X into Y for TAIL-ONLY.  The largest single step that can be 
taken to reduce the Ydot effect is to transition to NOSE+TAIL control.  
This is true even if VERN is selected since the PRCS jets can fire while 
the THC is deflected. 

�� Control of the induced Ydot while in LOW Z will lead to a closing rate.  

�� The asymmetric jet configuration will lead to increased deadbanding and 
associated perceived lateral rates in the COAS or centerline camera.  
The deadband motion should be checked before making manual inputs 
based on these visual cues.  

�� There is little difference between PRI and VERN, although larger burns 
should be performed in PRI as usual.   
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o Degraded LOW Z braking capability. 

�� -X translation will occur during LOW Z +Z braking pulses, which will 
require additional +X translation commands to offset the motion.  For 
example, as many as 10 +X pulses would be required to balance out the 
-X motion from a 0.05 ft/sec translation.   As with degraded +X 
translations, some Ydot will develop from the +X translations.  Control of 
this Ydot will completely nullify LOWZ braking while in TAIL-only, and 
will severely degrade the capability while in NOSE+TAIL control (maybe 
20% effective).   

      

• Impacts to TORVA and Vbar Approach 

o Modify DAP A9/B9 to NOSE+TAIL control prior to TORVA start.  Maintain 
NOSE+TAIL control until A10/B10 is selected at 75 ft. 

o The TORVA initiation should be performed in PRI as usual, but the number of 
+X pulses must be doubled.   Expect to have about 0.1 fps Ydot to control 
immediately after the TORVA start.  Control of the Ydot could increase Rdot 
slightly, so consider being conservative on Rdot management.   

o Management of Rdot during the Vbar approach should be conservative (similar 
to a VERN-fail case). 

o NORMZ corridor operations and achieving docking contact conditions are not 
difficult with degraded +X jets. 

• Impacts to Vbar Breakout and Shuttle Nose-In-Plane Breakout 

o The A9/B9 DAP should be modified to PRI NOSE+TAIL control to minimize Y-
axis coupling from +X burns. 

o The THC deflection time must be doubled to achieve the specified +X breakout 
burn delta V.     

o Do not attempt to null Ydot in either breakout because the out-of-plane 
translation gives even safer relative motion. 

 

BACKGROUND  
If a single +X jet is failed, there are many single additional failures that can result in loss of 
the other +X jet in that pod.  The Rndz team should provide a plan of action for the next 
worst failure. 
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7.6 Grappling a Rotating Payload 

PURPOSE 

To specify procedures, guidelines, and techniques for grappling a rotating payload. 

PROCEDURE 

Track-and-Capture Grapple from a Non-rotating Orbiter 

• Configure Aft Station for proximity operations. 

• Assess rates and stability of payload rotation. 

• Discuss options with MCC (grapple now vs. future EVA capture vs. other options). 

• If required, flyaround to an attitude that supports grapple (NOTE: Limit Orbiter rotation 
rate during flyaround to 0.5 deg/sec maximum in a single axis). 

• Return to LVLH or INRTL hold and null translational motion. 

• Attempt track-and-capture grapple with RMS. 

Note:  Rate matching is not recommended as a primary technique.  See comments in the 
BACKGROUND section, below. 

Track-and-Capture Technique Guidelines 

If the attitude of the payload CAN be predicted accurately 3 to 10 minutes in the future 
(i.e., the rotation is small and stable about 1 or 2 axes), discuss above procedures with the 
crew and MCC, and above all else, do not hurry.  Estimated Prop use:  < 100 lbs of 
propellant (50 fwd and 50 aft). (Because the attitude can be accurately predicted, the 
Orbiter should be able get to the proper attitude by performing no more than two 90-degree 
attitude maneuvers.) 

If the attitude of the payload CANNOT be predicted accurately 3 to 10 minutes in the 
future, the best technique may be to keep it stable and wait for the grapple fixture to rotate 
into the grapple envelope.  Since by definition it is hard to predict the attitude in this case, 
it is important to minimize the time between beginning an attitude maneuver and going in 
for grapple.  To accomplish this the pilot should be aggressive in performing the rotation 
and translation required to set up the grapple.  Estimated propellant usage can be 
excessive and very hard to predict, and could range from 100 to 500 lbs plus.  (Over 1200 
lbs of prop was used attempting to match rates on STS-87.) 
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BACKGROUND 

Why use the track-and-capture technique instead of match rates? 

1. Rotating the Orbiter to match rates makes the grapple task harder--in many cases 
much harder. 

• Rotating the Orbiter to match the payload rotation creates relative translation.  If the 
rates are matched, the relative attitude will stay in an acceptable envelope for grapple 
for a longer period of time, but the relative position will quickly move out of an 
acceptable range.  The faster the rotation the quicker this will happen. 

• Performing a track-and-capture from a non-rotating Orbiter allows translation rates to 
be nulled, but by definition, creates relative rotation.  The position will stay in the 
acceptable grapple envelope for a long period of time, but the payload will quickly 
rotate out of the grapple envelope.  

• SES runs with MOD and CB personnel have shown that grapple is more easily 
accomplished by nulling translation and accepting the corresponding high rotation 
rates. 

2. Matching rates is typically much more propellant expensive than track-and-capture. 

3. Matching rates increases the risk of losing the payload out of the stationkeeping box 
and potentially pluming the payload or creating relative motion problems, because 
translation is more dynamic. 

Should a Matched-Rates Flyaround technique ever be considered? 

The only cases the team has identified that an Orbiter matched-rates flyaround of a 
rotating payload may be required are:  

• if the payload is so big that rotation is required to reduce contact concerns, or  

• to reduce RMS loads during capture by rotating to reduce relative rates. 

In these cases rotating will probably make it harder to grapple, but may be necessary. 

If a matched-rates rotation is required, the team strongly recommends rotating about 
Orbiter body yaw.   The team also recommends that the RMS be moved as far aft as 
possible to reduce the cross-coupling of rotation into translation.  However, other factors 
such proximity to RMS reach limits and position of keel cameras must also be taken into 
account when deciding on the final RMS position. 

Why limit the Orbiter rotation rate during a flyaround to 0.5 deg/sec in a 
single axis? 

If an Orbiter flyaround of a rotating payload is required, limit rotation rates to no more than 
0.5 deg/sec and 1 axis at a time.  This applies equally to flyarounds from one LVLH/INRTL 
attitude to another and to matched-rates flyarounds.  Rotating above 0.5 can lead to safety 
problems.  The main concerns are:  

1. re-contact with the RMS upon termination of body minus roll and body minus yaw 
flyarounds, and  
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2. body minus pitch flyarounds getting out of control during the flyaround due to the 
very strong cross-coupling of body minus pitch rotation and minus X translation.    

If attitude CAN be accurately predicted 3 to 10 minutes into the future... 

At rotation rates up to 1.0 deg/sec the grapple can be successfully completed 90+% of the 
time.  At rates up to 2.0 deg/sec the grapple can be successfully completed 25% - 50% of 
the time.  Above 2.0 deg/sec the success rate goes down very rapidly. 

No safety limits have been identified such that grapple should not be attempted if payload 
rates exceed x deg/sec.  It is possible to damage the RMS by exceeding load limits during 
capture; however, RMS analysis has shown that load limits are not exceeded when 
attempting to grapple a Spartan type payload at rates well above 2.0 deg/sec.  

If attitude CANNOT be accurately predicted 3 to 10 minutes into the future... 

Typically this means the payload is in an unstable rotation. 

Rotation rates as low as 0.3 to 0.4 deg/sec can be very difficult to grapple. 

No safety limits have been identified such that grapple should not be attempted if payload 
rates exceed x deg/sec.  It is possible to damage the RMS by exceeding load limits during 
capture; however, RMS analysis has shown that load limits are not exceeded when 
attempting to grapple a Spartan type payload at rates well above 2.0 deg/sec.  

Miscellaneous Lessons Learned from STS-87 

RMS/Stationkeeping position should be selected to optimize stationkeeping cues (such as 
keel cameras), grapple cues (grapple pin 90 degrees to RMS operators line of sight) and 
minimize reach limits and plume concerns.   

RMS operator should ask the CDR to bias the payload stationkeeping position to help use 
the entire grapple window.  After the CDR gives goes to free drift the RMS operator can 
pre-condition the RMS attitude to use entire grapple window. 
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7.7 Twice Orbital Rate Vbar Approach 
 

PURPOSE 

To describe the operation and dynamics involved with the Twice Orbital Rate Vbar Approach (TORVA). 

 

PROCEDURE 

The procedures on the VBAR APPROACH cue card in the Rendezvous Checklist should be followed 
closely.  Being a large tabular cue card, the crew should follow the steps in each row from left to 
right.  That typically results in DAP changes being made before jet firings or Universal Pointing 
Inputs. 

The TORVA is started on the 600 ft line of the VBAR APPROACH cue card.  The procedure calls for 
the crew to: 

• Select DAP A9/B9 at 600 ft and a closing rate of –0.8 fps. 

• Change the Universal Pointing pitch setting to 179�, which corresponds to the Vbar attitude, taking 
into account the 1� ODS pressurization bias when no extended tunnel is in place. 

• Enter an ITEM 19 to actually kick off the maneuver. 

• Input approximately 22 +X pulses (“ups”) to null target motion in the centerline camera. 

• Maintain the target in the centerline camera until Vbar arrival. 

• End the TORVA with several –X pulses (“downs”) at the appropriate time on or near the Vbar. 

 

In failed VERN cases: 

With VERNs down, the crew will probably want to bias their TORVA to end up farther away than 
normal on the Vbar, to protect for increased closure rate induced by attitude control on the PRI jets.  
The crew would bias their TORVA in this manner by performing fewer +X pulses and by possibly 
initiating the TORVA at a slightly slower closing rate. 

 

In the event of GPC failures during the TORVA: 

Regaining attitude control and maneuvering to the Vbar attitude is first priority.  Don’t waste time 
talking around the room about which stringing to load.  Simply restring to all one GPC and continue to 
the Vbar where stationkeeping should be started.  The restringing can be done while stable on the 
Vbar, where no time constraints are on the crew.  This also gives the flight control team time to 
ensure all systems are “go” for approach. 
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BACKGROUND 
 
For ISS flights 5A.1 and subsequent, the Orbiter has been using a TORVA approach as shown in 
Figure 7.7-1.  At the end of the terminal phase, the Orbiter is at 600 ft with a closing rate of 0.8 ft/s. 
After the pilot nulls the target motion in the COAS, the TORVA is initiated by an AUTO maneuver to 
an LVLH attitude of PYR = 90, 0, 0 and by performing approximately twenty-two 0.05 ft/s pulses to 
null target motion in centerline camera.  Few Orbiter �X burns should be required to maintain the ISS 
within the COAS as the Orbiter begins a coasting trajectory toward the +Vbar.  Due to the outward 
acceleration from the twice orbital rate flyaround mechanics, the range rate will slow down quickly but 
should not be allowed to begin opening.  The maneuver will be completed as the Orbiter reaches the 
+Vbar and begins to hold LVLH attitude. The pilot will have to perform a number of Orbiter -X burns 
to null the apparent motion of the ISS in the COAS that will result. The Orbiter should reach the 
+Vbar at an interface-to-interface range of 310 ft in the nominal case.  The pilot then initiates a 
closing rate of 0.2 ft/s. The requirement for the pilot to maintain an 8� corridor from 250 ft to 30 ft also 
applies to the +Vbar final approach. 
 

 
Figure 7.7-1 TORVA and Vbar Approach Trajectory 

 
 
At 100 ft, the pilot will reduce the closing rate to 0.15 ft/s.  At 75 ft, the pilot will mode the DAP to 
NORM Z, switch to A10/B10, and configure the approach for single -X jet (deselect F1F and F2F) to 
reduce loads on the radiator that is extended out over the Orbiter nose.  Jet F2F was originally 
selected because the relative geometry between the Orbiter and ISS placed it the furthest jet away 
from the ISS, but an agreement was made to use F3F to reduce cross-coupling. 
 
At 30 � 5 ft, the pilot will brake to null the closing rate and will stationkeep to perform an angular 
alignment maneuver if necessary.  From 25 ft to docking, the procedure is identical to the +Rbar final 
approach.  Since the +Vbar does not offer the deceleration effect experienced on the �Rbar, the 
approach dynamics will differ.  During the +Rbar final approach, very little or no braking is required. 
During the +Vbar approach, however, braking burns will be required to slow the closing rate. Thus, 
the +Vbar approach will use more propellant due to the LOW Z braking burns required, and will result 
in more plume impingement from the NORM Z braking burns inside 75 ft. 
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7.8 Twice Orbit Rate Flyaround 

PURPOSE 

To specify procedures and techniques for performing a twice orbit rate flyaround (TORF). 

PROCEDURE 

Earth Track Method 

This method uses the UNIV PTG TRACK option and a specific value of the ROT RATE to 
achieve the maneuver.  The Orbiter Body Vector is changed prior to maneuver completion 
to keep the flyaround in progress. 

• Set DAP PRI ROT RATE and VERN ROT RATE to 0.13 deg/s. 

• Change UNIV PTG Body Vector once every quarter of the flyaround, anytime UNIV 
PTG ERROR is less than 180 degrees and greater than the ATT DB limit. 

• Select DAP: AUTO and translate to keep target in field-of-view. 

• Manage range rate near zero. 

UNIV PTG ROT Method 

This method uses the UNIV PTG ROT option to spin the Orbiter about an inertially fixed 
vector.  The ROT rate in combination with LVLH-to-inertial rate yields an effective rate of 
twice orbit rate with respect to LVLH during the flyaround. 

• Set DAP PRI ROT RATE and VERN ROT RATE to +0.065 deg/s. 

• Change UNIV PTG Body Vector to the appropriate rotation axis (+Y for Nose Forward, 
–Y for Tail Forward). 

• Select the ROT option on UNIV PTG. 

• Select DAP: AUTO and translate to keep target in field-of-view. 

• Manage range rate near zero. 

THC Strategy 

One can optimize the THC inputs needed to maintain a TORF by using the following rule-
of-thumb strategy.  Actual inputs should be made on the basis of observed values (field-of-
view lateral position, range rate), but can be optimized using the following information. 

• –Z (in) burns reach a maximum near ±Rbar and decrease towards ±Vbar. 

• No –Z (in) burns are required near ±Vbar, and are in fact discouraged. 

• ±X burns reach a maximum at the halfway points between the bar crossings. 

• No ±X burns are required near any of the bar crossings. 

                   



SHUTTLE OPS RESP: J. Yencharis Twice Orbit Rate Flyaround 
RNDZ CHB/DM-CH-08 REV B: 1/15/02 SCP 7.8 

Verify this is correct version before use. 7.8-2 

• “Speed up” burns are required in the +Rbar to +Vbar (“lower left”) quadrant and the –
Rbar to –Vbar (“upper right”) quadrant. 

• “Slow down” burns are required in the other two quadrants (“upper left” and “lower 
right”). 

BACKGROUND 

Idealized TORF in LVLH coordinates 

Motion constrained to the same area of the XZ LVLH plane exhibits a “football”-shaped 
trajectory in the absence of any course corrections.  Part of this trajectory is a natural 
tendency of the transverse velocity to vary with distance.  Assuming a constant rotation 
rate, by making inputs to keep the transverse velocity a constant, the range must remain 
constant.  The trick is to decide how best to make the delta-velocity inputs.  The optimal 
inputs for a TORF follow from examination of the Clohessy-Wiltshire (CW) equations for 
relative motion: 

ax t( ) = Ý Ý x − 2ω Ýz  Equation 7.8-1 

az t( ) = Ý Ý z + 2ω Ý x − 3ω 2 z  Equation 7.8-2 

By constraining the motion to a circle with constant range and constant twice orbit rate 
transverse velocity,  

Ý x = +2ωz  Equation 7.8-3 

Ý z = −2ω x  Equation 7.8-4 

and thus the û9 inputs required to meet these constraints are: 

ax t( ) = 0  Equation 7.8-5 

az t( ) = −3ω2 z  Equation 7.8-6 

The interpretation of these results is shown below. 

 
Figure 7.8.1  Idealized TORF in LVLH Coordinates 

• All corrections are made in the Z-LVLH direction, pushing towards the Vbar (i.e., DVz 
is negative if Z is positive, and vice-versa). 

• Instantaneous Z-LVLH burn magnitude is proportional to distance from the Vbar. 
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• No corrections are required in the X-LVLH direction. 

Note:  In the absence of any additional inputs, the resulting motion is “football-shaped,” 
with the size and location of the football dependent on the point at which inputs are 
discontinued. 

Idealized TORF in Body Coordinates 

Since the Orbiter performs a TORF by pointing the –Z Body axis towards the center, the 
above LVLH-based inputs could be transformed to body coordinates to determine body 
VGOs.  Alternatively, one can examine this scenario by using the polar-cylindrical form of 
the CW equations, 

aρ t( ) = Ý Ý ρ − ρ Ý θ 2 − 2ωρ Ý θ − 3ω2 ρsin 2 θ  Equation 7.8-7 

aθ t( ) = ρÝ Ý θ + 2 Ý ρ Ý θ + 2ω Ý ρ − 3ω 2 ρcosθsinθ  Equation 7.8-8 

subject to the same constant range and constant transverse velocity constraints as before, 
only expressed in polar form: 

ρ = R Equation 7.8-9 

Ý θ = −2ω  Equation 7.8-10 

This results in the following required ûvelocity inputs: 

aρ t( ) = −3ω2 R sin 2 θ  Equation 7.8-11 

aθ t( ) = −3ω 2 R cosθ sinθ  Equation 7.8-12 

If we assume the Orbiter performs the flyaround with the –Z Body axis directed towards 
the center, we can assign the Orbiter Z Body axis to the radial direction and the Orbiter X 
Body axis to the tangential direction. From this, one can conclude the following (ignoring 
Orbiter translational cross-coupling): 

                   



SHUTTLE OPS RESP: J. Yencharis Twice Orbit Rate Flyaround 
RNDZ CHB/DM-CH-08 REV B: 1/15/02 SCP 7.8 

Verify this is correct version before use. 7.8-4 

  
All VGO Z inputs are made in the –Z Body 
direction, pushing towards the center. 

No +Z Body inputs are required. 

Maximum –Z inputs occur at ±Rbar crossings. 

No –Z inputs are required near ±Vbar crossings. 

The total VGO Z required is twice the total VGO 
X required. 

Maximum VGO X inputs occur at the 4 
quadrature points of the flyaround. 

No VGO X inputs are required at the 4 Vbar/Rbar 
crossings. 

Speed-up (+X Body for Nose Forward) inputs are 
required in the lower left and upper right 
quadrants. 

Slow-down (–X Body for Nose Forward) inputs 
are required in the upper left and lower right 
quadrants. 

The total VGO X required is one-half the total 
VGO Z required. 

Figure 7.8.2  Idealized TORF in Body Coordinates, VGO Z and VGO X, Respectively 

From the original radial equation (Eq. 7.8-7), note the following interesting fact about the 
flyaround rate.  If one considers a general flyaround rate of n times orbit rate, 

aρ t( ) = −n 2 + 2n( )ω 2 R − 3ω2 Rsin 2 θ  Equation 7.8-13 

the leading term cancels out only when n = 2.  If the flyaround rate is slower than twice 
orbit rate (i.e., n < 2 in the above equation), the leading term is positive.  Thus, it follows 
that braking is required whenever the first term exceeds the second term in magnitude.  
This occurs at the points of the flyaround close to the ±Vbar (i.e., when theta is 
approximately equal to 0 or 180).  If the flyaround rate is faster than twice orbit rate (i.e., n 
> 2), the leading term is negative. This implies that a constant inward thrust during all 
points of the flyaround is required.  Although this flyaround is quicker and avoids braking 
inputs, it requires more propellant to execute than the twice orbit rate flyaround. 
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7.9 Low β Angle TORVA Lighting 

PURPOSE 
Provide direction for alleviating lighting problems on TORVA flights with a low beta angle.  When 
executing a rendezvous and TORVA on a flight with a low Beta angle (~ < 15 deg), the standard 
Ti TIG at Sunset – 28 typically puts TORVA init near noon. This places the sun directly behind 
the target, making visual confirmation of TORVA initial conditions difficult to impossible.  

PROCEDURE 
Note:  

This procedure is only valid for targets with 
active light sources (like ISS) because it will likely 
result in the radar failed correction being executed  

in darkness. 

 

1. Move Ti TIG earlier to Sunset – 38.5 minutes. FDO should be notified pre-launch. 

2. In case the radar fails and post-Ti day star tracker is not available: 

o Delay the intermediate MC2 targeting (usually at 35 min PET): 

PLT When NAV converged (SV UPDATES small and stable): 
 TARGET MC 2 BURN  >��$@  (Intermediate) 

To 44 min PET (this is nominal MC2 TIG – 6 minutes, but keep it fixed on PET): 

PLT TARGET MC 2 BURN  >��$@  (Intermediate) 

o Closely monitor MC2 TIG slip as night star tracker is incorporated into Nav. 

o Delete the END STAR TRACKER NAV callout at MC2 - 6 min 

o Modify the Post MC2 starred blocks to look like this: 

 

 

 

 

 

 

 

 

 

 

Figure 7.9-1 Low β Angle Timeline Changes 

 IF -Y S TRK TRACK 
PLT END STAR TRACKER NAV >��&@

 -Z AXIS TARGET TRACK >��'@

 IF NO RR INTO NAV 
CDR Go to RADAR FAIL PROCEDURES >��'@

 IF INITIAL RR ACQ POST-MC2 
CDR Perform LATE RR NAV >��(@

 If S TRK NAV,  
PLT END STAR TRACKER NAV >��&@

PLT TARGET MC 3 BURN  >��%@   (Preliminary) 
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BACKGROUND 
Moving Ti TIG to sunset – 38.5 should allow up to 7 minute MC2 TIG slip, and TORVA initiation 
as close as 525 ft while maintaining the sun >15 deg from camera centerline. One thing that is 
not protected is being slower than the braking gates from 2000 ft to TORVA init. The sun will 
cross through the centerline camera field of view on the Vbar between 200 and 150 ft. 

Impacts to Radar Failed Procedures 

 
Radar Failed Manual correction at MC2+19 will be dark unless MC2 slips more than +5 
min late (see Note above). Since the shuttle crew executes the RF correction based on visual 
elevation, they need to see the target. If the ISS is in LVLH 0, 0, 0 attitude, the SM tracking light 
will be visible to the shuttle crew. If the ISS is not in that attitude, one of the SM solar array tip 
lights will be visible. It is also likely that TCS will have acquired. It is recommended that the HHL 
with the night scope be used. 
 
Latest breakout time at MC2+24 will be dark unless MC2 slips more than 1 min late. If the 
shuttle crew has not yet acquired the target visually or with a range sensor, the breakout should 
be executed. Again, if the ISS is in LVLH 0, 0, 0 attitude, the SM tracking light will be visible to 
the shuttle crew. If the ISS is not in that attitude, one of the SM solar array tip lights will be 
visible. It is also likely that TCS will have acquired. It is recommended that the HHL with the 
night scope be used. 
 

Will get less than 8 min darkness pre MC2 for night star tracker if MC2 slips more than 1 
min early. If daytime star tracker is available post-Ti, this is no impact. But since day star tracker 
is not guaranteed (it would not have been available on STS-98), this is a concern. Allowing for 1 
min of initial data evaluation and going to OPS 202 at 3 minutes before a 3 minute early MC2, 
that leaves 4 minutes of data, which should yield 30 marks. Not quite the historical 40 mark 
requirement, but given that state vector errors will have been propagating for an orbit (the 
previous sunset), you should see a pretty good elevation residual and pick up lots of downtrack 
quickly. Delaying the end of the post-Ti night star tracker pass until about 1 hour PET (post MC2) 
will help finish cleaning up the nav state and support MC3 targeting. 

 

Final MC2 TIG could move significantly early and surprise people. If radar is failed and no 
post-Ti day star tracker is available, the preliminary and intermediate MC2 TIGs would be based 
on the pre-Ti star tracker pass and sensed accelerations through NCC, Ti, and MC1. There is 
enough error that, the preliminary solution could show an MC2 TIG near the 7 min late limit, and 
then large updates from nighttime star tracker could move the final MC2 TIG to the early limit 
and catch the crew and MCC by surprise. Moving the intermediate MC2 targeting to nominal 
MC2 TIG – 6 minutes puts it late enough to be based on some night star tracker data, while 
allowing MC2 to slip to the 3 min early limit and still have 3 minutes to get ready to execute the 
burn. In order to closely monitor the MC2 TIG slip as night star tracker data is incorporated, have 
NavCon running and configured to target of the FLTR, and call up the DAP_ORB_TGT ROSS 
Alarm on the same workstation. NavCon calculates its own MC2 TIG and compares it to the 
latest onboard TIG. The difference in TIGs is displayed in upper right hand cell of the 
DAP_ORB_TGT ROSS Alarm (see appendix B). 
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7.10 Standardized Approach Calls 

PURPOSE 

Provide direction for making standardized callouts to the flight control team at the initiation of final 
approach, 20, 10, and 5 feet.  

PROCEDURE 

As shown in the examples below, the Rendezvous Officer will make the following calls to the 
Flight Director at the initiation of final approach (near 30 feet), 20, 10 and 5 feet: 

� A reading of the range at the time of the call. 

� An evaluation of the range rate.  If the rate is within acceptable values (as reflected in the 
crew procedure), “good rate.”  If the rate is faster or slower than acceptable values, the 
delta between the current rate and the acceptable rate will be called to Flight.  

 

Table 7.10-1  Examples of Standardized Approach Calls 

Range “Good” Rdot 

Values 

Actual Range 

Rate 

Call to Flight Director 

Initiation of final approach  –0.05 to –0.09 -0.09 “28 feet, good rate.” 

20 feet –0.05 to –0.13 -0.14 “20 feet, a hundredth fast.” 

10 feet –0.07 to –0.13 -0.06 “10 feet, a hundredth slow.” 

5 feet –0.07 to –0.13 -0.13 “5 feet, good rate.” 

 

These calls will be made quickly and concisely to avoid distracting the flight control team from 
docking activities.  As always, discussion about failures or anomalous rates can override these 
calls.   

  

BACKGROUND 

In response to high contact rate experienced on STS-112, the Rendezvous community suggested, 
among other things, the standardization of status calls to the Flight Director at regular intervals 
inside of 30 feet, to increase situational awareness.  It would then be up to the individual Flight 
Director and flight crew to decide whether they’d like to have those calls read up during real-time 
docking operations.  The Orbit Flight Techniques Panel accepted this proposal on April 25, 2003. 
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8.1 RPOP Operations 

PURPOSE 

To provide details for using non-standard options within the Rendezvous and Proximity 
Operations Program (RPOP) covering: 

• Radar Bias Inputs  

• CCTV Tilt Bias Inputs  

and to provide constraints for selecting the COM port configuration within RPOP. 

PROCEDURE 

Radar Bias Inputs 

• Exit RPOP (SHIFT-F10) 

• Use Notepad to edit the appropriate RPOP I-load file, (for example tailfwd.ild).  
To determine the directory in which the .ild file resides, right click  
Properties>Shortcut  for the appropriate Win95 RPOP shortcut and look for the  
Start in  directory.   

• Use the arrow keys to scroll through the file.  Look for the radar range bias lines: 

 

;= Rendezvous Radar Range Bias (ft) 

;======================================= 

Bias=0 

 

• Enter the radar range bias in feet by replacing the zero on the second line. The sign 
convention is such that 

 

true range + radar range bias = measured radar range 

 

• Example 1:  Radar reads 1000 ft.  The true range is 750 feet.  Therefore, the bias to 
enter is 250. 

• Example 2:  Radar reads 1000 ft.  The true range is 1250 feet.  Therefore, the bias to 
enter is -250. 

• Save the change and exit Notepad. 

• Verify that the Iload change has been made on all RPOP PGSCs. 

• Run RPOP and confirm the radar range bias under File>Flight data. 
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CCTV Tilt Bias Inputs 

NOTE:  Since CCTV tilt biases are known to change any time the unit is tilted to a different 
position, the RPOP tilt bias function is not very useful in compensating for errors.  Use of 
the bias to compensate for readout errors is not recommended unless the CCTV will not be 
moved.   

The tilt bias can be used for creative workarounds to unique problems if the following 
convention is understood.  The Tilt bias is entered as the CCTV tilt digital readout when 
the CCTV has been verified to be pointing along the -Z axis.  One method of verifying a 
true 90 degree tilt would be to point the -Z axis at some celestial object and tweak the tilt 
until centered (remember that any subsequent adjustments could change the bias). 

Use the following steps to change the bias in the RPOP I-load file. 

• Use Notepad to edit the appropriate RPOP I-load file (for example tailfwd.ild).  To 
determine the directory in which the .ild file resides, right click Properties>Shortcut for 
the appropriate Win95 RPOP shortcut and look for the “Start in” directory.   

• Use the arrow keys to scroll through the file.  Look for the CCTV tilt bias lines: 

 

;======================================================== 

;= Forward CCTV tilt readout when true tilt is 90 degrees 

;======================================================== 

Forward Scale=90 

 

;======================================================== 

;= Aft CCTV tilt readout when true tilt is 90 degrees 

;======================================================== 

Aft Scale=90 

 

• Enter the biased tilt value for the appropriate camera.  

• Save the change and exit Notepad. 

• Verify that the Iload change has been made on all RPOP PGSCs. 

• Run RPOP and confirm the CCTV tilt biases under File>Flight data. 

RPOP and TCS COMM Port Configuration 

The PGSC comm ports and dynamic link library (DLL) must be configured properly to read 
HHL, PCMMU (PCDecom), and TCS data.  Both RPOP and TCS CAD are I-loaded with 
the nominal port config.  The following rules apply for any nominal or off-nominal cable or 
port config: 

• TCS CAD software “controls” the comm port connected to the TCS PDIP data cable 

• RPOP software “controls” the comm port connected to the PCDecom data cable  

• RPOP software “controls” the comm port connected to the HHL data cable 

• RPOP and TCS CAD share data internally via the DLL 
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• COM4 is occupied by the PCDecom Bit-sync card and is always connected directly to 
the PCMMU 

• COM4 and the port connected to TCS are always selected as NONE in the RPOP 
comm port config window 

 

An example for the standard Rndz Tools cable config (COM1=HHL, COM2=TCS, 
COM3=PCMMU) is as follows: 

• In TCS CAD, Select COM2 under Config>Com Port… 

• In RPOP, Select Config[cntrl-F10]>Comm Ports… to bring up the comm port config 
window.  Select the following: 

 

COM1 - HHL 

COM2 - None 

COM3 - PCMMU 

COM4 - None 

DLL  - TCS 

 

The RGPO should be aware that the comm port and software configs for the ICDS lab, 
SES, MPSR, and sometimes SMS are not necessarily as stated above.  For example, 
ICDS sends TCS data directly to RPOP via a comm port without passing through TCS 
CAD.  It is possible that a crew may have trained on the ground at some point with 
software or hardware that did not follow all the rules listed above.  

BACKGROUND 

RPOP is a Payload and General Support Computer (PGSC) application used on-orbit for 
situational awareness and navigation during rendezvous and proximity operations.  Certain 
capabilities not documented in the FDF exist within the software for contingency scenarios, 
specifically that RPOP has the ability to use a radar range bias and CCTV tilt biases to 
automatically compute and display the "true" relative range between the Orbiter and target 
when inputting marks. 
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8.2 Hand-Held Lidar Operations 

PURPOSE 

To provide operations information and specifications on the LTI hand-held lidar (HHL).  Lidar 
stands for light detection and ranging.   

PROCEDURE 

The HHL is used by the crew to provide estimates of range and range rate to a target. 

HHL Overview 

The HHL is referred to as NSRV1-OH by the manufacturer (LTI - Laser Technology Inc.) 

The HHL uses an infrared semiconductor laser diode and is a pulse laser. 

The HHL uses a least squares analysis to find the best-fit line of the range measurements 
and takes the slope of this line to determine the average velocity of the target during the 
measurement period. 

The HHL is not affected by diffraction and re-radiation; therefore, it does not bend around 
corners or experience strong returns due to secondary reflections off unwanted targets 

The HHL is immune to interference or errors caused by rotating or moving objects. 

Normal System Operation 

The HHL enters a self-test mode upon powering on (issues three mid-frequency beeps 
followed by the display going from “8.8.8.8” to “- - - -”, followed by a high tone).  An error 
message will be displayed if the HHL fails its self test. 

The HHL defaults to measurement mode with the distance displayed in whole feet. 

The trigger on the HHL can be held continuously while attempting to acquire a target.  A 
low tone is issued during this period.  When the HHL locks onto a target, the low tone stops 
-- this signifies that a measurement has begun.  The measurement period is variable -- 
between 0.5 and 5.0 seconds -- depending upon the length of time the trigger is held.  A 
short tone will sound at the completion of the measurement. 

Velocity and range are calculated with every measurement and represent the average 
position and velocity of the target during the measurement period. 

In tenths mode, the maximum displayable number is 999.9; in whole units mode, the 
maximum displayable number is 9999.  Numbers greater than either will result in the 
message “doF” (display overflow). 

The Velocity button toggles the display between tenths and hundredths of fps with leading 
zeros blanked and the leftmost digit showing the sign of the speed. 

If the range is increasing during the measurement, the velocity is positive and the leftmost 
digit is blanked.  If the range is decreasing the velocity is negative and the minus sign is 
displayed. 
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Test Mode 

If the Test Mode button is pressed and immediately released, the HHL will enter test tone 
mode and “tt” will be displayed.  The HHL will emit an audible tone when the trigger is 
depressed.  The pitch of the tone will change when the HHL acquires a target.  This mode 
is handy for verifying scope alignment. 

If the Test Mode button is held for approximately half a second, the power-up display test 
is initiated.  All LED display segments will be lighted.  If any segment of the display is not 
functioning properly, a flaw will be evident in one of the fields. 

If the Test Mode button is held for approximately 5 seconds, a software verification code 
will be displayed. 

To exit the test mode, press either the Range or Velocity button. 

Trapping of Erroneous Readings/Error Messages 

The data from each individual laser pulse must pass certain tests to ensure its quality 
before it is included in the aggregate data set. 

Of the total number of pulses used for a given measurement, a certain percentage must 
pass these initial raw data integrity tests before any other calculations are performed. 

In addition to the overall performance test, a limit has been placed on the maximum 
number of consecutive “bad” pulses. 

 

Table 8.2-1  HHL System Error Codes 

E50 Internal self-calibration error 1 

E51 Internal self-calibration error 2 

E52 Instrument temperature too low 

E53 Instrument temperature too high 

E60 Program checksum mismatch.  Unauthorized changing of 
instrument program IC. 

E61 External EEPROM checksum mismatch error 1 

E62 External EEPROM checksum mismatch error 2 

E63 External RAM test failure 

 

Table 8.2-2  HHL Measurement Error Codes 

E01 Never acquired a target because the target was out of 
range or the target was too close 

E02 An excessive percentage of the total laser pulses in the 
measurement sample was unsatisfactory 

E03 An excessive number of consecutive laser pulses in the 
measurement sample was unsatisfactory 

 

Scope Alignment 

Scope alignment is set at the factory.  The only reason the scope might ever go out of 
alignment would be from a heavy blow. 
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Scope Filter 

The scope filter is a ring located at the end of the scope.  By turning the filter clockwise the 
brightness and contrast can be adjusted for changes in lighting conditions. 

The laser should never be aimed directly into the sun.  Direct sun exposure in excess of 1 
second may damage the laser diode. 

Fixed Distance Tests 

Range measurements are referenced to the approximate center of the HHL. 

Standard Maintenance 

There are no moving parts or radio frequencies to go out of alignment.  The design of the 
HHL is capable of withstanding rough treatment and extreme environments (i.e., almost 
astronaut-proof). 

Serial Port Operation 

The serial bit stream is configured to the following format:  9600 baud, 1 start bit, 8 data 
bits, 1 stop bit, no parity. 

There is no data output in the event of a measurement error. 

The range and velocity data will be output correctly even if the display shows “doF”. 

 

Laser Technology, Inc. (LTI) Specification Sheet 

 

Table 8.2-3  General HHL Specifications 

Wavelength 775 nm ± 10 nm 
PRF 150 Hz 

Average power 26 uW ± 10% at 25 deg C (measured at full aperture - 48.5 mm) 

 

Table 8.2-4  HHL Range Specifications 

Minimum ≤ 12 ft 
Maximum* ≥ 1500 ft (30% diffuse target) 

 ≥ 5000 ft (2.5-inch diameter retroreflector) 
Accuracy ± 0.5 ft 

Display Resolution 0.1 ft 

*This is an approximation of the maximum range a target can be detected assuming 
60% attenuation through the Orbiter overhead window, round trip. 
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Table 8.2-5  HHL Range Rate Specifications 

Minimum 0 ft/s 
Maximum ≥ 10 ft/s 
Accuracy 0.5 second average 0.2 ft/s at 1σ 

 1.0 second average 0.1 ft/s at 1σ 
 2.0 second average 0.05 ft/s at 1σ 
 5.0 second average 0.02 ft/s at 1σ 

Display Resolution 0.01 ft/s 

 

Table 8.2-6  HHL Power Specifications 

Voltage 10.5 Vdc (seven alkaline batteries size "C") 

 

Table 8.2-7  HHL Physical Specifications 

Size, inches 12.2 high, 8.2 long, 3.5 wide (including handle and sighting scope); 5.1 
wide with battery housing 

Weight 6.5 lb. 

 

Table 8.2-8  HHL-PGSC Interface Specifications 

Connection Modified RS-232 cable, default to 9600 baud, 8 data bits, no parity, and 
1 stop bit. 
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8.3 Trajectory Control Sensor (TCS) 

OVERVIEW 

For detailed specifications, see the TCS systems brief on the GNC web site at 
http://mod.jsc.nasa.gov/df/df62/www/files/sb/tcs.pdf.  The TCS Project home page is 
located at http://www4.jsc.nasa.gov/eaprojects/ea-projects/flightgfe/tcs/html/tcs.htm.  For 
additional detail and locations of ISS reflectors, reference the JSC-27240, Rendezvous 
and Proximity Operations Design Reference (RPODR) for the International Space 
Station. 

The TCS is an Orbiter payload bay mounted laser that provides the crew with relative 
range, range-rate, bearing and bearing rate data.  It is a scan and track device that can 
operate in either a pulse or a continuous wave mode with a square 20° scan/track field of 
view.   

The TCS is mounted on the side of the Orbiter Docking System (ODS) and its center line 
is aligned with the orbiter –Z axis. TCS units are mounted to an accuracy of 0.24 inches.   

TCS units require passive reflectors on the target vehicle thus the TCS must be 
positioned so they can adequately see and track these reflectors during proximity 
operations.   The existing reflectors on the ISS PMA were located to accommodate TCS 
data all the way to docking based on the ODS mounted position of the TCS units.  

During orbit operations, the TCS is controlled from a PGSC located in the crew cabin. 
The raw TCS data is sent to the RPOP PGSC running via the CAD program where it is 
filtered and displayed as part of the RPOP data.  

Generally one TCS unit is carried, however, secondary TCS units can be mounted in off-
nominal positions in the cargo bay.  

SPECIFICATIONS 

Laser Ranges 

Both Lasers Operational 
Range (ft) Controlling Laser / Rationale 
< 5 No tracking.  Continuous Wave (CW) receiver becomes 

saturated by return signal. 
5 to 328 CW laser. 
328 to 1312 Both lasers. 
1312 to 5000 Pulsed laser. Maximum tested range on the ground was 5825 ft. 
 
CW Laser Only (Pulsed Laser Failed) 
Range (ft) Controlling Laser / Rationale 
< 5 No tracking.  CW receiver becomes saturated by return signal. 
5 to 1312 CW laser.  Maximum range tracked in flight was 1232 ft. 
 
 
Pulsed Laser Only (CW Laser Failed) 
Range (ft) Controlling Laser / Rationale 
< 66 No tracking.  Pulsed laser is electronically blanked. 
66 to 5000 Pulse laser.  Maximum tested range on the ground was 5825 ft. 
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Pulsed Laser To CW Laser Handoff (During Approach) 

 
The normal operational mode for the TCS unit is to acquire the target near a minimum 
distance of 5000 ft with the pulsed laser. The system will continue to track the 
retroreflectors exclusively with the pulsed laser until the range is less than 1312 ft. At this 
distance, the TCS software will begin the process of handing off operational control to 
the CW laser. This action is preferred due to the better accuracy of the CW laser. The 
handoff occurs in the background with no intervention by - or indication to - the user. 
Completion of the handoff must follow a series of tracking performance trials to ensure 
the CW system can continue to track the retroreflectors without a loss of tracking.  This 
feature is assured by the number of trials that must be successfully completed.  The 
number of trials is a function of the current range.  The greater the range the greater the 
number of successful CW updates that are required.  The tracking trials are grouped into 
sets of two update tests per trial. The following general requirement must be met for a 
successful handoff: 

 
Range (ft) Updates Required for CW-to-Pulsed Laser Handoff 
1312 to 997 3 sets of 2 updates 
997 to 499 2 sets of 2 updates 
499 to 66 1 set of 2 updates 
< 66 0 sets of 2 updates (immediate handoff) 

 
A counter counts the number of successful trials completed. If a failure occurs, the 
counter is decremented to a minimum of zero.  If a success occurs, it is incremented. 
When the required number of successes has accrued, the CW ranger begins tracking on 
the next update, completing the handoff process.  If a loss of tracking with the CW laser 
occurs and the range is less than 328 ft, the TCS system will attempt to reacquire the 
retroreflector exclusively with the CW laser. If a loss of tracking with the CW laser 
occurs and the range is greater than 328 ft and less than 1312 ft, the TCS system will 
attempt to reacquire the retroreflector with the CW laser. If these attempts are 
unsuccessful, the unit will promote to the pulsed laser. Following a successful acquisition 
with the pulsed laser, the unit will again attempt to handoff to the CW laser using the 
handoff criteria defined earlier in this section. 

 
 

CW Laser to Pulsed Laser Handoff (Undocking) 
 
The CW to Pulsed laser handoff will be slightly modified from the more structured 
Pulsed to CW handoff. The nominal method will be to continue tracking the 
retroreflectors with the CW laser until a loss of tracking occurs. The unit will attempt to 
reacquire the target with the CW laser. If an immediate reacquisition is not successfully 
completed, the TCS will begin a full scan in an attempt to resume tracking. If the last 
range was less that 100m(328ft), the CW laser will be used for the full scan. If the last 
range was greater than 100m(328ft) the TCS system may begin the full scan with the 
pulsed laser. After the acquisition is successful with the pulsed laser and if the range is 
less than 400m(1312ft), the TCS system will again attempt to handoff to the CW laser, 
according to the criteria defined in the previous section.  If the range is greater than 
400m(1312ft), the unit will continue to use the pulsed laser exclusively. 
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Table 8.3-1: TCS Accuracies 

Parameter Spec Particulars 

Range Accuracy 400 to 10’:    ± 0.01 * range 

10’ to Dock:  ± 0.1’ 

All accuracies are RSS of 1σ 
noise and bias 

Range Rate Limits ± 1 fps  

Range Rate Accuracy 400 to 262’:   ± 0.1 fps 

262’ to dock:  ± 0.01 fps 

 

Bearing Limits ± 20°  

Bearing Accuracy ± 0.5°  

Bearing Rate Limits ± 1° /s  

Bearing Rate Accuracy ± 0.5° /s  
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9.1 Rendezvous GPO Command Loads 

PURPOSE 

To document all commands issued by the Rendezvous GPO in the course of performing his or 
her normal duties. Formal Command Procedures are contained in the Flight Dynamics 
Command Procedures document.  Refer to section 4.7 COVARIANCE MATRIX MANAGEMENT 
for procedures using the Command Server.  The procedure below is a summary of that 
contained in the formal documentation, assuming use of the Command Server. 

PROCEDURE 

Set-Up 

To set-up your workstation for monitoring and/or building a command load, perform the 
following steps: 

• On Master DNAV select: Global Apps > Command Server > Start Command Manager. 

• Wait for Command Manager window to appear and indicate that it is running. 

• On Rendezvous DNAV select: Console Apps > Command > Covariance. 

• Wait for Covariance display to appear after a few seconds. 

Build 

To build a covariance matrix, perform the following steps.  If ONAV builds the covariance 
matrix (typical operation), proceed to Verify.  Available covariance matrices are defined in 
the BACKGROUND section. 

• Select the appropriate covariance from the Covariance display menu bar. 

File > Open RENDZ  (Rendezvous Covariance, 42101) 

File > Open PROX OPS (Prox Ops Covariance, 42102) 

File > Open COAS  (COAS Nav Covariance, 42103) 

• Verify that the selected covariance populates the blanks in the Build section of the 
display. 

• Verify that the Build Sequence Counter and the Verification Sequence Counter match 
the last digit of the command load number (i.e., "2" for command load 42102). 

• Click on GEN button in the Build Command section (it should turn green) to “arm” the 
command load. 

• Select CONFIRM button (it should turn green) to “fire” the command load.   

• Note appearance of command in Load Inventory. 

• Toggle NO COMPARE to COMPARE in Verification Sequence portion of display and 
inspect the populated fields in the Build portion as compared to the Ground Verification 
portion. Note any discrepancies (matches highlight in green, mismatches highlight in 
red). 
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Verify 

To verify a covariance matrix built by someone else, perform the following steps. 

• Select the appropriate covariance from the Covariance display menu bar. 

File > Open RENDZ  (Rendezvous Covariance, 42101) 

File > Open PROX OPS (Prox Ops Covariance, 42102) 

File > Open COAS  (COAS Nav Covariance, 42103) 

• Verify that the selected covariance populates the blanks in the Build section of the 
display. 

• Verify that the Build Sequence Counter and the Verification Sequence Counter match 
the last digit of the command load number (i.e., "2" for command load 42102). 

• Toggle NO COMPARE to COMPARE in Verification Sequence portion of display and 
inspect the populated fields in the Build portion as compared to the Ground Verification 
portion. Note any discrepancies (matches highlight in green, mismatches highlight in 
red). 

Uplink 

The protocol for performing an uplink is summarized below: 

• Contact FLIGHT for permission to uplink the command. 

 Example:  "FLIGHT, I would like to uplink a Rendezvous Covariance Matrix." 

• Upon a GO from FLIGHT, contact INCO and state that you wish to uplink command 
load <xxx> to the <GN/SM>. 

Example:  "INCO, I would like to uplink command load 42101 Rendezvous 
Covariance Matrix to the GN, with a GO from FLIGHT." 

• INCO will repeat your words back to you.  Remain on the INCO loop to receive his 
verbal verification of the command load uplink. 

• Also, watch for command to be uplinked under the Command Tracking section of the 
display; perform a horizontal scroll to see COMP, indicating success. 

Flush 

Perform the following steps to flush a command load.  If ONAV performed the build, ask 
ONAV to perform the flush; proceed to Clean-Up. 

• Set sequence number in the Build Sequence part of display to the load number to be 
deleted. 

• Select DEL button. 

• Select CONFIRM button. 

• Verify that the load disappears from the Load Inventory window. 
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Clean-Up 

To free workstation resources, drop the Command manager and Covariance display: 

• On Master DNAV select: Global Apps > Command Server > Stop Command Manager 

• In the Covariance display menu bar, select File > Exit. 

BACKGROUND 

Details on Covariance matrices can be found in SCP 4.7 COVARIANCE MATRIX 
MANAGEMENT. 

Command Load 42101 to GNC - Rendezvous Covariance Matrix 

The Rendezvous Covariance matrix uplink is used to provide a pristine covariance matrix 
for Rendezvous Navigation during the pre-Ti timeframe in the event a COVAR REINIT 
(SPEC 33 ITEM 16) is issued or RNDZ NAV is enabled or reinitialized (SPEC 33 ITEM 1).  
The uplink of the matrix does NOT change the current covariance matrix. 

UP 2000 UVC 0.0
VP 20000 UUC 0.0
WP 2000 VUC -0.9
UV 21 UVC -0.9
VV 2 VVC 0.0
WV 6 WWC 0.0

UVC 0.0  
Figure 9.1-1  Rendezvous Covariance Matrix 

Command Load 42102 to GNC - Prox Ops Covariance Matrix 

The Prox Ops Covariance matrix uplink is used to provide a pristine covariance matrix for 
Rendezvous Navigation during the post-Ti or deploy timeframe in the event a COVAR 
REINIT (SPEC 33 ITEM 16) is issued or RNDZ NAV is enabled or reinitialized (SPEC 33 
ITEM 1).  The uplink of the matrix does NOT change the current covariance matrix. 
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UP 1000 UVC 0.0
VP 1000 UUC 0.0
WP 1000 VUC -0.9
UV 1 UVC -0.9
VV 1 VVC 0.0
WV 1 WWC 0.0

UVC 0.0  
Figure 9.1-2  Prox Ops Covariance Matrix 

 

Command Load 42103 to GNC - COAS Navigation Covariance Matrix 

The COAS Navigation Covariance matrix uplink is used to provide a pristine covariance 
matrix for Rendezvous Navigation during the timeframe where COAS Navigation is used. 
The uplink of the matrix does NOT change the current covariance matrix.  The COAS 
Navigation procedure calls for a COVAR REINIT (SPEC 33 ITEM 16) to force NAV to use 
this matrix. 

UP 500 UVC 0.0
VP 5000 UUC 0.0
WP 1000 VUC -0.9
UV 5 UVC -0.9
VV 1 VVC 0.0
WV 1 WWC 0.0

UVC 0.0  
Figure 9.1-3  COAS Navigation Covariance Matrix 
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9.2 CRANS 

PURPOSE 

To provide details on using the Configurable Real-time Analysis System (CRANS) application. 

PROCEDURE 

Overview 
CRANS provides flight controllers with a quick method of assessing system impacts due to 
failures or to look ahead at the impacts of hypothetical failures.  The default configuration of 
CRANS will automatically detect and display system failures. 

General Operations: 

The RGPO CRANS application consists of individual matrices that list the various Orbiter 
systems of interest to rendezvous operations.  Each system component is displayed in a 
smaller unique box (or icon) within the matrices (see figure 9.2-1).   Each icon conveys the 
status of the system using color.  The color scheme for the icons in Rendezvous CRANS 
was designed to easily detect off-nominal conditions using the following color scheme: 

• Light green, white or gray - OK 

• Dark green - OK? (only partially or not automatically updated: manual configuration 
may be required) 

• Red - Failed 

• Amber - Warning or one failure away from lost capability 

• Blue - User configured 

Each matrix may be opened or iconified by clicking the left mouse button on either the icon 
body or in the small box in the upper right corner of the matrix, respectively.  Matrices come 
up in a standard RGPO arrangement but can be rearranged as desired by the operator. To 
move a matrix, place the cursor in the matrix title bar, click/hold the left mouse button, and 
drag the matrix to the desired location. Configurations can then be saved to the operators 
individual file and then recalled anytime in the future 

The CRANS application consists of both executable code (maintained by USA 
programmers) and user-specific data files (configured by the RGPOs). The data files define 
what components are displayed and the logic files define the dependencies. 
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Figure 9.2-1  CRANS Matrices and Icons 

Hypothetical Operations 

The operator may choose to assess the impacts of hypothetical failures by clicking on the 
desired system component icon.  This will permanently fail that component and the effects 
will cascade down to those components impacted by it.  A ” * ” character is displayed in the 
first column of a box if the displayed item hard failed.  When manually configured like this, 
the component will remain failed until deselected (toggled) by clicking on it again (will 
override real time updates to that component).  Manual configurations will not affect the real 
time updates of other components.  Real time failure detection in CRANS will continue to 
automatically detect failures as long as the RT OVERRIDE icon (bottom left of figure 9.2-1) 
is not selected (default configuration). 

DPS Stringing: 

If the operator desires to analyze hypothetical GPC failures, the GPC string configuration 
(NBAT) requires manual configuration.  Selecting the appropriate string configuration in the 
DPS Stringing matrix does this.  Real-time CRANS doesn’t automatically do this because it 
doesn’t have the ability to decode the NBAT.  Manual configuration of the strings is really 
only needed for the hypothetical mode.  If stringing isn’t assigned in CRANS, and an actual 
GPC failure occurs, the real-time feature of CRANS will detect and display the failure of the 
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FF and FA MDMs assigned to the failed GPC.  Therefore, the impacts of the failed GPC will 
be properly indicated even though the stringing hasn’t been assigned. 

Sub Matrices: 

Many of the components in the matrices have associated sub components (all displayed 
when you left click on the main icon).  These sub matrices show more detail of a component 
than can be practically displayed on the main matrices.  For example, some sub 
components under RNDZ RADAR are: Radar Failed, No RR to REL NAV, RR loss GPC 
ptg, etc.  If a sub component fails it will be displayed in the main matrix.   However, if 
several sub menu items fail only the highest priority (upper most) sub menu item will be 
displayed.  Thus there may be other failures that are shown in the sub menu but not on the 
main matrix level. 

System Component Failure Modes 

The operator can interrogate CRANS to display the failure logic of a component by pointing 
to the icon with the cursor, then clicking the center mouse button.  The failures that can 
impact that component will then be displayed in text form.  To exit this mode, hold the left 
mouse button down and then click the right mouse button at the same time 

Commonality Testing 

The commonality feature in CRANS may be useful to the operator in determining what 
events have a common failure.  This feature become available when one or more event box 
is “tagged” using the right mouse button as indicated by a “~” to the right of the icon. 
Tagging two or more event boxes, and then requesting commonality 

(Commands>Commonality) will result in a list of logic events which are common to the 
tagged events.  If commonality exists between the components CRANS will show what will 
fail them: “failed by _____”.  If no commonality exists CRANS will display “None”.  To return 

to the main window select Commands>Common Off.  To clear individual tags right click 

again on the icon.  To clear all tags select Commands>Clear Tags. 
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Commands Menu 

Table 9.2-1  Commands Menu Definitions 

Item Description 

Commonality See Commonality Testing section 

Fail Result Displays the downstream failure effects of tagged items in text form 

Reference Displays the items that directly reference the items that are tagged 

Clear Fails All failures and string configuration settings are reset to their startup values.  

Clear Tags All tagged items are reset (untagged).  (An item is tagged using the right mouse 
button) 

Suppress Suppresses all failed items in the selected matrix.  All this means is that the items 
change color.   Each item must be manually un-failed to return to normal 
operations.  

Print Data A summary of input and resultant failed item names is output to a printer.   If real 
time data is active then the current values of all MSIDs are output along with their 
status flags.   If this item is selected while in help, commonality, failure result or 
reference mode the contents of the display window will be printed.   

Save Config The current main window size and matrix/icon state/position information is saved to 
the configuration file that is selected under the CONFIG pulldown.    

Update Rate If real time data is being taken by the application, the update rate can be modified 
(must be greater than 1 sample per second). 

Send Data  This item is currently not functional.  

Un / Corral Corral – Matrices cannot be moved outside the main window.   Also, when moving 
or closing the main window all matrices will be closed/moved.  
UnCorral – Matrices can be moved outside the main window.  Or can be left open 
after closing the main window.    Select uncorral then select the applicable matrix.   

Locate Locates matrices. 

Exit Crans Exits the application.   

References 

CRANS User Guide, MMACS Console Handbook, JSC-26101, SCP 15.6. 
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9.3  Station Aids to Docking and 

Separation (SADS) 

9.3.1  RNDZTIME 

PURPOSE 

The RNDZTIME.xls spreadsheet is used to help in the planning of Shuttle dockings to the 
International Space Station (ISS).  The tool is integrates communication, trajectory, and lighting 
data into a single timeline that highlights important events between Ti and docking.  The software 
provides output in the form of a sequential table of events or a plot of the planned events.  The 
spreadsheet also provides a time conversion tool. 

COMPONENTS OF THE SOFTWARE 

The tool is composed of fourteen spreadsheets.  Information regarding the components is shown 
in Table 9.3-1.  For STS-114, there are two versions of the spreadsheet - one with the Rbar Pitch 
Maneuver and one without.  Since the name of the SADS spreadsheet can only be rndztime.xls, 
these two versions must be administratively maintained in separate, clearly marked directories.  
Features unique to the RPM version are described below in the Notes for the Rbar Pitch 
Maneuver. 

TYPICAL SESSION 

The following is an example of the typical use of this tool. 

1. Make a copy of the RNDZTIME.XLS spreadsheet in the user’s personal files.  Afterwards, 
remove the “read only” flag from the user’s copy of the spreadsheet. 

2. Obtain all external data needed for the spreadsheet.  This includes Predicted Site Acquisition 
Tables (PSATs) from the FDOs, approach type from the RNDZ book, array configurations, 
etc. 

3. Open the spreadsheet and complete all the needed data on the Control page. 

4. Press the EDIT COMM & LIGHTING DATA button and enter all the lighting, communication 
and TV data for the three orbits.  If needed, toggle the autocalculation off.  When complete, 
re-enable autocalculation (if needed) and press the RETURN TO CONTROL button.  It would 
probably be a good idea to perform a SAVE after any change in the data.   

5. Press the EDIT MISC DATA button and enter the camera/window constraints, the desired 
lighting calculations, any notes for the output table, and any user defined constraints.  If 
needed, toggle the autocalculation off.  When complete, re-enable autocalculation (if needed) 
and press the RETURN TO CONTROL button.  It would probably be a good idea to perform a 
SAVE after any change in the data.   

6. Generally, no updates are going to be needed for the Profile page.  However, if something 
has changed, press the EDIT PROFILE DATA button and enter the changes to the profile 
trajectory in the correct segment.  If needed, toggle the autocalculation off.  When complete, 
re-enable autocalculation (if needed) and press the RETURN TO CONTROL button.  It would 
probably be a good idea to perform a SAVE after any change in the data.   
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7. Press the EDIT PLAN DATA button and enter the prime & backup Ti and MC4 times, the 
docking times for the six possible plans and the duration of the 30 ft stationkeeping.  If the 
previously defined constraints are not satisfactory, input data in the optional categories for the 
six plans.  If needed, toggle the autocalculation off.  When complete, re-enable 
autocalculation (if needed) and press the RETURN TO CONTROL button.  It would probably 
be a good idea to perform a SAVE after any change in the data.   

8. Press the CALCULATE LIGHTING DATA button to update all the lighting calculations.  It 
would probably be a good idea to perform a SAVE after any change in the data.   

9. Press either the VIEW CURRENT PLAN DOCKING PLOT button or the VIEW CURRENT 
PLAN TABLE button and check the results.  If acceptable, print hardcopies (as needed) or 
distribute (as needed).  If changes need to be made, repeat steps 3 through 9 as needed. 

10. When the output is correct, press the GO TO RUSSIAN COMM VERIFICATION TABLE 
button and print a hardcopy (or make and electronic copy) and submit to RIO (as needed) for 
verification from the Russians.   

Notes for the Rbar Pitch Maneuver: 

For STS-114, a new sheet titled ‘RPM’ has been added to the rndztime.xls spreadsheet.  The user 
is not required to interface directly with this sheet.  The ‘RPM’ sheet computes the start window for 
the RPM using sunrise/sunset METs, Beta angle, nominal RPM pitch rate, and the geometric 
requirements for RPM photography (specified on the ‘RPM’ sheet).  The user should be aware of 
several changes that were required in order to fit this capability within the existing spreadsheet. 

1.  On the ‘Comm&Light’ sheet, the first sunset entered must be the one that immediately follows 
the nominal Ti burn.  The label for this time has been changed to “post-Ti sunset” to make this 
clear. 

2.  On the ‘Misc Data’, three lines are dedicated to the RPM start window open time, the window 
close time that assures a maximum period of photography (~93 seconds), and the window close 
time that assures 45 seconds of photography within constraints.  The METs for these three events 
were formerly available for manual input of event times.  These cells now contain formulas that 
pick the times off the ‘RPM’ sheet and must not be modified by the user.  The color of these cells 
has been changed from light blue to clear to indicate this to the user (consistent with other areas 
of the spreadsheet). 

3.  On the ‘Profiles’ sheet, two lines have been added to indicate the nominal start time and 
completion time of the RPM.  For Beta angles less than or equal to 20 degrees, the nominal RPM 
start time is set to 1 second after the opening of the window.  (This typically will result in a period 
of stationkeeping between 600 ft arrival and the RPM start, although this result is not displayed 
explicitly).  For Beta angle greater than 20 degrees, the nominal RPM start time is set to 1.9 
minutes after Rbar arrival. 

4.  The RPM times will now respond correctly to a change to the backup Ti rev. 

QA steps for the new RPM functionality: 

The following items can be checked to verify the spreadsheet is producing good RPM times: 

For 0 < |Beta| < 15 degrees: 

 Window open and RPM start at noon+4 minutes.  Window close at approximately noon+8 
minutes for the full photo window and approximately noon + 16 for the 45 second photo 
window. 

For 15 < |Beta| < 20 degrees: 

 Window open and RPM start at noon + 2 minutes.  Window close at approximately noon 
+ 8 minutes for the full photo window and approximately noon + 16 for the 45 second 
photo window. 
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For |Beta| > 20 degrees: 

 RPM window opens approximately 14-16 minutes before noon and closes at 
approximately 14-16 minutes after noon.  The nominal RPM start time should be 1.9 
minutes after Rbar arrival.   

 

 

Table 9.3-1  RNDZTIME Software Components 

Sheet Name Directly 

Accessed 

By User 

Purpose/Function 

Control Yes Input of mission overview data.  Provides buttons to access components of 
the spreadsheet and control execution of the spreadsheet functions. 

Time_Conv Yes Allows conversion between MET, GMT, DMT and Local. 
Comm & 
Light 

Yes Allows user to input lighting, satellite communication, ground station 
communication and TV coverage data for the pre-docking orbit, the docking 
orbit, and the backup docking orbit. 

Misc Data Yes Allows the user to input preferences for lighting calculations, camera and 
window field-of-view (FOV) constraints, table notes, and any event referenced 
to MC4, docking or MET. 

Profiles Yes Allows for definition of all the possible approaches to ISS.  The items are 
broken down into many segments to accommodate all possible scenarios. 

Plans Yes Allows the user to input the prime and backup Ti, MC4, docking time and 30 ft 
stationkeeping duration. 

Light_Comps No Computes all the information regarding sun in the centerline camera, sun in 
the overhead window, glare and sun in camera A/D. 

Comps No Computes all trajectory data and integrates into a single data set to be 
displayed in the output table. 

RNDZ Yes Allows user to view and print all Russian communication AOS/LOS times to be 
used for the docking time negotiation.  This sheet also contains the code to 
generate a data set to be plotted in the output plot. 

macro No Holds all the macro coding used in the spreadsheet. 
Table Yes Provides the tabular output based on the input data. 
Nom_Plot Yes Provides the plot output for the prime docking orbit. 
1RL_Plot Yes Provides the plot output for the backup docking orbit. 
VBI Control Yes Provides ability to compute whether or not ground communication coverage 

can be achieved once Orbiter has reached the Vbar. 

VBI Comps 

RPM 

No 

No 

Performs calculations to support VBI timing comps 

Computes the start window for the Rbar Pitch Maneuver 
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9.3.2.  SEPTIME 

PURPOSE 

This tool is used to help in the planning of Shuttle undockings from the International Space Station 
(ISS).  The tool integrates communication, trajectory, and lighting data into a single timeline that 
highlights important events around undocking.  The software provides output in the form of a 
sequential table of events or a plot of the planned events.  The spreadsheet also provides a time 
conversion tool. 

 

COMPONENTS OF THE SOFTWARE 

The tool is composed of twelve spreadsheets.  Information regarding the components are shown 
in Table 9.3-2. 

 

 

Table 9.3-2  SEPTIME Software Components 

Sheet Name Directly 

Accessed 

By User 

Purpose/Function 

Control Yes Input of mission overview data.  Provides buttons to access components 
of the spreadsheet and control execution of the spreadsheet functions. 

Time_Conv Yes Allows user to convert between MET, GMT, DMT and Local time. 
Comm & Light Yes Allows user to input lighting, satellite communication, ground station 

communication and TV coverage data for the pre-undocking orbit, the 
undocking orbit, and the backup undocking orbit. 

Misc Data Yes Allows the user to input preferences for lighting calculations, camera and 
window field-of-view (FOV) constraints, table notes, and any event 
referenced to undocking or MET. 

Profile Yes Allows for definition of the separation and flyaround (if applicable).  The 
sheet also helps calculate the times for a flyaround. 

Light_Comps No Computes all the information regarding sun in the centerline camera and 
sun in the overhead window. 

Comps No Computes all trajectory data and integrates into a single data set to be 
displayed in the output table. 

SEP Yes Allows user to view and print all Russian communication AOS/LOS times 
to be used for the undocking time negotiation.  This sheet also contains 
the code to generate a data set to be plotted in the output plot. 

macro No Holds all the macro coding used in the spreadsheet. 
Table Yes Provides the tabular output based on the input data. 
Nom_Plot Yes Provides the plot output for the prime undocking orbit. 
1RL_Plot Yes Provides the plot output for the backup undocking orbit. 
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TYPICAL SESSION 

The following is an example of the typical use of this tool. 

1. Make a copy of the SEPTIME.XLS spreadsheet in the user’s personal files.  Afterwards, 
remove the “read only” flag from the user’s copy of the spreadsheet. 

2. Obtain all external data needed for the spreadsheet.  This includes PSATs from the FDOs, 
separation profile from the RNDZ book, array configurations, etc. 

3. Open the spreadsheet and complete all the needed data on the Control page. 

4. Press the EDIT COMM & LIGHTING DATA button and enter all the lighting, communication 
and TV data for the three orbits.  If needed, toggle the autocalculation off.  When complete, 
re-enable autocalculation (if needed) and press the RETURN TO CONTROL button.  It would 
probably be a good idea to perform a SAVE after any change in the data.   

5. Press the EDIT MISC DATA button and enter the camera/window constraints, the desired 
lighting calculations, any notes for the output table, and any user defined constraints.  If 
needed, toggle the autocalculation off.  When complete, re-enable autocalculation (if needed) 
and press the RETURN TO CONTROL button.  It would probably be a good idea to perform a 
SAVE after any change in the data.   

6. Press the EDIT PROFILE DATA button and enter the trajectory profile for the undocking.  
When complete, re-enable autocalculation (if needed) and press the RETURN TO CONTROL 
button.  It would probably be a good idea to perform a SAVE after any change in the data.   

7. Press the CALCULATE LIGHTING DATA button to update all the lighting calculations.  It 
would probably be a good idea to perform a SAVE after any change in the data.   

8. Press either the VIEW CURRENT PLAN UNDOCKING PLOT button or the VIEW CURRENT 
PLAN TABLE button and check the results.  If acceptable, print hardcopies (as needed) or 
distribute (as needed).  If changes need to be made, repeat steps 3 through 9 as needed. 

9. When the output is correct, press the GO TO RUSSIAN COMM VERIFICATION TABLE 
button and print a hardcopy (or make and electronic copy) and submit to RIO (as needed) for 
verification from the Russians.   

 

 

                   



SHUTTLE OPS RESP:  S. Walker SADS 
RNDZ CHB/DM-CH-08 REV B PCN-2:  06/27/2005 SCP 9.3 

Verify this is correct version before use.  9.3-6 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This page intentionally left blank. 

                   



SHUTTLE OPS RESP: R. Bigonesse MCC Flightnotes Using the PC 
RNDZ CHB/DM-CH-08 REV B:  1/15/02 SCP 9.4 

 9.4-1 

9.4 Flight Notes 

PURPOSE 
To document the procedures for generating flight notes using the PCs. 

PROCEDURE 
Note:  These procedures assume that you have a user ID on the JSCMODM fileserver. 

Calling up the Flight Note system 

• Verify that the Flight Director has started the MCCPC System 

• Under the Start button, select MCC Menu 

• Select C – Applications 

• Select EFN Current Version (There will be 2 EFN choices) 

After the MCCPC initialization completes move on to the next section.  If the MCCPC 
initialization does not complete, check network connection. 

Note – The MCC PC System must be running to save and publish flight notes. 

Initializing the Flightnote Template 

• Check the ISS and Shuttle boxes at bottom right corner 

• Select New Flt Note 

• A warning prompt may appear asking about macros.  Enable macros. 

• A prompt will appear asking: 

◊ Title (e.g. Approach and Docking Timeline) 

◊ To – People to receive the Flight Note (usually FD, CAPCOM, FDO, PROP, 
FAO) 

◊ From – Sender of the Flight Note (default is GPO) 

◊ Action Required  

◊ Next Flight Planning Cycle 

◊ Not time Critical (1 – 4 hours) 

◊ ASAP 

◊ N/A – Info Only (usually used) 

Creating the Flightnote 

This section will discuss the common way the RGPO group uses the flight note system. 

Sometimes, before a flight or sim, a Microsoft Word document has been created with the 
information needed for the Flightnote.  The following will be an example of generating a Block 
22A flight note but the same basic principles can be applied to other RGPO flight notes. 
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   Block >��$@ Approach and Docking Time Flightnote Generation (no longer applicable 
after ISS 5A.1) 

• Alternating between the Flight Note Window and the Block >��$@ saved document 
can be accomplished under the Window option on the task bar. 

• Hit enter until the line numbers on the left side of the Flightnote reach 5 or 6. 

• On the >��$@ page, click on the first block (all of the approach information).  This 
block should be grouped as one object but if this is not the case: Hold down the shift 
key and left click on all the blocks to be included.  (An object is selected when blocks 
are present on the borders.  Not when there are hash marks.) 

• Select copy and switch to the Flightnote page.  Click on line 2 or 3. 

• Select Paste Special – Picture.  Verify all the information appears on the Flight Note. 

• Return to the >��$@ page and copy the RNDZ Updates data and paste it in the Flight 
Note below the block >��$@. 

• Copy the SADS spreadsheet data using the paste special – picture option.  The 
spreadsheets can be copied all at once but it may be easier to cut and paste one at a 
time. 

• Save the Flightnote using one of the three options in the following section but if 
prompted to change your save options to an upgraded version of Word – select NO.     

Saving the Flightnote 

There are three levels of flightnotes.  The three levels will appear in the middle bar on the 
Microsoft window template.  Choose the appropriate level and use the associated save 
procedure below: 

• Working Note (WN_Save): A working note is saved in the GPO WORK 
subdirectory. Use the WN_Save button on the button bar to save. 

• Internal Note (FCR_Inbox): An internal note is sent “inter-console” and will go 
into the individual operator’s INBOX subdirectory. Use the FCR_Inbox button on 
the button bar to save. 

• Flight Note (FLT_NOTE): A flight note is intended as an official note meant to be 
seen by FLIGHT, CAPCOM, and FAO (i.e., intended for uplink to the crew). These 
four positions will have messages appear on their machines when the note is sent. 
Use the FLT_NOTE button on the button bar to save. 

 

RPS will usually generate the working note using the WRK_Save.  Then after verification the 
RGPO will publish the Flightnote using the FLT_NOTE option. 

Note:  Whenever a note is saved, a name is assigned to it with the format OODDNNN.DOC, 
where: 

• OO is the operator code of the originator.  Examples are FD for Flight Director, FA 
for FAO, and FO for FDO. 

• DD is either FN for flight note, IN for internal note, WN for working note, BP for 
Burn PAD. 

• NNN is a number from 0 to 999 (incremented each time a note is sent or revised) 

                   



SHUTTLE OPS RESP: R. Bigonesse MCC Flightnotes Using the PC 
RNDZ CHB/DM-CH-08 REV B:  1/15/02 SCP 9.4 

 9.4-3 

Updating the Status of a Flightnote 

• Double-click on the ST of STATUS 

• Choose the correct STATUS from the list (Open, Closed, App_U/L, Uplinked, 
Withdrawn, etc) 

Revising a Flightnote 

• Double-click on REVISE NOTE and acknowledge the dialog with a Yes. 

• Make revisions as necessary.  Note that the revision letter in the Revision Block 
will be updated automatically by the template. 

• Follow the appropriate save procedures above. 

Viewing/Statusing Flightnotes 

• Double-click on the MCCPC icon in the Applications submenu. 

• Restrict (if desired) flightnotes based on status. 

• Select VIEW THE NOTE icon to view a note. 

Notes: 

• The database provides the filename, title, status, and time note was saved. 

• The default sort order is in reverse time order (newest at the top). 

Accessing MCCPC from a Windows95 Machine 

For now, MCCPC access is designed assuming Windows 3.1.  For Windows95 users, such as 
the Pentium in the MPSR, the access is different.  If you have created a shortcut icon per the 
following steps, simply double-click on it to access MCCPC.  To create the shortcut, perform the 
following steps: 

• With the right mouse button, single-click on the desktop. 

• In the menu, select New...Shortcut. 

• In the command line, type the following (exactly): 

U:\mccpc\mccpc229.exe  U:\mccpc\mccpc_gl.ini 

• Click on Next>. 

• In the name field, type MCCPC 2.29, then click on Finish. 

To update to a newer version of MCCPC, perform the following steps on an already-created 
shortcut: 

• With the right mouse button, single-click on the MCCPC shortcut icon. 

• In the menu, select Properties. 

• Select the Shortcut tab in the resulting dialog box. 

• In the Target line, change the 229 in mccpc229 to the newest number, and then 
click on OK. 
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BACKGROUND  
Additional information about the Flightnote Template is available below. 

Point of Contact 

Mary Lou Griffith x34306 Beeper (281) 891-9705 

Directory Structure 

As of the time of this writing, the directory structure on JSCMODM for MCCPC is below: 

 

Table 9.4-1  MCCPC Directory Structure 

Directory Description Read Access Write Access 

BURNPAD Burn PADs All FDO 
EE_CONSU  All EECOM, EGIL 
ENT_MSG  All All FCR positions 
FLT_NOTE  All All 
MCCPC  All All 
PL_CONST  All PAYLOADS 
PROP_CON  All PROP 
TIPS_UP  All All 
WX_SHEET Weather information All FDO 
MET_TMR  All  
PADM_UP PADMs for uplink All FD, CAPCOM, 

FAO, MATS 
PADM_DN PADMs downlinked All FD, CAPCOM, 

FAO, MATS 
MSG_RVW Messages to be reviewed All FAO, MATS 
INBOX\<POSITION> Messages sent to <POSITION> All All 
WORK\<POSITION> Working area for <POSITION> <POSITION> <POSITION> 

 

IDs and Passwords 

Your user ID is the same as your JSCDM server ID.  If it’s been longer than 30 days since you 
last used your password, you may have trouble logging on.  It may or may not prompt you for a 
new password.  If you have trouble, call one of the MCCPC Point-of-Contacts listed on the 
machine. 

                   



SHUTTLE OPS RESP:  S. O’Rourke ROSS Certified Alarms 
RNDZ CHB/DM-CH-08 REV B PCN-2:  06/27/2005 SCP 9.5 

 9.5-1 

9.5 ROSS Alarms 
 

PURPOSE 

The following is a reference on the certified ROSS alarms panels used by the Rendezvous team. 

 

PROCEDURES 

To certify an Alarm panel, the following actions must be performed: 

• User must provide a writeup on each field in the alarm panel, containing the 
following information 

◊ Description of alarm field contents. 

◊ Possible value(s) displayed in alarm field. 

◊ MSID(s) used to arrive at possible value(s). 

• User must test Alarm panel to verify correct operation 

• User must provide the above writeup to the ROSS Group Administrator (GA) and 
request that the panel be copied to the Read-Only area 

• User must provide the above writeup to RGPO CHB Book Manager for inclusion 
into this SCP including date built and tested 

Each alarm panel above is described in the following manner: 

• Name of alarm panel. 

• Build date and author. 

• Test date and testing engineer. 

• Picture of the alarm panel. 

• Field-by-field description of each alarm panel entry 

◊ (row, column) Alarm name as it appears in panel. 

◊ Description of alarm field contents. 

◊ Possible values displayed in alarm field. 

◊ MSIDs used to arrive at possible values. 
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BACKGROUND 

 

DAP_CONFIG Alarm Panel 

Built 08/01/95 by D.G. Hamm 

Tested 08/01/95 by D.G. Hamm 

 

 

1,1. PRIMARY DAP A 

Meaning: Displays the DAP A selected per item entry in SPEC 20 ITEM 1. 
Possible Values: PRIMARY DAP A value between 0 and 15 displayed as an integer.  Zero is 

displayed if the crew changes one of the DAP load items (equivalent to a 
'blank' on SPEC 20). 

MSID(s): V93J5779C - DAP LOAD SEL A  

 

2,1. TRANS PULSE 

Meaning: Displays the translation pulse size associated with DAP A per SPEC 20 ITEM 
17. 

Possible Values: TRANS PULSE value in ft/s displayed to 4 digits after decimal point 
MSID(s): LC_TPUL_PA - DAP A TRANS PULSE size acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93R1544C - TRANS 
PULSE LEVEL 
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3,1. ROT DISC 

Meaning: Displays the PRI rotation rate (historically known as "rot discrete") associated 
with DAP A per SPEC 20 ITEM 10. 

Possible Values: ROT DISC value in deg/s displayed to 4 digits after decimal point. 
MSID(s): LC_DIS_PA - DAP A NORM DISCRETE RATE acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93R1539C - NORM 
DISCRETE RATE 

 

4,1. ROT PULSE 

Meaning: Displays the PRI rotation velocity change (historically known as "rot pulse") 
associated with DAP A per SPEC 20 ITEM 13. 

Possible Values: ROT PULSE value in deg/s displayed to 4 digits after decimal point. 
MSID(s): LC_ROT_PA - DAP A NORM ROT PULSE LEVEL acquired by ROSS 

Telemetry from the cyclically-rotating DAP downlist contained in V93R1542C - 
NORM ROT PULSE LEVEL 

 

5,1. ATTITUDE DB 

Meaning: Displays the PRI attitude deadband associated with DAP A per SPEC 20 
ITEM 11. 

Possible Values: ATTITUDE DB value in deg displayed to 4 digits after decimal point. 
MSID(s): LC_ATT_PA - DAP A NORM ATT DEADBAND acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93H1540C - NORM 
ATT DEADBAND 

 

6,1. RATE DB 

Meaning: Displays the PRI rate deadband associated with DAP A per SPEC 20 ITEM 
12. 

Possible Values: RATE DB value in deg/s displayed to 4 digits after decimal point. 
MSID(s): LC_RAT_PA - DAP A NORM RATE LIMIT acquired by ROSS Telemetry from 

the cyclically-rotating DAP downlist contained in V93R1541C - NORM RATE 
LIMIT 

 

1,2. PRIMARY DAP B 

Meaning: Displays the DAP B selected per item entry in SPEC 20 ITEM 2. 
Possible Values: PRIMARY DAP B value between 0 and 15 displayed as an integer.  Zero is 

displayed if the crew changes one of the DAP load items (equivalent to a 
'blank' on SPEC 20). 

MSID(s): V93J5780C - DAP LOAD SEL B 

 

2,2. TRANS PULSE 

Meaning: Displays the translation pulse size associated with DAP B per SPEC 20 ITEM 
37. 

Possible Values: TRANS PULSE value in ft/s displayed to 4 digits after decimal point 
MSID(s): LC_TPUL_PB - DAP B TRANS PULSE size acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93R1544C - TRANS 
PULSE LEVEL 
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3,2. ROT DISC 

Meaning: Displays the PRI rotation rate (historically known as "rot discrete") associated 
with DAP B per SPEC 20 ITEM 30. 

Possible Values: ROT DISC value in deg/s displayed to 4 digits after decimal point. 
MSID(s): LC_DIS_PB - DAP B NORM DISCRETE RATE acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93R1539C - NORM 
DISCRETE RATE 

 

4,2. ROT PULSE 

Meaning: Displays the PRI rotation velocity change (historically known as "rot pulse") 
associated with DAP B per SPEC 20 ITEM 33. 

Possible Values: ROT PULSE value in deg/s displayed to 4 digits after decimal point. 
MSID(s): LC_ROT_PB - DAP B NORM ROT PULSE LEVEL acquired by ROSS 

Telemetry from the cyclically-rotating DAP downlist contained in V93R1542C - 
NORM ROT PULSE LEVEL 

 

5,2. ATTITUDE DB 

Meaning: Displays the PRI attitude deadband associated with DAP B per SPEC 20 
ITEM 31. 

Possible Values: ATTITUDE DB value in deg displayed to 4 digits after decimal point. 
MSID(s): LC_ATT_PB - DAP B NORM ATT DEADBAND acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93H1540C - NORM 
ATT DEADBAND 

 

6,2. RATE DB 

Meaning: Displays the PRI rate deadband associated with DAP B per SPEC 20 ITEM 
32. 

Possible Values: RATE DB value in deg/s displayed to 4 digits after decimal point. 
MSID(s): LC_RAT_PB - DAP B NORM RATE LIMIT acquired by ROSS Telemetry from 

the cyclically-rotating DAP downlist contained in V93R1541C - NORM RATE 
LIMIT 

 

1,3. VERN DAP A 

Meaning: Displays the DAP A selected per item entry in SPEC 20 ITEM 1.  (Simply a 
repeat of 1,1.) 

Possible Values: VERN DAP A value between 0 and 15 displayed as an integer.  Zero is 
displayed if the crew changes one of the DAP load items (equivalent to a 
'blank' on SPEC 20). 

MSID(s): V93J5779C - DAP LOAD SEL A 

 

2,3. TRANS PULSE 

Meaning: Displays the translation pulse size associated with DAP A per SPEC 20 ITEM 
17.  (Simply a repeat of 2,1.) 

Possible Values: TRANS PULSE value in ft/s displayed to 4 digits after decimal point 
MSID(s): LC_TPUL_PA - DAP A TRANS PULSE size acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93R1544C - TRANS 
PULSE LEVEL 

 

                   



SHUTTLE OPS RESP:  S. O’Rourke ROSS Certified Alarms 
RNDZ CHB/DM-CH-08 REV B PCN-2:  06/27/2005 SCP 9.5 

 9.5-5 

3,3. ROT DISC 

Meaning: Displays the VERN rotation rate (historically known as "rot discrete") 
associated with DAP A per SPEC 20 ITEM 23. 

Possible Values: ROT DISC value in deg/s displayed to 4 digits after decimal point. 
MSID(s): LC_DIS_VA - DAP A VERN DISCRETE RATE acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93R1545C - VERN 
DISCRETE RATE 

 

4,3. ROT PULSE 

Meaning: Displays the VERN rotation velocity change (historically known as "rot pulse") 
associated with DAP A per SPEC 20 ITEM 26. 

Possible Values: ROT PULSE value in deg/s displayed to 4 digits after decimal point. 
MSID(s): LC_ROT_VA - DAP A VERN PULSE LEVEL acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93R1548C - VERN 
PULSE LEVEL 

 

5,3. ATTITUDE DB 

Meaning: Displays the VERN attitude deadband associated with DAP A per SPEC 20 
ITEM 24. 

Possible Values: ATTITUDE DB value in deg displayed to 4 digits after decimal point. 
MSID(s): LC_ATT_VA - DAP A VERN ATT DEADBAND acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93H1546C - VERN 
ATT DEADBAND 

 

6,3. RATE DB 

Meaning: Displays the VERN rate deadband associated with DAP A per SPEC 20 ITEM 
25. 

Possible Values: RATE DB value in deg/s displayed to 4 digits after decimal point. 
MSID(s): LC_RAT_VA - DAP A VERN RATE LIMIT acquired by ROSS Telemetry from 

the cyclically-rotating DAP downlist contained in V93R1547C - VERN RATE 
LIMIT 

 

1,4. VERN DAP B 

Meaning: Displays the DAP B selected per item entry in SPEC 20 ITEM 2.  (Simply a 
repeat of 1,2.) 

Possible Values: VERN DAP B value between 0 and 15 displayed as an integer.  Zero is 
displayed if the crew changes one of the DAP load items (equivalent to a 
'blank' on SPEC 20). 

MSID(s): V93J5780C - DAP LOAD SEL B 

 

2,4. TRANS PULSE 

Meaning: Displays the translation pulse size associated with DAP B per SPEC 20 ITEM 
37.  (Simply a repeat of 2,2.) 

Possible Values: TRANS PULSE value in ft/s displayed to 4 digits after decimal point 
MSID(s): LC_TPUL_PB - DAP B TRANS PULSE size acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93R1544C - TRANS 
PULSE LEVEL 
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3,4. ROT DISC 

Meaning: Displays the VERN rotation rate (historically known as "rot discrete") 
associated with DAP B per SPEC 20 ITEM 43. 

Possible Values: ROT DISC value in deg/s displayed to 4 digits after decimal point. 
MSID(s): LC_DIS_VB - DAP B VERN DISCRETE RATE acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93R1545C - VERN 
DISCRETE RATE 

 

4,4. ROT PULSE 

Meaning: Displays the VERN rotation velocity change (historically known as "rot pulse") 
associated with DAP B per SPEC 20 ITEM 46. 

Possible Values: ROT PULSE value in deg/s displayed to 4 digits after decimal point. 
MSID(s): LC_ROT_VB - DAP B VERN PULSE LEVEL acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93R1548C - VERN 
PULSE LEVEL 

 

5,4. ATTITUDE DB 

Meaning: Displays the VERN attitude deadband associated with DAP B per SPEC 20 
ITEM 44. 

Possible Values: ATTITUDE DB value in deg displayed to 4 digits after decimal point. 
MSID(s): LC_ATT_VB - DAP B VERN ATT DEADBAND acquired by ROSS Telemetry 

from the cyclically-rotating DAP downlist contained in V93H1546C - VERN 
ATT DEADBAND 

 

6,4. RATE DB 

Meaning: Displays the VERN rate deadband associated with DAP B per SPEC 20 ITEM 
45. 

Possible Values: RATE DB value in deg/s displayed to 4 digits after decimal point. 
MSID(s): LC_RAT_VB - DAP B VERN RATE LIMIT acquired by ROSS Telemetry from 

the cyclically-rotating DAP downlist contained in V93R1547C - VERN RATE 
LIMIT 
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DAP_ORB_TGT Alarm Panel 

Built 02/03/94 by J.L. Williams 

Tested 02/03/94 thru 02/07/94 by J.L. Williams 

Revision A Built and Tested 04/11/96 by J.L. Williams 

 

 

1,1. ACTIVE DAP 

Meaning: Displays the active DAP.  Preloaded DAP numbers range from 1-15.  If the 
crew changes any of the DAP preloads, the DAP number is received as zero. 

Possible Values: DAP PRI A (followed by DAP number) 
 DAP VERN A (followed by DAP number) 
 DAP ALT A (followed by DAP number) 
 DAP PRI B (followed by DAP number) 
 DAP VERN B (followed by DAP number) 
 DAP ALT B (followed by DAP number) 
 DAP UNDETERMINED - no active DAP 

MSID(s): V72X2807X - FWD DAP SELECT A (LIGHT) 
 V72X2808X - FWD DAP SELECT B (LIGHT) 
 V72X2855X - FWD RCS JETS NORM (LIGHT) 
 V72X2856X - FWD RCS JETS VERNIER (LIGHT) 
 V72X2896X - FWD ALT PRCS MODE (LIGHT) 

 

2,1. TRANS PULSE 

Meaning: Displays the TRANS PLS size of the active DAP. 
Possible Values: TRANS PULSE in ft/s displayed to 2 digits after the decimal point. 

MSID(s): V90U2795C - TRANS VEL CHANGE-MAG PER PULSE 

 

3,1. ROT DISC 

Meaning: Displays the ROT DISC size of the active DAP. 
Possible Values: ROT DISC in deg/s displayed to 3 digits after the decimal point. 

MSID(s): V90U2787C - DISCRETE MANEUVER RATE-MAGNITUDE 
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4,1. ROT PULSE 

Meaning: Displays the ROT PULSE size of the active DAP. 
Possible Values: ROT PULSE in deg/s displayed to 3 digits after the decimal point. 

MSID(s): V90U2794C - BODY ANG RATE CHG-MAG PER PULSE 

 

5,1. ATTITUDE DB 

Meaning: Displays the ATTITUDE DB size of the active DAP. 
Possible Values: ATTITUDE DB in deg displayed to 3 digits after the decimal point. 

MSID(s): V90H2785C - PHASE PLANE ATT DBD-MAG REQ(ROLL) 

 

6,1. RATE DB 

Meaning: Displays the RATE DB size of the active DAP. 
Possible Values: RATE DB in deg/s displayed to 3 digits after the decimal point. 

MSID(s): V90U2786C - PHS PLANE RATE ERR LIM-MAG REQ R 

 

1,2. MC2 TIG 

Meaning: Displays the difference between the MC2 TIG computed onboard and the 
nominal MC2 TIG. 

Possible Values: NON MC2 MNVR 
 MC2 TIG ON TIME - displayed if difference less than 2 sec 
 MC2 EARLY value displayed in MM:SS 
 MC2 LATE value displayed in MM:SS 
 MC2 EARLY LIM state limit indicator set to 3 min 
 MC2 LATE LIM state limit indicator set to 7 min 

MSID(s): V95J7466C - MNVR TGT NO COMPUTED 
 LC_NXTMNVR - Next maneuver number as computed by ROSS Navcon 
 LC_ORBTIG - Onboard TIG solution from VAR PARAM slots designated in 

the ROSS Telemetry Options 
 LC_OTTIG - I-Loaded next TIG based on the next maneuver as computed by 

ROSS Navcon 

 

2,2. TIG DIFF CHK 

Meaning: Displays the difference, if any, between the onboard targeted TIG and the 
ROSS-computed TIG. 

Possible Values: TIG DIFF OK - displayed if difference less than 2 sec 
 TIG DIFF value displayed in MM:SS 
 MNVR MISMATCH 

MSID(s): V95J7466C - MNVR TGT NO COMPUTED 
 LC_NXTMNVR - Next maneuver number as computed by ROSS Navcon 
 LC_ORBTIG - Onboard TIG solution from VAR PARAM slots designated in 

the ROSS Telemetry Options 
 LC_NXTTIG - Next maneuver TIG as computed by ROSS Navcon 
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3,2. MNVR VIEW 

Meaning: Displays the current selected TGT Set numbers for both onboard and ROSS 
computations in a format XX.YY where XX=onboard and YY=ROSS 

Possible Values:  MNVR IDs 9.09 - both targeting NCC 
  MNVR IDs 10.10 - both targeting Ti 
  MNVR IDs 11.11 - both targeting MC1 
  MNVR IDs 12.12 - both targeting MC2 on EL 
  MNVR IDs 19.12 - onboard targeting MC2 on TIME 
  MNVR IDs 13.13 - both targeting MC3 
  MNVR IDs 14.14 - both targeting MC4 
  MNVR DIFF XX.YY - displayed for anything else 
MSID(s): V95J7466C - MNVR TGT NO COMPUTED 

 LC_NXTMNVR - Next maneuver number as computed by ROSS Navcon 

 

4,2. O-IGN CLOCK 

Meaning: Displays the time to the next maneuver based on ROSS calculations. 
Possible Values: O-IGN value displayed in HH:MM:SS with color state limits set to 5 and 1 min 

 O_IGN NOW! - special color state limit set to 0 sec 
MSID(s): LC_NXTTIG - Next maneuver TIG as computed by ROSS Navcon 

 LC_F22PET - Current PET in sec 

 

5,2. Y NODE XING 

Meaning: Displays the time until the next Y node crossing based on onboard vectors. 
Possible Values: Y NODE time displayed in MM:SS 

MSID(s): LC_YCRSTIM - Y-node crossing delta time computed by ROSS 

 

6,2. Y NODE VEL 

Meaning: Displays the anticipated velocity at the next Y node crossing based on 
onboard vectors. 

Possible Values: Y NODE VEL in ft/s displayed to 2 digits after decimal point 
MSID(s): LC_YNODVEL - Y-node velocity when crossing node as computed by ROSS 
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IMU_ST_21_22 Alarm Panel 

Built 02/03/94 by J.L. Williams 

Tested 02/03/94 thru 02/07/94 by J.L. Williams 

Revision A Built and Tested 12/01/97 by J.L. Williams 

 

 

1,1. IMU PRIME SELECT 

Meaning: Displays the onboard prime selected IMU 
Possible Values: PRIME SELECT IMU 1 

 PRIME SELECT IMU 2 
 PRIME SELECT IMU 3 

MSID(s): V90J2560C - SELECTED IMU ID 

 

2,1. STRK STAR LOCK 

Meaning: Indicates if the star tracker, when in TGT TRK, has locked onto a star by 
comparing consecutive measurements.  Assuming LVLH hold, a star will 
move through the field of view at orbit rate (0.06 deg/s).  The threshold used 
by this alarm panel is 0.450 degrees over an 8-second cycle. 

Possible Values: STAR LOCK - displayed if delta measurements >= 0.450 
 STRK OK - otherwise 

MSID(s): V90H0214C - TAC R/OPTICS V/Y/EL MEAS RESIDUAL 

 

3,1. STRK TGT TRACK 

Meaning: Indicates if the star tracker is tracking a target.  This bit is set by the star 
tracker logic once acquisition is confirmed. 

Possible Values: STRK GOOD TGT TRK 
 STRK NOT TRACKING TGT 

MSID(s): V90U4836C - SNAP STAR TRACKER MODE IND 
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4,1. -Y STRK STAR PRESENT 

Meaning: Indicates if the -Y star tracker detects a target in its field-of-view. 
Possible Values: -Y STRK STAR PRESENT 

 -Y STRK NO STAR PRES 
MSID(s): V71X5526B - -Y ST STAR PRESENT 

 

5,1. -Y STRK SHUTTER 

Meaning: Indicates the status of the -Y star tracker shutter. 
Possible Values: -Y STRK SHUTTER OP 

 -Y STRK SHUTTER CL 
MSID(s): V71X5524B - -Y ST SHUTTER CLOSED 

 

6,1. -Y STRK STATUS 

Meaning: Indicates the -Y star tracker mode per the downlisted status word. 
Possible Values: -Y STRK LOCK 

 -Y STRK STST FAIL 
 -Y STRK STST PASS 
 -Y STRK FALSE TGT 
 -Y STRK OUT FOV 
 -Y STRK HIGH RATE 
 -Y STRK NO TGT PRES 

MSID(s): V95J4930C - -Y ST STATUS INDICATION 

 

1,2. IMU DESELECT 

Meaning: Indicates the onboard deselected IMU. 
Possible Values: DESELECT IMU 1 

 DESELECT IMU 2 
 DESELECT IMU 3 
 DESELECT IMU 1 & 2 
 DESELECT IMU 1 & 3 
 DESELECT IMU 2 & 3 
 DESELECT ALL IMUs 
 3-LEVEL IMU 

MSID(s): V93X6711X - IMU 1 SEL/DES CMD 
 V93X6712X - IMU 2 SEL/DES CMD 
 V93X6713X - IMU 3 SEL/DES CMD 

notes: This field is unreliable if multiple IMUs are deselected. 

 

2,2. IMU SWITCHING 

Meaning: Indicates if a prime select IMU switch occurs during star tracker navigation.  
The switching notice will appear for approximately one second then revert to 
the neutral state. 

Possible Values: IMUs SWITCHING 
 IMUs OK 

MSID(s): V90X4868X - IND ST TO BE PROC BY FILTER 
 V90U4836C - SNAP STAR TRACKER MODE IND 
 V90J2560C - SELECTED IMU ID 

 

3,2. STRK DATA GOOD 

Meaning: Indicates whether the star tracker data good flag is ON. 
Possible Values: STRK DATA GOOD 

 STRK DATA 
MSID(s): V90X4835X - SNAP STAR TRACKER DATA GOOD 
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4,2. -Z STRK STAR PRESENT 

Meaning: Indicates if the -Z star tracker detects a target in its field-of-view. 
Possible Values: -Z STRK STAR PRESENT 

 -Z STRK NO STAR PRES 
MSID(s): V71X5026B - -Z ST STAR PRESENT 

 

5,2. -Z STRK SHUTTER 

Meaning: Indicates the status of the -Z star tracker shutter. 
Possible Values: -Z STRK SHUTTER OP 

 -Z STRK SHUTTER CL 
MSID(s): V71X5024B - -Z ST SHUTTER CLOSED 

 

6,2. -Z STRK STATUS 

Meaning: Indicates the -Z star tracker mode per the downlisted status word. 
Possible Values: -Z STRK LOCK 

 -Z STRK STST FAIL 
 -Z STRK STST PASS 
 -Z STRK FALSE TGT 
 -Z STRK OUT FOV 
 -Z STRK HIGH RATE 
 -Z STRK NO TGT PRES 

MSID(s): V95J4929C - -Z ST STATUS INDICATION 
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MIR_DOCK_STAT Alarm Panel 

Built 03/30/95 by M.M. Fletcher 

Tested 03/30/95 by M.M. Fletcher 

Revision A Verified 04/11/96 by J.L. Williams (removed TORF column) 

 

 

1,1. RING ALIGNMENT 

Meaning: Indicates if the docking system ring is aligned. 
Possible Values: Alignment OFF 

 Alignment ON 
MSID(s): V53X0782E - RING ALIGNMENT 

 

2,1. CONTACT 

Meaning: Indicates if the docking system contact switch has been tripped.  This usually 
occurs upon metal-to-metal contact, but it is possible to capture without 
tripping this contact if there is no misalignment between the docking 
interfaces. 

Possible Values: Contact OFF 
 Contact ON 

MSID(s): V53X0781E - INITIAL CONTACT 

 

3,1. CAPTURE 

Meaning: Indicates if the docking system capture latches have been tripped.  This 
usually occurs after initial contact, but it is possible to get this indication 
without a CONTACT indication if there is no misalignment between the 
docking interfaces. 

Possible Values: Capture OFF 
 Capture ON 

MSID(s): V53X0757E - CAPTURE 

 

4,1. DAMPING 

Meaning: Indicates if the docking system motion dampers are active.  This occurs after 
CAPTURE. 

Possible Values: Damping OFF 
 Damping ON 

MSID(s): V53X0771E - ELECTROMAG BRAKE ACTUATION 
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1,2. MIR DOCK DAP STATUS 

Meaning: Indicates if the Post-Contact Thrust (PCT) sequence is armed. 
Possible Values: PCT ARM 

 PCT INHIBIT 
MSID(s): V90X0109X - DOCKING ARM 

 

2,2. READY TO HOOK 

Meaning: Indicates that the two structural rings rings are in close proximity and that the 
hooks are ready to close. This is one of the last lights the crew checks for 
undocking status. 

Possible Values: Ready to Hook OFF 
 Ready to Hook ON 

MSID(s): V53X0752E - READY TO HOOK 

 

3,2. MIR UNDOCK 

Meaning: Indicates if the undocking sequence is complete. 
Possible Values: Undock Cmplt OFF 

 Undock Cmplt ON 
MSID(s): V53X0751E - UNDOCK COMPLETE 

 

4,2. CAPTURE LATCH 

Meaning: Indicates if the capture latches are being latched.  The capture latches 
provide only a temporary connection.  Once hooks are closed the capture 
latches are released. 

Possible Values: Latch Command OFF 
 Latch Command ON 

MSID(s): V53X0783E - ACTUATION OF CAPTURE LATCH DRIVE 
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OMS_RCS_Stat Alarm Panel 

Built 04/01/96 by J.L. Williams 

Tested 04/11/96 by J.L. Williams 

 

 

1,1. OPS/MM CONTROL 

Meaning: If in OPS 2, indicates the active major mode (201, 202) and the active DAP 
control (AUTO, INRTL, LVLH, FREE). 

Possible Values: MM 202 AUTO 
 MM 202 INRTL 
 MM 202 LVLH 
 MM 202 FREE 
 MM 201 AUTO 
 MM 201 INRTL 
 MM 201 LVLH 
 MM 201 FREE 
 NOT OPS 2 

MSID(s): V72X2850X - FWD DAP AUTO (LIGHT) 
 V72X2849X - FWD DAP MAN INRTL (LIGHT) 
 V72X2868X - FWD MANUAL LVLH (LIGHT) 
 V72X2897X - FWD FREE DRIFT MODE (LIGHT) 
 V90Q8001C - MAJOR MODE CODE 

 

2,1. OMS FIRING 

Meaning: Indicates if either or both OMS engine(s) is firing. 
Possible Values: BOTH OMS 

 LEFT OMS 
 RIGHT OMS 
 OMS OFF 

MSID(s): V43K4583X - OMS-L ENG CONTROL VLV 1 COIL 1 OP 
 V43K5583X - OMS-R ENG CONTROL VLV 1 COIL 1 OP 
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3,1. ENGINE SELECT 

Meaning: Indicates the engine selected per entry into ORBIT MNVR EXEC 201 ITEMS 
1-4. 

Possible Values: ENG SEL BOTH OMS 
 ENG SEL LEFT OMS 
 ENG SEL RIGHT OMS 
 ENG SEL +X RCS 
 ENG SEL UNKNOWN 

MSID(s): V94J3791C - PRIME PROP SYS INDICATOR FLAG 

 

4,1. RCS FUEL/OX LEFT 

Meaning: Displays the percentage of fuel and oxidizer remaining in the left tank in a 
format FU.OX where FU=fuel and OX=oxidizer. 

Possible Values: RCS L FU.OX % - fuel percentage to left of decimal, ox to right 
MSID(s): V72Q1375C - RCS-L AFT FU QUANTITY 

 V72Q1374C - RCS-L AFT OX QUANTITY 

 

5,1. RCS FUEL/OX RIGHT 

Meaning: Displays the percentage of fuel and oxidizer remaining in the right tank in a 
format FU.OX where FU=fuel and OX=oxidizer. 

Possible Values: RCS R FU.OX % - fuel percentage to left of decimal, ox to right 
MSID(s): V72Q1379C - RCS-R AFT FU QUANTITY 

 V72Q1378C - RCS-R AFT OX QUANTITY 

 

6,1. RCS FUEL/OX FWD 

Meaning: Displays the percentage of fuel and oxidizer remaining in the fwd tank in a 
format FU.OX where FU=fuel and OX=oxidizer. 

Possible Values: RCS F FU.OX % - fuel percentage to left of decimal, ox to right 
MSID(s): V72Q1371C - RCS FWD FU QUANTITY 

 V72Q1370C - RCS FWD OX QUANTITY 

 

1,2. TRANS X 

Meaning: Indicates RCS jet activity in the +/-X direction based upon jet chamber 
pressures. 

Possible Values: +X FIRING 
 -X FIRING 
 X - neutral state 

MSID(s): T_POS_X - LOCI comp based on +X jet chamber pressures 
 T_NEG_X - LOCI comp based on -X jet chamber pressures 

 

2,2. TRANS Y 

Meaning: Indicates RCS jet activity in the +/-Y direction based upon jet chamber 
pressures. 

Possible Values: +Y FIRING 
 -Y FIRING 
 Y - neutral state 

MSID(s): T_POS_Y - LOCI comp based on +Y jet chamber pressures 
 T_NEG_Y - LOCI comp based on -Y jet chamber pressures 
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3,2. TRANS Z 

Meaning: Indicates RCS jet activity in the +/-Z direction based upon jet chamber 
pressures. 

Possible Values: HI Z FIRING! 
 LO Z FIRING 
 +Z FIRING 
 -Z FIRING 
 Z - neutral state 

MSID(s): T _HI_POS_Z - LOCI comp based on HI Z jet chamber pressures 
 T_LOW_POS_Z - LOCI comp based on LO Z jet chamber pressures 
 T_POS_Z - LOCI comp based on +Z jet chamber pressures 
 T_NEG_Z - LOCI comp based on -Z jet chamber pressures 

 

4,2. ROT PITCH 

Meaning: Indicates RCS jet activity in the +/-pitch direction based upon jet chamber 
pressures. 

Possible Values: PRI +PIT FIRING 
 PRI -PIT FIRING 
 VERN +PIT FIRING 
 VERN -PIT FIRING 
 LO Z ATT +PIT FIRING 
 LO Z ATT -PIT FIRING 
 PITCH - neutral state 

MSID(s): R_POS_PITCH - LOCI comp based on +pitch pri jet chamber pressures 
 R_NEG_PITCH - LOCI comp based on -pitch pri jet chamber pressures 
 V_POS_PITCH - LOCI comp based on +pitch vernier jet chamber pressures 
 V_NEG_PITCH - LOCI comp based on -pitch vernier jet chamber pressures 
 Z_POS_PITCH - LOCI comp based on +pitch LO Z attitude pri jet chamber 

pressures 
 Z_NEG_PITCH - LOCI comp based on -pitch LO Z attitude pri jet chamber 

pressures 

 

5,2. ROT ROLL 

Meaning: Indicates RCS jet activity in the +/-roll direction based upon jet chamber 
pressures. 

Possible Values: PRI +ROLL FIRING 
 PRI -ROLL FIRING 
 VERN +ROLL FIRING 
 VERN -ROLL FIRING 
 LO Z ATT +ROLL FIRING 
 LO Z ATT -ROLL FIRING 
 ROLL - neutral state 

MSID(s): R_POS_ROLL - LOCI comp based on +roll pri jet chamber pressures 
 R_NEG_ROLL - LOCI comp based on -roll pri jet chamber pressures 
 V_POS_ROLL - LOCI comp based on +roll vernier jet chamber pressures 
 V_NEG_ROLL - LOCI comp based on -roll vernier jet chamber pressures 
 Z_POS_ROLL - LOCI comp based on +roll LO Z attitude pri jet chamber 

pressures 
 Z_NEG_ROLL - LOCI comp based on -roll LO Z attitude pri jet chamber 

pressures 
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6,2. ROT YAW 

Meaning: Indicates RCS jet activity in the +/-ya direction based upon jet chamber 
pressures. 

Possible Values: PRI +YAW FIRING 
 PRI -YAW FIRING 
 VERN +YAW FIRING 
 VERN -YAW FIRING 
 YAW - neutral state 

MSID(s): R_POS_YAW - LOCI comp based on +yaw pri jet chamber pressures 
 R_NEG_YAW - LOCI comp based on -yaw pri jet chamber pressures 
 V_POS_YAW - LOCI comp based on +yaw vernier jet chamber pressures 
 V_NEG_YAW - LOCI comp based on -yaw vernier jet chamber pressures 
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REL_NAV_33 Alarm Panel 

Built 02/03/94 by J.L. Williams 

Tested 02/03/94 thru 02/07/94 by J.L. Williams 

Revision A Built and Tested 04/11/96 by J.L. Williams and T.G. Miller 

Revision B Built and Tested 10/31/97 by J.L. Williams 

 

 

                   



SHUTTLE OPS RESP:  S. O’Rourke ROSS Certified Alarms 
RNDZ CHB/DM-CH-08 REV B PCN-2:  06/27/2005 SCP 9.5 

 9.5-20 

1,1. RNDZ NAV 

Meaning: Indicates whether RNDZ NAV is enabled or disabled per entry into SPEC 33 
ITEM 1. Will indicate for 1 cycle if RNDZ NAV state changes from ENA to DIS.  
Finally, indicates if UNIV PTG has TGT TRK selected and RNDZ NAV not 
enabled. 

Possible Values: RNDZ NAV ENABLED 
 RNDZ NAV NOT ENABLED 
 RNDZ NAV JUST DISABLED - displayed for 1 cycle when transition from 

ENABLED to DISABLED occurs, then reverts to RNDZ NAV NOT ENABLED 
 RNAV DIS & TGT ID = 1 

MSID(s): V90X4765X - RNDZ NAV ACTIVE FLAG 
 V93U6810C - TGT VECTOR ID 

Note: This field combines the functionality of two former fields. 

 

2,1. KU ANT 

Meaning: Indicates whether Ku antenna enable flag is set per entry in SPEC 33 ITEM 2 
Possible Values: KU ANT ENABLED 

 KU ANT NOT ENABLED 
MSID(s): V93X6859X - KU ANTENNA ENA/INH CMD 

 

3,1. MEAS ENA 

Meaning: Indicates whether MEAS_ENABLE flag is set per entry in SPEC 33 ITEM 3 
Possible Values: MEAS ENA ON 

 MEAS ENA OFF 
MSID(s): V90X1417X - NAV MEASUREMENT ENABLE IND 

 

4,1. SV SEL 

Meaning: Indicates whether the PROP or FLTR vector is selected per entry in SPEC 33 
ITEM 4 and also indicates if any vector transfers are commanded per entry in 
SPEC 33 ITEM 8 thru ITEM 11.  Selected vector transfer appears for 1-2 
seconds, then reverts to the PROP/FLTR selection. 

Possible Values: SV SEL PROP - true if PROP vector selected 
 SV SEL FLTR - true if FLTR vector selected 
 FLTR TO PROP - SPEC 33 ITEM 8 selected. 
 PROP TO FLTR - SPEC 33 ITEM 9 selected. 
 ORB TO TGT - SPEC 33 ITEM 10 selected. 
 TGT TO ORB - SPEC 33 ITEM 11 selected. 

MSID(s): V90X4986X - POS FDBK UPP SOURCE FLAG 
 V90X4984X - POS FDBK FLTRD TO PROP FLAG 
 V90X4985X - POS FDBK PROP TO FLTRD FLAG 
 V90X1413X - ORBITER TO TARGET SV IND 
 V90X1414X - TARGET TO ORBITER SV IND 

 

5,1. COAS X 

Meaning: Displays where in the COAS X direction the TGT should be based on -Z S 
TRK measurements. 

Possible Values: COAS X in deg displayed to 2 digits after decimal point 
MSID(s): V95H4940C - VERTICAL OFFSET OF -Z COAS IND 
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6,1. COAS Y 

Meaning: Displays where in the COAS Y direction the TGT should be based on -Z S 
TRK measurements. 

Possible Values: COAS Y in deg displayed to 2 digits after decimal point 
MSID(s): V95H4941C - HORIZ OFFSET OF -Z COAS IND 

 

7,1. ANG SEL 

Meaning: Indicates the angle source selected for incorporation into RNDZ NAV per 
entry in SPEC 33 ITEM 12 thru ITEM 14. Also indicates if there is a mismatch 
between the ANG SEL and the Ku ANT ENA state indicated per SPEC 33 
ITEM 2. 

Possible Values: ANG SEL S TRK 
 ANG SEL RR 
 ANG SEL COAS 
 ANG SEL RR & Ku ANT NT ENA 
 ANG SEL STRK & Ku ANT ENA 

MSID(s): V90J1416C - ST/RR/COAS DATA SEL IND 
 V93X6859X - KU ANTENNA ENA/INH CMD 

 

8,1. RNG RESID 

Meaning: Displays the range residual computed by RNDZ NAV. 
Possible Values: RNG RESID in kft displayed to 3 digits after decimal point 

MSID(s): V90H0221C - BARO ALT/RR RNG MEAS RESIDUAL 

 

9,1. RDOT RESID 

Meaning: Displays the range rate residual computed by RNDZ NAV. 
Possible Values: RDOT RESID in ft/s displayed to 3 digits after decimal point 

MSID(s): V90A0711C - DRAG ALT/RR R DOT MEAS RESIDUAL 

 

10,1. V/EL/Y RESID 

Meaning: Displays the Vertical (S TRK), Trunnion (RR), or Y (COAS) angle residual 
computed by RNDZ NAV per the selected angle source. 

Possible Values: V/EL/Y RESID in deg displayed to 3 digits after decimal point 
MSID(s): V90H0214C - TAC R/OPTICS V/Y/EL MEAS RESIDUAL SPECIAL 

 

11,1. H/AZ/X RESID 

Meaning: Displays the Horizontal (S TRK), Shaft (RR), or X (COAS) angle residual 
computed by RNDZ NAV per the selected angle source. 

Possible Values: H/AZ/X RESID in deg displayed to 3 digits after decimal point 
MSID(s): LC_AZRESID - derived from V90H0212C - TAC AZ/OPTICS H/X/AZ MEAS 

RESIDUAL SPECIAL after converting from rad to deg 

 

12,1. RR RANGE DATA GOOD 

Meaning: Data good indicator for range data.  Will indicate LOST DGs for 1 cycle if 
state changes from GOOD to NO GOOD. 

Possible Values: RR RANGE DATA GOOD 
 RR RANGE LOST DGs 
 RR RANGE NO DG IND 

MSID(s): V74X2615J - KU-A CH1 RANGE DATA GOOD (R)WD2B14 
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1,2. SV UPDATE 

Meaning: Displays the magnitude of the last RNDZ NAV sensor position update made 
to the FLTR vector. 

Possible Values: SV UPDATE in ft displayed to the nearest foot with color state limit 
threshholds set at 10 and 50 feet 

MSID(s): V90H4999C - RSS FLTR CORRECTION POS 

 

2,2. F-P 

Meaning: Displays the RSS position difference between the FLTR and PROP state 
vectors. 

Possible Values: F-P in ft displayed to the nearest foot 
MSID(s): V90H4997C - RSS FLTR MINUS PROP POS 

 

3,2. COVAR 

Meaning: Displays the value of the RSS of the 1,1 2,2 and 3,3 covariance matrix 
elements and indicates if a COVAR REINIT has been issued per entry in 
SPEC 33 ITEM 16. 

Possible Values: COVAR RSS displayed to zero digits after the decimal point 
 COVAR REINIT - SPEC 33 ITEM 16 issued. 

MSID(s): V90U4006C - COVARIANCE MATRIX ELEMENT 1,1 
 V90U4027C - COVARIANCE MATRIX ELEMENT 2,2 
 V90U4047C - COVARIANCE MATRIX ELEMENT 3,3 
 V90X1415X - COVAR MATRIX REINIT IN PROG FLAG 

 

4,2. ONAV RANGE 

Meaning: If RNDZ NAV is enabled, displays the range between the chaser and target 
based upon onboard vectors. 

Possible Values: ONAV RNG in ft displayed to 1 digit after decimal point 
 ONAV RNG N/A - if RNDZ NAV is not enabled 

MSID(s): V90X4765X - RNDZ NAV ACTIVE FLAG 
 LC_LVRFX - X-LVLH component of TARGET minus FLTR vectors computed 

by ROSS Telemetry 
 LC_LVRFY - Y-LVLH component of TARGET minus FLTR vectors computed 

by ROSS Telemetry 
 LC_LVRFZ - Z-LVLH component of TARGET minus FLTR vectors computed 

by ROSS Telemetry 

 

5,2. E3-E1 GRNG 

Meaning: Displays the range between the chaser and target based upon the contents of 
ephimerides 3 (target) and 1 (chaser). 

Possible Values: E3-1 GRNG in ft displayed to 1 digit after decimal point 
MSID(s): EPH1_M50_X - M50 X-component of ephemeris 1 

 EPH1_M50_Y - M50 Y-component of ephemeris 1 
 EPH1_M50_Z - M50 Z-component of ephemeris 1 
 EPH3_M50_X - M50 X-component of ephemeris 3 
 EPH3_M50_Y - M50 Y-component of ephemeris 3 
 EPH3_M50_Z - M50 Z-component of ephemeris 3 
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6,2. E4-E1 GRNG 

Meaning: Displays the range between the chaser and target based upon the contents of 
ephimerides 4 (target) and 1 (chaser). 

Possible Values: E4-1 GRNG in ft displayed to 1 digit after decimal point 
MSID(s): EPH1_M50_X - M50 X-component of ephemeris 1 

 EPH1_M50_Y - M50 Y-component of ephemeris 1 
 EPH1_M50_Z - M50 Z-component of ephemeris 1 
 EPH4_M50_X - M50 X-component of ephemeris 4 
 EPH4_M50_Y - M50 Y-component of ephemeris 4 
 EPH4_M50_Z - M50 Z-component of ephemeris 4 

 

7,2. DV COUNT 

Meaning: Displays the current value in the delta-V counter. Displays a color state 
change for 1 cycle when the value increments. 

Possible Values: DV COUNT displayed as an integer 
MSID(s): V90J5184C - NO. OF ACCUM DELTA VELOCITIES 

 

8,2. RNG RATIO 

Meaning: Displays the range residual ratio as computed by RNDZ NAV. 
Possible Values: RNG RATIO displayed to 3 digits after decimal point 

 RNG RATIO HI color state limit threshhold set at 0.300 
MSID(s): V90U0222C - BARO ALT/RR RNG RESID RATIO 

 

9,2. RDOT RATIO 

Meaning: Displays the rdot residual ratio as computed by RNDZ NAV. 
Possible Values: RDOT RATIO displayed to 3 digits after decimal point 

 RDOT RATIO HI color state limit threshhold set at 0.300 
MSID(s): V90U0713C - DRAG ALT/RR R DOT RESID RATIO 

 

10,2. V/EL/Y RATIO 

Meaning: Displays the Vertical (S TRK), Trunnion (RR), or Y (COAS) angle ratio 
computed by RNDZ NAV per the selected angle source. 

Possible Values: V/EL/Y RATIO displayed to 3 digits after decimal point 
 V/EL/Y RAT HI color state limit threshhold set at 0.300 

MSID(s): V90U0217C - TAC R/OPTICS V/Y/EL RESID RATIO 

 

11,2. H/AZ/X RATIO 

Meaning: Displays the Horizontal (S TRK), Shaft (RR), or X (COAS) angle residual ratio 
computed by RNDZ NAV per the selected angle source. 

Possible Values: H/AZ/X RATIO displayed to 3 digits after decimal point 
 H/AZ/X RAT HI color state limit threshhold set at 0.300 

MSID(s): V90U0216C - TAC AZ/OPTICS H/X/AZ RESID RATIO 

 

12,2. RR RNG RATE DATA GOOD 

Meaning: Data good indicator for range rate data.  Will indicate LOST DGs for 1 cycle if 
state changes from GOOD to NO GOOD. 

Possible Values: RR RNG RATE DATA GOOD 
 RR RNG RATE LOST DGs 
 RR RNG RATE NO DG IND 

MSID(s): V74X2616J - KU-A CH1 RANGE RATE GOOD (R)WD2B15 
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1,3. RR RNG  

Meaning: Displays the line-of-sight raw range to the target. 
Possible Values: RR RNG in ft displayed to 1 digit after decimal point 

 RR RNG ZERO 
 RNG > 135 kft color state limit threshhold set at 135,000 ft 

MSID(s): V74U2623J - KU-A CH 1 RDR RANGE BITS 01-23 

 

2,3. RR RDOT  

Meaning: Displays the line-of-sight raw range rate to the target. 
Possible Values: RR RDOT in ft/s displayed to 3 digits after decimal point with color  state 

thresholds set to indicate opening or closing rates 
MSID(s): V74R2621J - KU-A CH 1 RANGE RATE BITS 01-16WD5 

 

3,3. RR EL 

Meaning: Displays the elevation angle of the Ku antenna relative to its null position 
pointing along the -Z body axis of the Orbiter.  Positive elevation is towards 
the nose. 

Possible Values: RR EL in deg displayed to 2 digits after decimal point with color state limit 
threshholds set to 5 and 30 deg 

MSID(s): V74H2619J - KU-BAND A CH1 PITCH WORD 4  WD4 

 

4,3. RR AZ 

Meaning: Displays the azimuth angle of the Ku antenna relative to its null position 
pointing along the -Z body axis of the Orbiter.  Positive azimuth is towards the 
port wing. 

Possible Values: RR AZ in deg displayed to 2 digits after decimal point with color state limit 
threshholds set to 5 and 30 deg 

MSID(s): V74H2618J - KU-BAND A CH1 ROLL WORD 3   WD3 

 

5,3. RR wP 

Meaning: Displays the elevation angle rate of the Ku antenna.  Positive elevation rate is 
towards the nose. 

Possible Values: RR wP in mrad/s displayed to 2 digits after decimal point 
MSID(s): V74R2628J - KU BAND A CH 1 PITCH RATE     WD10 

 

6,3. RR wR 

Meaning: Displays the azimuth angle rate of the Ku antenna.  Positive azimuth rate is 
towards the port wing. 

Possible Values: RR wR in mrad/s displayed to 2 digits after decimal point 
MSID(s): V74R2626J - KU BAND A CH 1 ROLL RATE       WD9 

 

7,3. STRK ANGLES DATA GOOD 

Meaning: Data good indicator for star tracker data.  Will indicate LOST DGs for 1 cycle 
if state changes from GOOD to NO GOOD. 

Possible Values: STRK ANGLES DATA GOOD 
 STRK ANGLES LOST DGs 
 STRK ANGLES NO DG IND 

MSID(s): V90X4835X - SNAP STAR TRACKER DATA GOOD 
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8,3. RNG AIF/MARK 

Meaning: Indicates the value of the AUTO, INHIBIT, FORCE (AIF) flag for the 
incorporation of range data into RNDZ NAV per entry into SPEC 33 ITEM 17, 
ITEM 18, and ITEM 19, along with  the number of range marks incorporated 
into RNDZ NAV. 

Possible Values: RNG AUTO with number of marks displayed as an integer 
 RNG INH with number of marks displayed as an integer 
 RNG FORCE with number of marks displayed as an integer 

MSID(s): V90J1362C - RNDZ NAV RR RNGE AUTO/INH/FOR FLAG 
 V90J1400C - RR RNG MARKS ACCEPTED 

Note: This field combines the functionality of two former fields. 

 

9,3. RDOT AIF/MARK 

Meaning: Indicates the value of the AUTO, INHIBIT, FORCE (AIF) flag for the 
incorporation of range rate data into RNDZ NAV per entry into SPEC 33 ITEM 
20, ITEM 21, and ITEM 22, along with  the number of range rate marks 
incorporated into RNDZ NAV. 

Possible Values: RDOT AUTO with number of marks displayed as an integer 
 RDOT INH with number of marks displayed as an integer 
 RDOT FORCE with number of marks displayed as an integer 

MSID(s): V90J1368C - RNDZ NAV RANGE RATE A/I/F FLAG 
 V90J1401C - RR R DOT MARKS ACCEPTED 

Note: This field combines the functionality of two former fields. 

 

10,3. ANGLE AIF/MARK 

Meaning: Indicates the value of the AUTO, INHIBIT, FORCE (AIF) flag for the 
incorporation of the selected angle source data into RNDZ NAV per entry into 
SPEC 33 ITEM 23, 24, and 25, along with the number of angle marks 
incorporated into RNDZ NAV. 

Possible Values: ANG AUTO with number of marks displayed as an integer 
 ANG INH with number of marks displayed as an integer 
 ANG FORCE with number of marks displayed as an integer 

MSID(s): V90J1361C - RNDZ NAV ANGLE AUT/INH/FOR FLAG 
 V90J1403C – V/Y/EL ANGULAR MARKS ACCEPTED 

Note: This field combines the functionality of two former fields. 

 

11,3. RATIO CHECK 

Meaning: Indicates if a high ratio is observed in any one of the RNDZ NAV data 
sources. 

Possible Values: HIGH RATIO - displayed if any ratio exceeds 0.3 
 RATIOS NORMAL - neutral state 

MSID(s): V90U0222C - BARO ALT/RR RNG RESID RATIO 
 V90U0713C - DRAG ALT/RR R DOT RESID RATIO 
 V90U0217C - TAC R/OPTICS V/Y/EL RESID RATIO 
 V90U0216C - TAC AZ/OPTICS H/X/AZ RESID RATIO 

Note: This field was moved to this alarm panel from RNDZ_SUMMARY 

 

12,3. RR ANGLES DATA GOOD 

Meaning: Data good indicator for angular data.  Will indicate LOST DGs for 1 cycle if 
state changes from GOOD to NO GOOD. 

Possible Values: RR ANGLES DATA GOOD 
 RR ANGLES LOST DGs 
 RR ANGLES NO DG IND 

MSID(s): V74X2590J - KU-A CH1 RDR ANG DATA GD (R)WD1B07 
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1,4. RR POINTING 

Meaning: Indicates the current Ku antenna pointing mode selected on the rotary switch 
S7 on panel A1U. 

Possible Values: GPC ACQ 
 GPC DESIG 
 AUTO TRK 
 MAN SLEW 

MSID(s): V74X2584J - KU-A CH1 ANT STRG AUTO (CR) WD1B01 
 V74X2585J - KU-A CH1 ANT STRG GPC DES CRWD1B02 
 V74X2586J - KU-A CH1 ANT STRG GPC ACQ CRWD1B03 

note: all 3 MSIDs above = FALSE means MAN SLEW 

 

2,4. KU MODE 

Meaning: Indicates the current Ku antenna mode selected. 
Possible Values: Ku MODE COMM 

 Ku MODE RR PASV 
MSID(s): V74S2420E - KU-BAND A RADAR PASSIVE MODE 

 

3,4. RR OUTPUT 

Meaning: Indicates the setting of the Ku antenna power output control switch, reflecting 
the maximum output power possible. 

Possible Values: RR OUTPUT LO 
 RR OUTPUT MED 
 RR OUTPUT HI 
 RR OUTPUT MED & CLOSE - if RNG < 500 ft 
 RR OUTPUT HI & CLOSE - IF RNG < 500 ft 

MSID(s): V74S2495E - KU-BAND A RADAR OUTPUT-MED 
 V74S24965E - KU-BAND A RADAR OUTPUT-HIGH 
 V74U2623J - KU-A CH 1 RDR RANGE BITS 01-23 

note: MED and HI MSIDs above both = FALSE means RR OUTPUT LO 

 

4,4. SIGNAL 

Meaning: Displays the return signal strength to the Ku antenna. 
Possible Values: SIGNAL in dBM displayed to 1 digit after decimal point 

MSID(s): V74E2508A - KU-BND A RDR/COMM RCVD SIG STR-AGC 

 

5,4. RR RNG MODE 

Meaning: Indicates the mode of the automatic range and angle search setting of the Ku 
antenna per entry in SM 201 ANTENNA ITEM 1 and ITEM 2; if a Ku self test 
is in progress, the field is overriden to indicate the status of Ku self test based 
on the Ku SELF TEST bit per entry in SM 201 ANTENNA ITEM 7 and the 
radar range. 

Possible Values: RR RNG AUTO 
 RR RNG MIN 
 Ku SELF TEST IN PROGRESS - SM 201 ITEM 7 selected 
 Ku SELF TEST PASSED - all 8's in the range field 
 Ku SELF TEST FAILED - all 3's in the range field 

MSID(s): V93X5641X - ANTENNA-RADAR RANGE ESTIMATE-MIN 
 V74X2592J - KU-A CH1 RDR STST IN PROG(R)WD1B09 
 V74U2623J - KU-A CH 1 RDR RANGE BITS 01-23 
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6,4. RR SEARCH 

Meaning: Indicates the status of the Ku antenna search and track functions. 
Possible Values: RR TRACK - tracking target or TDRS 

 RR DET - detected target or TDRS 
 RR SEARCH - searching for target or TDRS 
 RR LOST LOCK - not actively tracking or searching target in PASV mode 
 RR WARN - reached beta mask limit while in COMM mode 
 RR OK - not actively tracking or searching TDRS in COMM mode 

MSID(s): V74S2420E - KU-BAND A RADAR PASSIVE MODE 
 V74X2601J - KU-A CH1 SEARCH (CR)        WD2B00 
 V74X2602J - KU-A CH1 DETECT (CR)        WD2B01 
 V74X2603J - KU-A CH1 TRACK (CR)         WD2B02 
 V74X2614J - KU-A CH1 SCAN WARN LIMIT(CR) WD2B13 

 

7,4. COAS ANGLES DATA GOOD 

Meaning: Data good indicator for COAS data.  Will indicate LOST DGs for 1 cycle if 
state changes from GOOD to NO GOOD. 

Possible Values: COAS ANGLES DATA GOOD 
 COAS ANGLES LOST DGs 
 COAS ANGLES NO DG IND 

MSID(s): V90X4849X - SNAP COAS ANGLE MEAS DATA GOOD 

 

8,4. X (DOWNTRACK) UPDATE 

Meaning: Displays the LVLH X-component difference between the FLTR and PROP 
vectors. 

Possible Values: X (DNT) F-P in ft displayed as an integer 
MSID(s): V90X4765X - RNDZ NAV ACTIVE FLAG 

 LC_LVRFX - LVLH X-component of TARGET minus FLTR vector computed 
by ROSS 

 LC_LVRPX - LVLH X-component of TARGET minus PROP vector computed 
by ROSS 

 

9,4. Y (OUT-OF-PLANE) UPDATE 

Meaning: Displays the LVLH Y-component difference between the FLTR and PROP 
vectors. 

Possible Values: Y (DOOPNT) F-P in ft displayed as an integer 
MSID(s): V90X4765X - RNDZ NAV ACTIVE FLAG 

 LC_LVRFY - LVLH Y-component of TARGET minus FLTR vector computed 
by ROSS 

 LC_LVRPY - LVLH Y-component of TARGET minus PROP vector computed 
by ROSS 

 

10,4. Z (RADIAL) UPDATE 

Meaning: Displays the LVLH Z-component difference between the FLTR and PROP 
vectors. 

Possible Values: Z (RAD) F-P in ft displayed as an integer 
MSID(s): V90X4765X - RNDZ NAV ACTIVE FLAG 

 LC_LVRFZ - LVLH Z-component of TARGET minus FLTR vector computed 
by ROSS 

 LC_LVRPZ - LVLH Z-component of TARGET minus PROP vector computed 
by ROSS 
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11,4. MARK REJECTED 

Meaning: Indicates if any source of data is rejected by RNDZ NAV. 
Possible Values: MARK REJECTED 

 MARK OK 
MSID(s): V90X0223X - BARO ALT/RR RNG EDIT HIST IND 

 V90X0712X - DRAG ALT/RR R DOT EDIT HIST IND 
 V90X0215X - TAC R/OPTICS V/Y/EL EDIT HIST IND 
 V90X0213X - TAC AZ/OPTICS H/X/AZ EDIT HIST IND 

note: If any of the above MSIDs is TRUE, the MARK REJECTED state will appear. 

 

12,4. RR ANG RATES DATA GOOD 

Meaning: Data good indicator for angular rate data.  Will indicate LOST DGs for 1 cycle 
if state changes from GOOD to NO GOOD. 

Possible Values: RR ANG RATES DATA GOOD 
 RR ANG RATES LOST DGs 
 RR ANG RATES NO DG IND 

MSID(s): V74X2591J - KU-A CH1 RDR ANG RT DG (R)  WD1B08 
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RNDZ_SUMMARY Alarm Panel 

(Based on DEFAULT and NEW_CONFIG Alarm Panels) 

Original Built 08/01/93 by C.K. Meyer and D.G. Hamm 

Tested 08/01/93 by D.G. Hamm 

RNDZ_Summary Built and Tested 04/11/96 by J.L. Williams 

Revision A Built and Tested 10/31/97 by J.L. Williams 

 

 

 

1,1. RNDZ NAV 

Meaning: Indicates whether RNDZ NAV is enabled or disabled per entry into SPEC 33 
ITEM 1. 

Possible Values: RNDZ NAV ENABLED 
 RNDZ NAV DISABLED 

MSID(s): V90X4765X - RNDZ NAV ACTIVE FLAG 
notes: Similar to REL_NAV_33 Alarm Panel location 1,1.  Does not indicate state 

change fron ENA to DIS, nor indicates TGT TRK with RNDZ NAV not enabled. 
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2,1. OPS/MM CONTROL 

Meaning: If in OPS 2, indicates the active major mode (201, 202) and the active DAP 
control mode (AUTO, INRTL, LVLH, FREE). If not in OPS 2, displays the 
active major mode only. 

Possible Values: MM 202 AUTO 
 MM 202 INRTL 
 MM 202 LVLH 
 MM 202 FREE 
 MM 201 AUTO 
 MM 201 INRTL 
 MM 201 LVLH 
 MM 201 FREE 
 MM displayed as an integer if not 201 or 202 

MSID(s): V72X2850X - FWD DAP AUTO (LIGHT) 
 V72X2849X - FWD DAP MAN INRTL (LIGHT) 
 V72X2868X - FWD MANUAL LVLH (LIGHT) 
 V72X2897X - FWD FREE DRIFT MODE (LIGHT) 
 V90Q8001C - MAJOR MODE CODE 

 

3,1. ENGINE SELECT 

Meaning: Indicates the engine selected per entry into ORBIT MNVR EXEC 202 ITEMS 
1-4 

Possible Values: ENG SEL Both OMS 
 ENG SEL Left OMS 
 ENG SEL Right OMS 
 ENG SEL +X RCS 
 ENG SEL UNKNOWN 

MSID(s): V94J3791C - PRIME PROP SYS INDICATOR FLAG 

 

4,1. OMS FIRING 

Meaning: Indicates if either or both OMS engine(s) is firing. 
Possible Values: BOTH OMS Burning 

 LEFT OMS Burning 
 RIGHT OMS Burning 
 OMS Engines OFF 

MSID(s): V43K4583X - OMS-L ENG CONTROL VLV 1 COIL 1 OP 
 V43K5583X - OMS-R ENG CONTROL VLV 1 COIL 1 OP 

 

5,1. RCS TRANS 

Meaning: Indicates if an RCS translational firing is in progress. 
Possible Values: RCS Trans in progress 

 RCS Trans OFF - default state 
MSID(s): T_POS_X - +X translation computed by ROSS 

 T_NEG_X - -X translation computed by ROSS 
 T_POS_Y - +Y translation computed by ROSS 
 T_NEG_Y - -Y translation computed by ROSS 
 T_POS_Z - +Z translation computed by ROSS 
 T_NEG_Z - -Z translation computed by ROSS 
 T_POS_LO_Z - LOW Z +Z translation computed by ROSS 
 T_POS_HI_Z - HI Z +Z translation computed by ROSS 
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6,1. TFL 

Meaning: Displays the current Telemetry Format Load (TFL) selected on the Orbiter 
Possible Values: TFL displayed as an integer between 0-255 

MSID(s): V75X4070D - ORBITER TELEMETRY FORMAT LOAD NUMBER 

 

1,2. KU MODE 

Meaning: Indicates the current Ku antenna mode selected. 
Possible Values: Ku MODE COMM 

 Ku MODE RR PASV 
MSID(s): V74S2420E - KU-BAND A RADAR PASSIVE MODE 

 

2,2. RR RNG 

Meaning: Displays the line-of-sight GNC range to the target. 
Possible Values: RR Range in ft displayed to 1 digit after decimal point 

 RR Range Not Available - if radar is not in PASV mode 
MSID(s): V74S2420E - KU-BAND A RADAR PASSIVE MODE 

 V90U4895C - SNAP RR RANGE MEAS 
notes: Driven from GNC data. The RR Range displayed on the REL_NAV_33 Alarm 

Panel is driven from SM data. 

 

3,2. ONAV RNG 

Meaning: If RNDZ NAV is enabled, displays the line-of-sight navigated range to the 
target based upon an RSS of the vector difference between the FLTR and the 
TGT vectors. 

Possible Values: ONAV RNG in ft displayed to 1 digit after decimal point 
 ONAV RNG Not Available - if RNDZ NAV is not enabled 

MSID(s): V90X4765X - RNDZ NAV ACTIVE FLAG 
 LC_LVRFX - X-LVLH component of TARGET minus FLTR vectors computed 

by ROSS Telemetry 
 LC_LVRFY - Y-LVLH component of TARGET minus FLTR vectors computed 

by ROSS Telemetry 
 LC_LVRFZ - Z-LVLH component of TARGET minus FLTR vectors computed 

by ROSS Telemetry 

 

4,2. GND RANGE 

Meaning: Displays the range between the chaser and target based upon the contents of 
ephemerides 3 (target) and 1 (chaser). 

Possible Values: GND FINAV Range value in ft displayed to 1 digit after decimal point. 
MSID(s): EPH1_M50_X - M50 X-component of ephemeris 1. 

 EPH1_M50_Y - M50 Y-component of ephemeris 1 
 EPH1_M50_Z - M50 Z-component of ephemeris 1 
 EPH3_M50_X - M50 X-component of ephemeris 3 
 EPH3_M50_Y - M50 Y-component of ephemeris 3 
 EPH3_M50_Z - M50 Z-component of ephemeris 3 

 

5,2. TCS INTERFACE RANGE 

Meaning: Displays the interface-to-interface range based upon data from TCS to 
whichever reflector it is tracking.  Proper interface determination requires user 
intervention to define the reflector being tracked. 

Possible Values: TCS IF Range value in ft displayed to 2 digits after decimal point. 
MSID(s): TC_TCS2IR - Orbiter to target docking interface range using TCS 2 as 

computed by VPOP 
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6,2. OI/GNC/SM DFL 

Meaning: Displays the current OI/GNC and SM Decom Format Loads (DFL) selected on 
the Orbiter. 

Possible Values: GNC.SM DFL displayed as XX.YY, where XX=OI/GNC DFL, YY=SM DFL 
MSID(s): V93Q0022CX - ORBITER OI/GNC DECOM FORMAT LOAD NUMBER 

 V93Q0022CY - ORBITER SM DECOM FORMAT LOAD NUMBER 

 

1,3. TRANS NOMINAL 

Meaning: Indicates if a FWD THC deflection occurs while in FREE DRIFT 
Possible Values: TRANS in FREE 

 TRANS NOMINAL 
MSID(s): V72X2897X - FWD FREE DRIFT MODE (LIGHT) 

 V90X7694X - SEL FWD THC NEG X OUTPUT 
 V90X7695X - SEL FWD THC NEG Y OUTPUT 
 V90X7696X - SEL FWD THC NEG Z OUTPUT 
 V90X7697X - SEL FWD THC POS X OUTPUT 
 V90X7698X - SEL FWD THC POS Y OUTPUT 
 V90X7699X - SEL FWD THC POS Z OUTPUT 

 

2,3. RR RDOT  

Meaning: Displays the line-of-sight GNC range rate to the target. 
Possible Values: RR Range Rate in ft/s displayed to 3 digits after decimal point 

MSID(s): V90U4896C - SNAP RR RANGE RATE MEAS 
notes: Driven from GNC data. Similar to REL_NAV_33 Alarm Panel location 2,3 

except that data source is GNC instead of SM. 

 

3,3. ONBOARD NAV STATUS 

Meaning: Indicates if any source of data is rejected by RNDZ NAV or if a high ratio 
value occurs. 

Possible Values: MARK REJECTED 

 HIGH RATIO 

 Onboard NAV OK - neutral state 
MSID(s): V90X0223X - BARO ALT/RR RNG EDIT HIST IND 

 V90X0712X - DRAG ALT/RR R DOT EDIT HIST IND 
 V90X0215X - TAC R/OPTICS V/Y/EL EDIT HIST IND 
 V90X0213X - TAC AZ/OPTICS H/X/AZ EDIT HIST IND 
 V90U0222C - BARO ALT/RR RNG RESID RATIO 
 V90U0713C - DRAG ALT/RR R DOT RESID RATIO 
 V90U0217C - TAC R/OPTICS V/Y/EL RESID RATIO 
 V90U0216C - TAC AZ/OPTICS H/X/AZ RESID RATIO 

Note: This field combines the functionality of two former fields. 
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4,3. DATA TO NAV STATUS 

Meaning: Indicates if any good data is being incorporated into RNDZ NAV.  Good data 
is defined as the DATA GOOD flag is true and the AIF flag is set to AUTO. 

Possible Values: NO DATA TO NAV 
 Radar Data to NAV 
 S TRK Data to NAV 
 COAS Data to NAV 

MSID(s): V90X4835X - SNAP STAR TRACKER DATA GOOD 
 V90X4849X - SNAP COAS ANGLE MEAS DATA GOOD 
 V90X4866X - IND RR TO BE PROC BY FILTER 
 V90X4868X - IND ST TO BE PROC BY FILTER  
 V90X4880X - IND COAS TO BE PROC BY FILTER  
 V90X4899X - SNAP RR RANGE DATA GOOD 
 V90X4900X - SNAP RR RNG RATE DATA GOOD 
 V90X4901X - SNAP RR ANGLES DATA GOOD  
 V90J1361C - RNDZ NAV ANGLE AUT/INH/FOR FLAG 
 V90J1362C - RNDZ NAV RR RNG AUT/INH/FOR FLAG 
 V90J1368C - RNDZ NAV RANGE RATE A/I/F FLAG 

 

5,3. TCS INTERFACE RANGE RATE 

Meaning: Displays the interface-to-interface range rate based on data from TCS 1 to 
whichever reflector it is tracking.  Proper interface determination requires user 
intervention to define the reflector being tracked. 

Possible Values: TCS IF Range Rate value in ft/s displayed to 2 digits after decimal point. 
MSID(s): TC_TCS2IRD - Orbiter to target docking interface rdot using TCS 2 as 

computed by VPOP 

 

6,3. DAY/NIGHT INDICATOR 

Meaning: Indicates whether the Orbiter is in daylight or darkness. 
Possible Values: DAY - displayed if time to SR > SS 

 NIGHT - displayed if time to SS > SR 
MSID(s): TC_SUNRIS - supplied by VPOP 

 TC_SUNSET - supplied by VPOP 

 

1,4. ATTITUDE CONTROL STATUS 

Meaning: Indicates if an Orbiter rotation maneuver is in progress (a maneuver in 
progress is defined as the RSS of the body rates exceeding 0.1 deg/s) or if 
the Orbiter is in FREE DRIFT. 

Possible Values: FREE DRIFT elapsed time displayed in DDD/HH:MM:SS if in DAP:FREE 

 ROT MNVR IN PROGRESS - displayed if not in DAP:FREE and if the RSS of 
the body rates > 0.1 deg/s 

 Attitude Hold OK - neutral state 
MSID(s): V72X2897X - FWD FREE DRIFT MODE (LIGHT) 

 LC_DRFTIME - Elapsed time in free drift as observed by ROSS 
 V95R7476C - IMU BODY RATE AROUND X-AXIS 
 V95R7477C - IMU BODY RATE AROUND Y-AXIS 
 V95R7487C - IMU BODY RATE AROUND Z-AXIS 

Note: This field combines the functionality of two former fields. 
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2,4. SV STATUS 

Meaning: Indicates whether the PROP or FLTR vector is selected per entry in SPEC 33 
ITEM 4 and also indicates if any vector transfers are commanded per entry in 
SPEC 33 ITEM 8 thru ITEM 11.  Selected vector transfer appears for 1-2 
seconds, then reverts to the PROP/FLTR selection. 

Possible Values: SV SEL PROP - true if PROP vector selected 
 SV SEL FLTR - true if FLTR vector selected 
 FLTR TO PROP - SPEC 33 ITEM 8 selected. 
 PROP TO FLTR - SPEC 33 ITEM 9 selected. 
 ORB TO TGT - SPEC 33 ITEM 10 selected. 
 TGT TO ORB - SPEC 33 ITEM 11 selected. 

MSID(s): V90X4986X - POS FDBK UPP SOURCE FLAG 
 V90X4984X - POS FDBK FLTRD TO PROP FLAG 
 V90X4985X - POS FDBK PROP TO FLTRD FLAG 
 V90X1413X - ORBITER TO TARGET SV IND 
 V90X1414X - TARGET TO ORBITER SV IND 

 

3,4. MNVR VIEW 

Meaning: Displays the current selected onboard TGT Set number 
Possible Values: Targeting NCC - TGT Sets 9 or 29. 

 Targeting Ti - TGT Sets 10 or 30. 

 Targeting MC1 - TGT Sets 11 or 31. 

 Targeting MC2 on EL - TGT Sets 12 or 32. 

 Targeting MC2 on TIME - TGT Set 19. 

 Targeting MC3 - TGT Sets 13 or 33. 

 Targeting MC4 - TGT Sets 14 or 34. 

 No Onboard Targeting - displayed if TGT set is 0. 

 MNVR ID value displayed as an integer for any other TGT Set 
MSID(s): V95J7466C - MNVR TGT NO COMPUTED 

 

4,4. GUIDANCE MODE 

Meaning: Displays the current active guidance mode on the Orbiter 
Possible Values: EXT DV 

 LAMBERT with next computed Lambert burn TIG displayed in 
DDD/HH:MM:SS MET 

MSID(s): V94X4029X - GUIDANCE MODE FLAG 
 LC_ORBTIG - onboard-computed burn TIG PET in sec 
 PET_OFFSET - ROSS conversion from PET to MET 

 

5,4. GNC TIMER 

Meaning: Displays the countdown time to the next LOADed burn TIG in MM 202.  If the 
burn was missed, displays time after nominal TIG. 

Possible Values: 202 GNC TIMER countdown/up clock displayed in MM:SS with color state 
limits set to 5 min before, 2 min before, at TIG, and 1 min after (for late 
burns). 

MSID(s): V90Q8001C - MAJOR MODE CODE 
 V94W3790C - TIME OF IGNITION 
 LC_F22GMT - Current GMT in sec 

 

6,4. GMT LIFTOFF 

Meaning: Displays the GMT of liftoff. 
Possible Values: GMT Lift-off value displayed in DDD/HH:MM:SS 

MSID(s): LAUNCH_GMT - Liftoff GMT obtained by ROSS from the MOC 
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 TCS_INFO Alarm Panel 

(Based upon TCS2_NEW Alarm Panel) 

Original Built and Tested 02/15/96 by D.G. Hamm 

TCS_INFO Built and Tested 12/01/97 by P.T. Snow 

 

 

 

1,1. RAW RANGE 

Meaning: Displays the raw range from TCS 2 to whichever reflector it is tracking. 
Possible Values: Raw Range value in ft displayed to 2 digits after decimal point 

MSID(s): TC_TCS2RNG -  Downlisted range in feet from TCS 2 as processed by VPOP 

 

2,1. RAW RANGE RATE 

Meaning: Displays the raw range rate from TCS 2 to whichever reflector it is tracking. 
Possible Values: Raw Range Rate value in ft/s displayed to 2 digits after decimal point 

MSID(s): TC_TCS2RD - Downlisted range rate in feet per sec from TCS 2 as 
processed by VPOP 

 

3,1. PDI DECOM MET 

Meaning: Displays the Payload Data Interleaver (PDI) timestamp associated with the 
TCS measurements. 

Possible Values: PDI DECOM MET value displayed in DDD/HH:MM:SS format. 
MSID(s): P77W0002DP - PDI DECOM GMT DAY 

 P77W0003DP - PDI DECOM GMT HOUR 
 P77W0004DP - PDI DECOM GMT MINUTE 
 P77W0005DP - PDI DECOM GMT SECOND 
 LC_F22GMT - Onboard GMT in seconds as converted by ROSS Telemetry 
 LC_F22MET - Onboard MET in seconds as converted by ROSS Telemetry 

 

1,2. INTERFACE RANGE 

Meaning: Displays the interface-to-interface range based on data from TCS 2 to 
whichever reflector it is tracking.  Proper interface determination requires user 
intervention to define the reflector being tracked. 

Possible Values: IF Range value in ft displayed to 2 digits after decimal point 
MSID(s): TC_TCS2IR -  Orbiter to target docking interface range using TCS 2 as 

computed by VPOP 
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2,2. INTERFACE RANGE RATE 

Meaning: Displays the interface-to-interface range rate based on data from TCS 2 to 
whichever reflector it is tracking.  Proper interface determination requires user 
intervention to define the reflector being tracked. 

Possible Values: IF Range Rate value in ft/s displayed to 2 digits after decimal point 
MSID(s): TC_TCS2IRD - Orbiter to target docking interface rdot using TCS 2 as 

computed by VPOP 

 

2,3. UNIT ID 

Meaning: Displays the TCS number corresponding to a particular ID number. 
Possible Values: TCS 2 Unit ID value displayed as a TBD 

MSID(s): P78U0764D - DTCS UNIT ID NUMBER 

 

1,3. RAW ELEVATION 

Meaning: Displays the raw elevation angle from TCS 2 to whichever reflector it is 
tracking. 

Possible Values: Raw Elevation value in deg displayed to 1 digit after decimal point. 
MSID(s): TC_TCS2EL - Downlisted elevation in rad from TCS 2 as processed by VPOP 

 

2,3. RAW AZIMUTH 

Meaning: Displays the raw azimuth angle from TCS 2 to whichever reflector it is 
tracking. 

Possible Values: Raw Azimuth value in deg displayed to 1 digit after decimal point. 
MSID(s): TC_TCS2AZ - Downlisted azimuth in rad from TCS 2 as processed by VPOP 

 

3,3. STATUS ID 

Meaning: Displays the current status/mode of the TCS 2 laser. 
Possible Values: TCS2 Not Tracking 

TCS2 Tracking 

TCS2 Reacquiring 

TCS2 Standby (Not in range) 

TCS2 Abort 

TCS2 Autosafe 

TCS2 First Acq 

Unrecognized TCS2 Mode 
MSID(s): P78U0151D - SW STATUS: MODE (3 BITS) WORD 15 

 

 

1,4. INTERFACE ELEVATION 

Meaning: Displays the interface-to-interface elevation angle based on data from TCS 2 
to whichever reflector it is tracking.  Proper interface determination requires 
user intervention to define the reflector being tracked. 

Possible Values: IF EL value in deg displayed to 1 digit after decimal point. 
MSID(s): TC_TCS2IEL - Orbiter to target docking interface elev using TCS 2 as 

computed by VPOP 
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2,4. RAW AZIMUTH 

Meaning: Displays the interface-to-interface azimuth angle based on data from TCS 2 to 
whichever reflector it is tracking.  Proper interface determination requires user 
intervention to define the reflector being tracked. 

Possible Values: IF AZ value in deg displayed to 1 digit after decimal point. 
MSID(s): TC_TCS2IAZ - Orbiter to target docking interface azi using TCS 2 as 

computed by VPOP 

 

3,4. VPOP REFLECTOR 

Meaning: Displays the reflector selected by the user for determining the conversion of 
TCS data from raw values to interface-to-interface values. 

Possible Values: VPOP Refl #1 PMA2 Planar 

VPOP Refl #2 PMA2 Hemi 

VPOP Refl #3 FGB FWD Hemi 

VPOP Refl #4 FGB Aft Hemi 

VPOP Refl #5 PMA3 Planar 

VPOP Refl #6 SM Aft 

Unknown VPOP Reflector 

VPOP UI NOT RUNNING 
MSID(s): UI_T2TRKX - X-coordinate of the reflector selected by the user in the VPOP 

user interface. 
Note: Currently uses the X-coordinate to determine which reflector was selected by 

the user.  Obviously, this is valid on a flight-specific basis, and must be 
updated by the user for a different reflector configuration. 
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TGT_GNC_TIMER Alarm Panel 

Built 12/15/95 by T.G. Miller 

Tested 12/15/95 by T.G. Miller 

 

 

1,1. GNC TIMER 

Meaning: Displays the time until the next burn.  If the burn was missed, displays time 
after nominal TIG. 

Possible Values: 202 GNC Timer countdown/up clock displayed in HH:MM:SS with color state 
limit threshholds set to 5 min before, 2 min before, at TIG, and 1 min after (for 
late burns). 

MSID(s): V90Q8001C - MAJOR MODE CODE 
 V94W3790C - TIME OF IGNITION 
 LC_F22GMT - Current GMT in sec 

 

1,2. DV TOT 

Meaning: Displays the predicted RSS of the burn velocities of the targeted maneuver in 
Orbiter body coordinates. 

Possible Values: DV TOT in ft/s displayed to 3 digits after decimal point 
MSID(s): V94L3795C - TOTAL DELTA V REQD FOR MANEUVER 
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THC_RHC Alarm Panel 

Built 02/03/94 by J.L. Williams 

Tested 02/03/94 thru 02/07/94 by J.L. Williams 

 

 

1,1. FWD THC X 

Meaning: Indicates if the FWD THC is deflected in the +/-X Orbiter body direction.  
Direction is indicated for about 1 second, then reverts to a neutral state. 

Possible Values: +X BODY 

 -X BODY 

 FWD THC X - neutral state 
MSID(s): V90X7697X - SEL FWD THC POS X OUTPUT 

 V90X7694X - SEL FWD THC NEG X OUTPUT 

 

2,1. FWD THC Y 

Meaning: Indicates if the FWD THC is deflected in the +/-Y Orbiter body direction.  
Direction is indicated for about 1 second, then reverts to a neutral state. 

Possible Values: +Y BODY 

 -Y BODY 

 FWD THC Y - neutral state 
MSID(s): V90X7698X - SEL FWD THC POS Y OUTPUT 

 V90X7695X - SEL FWD THC NEG Y OUTPUT 

 

3,1. FWD THC Z 

Meaning: Indicates if the FWD THC is deflected in the +/-Z Orbiter body direction.  
Direction is indicated for about 1 second, then reverts to a neutral state. 

Possible Values: +Z BODY 

 -Z BODY 

 FWD THC Z - neutral state 
MSID(s): V90X7699X - SEL FWD THC POS Z OUTPUT 

 V90X7696X - SEL FWD THC NEG Z OUTPUT 
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4,1. FLT CTL PWR 

Meaning: Indicates the status of the FLT CTRLR PWR switch in both the FWD and AFT 
cockpits 

Possible Values: AFT FLT CTL PWR ON 

 FWD FLT CTL PWR ON 

 F/A FLT CTL PWR ON 

 FLT CTL PWR OFF 
MSID(s): V73X3001X - LH DDU PWR SPLY A GOOD 

 V73X3021X - AFT DDU PWR SPLY A GOOD 

 

5,1. SENSE SWITCH 

Meaning: Indicates the setting of the AFT cockpit sense switch. 
Possible Values: -X SENSE 

 -Z SENSE 
MSID(s): V72K5180X - SENSE SW -X CON A 

 

6,1. TRANS NOMINAL 

Meaning: Indicates if a FWD THC deflection occurs while in FREE DRIFT 
Possible Values: TRANS in FREE 

 TRANS NOMINAL 
MSID(s): V72X2897X - FWD FREE DRIFT MODE (LIGHT) 

 V90X7694X - SEL FWD THC NEG X OUTPUT 
 V90X7695X - SEL FWD THC NEG Y OUTPUT 
 V90X7696X - SEL FWD THC NEG Z OUTPUT 
 V90X7697X - SEL FWD THC POS X OUTPUT 
 V90X7698X - SEL FWD THC POS Y OUTPUT 
 V90X7699X - SEL FWD THC POS Z OUTPUT 

 

1,2. AFT THC X 

Meaning: Indicates if the AFT THC is deflected in the +/-X Orbiter body direction.  
Direction is indicated for about 1 second, then reverts to a neutral state. 

Possible Values: +X BODY 

 -X BODY 

 AFT THC X - neutral state 
MSID(s): V90X8139X - SEL AFT THC NEG Y OUTPUT 

 V90X8143X - SEL AFT THC POS Y OUTPUT 

 

2,2. AFT THC Y 

Meaning: Indicates if the AFT THC is deflected in the +/-Y Orbiter body direction.  
Direction is indicated for about 1 second, then reverts to a neutral state. 

Possible Values: +Y BODY 

 -Y BODY 

 AFT THC Y - neutral state 
MSID(s): V90X8140X - SEL AFT THC POS Z OUTPUT 

 V90X8141X - SEL AFT THC NEG Z OUTPUT 
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3,2. AFT THC Z 

Meaning: Indicates if the AFT THC is deflected in the +/-Z Orbiter body direction.  
Direction is indicated for about 1 second, then reverts to a neutral state. 

Possible Values: +Z BODY 

 -Z BODY 

 AFT THC Z - neutral state 
MSID(s): V90X8145X - SEL AFT THC NEG X OUTPUT 

 V90X8136X - SEL AFT THC POS X OUTPUT 

 

4,2. AFT RHC PIT 

Meaning: Indicates if the AFT RHC is deflected in the +/-PITCH Orbiter body direction.  
Direction is indicated for at least 1 second, then reverts to a neutral state. 

Possible Values: +PITCH 
 -PITCH 
 AFT RHC PIT - neutral state 

MSID(s): V90H2538C - SELECTED AFT RHC PITCH CMD 

 

5,2. AFT RHC ROLL 

Meaning: Indicates if the AFT RHC is deflected in the +/-ROLL Orbiter body direction.  
Direction is indicated for at least 1 second, then reverts to a neutral state. 

Possible Values: +ROLL 
 -ROLL 
 AFT RHC ROLL - neutral state 

MSID(s): V90H2545C - SELECTED AFT RHC YAW CMD  
Note: Original MSID is in RHC reference frame. For purposes of this field, it has 

been transformed to the Orbiter body reference frame. 

 

6,2. AFT RHC YAW 

Meaning: Indicates if the AFT RHC is deflected in the +/-YAW Orbiter body direction.  
Direction is indicated for at least 1 second, then reverts to a neutral state. 

Possible Values: +YAW 
 -YAW 
 AFT RHC YAW - neutral state 

MSID(s): V90H2542C - SELECTED AFT RHC ROLL CMD  
Note:  Original MSID is in RHC reference frame. For purposes of this field, it has 

been transformed to the Orbiter body reference frame. 
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TRAJECTORY_INFO Alarm Panel 

Built 03/01/96  by D.G. Hamm 

Tested 03/01/96 by D.G. Hamm 

Revision A Built and Tested 04/11/96 by J.L. Williams 

 

 

1,1. SUNRISE 

Meaning: Displays the time remaining until the next sunrise. 
Possible Values: Sunrise value displayed in HMS with a color limit state set to change state at 

SR-10 min 
MSID(s): TC_SUNRIS - supplied by VPOP 

 

2,1. ALTITUDE 

Meaning: Displays the orbital altitude. 
Possible Values: Altitude value displayed in nmi to 2 digits after decimal point. 

MSID(s): TC_ORBALT - supplied by VPOP 

 

3,1. BETA ANGLE 

Meaning: Displays the current beta angle. 
Possible Values: Beta Angle value displayed in degrees to 2 digits after decimal point 

MSID(s): TC_SBETA - supplied by VPOP 

 

4,1. INCLINATION 

Meaning: Displays the orbital inclination. 
Possible Values: Inclination value displayed in degrees to 1 digit after decimal point. 

MSID(s): TC_INCLIN - supplied by VPOP 

 

                   



SHUTTLE OPS RESP:  S. O’Rourke ROSS Certified Alarms 
RNDZ CHB/DM-CH-08 REV B PCN-2:  06/27/2005 SCP 9.5 

 9.5-43 

5,1. ONBOARD RELATIVE X POSITION 

Meaning: Displays the X-LVLH component of the relative vector between chaser and 
target. 

Possible Values: Obd Rel X value displayed in nmi to 2 digits after decinal point. 
MSID(s): LC_LVRFX - X-LVLH component of TARGET minus FLTR vectors computed 

by ROSS Telemetry 

 

1,2. NOON 

Meaning: Displays the time remaining until the next noon. 
Possible Values: Noon value displayed in HMS with a color state limit set to change state at N-

10 min. 
MSID(s): TC_ONOON - supplied by VPOP 

 

2,2. SUN PITCH 

Meaning: Displays the pointing vector pitch component of the line-of-sight vector to the 
sun. 

Possible Values: Sun Pitch value displayed in degrees to 2 digits after decimal point. 
MSID(s): TC_SUNPCH - supplied by VPOP 

 

3,2. SUN YAW 

Meaning: Displays the pointing vector yaw component of the line-of-sight vector to the 
sun. 

Possible Values: Sun Yaw  value displayed in degrees to 2 digits after decimal point. 
MSID(s): TC_SUNYAW - supplied by VPOP 

 

4,2. LATITUDE 

Meaning: Displays the current latitude of the Orbiter. 
Possible Values: Latitude value displayed in degrees to 1 digit after decimal point. 

MSID(s): CUR_O_LAT - supplied by the MOC 

 

5,2. ONBOARD RELATIVE Y POSITION 

Meaning: Displays the Y-LVLH component of the relative vector between chaser and 
target. 

Possible Values: Obd Rel Y value displayed in nmi to 2 digits after decimal point. 
MSID(s): LC_LVRFY - Y-LVLH component of TARGET minus FLTR vectors computed 

by ROSS Telemetry 

 

1,3. SUNSET 

Meaning: Displays the time remaining until the next sunset. 
Possible Values: Sunset value displayed in HMS with color state limits set to change at SS-10, 

SS-5, and SS-2 min 
MSID(s): TC_SUNSET - supplied by VPOP 

 

2,3. EARTH PITCH 

Meaning: Displays the pointing vector pitch component of the line-of-sight vector to the 
center of the earth. 

Possible Values: Earth Pitch value displayed in degrees to 2 digits after decimal point 
MSID(s): TC_EARPCH - supplied by VPOP 
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3,3. EARTH YAW 

Meaning: Displays the pointing vector yaw component of the line-of-sight vector to the 
center of the earth. 

Possible Values: Earth Yaw  value displayed in degrees to 2 digits after decimal point 
MSID(s): TC_EARYAW - supplied by VPOP 

 

4,3. LONGITUDE 

Meaning: Displays the current longitude of the Orbiter. 
Possible Values: Longitude value displayed in degrees to 1 digit after decimal point 

MSID(s): CUR_O_LON - supplied by the MOC 

 

5,3. ONBOARD RELATIVE Z POSITION 

Meaning: Displays the Z-LVLH component of the relative vector between chaser and 
target. 

Possible Values: Obd Rel Z value displayed in nmi to2 digits after decimal point 
MSID(s): LC_LVRFZ - Z-LVLH component of TARGET minus FLTR vectors computed 

by ROSS Telemetry 

 

1,4. PERIOD 

Meaning: Displays the orbital period. 
Possible Values: Period value displayed in HMS 

MSID(s): TC_OETAU - supplied by VPOP 

 

2,4. APOGEE 

Meaning: Displays the height of apogee of the current orbit. 
Possible Values: Apogee value displayed in nmi to 1 digit after decimal point 

MSID(s): TC_HAPOGEE - supplied by VPOP 

 

3,4. PERIGEE 

Meaning: Displays the height of perigee of the current orbit. 
Possible Values: Perigee value displayed in nmi to 1 digit after decimal point 

MSID(s): TC_HPERIGE - supplied by VPOP 

 

4,4. CIRCULAR VELOCITY 

Meaning: Displays the circular velocity of the current orbit 
Possible Values: Circ Velocity value displayed in ft/s to 1 digit after decimal point 

MSID(s): CUR_O_VI - supplied by the MOC 

 

5,4. DAY/NIGHT INDICATOR 

Meaning: Indicates whether the Orbiter is in daylight or darkness. 
Possible Values: DAY - displayed if time to SR > SS 

 NIGHT - displayed if time to SS > SR 
MSID(s): TC_SUNRIS - supplied by VPOP 

 TC_SUNSET - supplied by VPOP 
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9.6 File Export from the MCC 
Workstation to the PC 

PURPOSE 
To document the procedures used to export files from the MCC workstation to the MCC or office 
PC.  

PROCEDURE 
Note:  The user must have an IPS account. 

1. The person receiving the file, usually yourself, must have a user directory in the  
/fads/msn/gds/gen_common/topo/pcdrop directory on the IPS system.  For questions and 
further details see the PCDrop Users Guide on the TOPO home page at 
http://mod.jsc.nasa.gov/dm/dm33/TOPO_WEB/main.html. 

2. To export file size must be less than 7MB. 

3. See “Performing X-Window Dumps” below to create graphic files that can be translated to 
the PC. 

Starting MCC File Transfer 

• From master DNAV menu, select Tools > MCC File Transfer. 

 The XFTP window will appear.  The widgets on the left side of the window allow 
the user to select the file to be exported.  The widgets on the right side allow the 
user to select the destination path. 

 Note: the ASCII and Binary radio buttons in XFTPs are irrelevant to the export 
process.  Either may be used. 

Select File to be Exported and Destination Path 

• Using widgets on the left side navigate to the file to be exported. 

• On the right side click the Connect > Connect to Remote.     

 Enter “msn6” in the Host Name text box 

 Enter your IPS user ID in the User Name text box 

• Click Connect and then enter your IPS password.   

• The “file picker “ widget on the right is now pointed to your IPS home directory.  
Use this widget to navigate to the recipient’s JIN user name (usually your own) at 
path /fads/msn/gds/gen_common/topo/pcdrop.   

• Highlight (click on) the file to be exported in the “file picker” widget on the left.   
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 Copy the File to IPS  

Click on the Copy button in the Xfer Ops box.  The file will immediately be transferred to the 
IPS.  The cron job operating on the pcdrop directories executes once every 5 minutes.  When 
the next cron cycle is performed, the IPS resident file becomes an email attachment addressed 
to the recipient’s JIN account.  The file can then be accessed via the users standard email 
application.   

 

Performing X-Window Dumps 

Any window on a MCC workstation can be dumped to the PC.  This is usually used to dump 
graphic files to the PC and especially useful for documentation purposes.   

• Open a Unix window and execute PWD to print the path to your current directory.  

• In the same window execute the command “xwd > filename.xwd”.  This creates a X-
Window dump file in your present working directory.  If the file is being exported to the 
PC environment, use the xwd extension.  Files with this extension will be automatically 
converted to the GIF files during the export process. 

• No borders option: to perform an X-Window dump without the windows border, use the 
nobdrs option.  Example: xwd -nobdrs >myfile.wxd 
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9.7 MEWS Help Notes 

PURPOSE 

To document a few help notes for retrieving and plotting ODRC data via MEWS. 

PROCEDURE 

Note:   1. These procedures are cursory and are not intended as a complete “how-to.” 

  2. MEWS can be very slow.  Be patient. 

Starting MEWS 

On Master DNAV select Global Apps > MEWS/ODRC 

• In the Select MEWS window, Enter 1 <Ret> (New MEWS)  

Initializing MEWS 

1. Initialize the Flight # & Subsys: 

From the Minit menu bar, select File > Reset MEWS Configuration 

Single click on the MEWS Flight button, select (highlight) your flight from the scrollable 
list and select OK. 

If your flight is not in the scrollable list, then select Cancel twice to return to the Minit 
window. 

From the Minit menu bar select Utilities > Create a Flight 

Type your 3-digit flight number (Example: 096) and OV number (Example: 103) in the 
text windows and click OK. 

Repeat step 1 in Initializing MEWS 

If the Mew subsys is not RGPO, single click on the MEWS Subsys button, select 
(highlight) RGPO from the scrollable list and select OK. 

2. Initialize the MET reference:   

From the Minit menu bar select Applications > ODRC Interface 

From the ODRC Interface menu bar select Reports > Mission Events Table 

An Events Table containing the GMT of ascent and entry events appears on the 
screen.  The user can leave the window on the screen for reference, exit or print the 
window. 

Note: The GMT of lift-off is now available to the MEWS application so that data, plot 
and tab requests can be made using MET. 
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3. Initialize MSID nomenclature access:   

From the ODRC Interface menu bar select Reports > Nomenclature Report 

In the Select Data Source for Nomenclature Report window toggle the button to 
Shuttle Data Tape and click on Apply. 

If the message “Local nomenclature report already exists” is received the user can 
select Cancel, because the report is already available. 

Note:  By running the Nomenclature report a short description of each MSID is 
available to the user during the ODRC data request process.  

At this point MEWS has been initialized to recognize your flight, access the GMT of 
lift-off (so MET can be used) and access MSID nomenclature files.  Proceed with the 
next step. 

Issuing a Data Request to the ODRC Host 

Downlist data stored in the ODRC system can be retrieved by running the MEWS ODRC 
Request application.  The user must specify one or more MSID(s) and define the start and 
stop time of the request in GMT or MET.  The output is stored in “change only”, binary data 
files that can then be accessed by the MEWS Plot (graphical) or Tab (digital) applications 
for viewing by the user.   

If not already running, on Master DNAV select Global Apps > MEWS/ODRC 

• On the Minit menu bar select Application > ODRC Request 

• On the ODRC Interface menu bar select Request SSP > Operational Downlink  

• Define the MSID Items List: Use one of 
the 3 methods below to add the MSIDs 
associated with this request to the Items 
List window on the Build Request Items 
List panel: 

1. Text Window:  Type the MSID 
number in the Add Item text window 
then click on the MSID button in the 
Item Type list. (middle column). 

2. Scrollable MSID List:  Click on the 
List MSID button.  This will bring up 
a window that can be used to print 
all available MSIDs to the screen 
(along with a brief description) and 
then add them to the Items List 

3. Plists (files containing 1 or more 
MSID):  Click on List Files.  Click on 
Local Plists in the Files Types list on 
the right side of the window.  
Highlight the desired Plist(s). Click 
on Done.  (If your Plist does not 
exist, see Creating Plists). 

 

 

 
Figure 9.7-1 MEWS Menu 
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• Define the start, stop and rate:  In the Data Request Times and Rate panel Select 
either GMT or MET by toggling the Time Reference button.  Complete the start and 
stop times.  Fill in the Update Rate text box (0 = max rate). 

• Other stuff:  

1. Calibration toggle button: toggle to MCC calibration 

2. Product Type toggle button:  toggle to COD 

3. Run Number test box: type 0 (zero) for flight data (call x3 - ODRC for help if you 
are requesting data from a sim) 

4. Filename text box: Either type in a file name or accept the default 

• Click on Request.  You can view the status of your request to confirm receipt and 
completion on the ODRC interface window.   

Creating or Editing Plists 

Plists (files of containing 1 or more MSID) can make it easy to create, store and edit lists of 
MSIDs that are used as input to the MEWS data requests.  It is the only way to save the 
MSID list used in a data request. 

• From the MINIT menu bar select Applications > ODRC Interface.    

• To create a Plist:  From the ODRC Interface menu bar select Plist > Create a 
Parameter List. 

• To edit a Plist: From the ODRC Interface menu bar select Plist > Modify a Parameter 
List 

• Use the Text box, Scrollable list or Plist methods to Build a Request Item List.  These 
methods are described in the Define the MSID Lists section in Issuing a Data 
Request to the ODRC Host 

Plotting Data Obtained from the ODRC Host 

• Start the MEWS initialization program (Minit) if not already running. 

• From the Minit menu bar select Applications >Plot 

• From the Plot menu bar select Data > Select Data File      

• All available data files for the specific flight are listed (i.e. the output file from all 
completed ODRC Data Requests).  Highlight the file of interest and click on done.  

• If a format file with the proper MSIDs and scale parameters does not exist, select 
Format > Create Format File(Modify Format File).  For grid 1, (2 &3) define the MSID, 
and scale parameters for 1, 2 or 3 grids and click on save.  

• From the menu bar select Format > Select Format File, highlight the desired file and 
click on done. 

• If desired, change the time reference from GMT to MET.  From the menu bar select 
Scale > Change Time Reference to MET. 

• From the menu bar select Plot > View Plot.  You’ll see your plot. 
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Displaying/Creating Digital Output Files 

MEWS can display digital data to the screen or create a tab delimited ANSI output files.   
Use this application if you want to transfer digital data to a PC.   

• From the MINIT menu bar select Applications > Tab 

• From the TAB menu bar select Data > Select Data Source.  All data files for the 
specific flight are listed (i.e. the output file from all completed ODRC Data Requests).  
Highlight the file of interest and click on done.  

• If a format files with the proper MSIDs and format does not exist, select Format > 
Create Format File (Modify Format File).  Type one of MSID of interest in the text box, 
if desired modify the format and/or add a description in the nomenclature box then 
click on Add.   Repeat for all MSIDs to be added to the output file.  When done, click 
on save.  

• From the menu bar select Format > Select Format File, highlight the desired file and 
click on done. 

• If desired, change the time reference from GMT to MET by selecting Scale > Change 
Time Reference to MET. 

• From the menu bar select Tab > Tab to Screen to view the file. 

• From the menu bar select Tab > Tab to File to create a digital, tab delimited file.   

• Note:  Usually the user does not need to know the directory path where MEWS files 
are stored.  However, if the user is going to transfer tab files to the IPS system (see 
SCP 2.16 File Export from the MCC Workstation to the PC) for transfer to the PC, the 
user must know the directory path.  The path can be found on the Build User Items List 
window by clicking on Node Address.  Tab files are stored in the path listed in Node 
Address plus   .../tab_output/”filemname”. 
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9.8 Acquisition Monitor (AcqMon) 

PURPOSE  

To describe basic usage of the FDO Acquisition Monitor (AcqMon) program for the purpose of 
determining sunrise/sunset, TDRS, and ground station acquisition times.   In this basic mode, the 
RGPO will view acquisition data based on an ephemeris built by FDO.  Details on advanced 
usage can be found in the AcqMon User's Guide (UG-ACQMON-4.0DA) or by using the HELP 
pulldown menu in the AcqMon application. 

PROCEDURE 

1. Start AcqMon 

• On RNDZ DNAV, select 

 Console Apps > AcqMon 

or 

• On MASTER DNAV, select 

  Shuttle > FDO > Acquisition > AcqMon - Orbiter (or Target) 

2. Determine the correct ephemeris 

• Ask FDO which ephemeris is current for the desired vehicle (shuttle or target) 

3. Configure AcqMon for the desired acquisition table 

• Choose the desired ephemeris.  On the AcqMon menu, select SOURCE > MOC or 
SOURCE > GLOBAL.  Select the desired ephemeris (1 - 10).  This will populate the 
data table area of the AcqMon window.   Note: MOC nomenclature will likely change 
when TSU is fully implemented.   

• Select the desired data table (Ground ACQ, TDRSS Acq, Sun Rise/Set) by clicking the 
appropriate button, located just above the data table.  

• Use the CONTROLS pulldown to select MET, GMT, or DT for display in the table. 

• Under the EDIT pulldown, the START TIME option can be used, if desired, to pick a 
start time other than the current time.  After selecting EDIT > START TIME > USER 
START…, a GMT time can be entered.  To force the table to start at the current time 
again, select EDIT > START TIME > CURRENT TIME. 

4. Print 

• The table can be printed via a window dump from the Master DNAV or from the 
AcqMon print menu command.  
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BACKGROUND  

The Acquisition Monitor (AcqMon) processor provides a tool for the Space Shuttle and Space 
Station Flight Controllers to analyze and monitor acquisition information for an orbiting space 
vehicle with respect to the Tracking and Data Relay Satellites (TDRSS), Ground Station and Data 
Network (GSTDN), the sun, and the moon.  AcqMon presents the data in a tabular graphical 
format.  The acquisition data are generated by the TSA Predicted Satellite Acquisition Table 
(PSAT) processor.  AcqMon reads the acquisition data associated with a user-selected 
ephemeris, sorts the data, and then displays the data in a scrollable table.  AcqMon also connects 
to a timing source to monitor GMT and MET, display the next acquisition events, and checks for 
changes to any of the ephemeris and acquisition data files.  AcqMon will automatically update the 
data on any file change.   

AcqMon can be executed from the RNDZ DNAV menu or from the Global FDO DNAV menu. 

It is important to note that the AcqMon processor computes acquisition times based on line-of-
sight contact only.   Acquisition times are not adjusted to reflect scheduling of TDRS or ground 
station services, or body blockage.  The GC's TDRS SHO application should be consulted to 
determine the exact availability of TDRS.  When checking for ground station coverage, consult the 
FDO to verify that the correct minimum elevation was used in computing the coverage.   
 

User Interface 

 

AcqMon contains a menu bar, a text area broken into two parts, 1) the General area display and 
2) the data tables, and the bottom line displays error or status messages.  The main window title 
bar will reflect the current vehicle being processed with its flight or incremental number and will 
reflect what time type the time tags are being displayed as; i.e., GMT, MET, or DT. 

Menu Bar 

The menu bar is made up of the following categories: File, Edit, Controls, Source and Help.  
Clicking on any of the first four items will cause a pull down menu to appear with more categories.  
Clicking on the Help will pop up a scrollable text area with a copy of the user’s manual minus the 
pictures.  The pulldown menus have some special symbols to denote specific functionality.  A 
menu item with 3 periods, “…”, will bring up a separate input or display menu.  An asterisk, “*”, will 
denote that a toggle selection is enabled. 

File 

The File category consists of the following options: 

 

1. Print - This pulldown display two options for printing.  The user can select which files to send 
to the printer or to a ASCII file. 

a) Printer - The printout will be the entire contents of the acquisition file and in the current 
display of the table.  Refer to Figure 9.8-1  AcqMon Printer Selection Window. 

b) File - Lets the user print any of the four tables to a file specified by the user.  A window 
pops up display toggle buttons for each table and a text field for the directory path and 
name of the file.  The default directory is /tmp.  The default names are acqmon_ground, 
acqmon_moon, acqmon_sun and acqmon_tdrs.  AcqMon checks to see if the user has 
write permissions to write to the specified directory Refer to Figure 9.8-2 AcqMon Print 
ASCII File Menu. 

2. Quit - This option causes a confirmation window to pop up to ensure the user really wants to 
exit the program. 
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Figure 9.8-1  AcqMon Printer Selection Window 

 

 

 

Figure 9.8-2 AcqMon Print ASCII File Menu 

 

Edit Menu 

 

1. Start Time - Allows the user to select to display Current Time (default) at the top of the table 
or to enter a User Start time to put at the top of the table. 

a)  Current Time - This selection causes the first record at the top of each table to be at 
current time - 1.5 hours.  As time passes, the first record will drop off and a new bottom 
record will be added until at the end of the data file. 
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b)  User Start … - This selection pops up a menu to allow the user to enter in GMT time, the 
time of the data to be displayed at the top of the tables.  No data updates will be done as 
with the Current Time option.  Refer to Figure 9.8-3 AcqMon User Start Time Menu. 

 

 

 

 

 

Figure 9.8-3 AcqMon User Start Time Menu 

 

 

Controls Menu 

 

The Controls menu provides the following options: 

1.  SHOW GMTs - Changes the time tags in the tables to GMT format and display the GMT 
format options. 

a) SHOW DAYS - Changes the time tags in the tables and current wall clock time to be 
displayed in DAY format (DDD:HH:MM:SS).  This is the default for the shuttle vehicle. 

b)  SHOW CAL - Changes the time tags in the tables and current wall clock time to be 
displayed in Calendar format (MM/DD:HH:MM:SS).  This is the default for the station 
vehicle. 

2.  SHOW METs/SHOW IETs - Changes the time tags in the table to MET or IET format and 
updates the title line to indicate time type.  MET is displayed for shuttle and IET is displayed 
for station. 

3.  SHOW DTs - Changes the time tags in the table to display as a count down from the current 
GMT time.  When an entire record has counted to zero, then that record is popped off the top 
of the table.  The title line is updated to indicate the time type. 

 

Source Menu 

 

The source menu provides the following sub menu options: 

1.  MOC  – The MOC submenu give a  list  (Ephemeris 1-10)  from which, we can select the MOC 
ephemeris data and associated acquisition data to be displayed.  This option is disabled for 
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the station vehicle. The source and status labels on the top portion of the main menu will be 
updated. 

2.  Global – The Global submenu give a list (Ephemeris 1-8) from which we can select the Global 
ephemeris data from the vehicle already selected and associated acquisition data to be 
displayed. The source and status labels on the top portion of the main menu will be updated. 

    

Text Area 

 

The text area of the main menu displays the acquisition data.  It is broken into two parts, a 
General information area and the data Tables.  Resizing the main menu height-wise, will resize 
the table portion only. 

 

General Information 

 

This portion of the text area displays the current GMT and MET times, the ephemeris source and 
status, the name of the next TDRSS and Ground acquisitions, and a countdown from current 
GMT of the next acquisition events.  The following table describes each parameter: 

 

Item Format Description 

Source String Current Acquisition Data Source Ephemeris or Local PSAT_UDE 
Name 

Comment  String Comment field from PSAT File Menu 

GMTR YYYY:DDD:HH:MM:SS.SSS Liftoff Time 

GMT DDD/HH:MM:SS or 

MM/DD:HH:MM:SS 

Current Greenwich Mean Time  

MET DDD/HH:MM:SS Current Mission or Increment Elapsed Time 

Status String in color Status of Ephemeris Source 

TAOS String Name of next TDRSS to be acquired 

GAOS String Name of next Ground site to be acquired 

Sunrise HH:MM:SS Count-down from current GMT to next Sunrise event 

Noon HH:MM:SS Count-down from current GMT to next Noon event 

Sunset HH:MM:SS Count-down from current GMT to next Sunset event 

Data Age DDD/HH:MM:SS DT count since last PSAT data source update 

Timing ROSS or MANUAL Timing data source 

Beta Fff.f Current solar beta angle in decimal degrees 

Table 9.8-1 AcqMon Data Sources 

Refer to the Figure 9.8.4 for a picture of the display. 

 

 

Acquisition Tables 
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This portion of the text area displays the acquisition tables for Ground Site data (default), TDRSS 
data, Sun data, and Moon data.  There are tabs for each table to select which table to view.  If the 
tab is disabled, then no data for that table type is available due to error processing the file or the 
file was not generated by the PSAT program.  The tab will be highlighted for the current table 
being displayed.  All tables are scrollable vertically and horizontally.  Resizing the main menu 
vertically will allow more records to be viewed. 

 

Ground Site Data 

 

The following table describes the parameters to be displayed on the ground site table.  Refer to 
Figure 9.8.4 for an example of the display. 

 

Item Format Description 

Orbit/ 

Daily Orbit 

int*5/int*2 Orbit Count/Daily Orbit Number for this AOS or this time depending on 
sort option 

Site String Ground site name 

AOS DDD/HH:MM:SS or 

MM/DD:HH:MM:SS 

Time of acquisition of signal with specified site 

LOS DDD/HH:MM:SS or 

MM/DD:HH:MM:SS 

Time of loss of signal with specified site 

Delta Time HH:MM:SS Total time of acquisition with specified site 

Max El Double Maximum elevation in degrees of satellite above the specified site 

Table 9.8-2 AcqMon Ground Site Data 
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Figure 9.8-4 Ground Site Acquisition Table 

TDRSS Data 

 

The following table describes the parameters to be displayed on the TDRSS table.  Refer to 
Figure 9.8.5 for an example of the display. 

 

Item Format Description 

Orbit/ 

Daily Orbit 

int*5/int*2 Orbit Count/Daily Orbit Number for this AOS or this time depending on 
sort option 

Satellite String Satellite name 

AOS DDD/HH:MM:SS or 

MM/DD:HH:MM:SS 

Time of acquisition of signal with specified satellite 

LOS DDD/HH:MM:SS or 

MM/DD:HH:MM:SS 

Time of loss of signal with specified satellite 

Delta Time HH:MM:SS Total time of acquisition with specified satellite 

Table 9.8-3 AcqMon TDRSS Data 
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Figure 9.8-5 TDRSS Acquisition Table 

 

Sun Data 

 

The following table describes the parameters to be displayed on the Sun table.  Refer to Figure 
9.8.6 for an example of the display. 
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Item Format Description 

Orbit/ 

Daily Orbit 

int*5/int*2 Orbit Count/Daily Orbit Number for this AOS or this 
time depending on sort option 

SunRise DDD/HH:MM:SS or MM/DD:HH:MM:SS Time of Sunrise event for specified orbit 

TermRise DDD/HH:MM:SS or MM/DD:HH:MM:SS Time of Terminator Rise event for specified orbit 

Noon DDD/HH:MM:SS or MM/DD:HH:MM:SS Time of Noon event for specified orbit 

TermSet DDD/HH:MM:SS or MM/DD:HH:MM:SS Time of Terminator Set event for specified orbit 

SunSet DDD/HH:MM:SS or MM/DD:HH:MM:SS Time of Sunset event for specified orbit 

Midnite DDD/HH:MM:SS or MM/DD:HH:MM:SS Time of Midnight event for specified orbit 

Beta Double Solar beta angle in degrees for specified orbit 

Table 9.8-4 AcqMon Sun Data 

 

 

 

 

Figure 9.8-6 Sun Acquisition Table 
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A. Acronyms and Abbreviations 
 

 

A/E Ascent / Entry 

ACA Access Control and Audit 

ACS Attitude Control System (ISS) 

ADI Attitude Direction Indicator 

APDS Androgynous Peripheral Docking System (aka APAS) 

APU Auxiliary Power Unit 

ATT Attitude 

Az Azimuth 

BCE Bus Control Element 

BPV Body Pointing Vector 

BV Body Vector 

C/L Checklist 

CB Compute Buffer 

CCC Consolidated Control Center 

CDE  Consolidated Development Environment 

CMG Control Moment Gyroscope 

COAS Crew Optical Alignment Sight 

COTS  Commercial Off the Shelf 

CPA  Closest Point of Approach 

CRANS Configurable Realtime Analysis System 

CW Clohessy-Wiltshire, Continuous Wave 

DACQ Data Acquisition (telemetry stream) 

DAP Digital Autopilot 

DB Deadband or Display Buffer 

DESIG Designate 

DET Rendezvous radar in detect mode 

DEU Display Electronics Unit 

DFE Data Flow Engineer 

DFL Data Format Load 

DGEN Data GENeration 

DLL Dynamic Link Library 

DMT Detailed Maneuver Table, Decreed Moscow Time 

DNAV Display Navigation 

DOF Degrees of Freedom 
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doF Display Overflow (HHL) 

DPS Data Processing System 

DTO Detailed Test Objective 

DVIS Digital Voice Intercommunications System 

DVTOT Total Delta Velocity 

DYN Dynamics 

EECOM Emergency Environmental Consumables Manager 

EGIL Electrical Generation and Illumination 

El Elevation 

EPDC Electrical Power Distribution and Control 

ET External Tank 

EXDV External Delta Velocity 

F/I/W Failure Impact-Assessment Workaround 

FADS Flight Analysis and Design System 

FADS Flight Analysis Design System 

FAO Flight Activities Officer 

FC Flight Controllers 

FCOH Flight Controller’s Operational Handbook 

FCR Flight Control Room 

FCT Flight Control Team 

FD Flight Director 

FDF Flight Data File 

FEP Front End Processor (telemetry) 

FES Flight Evaporator System 

FLTR Filter Vector 

FN Flight Note 

FOM Figure of merit 

FOV Field of View 

FPA Flight path angle 

FRCS Forward RCS 

FREE Free Drift DAP Mode 

FRR Flight Readiness Review 

FSM Facilities System Manager 

FSSR Functional subsystem software requirements 

FSW Flight Software 

FTP File Transfer Protocol 

G&C Ground Rules and Constraints, Guidance and Control 

GA Group Administrator 

GC Ground Control 
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GDR Generalized data retrieval 

GDSG Ku antenna pointing and inertial stabilization are under GPC control 

GMT Greenwich Mean Time 

GNC Guidance Navigation and Control 

GPC General Purpose Computer 

HDR High Data Rate 

HHL Hand Held Lidar 

HP Height at perigee 

HT Height above the surface of the earth 

I/O Input/output 

IBCS ISS Body Coordinate System 

IC Initial Conditions  

IFM In-flight Maintenance 

ILC Integrated Load checkout 

I-Load Initial Load 

IMU Inertial measurement unit 

INCO Instrumentation and Communications 

INS Inertial navigation system 

INTL Inertial DAP Mode 

IPS Instrument Pointing System, Integrated Planning System 

ISCS ISS Structural Coordinate System 

ISP Information Sharing Protocol 

Isp  
Specific impulse 

ISPHOST Information Sharing Protocol Host 

J2K0  Julian Epoch 2000.0 

JMICB Joint Mission Integration Control Board 

JOIP Joint Operations Integration Plan 

LCG Lambert Cyclical Guidance 

LDR Low Data Rate 

Lidar Light Detection and Ranging 

LOS Line of Sight, Loss of Signal 

LOWZ Low Z DAP control mode 

LRU Line Replaceable Unit 

LSO  Landing Support Officer 

LVC Local Vertical Curvilinear 

LVLH Local Vertical Local Horizontal 

Man Manual 

MC Midcourse Correction Burn 
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MCDS Multifunction CRT Display System 

MDM Multiplexer / Demultiplexer 

MDRF Mission Data Request Form 

MEWS Mission Evaluation Workstation Software 

MM Major Mode 

MMACS  

MMU Mass Memory Unit 

MOC Mission Operations Computer 

MOCR Mission Operations Control Room 

MOIR Mission Operations Integration Room 

MPSR Multi Purpose Support Room 

mrad milliradians 

MSID Measurement Stimulus Identifier 

MSK Manual Select Keyboard 

NBAT Nominal Bus Assignment Table 

NC Phase Adjust Rendezvous Burn 

NCC Corrective Combination Rendezvous Burn 

NH Differential Height Adjust Rendezvous Burn 

NORMZ Norm Z DAP control mode 

NPC Rendezvous plane change 

NSP  

ODRC Orbital Data Retrieval System 

ODS Orbiter Docking System 

OF  Offset field 

OFD  Orbit Flight Design 

OFS Onboard Fault Summary 

OM Omicron 

OMP Orbit Maneuver Processor 

OMS Orbital Maneuvering System 

OOP Out of Plane 

ORBT Optimized R-bar Trajectory 

OTBP Orbit Targeting Bench Program 

OTSF Orbit Targeting Specialist function 

PABX Public Access phone 

PAD Pre-Advisory Data 

PAO Public Affairs Officer 

PCDECOM  Payload Commutation/Decommutation 

PCM Pulse Code Modulator 

PCMCIA Personal Computer Memory Card International Association 
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PCMMU Pulse Code Modulation Master Unit 

PDI Payload Data Interlever 

PDRS Payload Deployment and Retrieval System 

PDSS Payload Data Service System 

PEG Powered Explicit Guidance 

PEG4 Powered Explicit Guidance 4 

PEG4A Powered Explicit Guidance 4 Ascent - Linear Terminal Velocity Constraint 

PEG4D Powered Explicit Guidance 4 Descent - Linear Terminal Velocity Constraint 

PEG7 Powered Explicit Guidance 7 - External Delta V Mode on-orbit  

PET Phase Elapsed Time 

PGSC Payload and General Support Computer 

PIP Payload Integration Plan 

PIT Pitch 

PL Payload Forward 

PLBAY Payload Bay 

PLS Pulse 

PRCS Primary reaction control system 

PRED MATCH Predicted Match 

PRIM Primary DAP control mode 

Prop Propellant 

PROP Propagated 

PROXOPS Proximity Operations 

PSAP Predicted Site Acquisition Processor 

PSAT Predicted Site Acquisition Table 

PSL Perpendicular to the Sun Line 

PTC Passive Thermal Control 

PTM Payload Telemetry Message 

RCT Rendezvous Constraints Table 

REF Reference  

REL NAV Relative Navigation 

RES Residuals 

RHC Reaction Hand Controller 

RIO Russian Interface Officer 

RJD Reaction Jet Drivers 

RM Redundancy Management 

RMD Relative Motion Digitals 

RMS Remote manipulator System 

ROSS Realtime Operations Support Software 

ROT Rotation 
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ROTR Rotation about a specific eigen axis 

RPL ROSS Parameter List 

RPOP Rendezvous and Proximity Operations Program  

RPS Rendezvous Procedures Support 

RPT Rendezvous Plan Table 

RPY Roll Pitch Yaw 

RR Rendezvous Radar 

RSA Russian Space Agency 

RSBY Rectilinear Shuttle Body 

RSS Root Sum Squared 

RTP Rendezvous Targeting Processor 

SA Save Area 

SADS Station Aids to Docking and Separation 

SCA Satellite Control Analyst 

SCP Specific Console Procedure 

SELS SFOC Electronic Library System 

SES Systems Engineering Simulator 

SFOC Space Flight Operations Contract 

SGI Silicon Graphics Interface 

SMS Shuttle Mission Simulator 

SNIP Shuttle Nose in Plane 

SOR Stable Orbit Rendezvous 

SPADOC Space Defense Operations Center - USSPACECOM 

SPEC Specialist Function 

SPORTS Spacecraft Proximity Operations Real-Time Simulator 

SR/SS Sunrise/Sunset 

SRCH Search 

SSP Space Shuttle Program 

ST Star Tracker 

STAMPS Spacecraft Trajectory Analysis and Mission Planning Simulation 

STBY Standby 

STF SOC Transmittal Form 

STRG String 

STRK Star Tracker 

STS Space Transportation System 

SVO Special Vehicle Operations 

T1 Targeted time for the burn 

T1 TIG Time of Ignition Relative to Basetime 

T1ILOAD I-loaded time for the burn 
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T2 TIG Basetime 

TCA Time of Closet Approach 

TCS Trajectory Control Sensor 

TCS CAD Trajectory Control Sensor Command and Display 

TDR True-of-date rotating 

TDRE TDRS East 

TDRS Tracking and Data Relay Satellite 

TDRW TDRS West 

TDRZ TDRS Spare 

TELEV Elevation Angle Search Task 

TFF Time for Free Fall 

TFL Telemetry Format Loads 

TGO Time to Go 

TGT Target 

TGT DT Target Delta Time 

TGT EL ANG Target Elevation Angle 

TGT ITER Target Iteration 

THC Translational Hand Controller 

TI Target Intercept 

TIG Time of Ignition 

TIPS Thermal Impulse Printer System 

TOAST  Trajectory Operational Application Software Task 

TOCSS Trajectory Operations Computer Systems Support  

TORF Twice Orbital Rate Flyaround 

TORRA Twice Orbital Rate -R-Bar Approach 

TORVA Twice Orbital Rate Rbar to Vbar transition 

TPI Terminal Phase Initiation 

TRAD Tools for Rendezvous and Docking 

TRAJ Trajectory officer 

TRANS DAP Transition Digital Autopilot 

TRCK Rndz Radar Performing Close-loop Tracking 

TRK Track 

trkdyn Track/Dynamics 

TSP Trajectory Software Pane 

TSS GND Trajectory Control Sensor Ground Display User Interface Application 

TSTAC Trajectory Synchronous to Asynchronous Converter 

TTA Time to Apogee 

TTC Time to Circularize 

TTP Time to Perigee 

                   



SHUTTLE OPS RESP: R. Bigonesse Acronyms and Abbreviations 
RNDZ CHB/DM-CH-08 REV B: 1/15/02 Appendix A 

Verify this is correct version before use.  A-8 

TUP Trajectory Update 

TV Thrust Vector 

TVR Thrust Vector Roll 

U/L Uplink 

UP Universal Pointing 

UPP User Parameter Processing 

USA United Space Alliance 

USSPACECOM United States Space Command 

UVW Quasi-inertial, right-handed Cartesian coordinate system 

VAT Vector Administration Table 

Vbar Velocity Vector Axis 

VC Vector Compare 

VCR Video Cassette Recorder (records data in this case - ROSS function) 

VEL Velocity 

VERN Vernier Attitude DAP Control Mode 

VGA Video Graphics Array 

VGO Velocity to GO 

Vhoriz Horizontal component of Velocity 

VIT Vent initialization table 

VP Variable Parameter 

VPOP Visual Proximity Operations Processor 

VRCS Vernier Reaction Control System 

VTL Vent Timeline 

VTS Video Transfer Switch 

Vvert Vertical component of Velocity 

WGL Weight Gain/Loss 

WN Working Note 

Wp Weight of propellant consumption  

WS Workstation 

WSS Workstation Systems Support 

Wv Weight of vehicle at start of burn 

XD X LVLH Offset 

XH +X high RCS 

XL +X low RCS 

XTDV External delta V 

XTND Extended 

YD  Y LVLH Offset 

YL +Y low RCS 

YPR Yaw Pitch Roll 
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ZD  Z LVLH Offset 

ZFW Orbit Fixed 

ZH +Z high RCS 

ZL +Z low RCS 

ZM -Z high RCS 

 

 

                   


